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Preface
Welcome to the Gplus Adapter 7.5 for Siebel CRM Deployment Guide. This 
guide lists system requirements for the Gplus Adapter 7.5 for Siebel CRM (the 
Gplus Adapter) and describes how to install and configure the components of 
this Adapter. 

The Gplus Adapter 7.5 for Siebel CRM is a software solution that provides 
seamless integration between Siebel CRM and Genesys 7 solutions. This 
combination brings together Siebel’s leading software applications and 
Genesys’ contact center solutions.

The Gplus Adapter provides a single point of access to contact information. 
The Adapter brings together multiple media and channels, and provides access 
to the power of Siebel software, promoting better contact relationships overall. 

More information about the Gplus Adapter and how to use it is provided in the 
Gplus Adapter 7.5 for Siebel CRM User’s Guide. 

Note: This document is valid only for Genesys Release 7.5 of the Gplus 
Adapter product. To see documents created for other releases of this 
product, please visit the Genesys Technical Support website, or request 
the Documentation Library CD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com.

This chapter includes the following sections:
 Intended Audience, page 12
 Chapter Summaries, page 12
 Document Conventions, page 13
 Related Resources, page 15
 Making Comments on This Document, page 16

In brief, you will find the following information in this guide:

• System requirements

• Configuration information

• Installation procedures

orderman@genesyslab.com
orderman@genesyslab.com
orderman@genesyslab.com
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Intended Audience
This guide is intended for system administrators or other individuals who 
install and configure the Gplus Adapter.

This guide assumes that you have a basic understanding of:

• Computer-telephony integration (CTI) concepts, processes, terminology, 
and applications.

• TCP/IP Internetworking fundamentals including routing and client/server 
application communications via TCP sockets.

• Basic conceptual understanding of database systems, including SQL 
commands necessary to validate availability of your company’s database 
environment. You should involve your company’s DBA resources during 
the implementation of this project.

• The network configurations used in your company’s computing 
environment.

You should also be familiar with the following Genesys solutions:

• Framework 7.2 or 7.5

• Enterprise Routing 7.2 or 7.5

• Outbound Contact Solution 7.5, 7.2, 7.1, or 7.0

• Multimedia 7.2 or 7.5 (formerly Multi Channel Routing [MCR])

Chapter Summaries
This Deployment Guide provides installation and configuration information for 
the Gplus Adapter. To help you locate information, the guide includes a Table 
of Contents and an Index. In addition to this opening chapter, this guide 
contains the following chapters:

• Chapter 1, “System Requirements,” on page 17, describes the minimum 
system and software requirements for installing this product.

• Chapter 2, “Configuration and Installation of the Gplus Communication 
Server for Siebel CRM,” on page 31, describes how to configure and 
install the Communication Server and Driver.

• Chapter 3, “Configuration and Installation of the Configuration 
Synchronization Component,” on page 55, describes how to configure and 
install the Configuration Synchronization Component. 

• Chapter 4, “Configuration and Installation of the Campaign 
Synchronization Component,” on page 83, describes how to configure and 
install Campaign Synchronization Component. This component enables 
Siebel CRM users to export campaigns and campaign-related data from 
Siebel to Genesys.
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• Chapter 5, “Configuration and Installation of the Voice Component,” on 
page 119, describes how to configure and install the Voice Component, 
including driver parameters, device commands, and device events for the 
Voice Component. This component includes solutions for Voice and Web 
Callback, Outbound Campaign, Expert Contact, and Network Routing.

• Chapter 6, “Configuration and Installation of the Gplus UCS Gateway,” on 
page 325, describes how to configure and install the Genesys Gplus UCS 
Gateway Server. This server is a back-end component used by the Gplus 
Multimedia Component to access data stored in the Genesys Universal 
Server Desktop.

• Chapter 7, “Configuration and Installation of the Multimedia Component,” 
on page 331, describes how to configure and install the Multimedia 
Component.

• Chapter 8, “Configuration and Installation of the Media Routing 
Component,” on page 371, describes how to configure and install the 
Media Routing Component. This component is used for routing any type 
of interaction supported by Genesys Multimedia.

• Chapter 9, “Uninstallation Instructions,” on page 393, provides step-by-
step instructions on uninstalling the Gplus Adapter for Siebel CRM 
Components.

• The Appendix, “Scripts” on page 435, describes how to generate and 
deploy browser scripts and update the Application_PreNavigate event.

Document Conventions
This guide uses the following document conventions:

Words and Terminology

Throughout this document, the Voice, Multimedia, and Media Routing 
components of the Gplus Adapter are categorized as “driver-based 
components,” whereas the Configuration Synchronization, Campaign 
Synchronization, Communication Server, and UCS Gateway components of 
the Gplus Adapter are called “server-based components.”

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. Here is a sample version number:
75gp_dep_slcrm_08-2007_v7.5.001.00

You will need this number when you are talking with Genesys Technical 
Support about this product. 
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Type Styles

Italic

In this document, italic is used for the titles of documents, when a term is being 
defined, for emphasis, and for mathematical variables.

Examples • Please consult the Genesys 7 Migration Guide for more information.

• A customary and usual practice is one that is widely accepted and used 
within a particular industry or profession.

• Do not use this value for this option.

• The formula, x +1 = 7 where x stands for . . .

Monospace Font

A monospace font, which is shown in the following examples, is used for: 

• All programming identifiers and GUI elements. This convention includes 
the names of directories, files, folders, configuration objects, paths, scripts, 
dialog boxes, options, fields, text and list boxes, operational modes, all 
buttons including radio buttons, check boxes, commands, tabs, CTI events, 
and error messages; the values of options; logical arguments and command 
syntax; and code samples.

Examples  Select the Show variables on screen check box.
 Click the Summation button.
 In the Properties dialog box, enter the value for the host server in your 

environment.
 In the Operand text box, enter your formula.
 Click OK to exit the Properties dialog box.
 The following table presents the complete set of error messages 

T-Server® distributes in EventError events.
 If you select true for the inbound-bsns-calls option, all established 

inbound calls on a local agent are considered business calls.

• For any text the user must manually enter during a configuration or 
installation procedure: 

Example  Enter exit at the command line.

Information About Screen Captures Used in This 
Document

Screen captures taken from the product GUI (graphical user interface) and 
used in this document may contain minor errors in spelling, capitalization, or 
grammar. The text accompanying and explaining the screen captures corrects 
such errors except when such a correction would prevent you from installing, 
configuring, or successfully using the product. For example, if an option in the 
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Siebel user interface contains a spelling error, then this document may use the 
name exactly as it appears in that Siebel user interface; such errors are not 
necessarily corrected in any accompanying text.

Use of Square Brackets

In any logical arguments, commands, and programming syntax presented in 
this document, square brackets are used to indicate that a particular parametric 
value is optional. That is, the value is not required to resolve a command, 
argument, or programming syntax. The customer/user decides whether to 
supply a value and what that value is. Here is a sample:

smcp_server -host [/flags]s

Use of Angle Brackets

Angle brackets are used to indicate that a value in a logical argument, 
command, or programming syntax is required, but that the user must supply 
the data for the value. Because the value is specific to an individual 
enterprise—for example, DNs or port numbers—the program cannot predict 
(that is, program in) what the value is. Here is a sample:

smcp_server -host <confighost>

Related Resources
• Gplus Adapter 7.5 for Siebel CRM User’s Guide. Explains how to use the 

Adapter in your contact center environment. Introduces the Gplus Adapter 
and highlights new features in the current release.

• Gplus Adapter 7.5 for Siebel CRM Developer’s Guide. Describes the API 
(application programming interface) with which you can customize the 
export of campaigns, campaign contacts, and Do Not Call requests from 
Siebel to Genesys software.

• The Release Notes and Product Advisory for this product and associated 
products, are available on the Genesys Technical Support website at 
http://genesyslab.com/support.

• The Genesys Technical Publications Glossary, which ships on the Genesys 
Documentation Library CD. Provides a fairly comprehensive list of 
Genesys and CTI terminology and acronyms in this document.

• The Genesys Migration Guide, also on the Genesys Documentation 
Library CD, which contains a documented migration strategy for each 
software release. Please refer to the applicable portion or contact Genesys 
Technical Support for additional information.

Information on supported hardware and third-party software is available on the 
Genesys Technical Support website in the following documents: 

http://genesyslab.com/support
http://genesyslab.com/support
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• Genesys Supported Operating Systems and Databases

• Genesys Supported Media Interfaces

Genesys product documentation is available on the:

• Genesys Technical Support website at http://genesyslab.com/support. 

• Genesys Documentation Library CD, which you can order by e-mail from 
Genesys Order Management at orderman@genesyslab.com. 

Making Comments on This Document
If you especially like or dislike anything about this document, please feel free 
to e-mail your comments to Techpubs.webadmin@genesyslab.com. 

You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the information in this document only and to the 
way in which the information is presented. Speak to Genesys Technical 
Support if you have suggestions about the product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

http://genesyslab.com/support/dl/retrieve/default.asp?item=B6C52FB62DB42BB229B02755A3D92054
http://genesyslab.com/support/dl/retrieve/default.asp?item=A9CB309AF4DEB8127C5640A3C32445A7
http://genesyslab.com/support
http://genesyslab.com/support/home/index
mailto:orderman@genesyslab.com
mailto:techpubs.webadmin@genesyslab.com
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Chapter

1 System Requirements
This chapter outlines the minimum system and software requirements for the 
Gplus Adapter 7.5 for Siebel CRM (Gplus Adapter). 

Please review the system requirements before installing the Gplus Adapter. 

This chapter provides information on the following:
 Deployment Options, page 17
 Installation Options, page 18
 Universal Definition File, page 22
 System Requirements for Gplus Adapter Components, page 23
 Date and Time Synchronization, page 29

Deployment Options
If you are deploying the Gplus Adapter for the first time, Gplus Adapter 
migration issues are not your concern. If your organization has already 
deployed an earlier version of the Gplus Adapter, your deployment options 
will vary depending on the version of the Gplus Adapter that you use. Table 1 
describes, at a very high level, where to find the appropriate instructions for 
installing the Gplus Adapter 7.5 for Siebel CRM, depending on whether your 
organization has a previous version of the Adapter. 

Note: In the following table and throughout this document, the Voice, 
Multimedia, and Media Routing components of the Gplus Adapter are 
identified as “driver-based components,” and the Configuration 
Synchronization, Campaign Synchronization, Communication Server, 
and UCS Gateway components of the Gplus Adapter are called 
“server-based components.”
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Note:  Customers are responsible for migration of all customizations.

Installation Options
Some of the features of this release of the Gplus Adapter 7.5 for Siebel CRM 
have a dependency upon other Siebel or Genesys products, and some also 
depend on other Gplus Adapter components. To use these Gplus Adapter 
features, you must implement the requirements. 

The standard procedure, which this document assumes you are following, is to 
install all of the required external product requirements first, before you start 
the installation of the Gplus Adapter.

Gplus Adapter External Requirements

Table 2 lists the Genesys and Siebel application software required for various 
types of Gplus Adapter deployments. Depending on the Gplus Adapter 
components and features installed at your site, certain pieces of Siebel and 
Genesys software must also be present to support your deployment, in addition 
to the fundamental requirements.

Table 1: Deployment Options

Customers Details Comments

New users of the Gplus 
Adapter for Siebel CRM.

Follow the installation instructions 
detailed in the Gplus Adapter 7.5 for 
Siebel CRM Deployment Guide.

New customers are those 
deploying the Gplus Adapter 
for Siebel CRM for the first 
time.

Existing users of Gplus 
Adapter 6.5.2, 7.0, 7.1, or 7.2 
for Siebel CRM who want 
new (7.5) features and 
maintenance.

Follow the procedures for migrating 
from the Gplus Adapter 6.5.2, 7.0, 7.1, 
or 7.2 for Siebel to the Gplus Adapter 
7.5 for Siebel CRM in the appropriate 
section of the Genesys 7 Migration 
Guide.

Warning: For information 
regarding the uninstall 
process, refer to the Gplus 
Adapter for Siebel CRM 
documentation. Then if 
necessary, contact Genesys 
Technical Support.

Existing users of a pre-6.5.2 
Gplus Adapter for Siebel who 
are seeking new (7.5) features 
and maintenance.

Contact Genesys Technical Support to 
discuss options specific to your 
current version and configuration.
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The underlying Genesys framework of the integrated Siebel and Gplus 
Adapter solution is powered by Genesys Framework and T-Servers.

The requirements listed above are particularly significant if you want 
additional information about the software that supports a Gplus Adapter 
feature. The Gplus Adapter integrates many software applications. Detailed 
information about some Gplus Adapter features is only available in the proper 
documentation for the integrated software application that powers the feature.

Table 2:  Gplus Adapter Options and Related System 
Requirements

Fundamental Requirements (required for any deployment): 

• Siebel Call Center Application

• Genesys Framework

Basic Voice

• Fundamental requirements, as listed 
above.

• Genesys T-Server

Genesys E-mail

• Gplus Adapter Multimedia 
Component

• Genesys Multimedia

Expert Contact

• Genesys CTI-Less T-Server

Universal Callback

• Genesys Universal Callback server

Media Routing

• Gplus Adapter Multimedia 
Component

• Interaction Server (part of Genesys 
Multimedia)

Outbound Campaign

• Siebel Marketing

• Genesys Outbound Contact Server

Genesys Chat

• Gplus Adapter Multimedia 
Component

• Genesys Multimedia

Communication Server

• Fundamental requirements only, as 
listed above.

UCS Gateway

• Fundamental requirements, as listed 
above.

• Sun Java Runtime Environment 
(JRE) 1.5.x or later

Configuration Synchronization

• Fundamental requirements, as listed 
above.

• Genesys T-Server

Campaign Synchronization

• Fundamental requirements, as listed 
above.

• Siebel Marketing

• Genesys Outbound Contact Server
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Gplus Adapter Internal Requirements

Some of the components of this 7.5 release of the Gplus Adapter for Siebel 
CRM have a dependency upon another Gplus Adapter component. This means 
that you must install some components before others. Table 3 on page 20 lists 
each major Gplus Adapter component and provides notes on its dependencies 
on other Gplus Adapter components. 

To see the external software requirements for each component, refer to the 
listing for that component under “System Requirements for 
Gplus Adapter Components” on page 23.

Table 3: Internal Dependencies Among Gplus Adapter 
Components

Gplus Adapter 
Components/Features 

/Functionality
Gplus Adapter (Internal) Requirements

Communication Server No prerequisite Gplus Adapter components.

The Communication Server is a prerequisite for 
Gplus Adapter driver-based components.

Configuration 
Synchronization Component

No prerequisite Gplus Adapter components.

No Gplus Adapter components have 
dependencies on this component. However, 
Configuration Synchronization functionality is 
intended for use with the Voice and Multimedia 
components.

Campaign Synchronization 
Component

No prerequisite Gplus Adapter components.

No Gplus Adapter components have technical 
dependencies on this component. However, 
Campaign Synchronization functionality is 
intended for use with the Outbound Campaign 
feature of the Voice Component.

Voice Component

including:

• Basic Voice

• Expert Contact

• Outbound Campaign

• Universal Callback

Gplus Communication Server for Siebel CRM 
should be installed first.

You must first import the Basic Voice feature 
before importing the other Gplus Adapter Voice 
Components. 

You must configure the Voice Component, 
including all of the features you intend to use, 
before adding any other driver-based Adapter 
Component. 
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Multimedia Component

including:

• Genesys E-mail

• Genesys Chat

The following components should be deployed:

• Gplus UCS Gateway for Siebel CRM

• Gplus Communication Server for Siebel 
CRM

Media Routing Feature The following component should be deployed:

• Gplus Adapter for Siebel CRM Multimedia 
Component

Table 3: Internal Dependencies Among Gplus Adapter 
Components (Continued) 

Gplus Adapter 
Components/Features 

/Functionality
Gplus Adapter (Internal) Requirements
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Universal Definition File
This release includes a new definition file, the GenComm_universal.def file. 
This universal.def file is used by the Gplus Adapter Voice, Multimedia 
Component, and Media Routing Component. This text file provides sample 
Siebel configuration data for these components. The file contains configuration 
parameters, driver descriptions, profile descriptions, and event and command 
descriptions. The configurations created with the data from this .def file 
incorporate the following drivers:

• Gplus_Voice

• Gplus_OpenMedia

And the following profiles:

• Gplus Voice

• Gplus OpenMedia

If your goal is a configuration that does not use one of these drivers, you must 
remove any unused driver and corresponding profile after you import them. 
For more information, see Chapter 5, “Configuration and Installation of the 
Voice Component” and Chapter 7, “Configuration and Installation of the 
Multimedia Component”.

Before Importing the Definition File

The GenComm_universal.def file includes commands and events to support the 
Voice, Multimedia, and Media Routing components. Use this file to create the 
drivers and the profiles for these components.

To implement some configurations, you must modify the GenComm 
_universal.def file before importing it.

Migrations and Upgrades

If you are migrating or upgrading to the Gplus Adapter 7.5 for Siebel CRM, 
refer to the Genesys 7 Migration Guide for crucial information about migrating 
your customizations to the newer version of the Adapter. The Genesys 7 
Migration Guide includes information and examples that may simplify the 
migration of customizations coded in your old.def file. 

Gplus Adapter implementation libraries are common to all driver-based 
components (Voice, Multimedia, Media Routing) of the Gplus Adapter 7.5 for 
Siebel CRM. 

This means that if any of the driver-based components is upgraded to the 
newer version, then all Gplus Adapter for Siebel CRM components running in 
this Siebel Server will share and use the new upgraded Adapter 
implementation libraries.



Gplus Adapter for Siebel CRM—Deployment Guide 23

Chapter 1: System Requirements System Requirements for Gplus Adapter Components

System Requirements for 
Gplus Adapter Components

The Gplus Adapter is integrated with the Siebel Server, so all Siebel Server 
hardware and software requirements are applicable to the Gplus Adapter and 
its components. The Siebel Server must have the Communications Session 
Manager component enabled in order to use the Gplus Adapter. Refer to the 
Siebel documentation for current system requirements.

Note: Information about supported operating systems and platforms is 
available in the Genesys 7 Supported Operating Systems and 
Databases Reference Manual.

Note: For the most up-to-date information about supported Genesys 
applications, consult the Gplus Adapter for Siebel CRM chapter in the 
latest Genesys 7 Interoperability Guide. 

Gplus Communication Server Requirements

Hardware Requirements

You need the following hardware to deploy the Gplus Adapter for Siebel CRM 
Communication Server:

• Pentium III 700 Mhz CPU or faster 

• 256 MB of RAM 

• 64 MB of disk space 

• 800 × 600 256-color monitor or higher 

• Network adapter and network connection 

Note: These are minimum hardware requirements. For large call centers 
and/or large call volumes, more hardware resources (especially RAM 
and CPU) will be required.
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Software Requirements

You need the following software to deploy the Gplus Communication Server.

Genesys Applications

• Consult the Gplus Adapter for Siebel CRM chapter in the Genesys 7 
Interoperability Guide.

Configuration Synchronization Component Requirements

Hardware Requirements

You need the following hardware to deploy the Gplus Adapter for Siebel CRM 
Configuration Synchronization Component:

• Pentium III 700 Mhz CPU or faster 

• 256 MB of RAM 

• 200 MB of disk space 

• 800 × 600 256-color monitor or higher 

• Network adapter and network connection 

Note: These are minimum hardware requirements. For large call centers 
and/or large call volumes, more hardware resources (especially RAM 
and CPU) will be required.

Software Requirements

You need the following software to deploy the Gplus Adapter for Siebel CRM 
Configuration Synchronization Component:

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Server

• Siebel Tools

• Siebel Web Engine

• Siebel Web Client

Genesys Applications

• Framework 7.0, 7.1, 7.2, or 7.5
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Campaign Synchronization Component Requirements

Hardware Requirements

You need the following hardware to deploy the Gplus Adapter for Siebel CRM 
Campaign Synchronization Component:

• Pentium III 700 Mhz CPU or faster 

• 256 MB of RAM 

• 500 MB of disk space 

• 800 × 600 256-color monitor or higher 

• Network adapter and network connection 

Note: These are minimum hardware requirements. For large call centers 
and/or large call volumes, more hardware resources (especially RAM 
and CPU) will be required.

Software Requirements

You need the following software to deploy the Gplus Adapter 7.5 for Siebel 
CRM Campaign Synchronization Component.

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Server

• Siebel Tools

• Siebel Web Engine

• Siebel Web Client

• Siebel Marketing

Note: Campaign Synchronization functionality is intended for use with the 
Outbound Campaign feature, which requires Siebel Marketing; so 
Campaign Synchronization effectively requires Siebel Marketing.

Genesys Applications

• Framework 7.0, 7.1, 7.2, or 7.5

• Outbound Contact 7.0, 7.1, or 7.2, or 7.5 (7.2 or higher required for 
support of Call Result synchronization)
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Voice Component Requirements

The Voice Component includes several features:

• Basic Voice

• Expert Contact

• Outbound Campaign

• Universal Callback 

Most of these Voice features can be regarded as options, but to deploy any 
feature of the Siebel CRM Voice Component, you must first deploy the 
fundamental Basic Voice feature. The system requirements for this feature are 
listed below. 

Basic Voice Feature (Fundamental Voice Component) 
Requirements

The following minimum requirements apply to all Voice Component features.

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Server

• Siebel Call Center

• Siebel Tools

• Siebel Web Client

Genesys Applications

• Framework 7.0, 7.1, 7.2, or 7.5

• Gplus Communication Server 7.2 or 7.5

• Configuration Server 7.0, 7.1, 7.2, or 7.5

• Configuration Manager 7.0, 7.1, 7.2, or 7.5

• T-Server 7.0, 7.1, 7.2, or 7.5 (7.2 or higher is required if using Two-Step 
Network Transfer functionality)

Expert Contact Feature Requirements

In addition to the requirements for the Basic Voice feature listed above, you 
need the following software to deploy the Expert Contact feature of the Voice 
Component.

Genesys Gplus Adapter Components

• Basic Voice
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Genesys Applications

• Genesys Expert Contact 7.0, 7.1, or 7.2

Outbound Campaign Feature Requirements

In addition to the requirements for the Basic Voice feature listed above, you 
need the following software to deploy and use the Outbound Campaign 
feature.

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Marketing

Note: In addition to the fundamental Siebel application requirements (the 
requirements imposed by the Basic Voice feature), the Outbound 
Campaign feature also requires Siebel Marketing. Siebel Marketing is 
required to manage outbound campaign interactions.

Genesys Applications 

• Outbound Contact 7.0, 7.1, 7.2, or 7.5

Genesys Gplus Adapter Components

• Gplus Configuration Synchronization Component

• Gplus Campaign Synchronization Component

Universal Callback Feature Requirements

In addition to the requirements for the Basic Voice feature listed above, you 
need the following software to deploy the Universal Callback feature of the 
Voice Component:

Genesys Applications 

• Universal Callback Server 7.1

Gplus UCS Gateway Requirements

Hardware Requirements

You need the following hardware to deploy the Gplus Adapter for Siebel CRM 
Communication Server:

• Pentium III 700 Mhz CPU or faster 

• 256 MB of RAM 
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• 64 MB of disk space 

• 800 × 600 256-color monitor or higher 

• Network adapter and network connection 

Note: These are minimum hardware requirements. For large call centers 
and/or large call volumes, more hardware resources (especially RAM 
and CPU) will be required.

Software Requirements

You need the following software to deploy the Gplus UCS Gateway.

Genesys Applications 

• Framework 7.2 or 7.5

Other Applications 

• Sun Java Runtime Environment (JRE) 1.5.x

Multimedia Component Requirements

You need the following software to deploy the Gplus Adapter 7.5 for Siebel 
CRM Multimedia Component.

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Server

• Siebel Tools

• Siebel Call Center

• Siebel Web Client

Genesys Applications 

• Framework 7.2 or 7.5

• Multimedia 7.2 or 7.5

• Universal Routing 7.2 or 7.5

Note: For information about service packs and patches required by Siebel, 
see Siebel documentation and the Siebel Technical Support website.
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Gplus Adapter Media Routing Component Requirements

You need the following software to deploy the Gplus Adapter 7.5 for Siebel 
CRM Media Routing Component.

Siebel 7.5.3, 7.7/7.8/8.0/8.1 Applications

• Siebel Server

• Siebel Tools

• Siebel Call Center

• Siebel Web Client

Genesys Applications 

• Multimedia 7.2 or 7.5 

• Framework 7.2 or 7.5 

• Universal Routing 7.2 or 7.5 

Genesys Gplus Adapter Components

• Gplus Adapter 7.5 for Siebel CRM Multimedia Component

• Gplus Communication Server 7.5

Date and Time Synchronization
Interactions between client/server applications in a multi-tiered computing 
environments rely heavily on the proper configuration of the client and host 
system. An important consideration is the proper management of the 
Date/Time and Time Zone configuration. 

The records exchanged among Genesys, Siebel, and database systems carry 
timestamps. Computing systems designed to work together can produce 
unpredictable results if the system dates and time are not synchronized. 
Therefore, please make every effort to adhere to the following time 
synchronization guidelines:

• Enterprise servers that host Genesys, Siebel or database applications 
should have their Time Zone configured properly for their particular 
geographic region. To configure the timezone, please see the instructions 
from the hardware or software manufacturer for your particular operating 
system(s).

• As a best practice, all servers that process Genesys and Siebel data should 
be synchronized to the second. This synchronization should be maintained 
continuously and validated on a regular basis. For security reasons, 
Genesys strongly recommends the use and deployment of Network Time 



30 Gplus Adapter 7.5

Chapter 1: System Requirements Date and Time Synchronization

Protocol (NTP), version 4.1 or greater. The full protocol suite should be 
deployed, and derivative protocols like DAYTIME, SNTP, or RDATE 
should be avoided.

• For a large environment with multiple call centers or multiple contact 
points, the deployment of a network time appliance with stratum 1 access 
should be considered. For those deployments in WAN environments where 
packet latency may affect NTP operation, multiple NTP appliances should 
be deployed to individual LAN segments. Genesys does not recommend 
particular equipment at this time, however, we do want you to be aware of 
the following manufacturers of dedicated timeserver hardware:

• For enterprise deployments in regulated environments (financial services, 
insurance, government, brokerage, and so on), check with appropriate legal 
resources. Certain jurisdictions have specific requirements that may 
supersede these suggestions.

• Deployment of timeserver resources can impact the operations of certain 
authentication technologies. You should coordinate the deployment of NTP 
with members of your systems security and database technologies 
department(s).

• For more information about NTP, see http://www.ntp.org. 

EndRun Technologies
http://www.endruntechnologies.com

Praecis Cntp

Datum Corporation
http://www.datum.com

Syncserver S100

True Time
http://www.truetime.com

TimeVault

TrueTime 
http://www.truetime.com

NTS-200

Lantronix
http://www.lantronix.com

CoBox NTP
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2 Configuration and 
Installation of the Gplus 
Communication Server for 
Siebel CRM
This chapter describes how to configure and install the Gplus Communication 
Server for Siebel CRM. 

This chapter includes the following sections:
 Overview, page 31
 New in This Release, page 32
 Planning, page 32
 Configuring Genesys, page 33
 Installation, page 44
 Configuring Siebel, page 52

Overview
The Gplus Communication Server for Siebel CRM reduces in-process 
coupling between Genesys and Siebel code and to increase the isolation level 
among communication components. The result is decreased risk of failure and 
more flexible deployment possibilities for a heterogeneous environment 
(platforms, operating system).

The Gplus Communication Server for Siebel CRM communication component 
consists of two major parts:

Genesys Communication Driver. The Communication driver is a thin layer 
which delivers messages between Siebel Communication Server and the Gplus 



32 Gplus Adapter 7.5

Chapter 2: Configuration and Installation of the Gplus Communication Server for Siebel CRM New in This Release

Communication Server. The Gplus Communication driver must be deployed 
on a Siebel Server host.

Gplus Communication Server. The Gplus Communication Server acts as a 
host process for pluggable remote drivers for underlying Genesys 
communication middleware (voice T-Servers and Open Media Interaction 
Server). The Communication Server may run on different hosts with different 
platforms and operating systems.

Note: The Gplus Communication Server is a prerequisite for all driver-based 
components.

The process of configuring and installing the Gplus Communication Server for 
Siebel CRM consists of: 

1. Planning 

2. Configuring Genesys 

3. Installation of Communication Server 

4. Deployment of Communication Driver on Siebel host 

5. Configuring Siebel 

New in This Release
This section provides information about new features or functionality in this 
release of the Gplus Communication Server:

• Supports Siebel 8.0, 8.1.

• Supports secure connection between the Gplus Communication Driver and 
the Gplus Communication Server.

• Supports secure connection between the Gplus Communication Server and 
Configuration Server.

• Supports the Genesys Advanced Disconnect Detection Protocol (ADDP) 
for connections between the Gplus Communication Driver and the Gplus 
Communication Server

Planning
In planning, you must answer the following question first:

Will the Gplus Communication Server for Siebel CRM be deployed on the 
same host as the Siebel Server, or will it be deployed on a different host?

Important considerations to take into account include:

• Average CPU load on Siebel server host

• Network throughput, latency, and reliability
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The Gplus Communication Server is implemented as a Genesys server, and is 
represented by an application object in Genesys Configuration Manager. 
Installation of the component delivers both the Gplus Communication Server 
and the Genesys Communication Driver. This may be considered as 
installation of a Genesys server which delivers added capabilities: the Genesys 
Communication Driver for a given platform (operating system).

Three deployment options (scenarios) may be considered: 

1. Both the Server and Driver parts of the component may be deployed on the 
same host as the Siebel Server. In this case, one installation will deliver 
both parts to the required locations.

2. The Server part of the component may be deployed on a dedicated host, 
but on the same platform (operating system) as the Siebel host. Installation 
will be performed on the dedicated host, and the Driver part of the 
component should be moved manually to the Siebel Server host after that.

3. The Server part of the component may be deployed on a dedicated host 
which uses an operating system that is different than that of the Siebel host. 
Technically this can be done, but requires two installations to deliver the 
Server and Driver parts of the component to different platforms. One 
installation will be performed on the dedicated host to install the Server 
part. Another installation will be performed on the Siebel host to install the 
Driver part. Note that the later installation will also install the Server part 
of the component along with the required Driver part.

Note: The second installation requires an additional Application Object 
in Configuration Manager that is used only during installation.

Configuring Genesys
This section describes how to configure the Genesys section of the Gplus 
Communication Server. 

Importing the Application Template

To import the Communication Server Application Template:

1. In Configuration Manager, under Environment, right-click the Application 
Templates folder.

2. Select Import Application Template.

3. Browse to and select the Application Template for the Communication 
Server. The name of this template is:
Gplus_Comm_Server_for_SiebelCRM_750.apd

4. Click Open. 
The Properties dialog box for the Application Template object displays.
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5. Click OK to accept the default values.

The Application Template object has been imported to the Genesys 
Configuration Layer. 

Creating the Application Object

To create the Application object for the Communication Server:

1. In Configuration Manager, under Environment, right-click the 
Applications folder.

2. Select New > Application.

Select the Application Template that you just created:
Gplus_Comm_Server_for_SiebelCRM_750.apd

3. Click OK.

The Properties dialog box for the Application appears.

Below are instructions for configuring the tabs in the Properties dialog box, 
arranged in the order in which they display. The first tab is the General tab (see 
Figure 1).

Figure 1: View of General Tab in Single-Tenant Environment
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General Tab

1. Enter the name of the Application object you are configuring.

2. Select the Tenants tab.

Tenants Tab

Figure 2: View of Tenants Tab

1. Select the Genesys Tenants under which the objects that are exported from 
Siebel will be created.

For example, in Figure 2, the MCR tenant has been added.

2. Select the Server Info tab.
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Server Info Tab

1. Host field: Use the Browse button to select the host where you are installing 
the Gplus Communication Server and click OK.

2. Communications Port field: Enter any valid port number for the port with 
the ID of default. Genesys recommends setting this to 18001, since this 
corresponds to the value provided by the installation sample configuration 
file for Siebel (the .def file). 

Notes: This value determines the HTTP port number used by the Gplus 
Communication Server to receive HTTP packets from the Gplus 
Communication Driver. Use the value you enter here later when 
you configure the Siebel portion of the Gplus Communication 
Server.

To configure a communication port that supports ADDP, leave the 
Connection Protocol field blank, or enter the word setup. For 
proper support of ADDP functionality, you must have at least one 
communication port on the Gplus Communication Server side. 
This port is used for communication with the Gplus 
Communication Driver.

3. Communications Port field (optional): To support the Media Routing 
Component, add one more communication port with any valid ID and any 
valid port number. Set the Connection Protocol option value to tcp. (If 
you do not need to configure the Media Routing Component, skip this 
step.)

Note: This option determines the HTTP port number used by the Gplus 
Communication Server to receive HTTP packets from the Siebel 
outgoing Web Service that the Media Routing Component uses. Use 
the value you enter here later when you configure the Siebel part of the 
Media Routing Component.

4. 4. Select the Start Info tab.

Start Info Tab

1. Working Directory field: Enter the full name of the Component installation 
directory on the host you specified on the Server Info tab. The value you 
enter in this field will be used as the default destination folder during 
installation.

2. Enter any valid value into each of the following fields:
 Command Line
 Command Line Arguments
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The values you enter in these fields will be overwritten during installation; 
however, data must be present in these fields during the configuration 
process.

3. Leave the default values for the remaining fields.

4. Select the Connections tab.

This step is mandatory for configuring the server to work with the Voice, 
Multimedia, and Media Routing components. You may also configure a 
connection to the Genesys Message Server.

Connections Tab

Figure 3: View of Connections Tab in Multi-Tenant Environment

The content of the Connections tab depends on the Adapter components being 
used. For the Voice component it is necessary to add a connection to the 
corresponding T-Server. For backward compatibility, the Voice component also 
supports a way to define connection to the T-Server without adding the T-
Server to the Connections list, as in Release 7.2. For details, please see 
“Connection to T-Server” on page 157. For Multimedia and Media Routing 
components, it is necessary to add a connection to the Interaction Server:
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1. Add a connection to the Interaction Server and/or T-Server, as shown in 
Figure 3.

2. Optionally, add a connection to the Genesys Message Server.

3. Optionally, add a connection to the Genesys Configuration Server.

4. Select the Options tab.

Options Tab

On the Options tab (see Figure 4 on page 38), in the Sections pane, the 
following sections are listed:

• HTTP

• Log

• open-media-driver

• open-media-userdata

Double-click the HTTP section to start.

Figure 4: View of Options Tab
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HTTP Section Options

ClientPortRangeStart 
(Optional) This option provides the value for the start of the port range used to 
open a client connection to the Gplus Communication Driver. A value of 0 
means that the server relies on the operating system to assign a unique port 
number to the application. Valid values are positive integers greater than or 
equal to (>=) 0. The default value is 0.

Note: If an invalid value is provided, the option value will be set to 0 (the 
default).

ConnectTimeout 
This option provides the timeout value in milliseconds (ms) for connection to 
the Gplus Communication Driver. Valid values are positive integers greater 
than or equal to (>=) 1000. The default value is 10000.

MaxProcessingThreads 
This option provides the value for the maximum number of allowed threads 
that process incoming requests. Valid values are positive integers greater than 
or equal to (>=) 4. The default value is 50.

MaxClientConnections 
This option provides the value for the maximum number of allowed client 
connections to a particular endpoint (listening port on the driver side). Valid 
values are positive integers greater than or equal to (>=) 4. The default value is 
25.

RetryAttempts 
This option is used to control the number of attempts to send a request from the 
Gplus Communication Server to the Gplus Communication Driver. Valid 
values are positive integers greater than or equal to (>=) 1. The default value is 
1.

RequestTimeout 
(Optional) This option provides the timeout value in milliseconds (ms) for 
handling an HTTP request submitted by the Communication Server to the 
Communication Driver. The valid values are positive integers that are greater 
than (>) the defined minimum value. Where, the minimum value is calculated, 
as follows:

(ConnectTimeout) x (RetryAttempts) x (2.5) 

The default value is 30000.
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Note: If an invalid value is provided, the option value will be calculated as 
defined above (it will not be set as the default value).

ServiceInactivityTimeout 
(Optional) This option provides the timeout value in milliseconds (ms) for 
handling an inactive agent session. If there is no agent activity during the 
period of the timeout, the agent's session is treated as lost, and is removed. 
Default value is 3600000. Valid values are 0, or positive integers greater than or 
equal (>=) 600000. If ServiceInactivityTimeout equals 0, the lost sessions will 
not be removed.

Note: If an invalid value is provided, the option value will be set to 3600000 
(the default).

ADDPTimeout
(Optional) Specifies the time interval (in seconds) that Gplus Communication 
Server waits for a response from the Gplus Communication Driver after 
sending a polling signal. This option is applicable for client connections from 
Gplus Communication Server to the Gplus Communication Driver. Valid 
values are non-negative integers (greater than or equal to 0). The value 0 
(default) turns the ADDP protocol off for all client connections from Gplus 
Communication Server to the Gplus Communication Driver.

ADDPRemoteTimeout
(Optional) Specifies the time interval (in seconds) that the Gplus 
Communication Driver waits for a response from Gplus Communication 
Server after sending a polling signal. This option is applicable for client 
connections from Gplus Communication Server to the Gplus Communication 
Driver. Valid values are non-negative integers (greater than or equal to 0). The 
value 0 (default) disables this option for all client connections from Gplus 
Communication Server to the Gplus Communication Driver.

ADDPTrace
(Optional) Specifies if the trace functionality is on or off. This option is 
applicable for client connections from Gplus Communication Server to the 
Gplus Communication Driver. Valid values are: off (default)—trace is off; 
local—trace is on for Gplus Communication Server; remote—trace is on for 
Gplus Communication Driver; both—trace is on for both sides.

Log Section

The Gplus Communication Server supports the unified set of log options 
(common log options) to allow precise configuration of the log file output. For 
a complete list of unified log options and their descriptions, see the “Common 
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Log Options” chapter of the Framework 7 Configuration Options Reference 
Manual.

Selective
Protection of

Sensitive Data in
Logs

To protect against presentation in the Adapter’s log of private parameters 
included in UserData, Extensions, and Reasons, a number of options can be 
configured in the Options section of the Gplus Communication Server 
Application Object in Configuration Manager.

These options are described in the Log-Filter and Log-Filter-Data sections of 
the Framework 7.5 Configuration Options Reference Manual.

The Log-Filter section defines the parameter default-filter-type with valid 
values copy, hide or skip. This parameter specifies the default method of 
presenting KVList information (including UserData, Extensions, and Reasons) 
in the log. See Figure 5 on page 42 for an example.

The Log-Filter-Data section defines a list of key-value pairs and specifies the 
way of presenting each individual KVList pair defined by the key name in the 
log. The key defines the parameter name, while the value (which can be 
defined as copy, hide or skip) specifies how this parameter will be presented 
in the log. See Figure 6 on page 43 for an example.
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Figure 5: Log-Filter Parameters in Configuration Manager
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Figure 6: Log-Filter-Data Parameters in Configuration Manager

open-media-driver Section

internal-port Option

This option is used to define the port number used for interthread 
communications. A value of -1 disables the option. A value of 0 indicates that 
the port will be selected automatically. Any positive integer value defines the 
exact port value. Default value is -1.

service-duplicate-overwrite Option

When this option is set to true, subsequent agent sessions with the same user 
name will be allowed, and the previous agent session will be disabled. When 
this option is set to false, only one session per agent is allowed. Default value 
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is false. This option is needed as a workaround when a session is not closed by 
Siebel, but the browser is forcibly closed.

open-media-userdata Section

ThirdPartyId Option

This option defines how particular user data will be sent to Siebel. All data is 
normally sent encoded as a single UserData field. It may be convenient to have 
part of the user data delivered to Siebel as a top-level key. The user data key 
should be added to the section with the value top, indicating that the key will 
be sent as a top-level key in the data set. Default value is top.

Installation
This section describes the installation process for the Gplus Adapter 7.5 
Communication Server for Siebel CRM. Depending on your chosen 
deployment option (see “Planning” on page 32) one or two installations should 
be performed.

To run an installation that delivers the Driver part of the component directly 
under the Siebel Server (Deployment Scenario 1 and the second installation in 
Deployment Scenario 3), the system administrator should have appropriate 
privileges and stop the Siebel Server before installation.

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

1. To start the installation process, run the setup.exe file (for Windows), or 
install.sh file (for UNIX) from the Gplus Communication Server 
installation package.

2. Answer installation questions according to your selected deployment 
scenario.

Deployment of Communication Driver on the Siebel Host

This section’s steps are required for Deployment Scenario 2 (see “Planning” on 
page 32).

1. Stop the Siebel Server.

2. Move files from the Driver subdirectory of the target installation directory 
on the dedicated host to the bin folder (for Windows), or to the lib folder 
(for UNIX) in the Siebel directory hierarchy of the Siebel host.
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Configuring GenCommDrv.ini (Optional)

GenCommDrv.ini is delivered by the installation, or manually (in Deployment 
Scenario 2) to the bin folder (for Windows), or the lib folder (for UNIX) in the 
Siebel directory hierarchy of the Siebel host. It describes the default 
configuration of the Driver part of the component. An advanced administrator 
may change that predefined configuration, but should take responsibility for 
coordination of options for the Driver and Server parts of the component.

The properties in the GenCommDrv.ini file are:

Table 4: GenCommDrv.ini Parameters

Property Name Values Description

General Section

SiebelAPI Default Value: 2

Valid Values: 1, 2

Note: If an invalid 
value is applied, the 
default value (2) is 
used.

(Optional) This property defines the Siebel API 
version to use.

CheckServiceTimeout Default Value: 2000

Valid Values: A 
positive integer 
greater than or equal 
to (>=)1000

Note: If an invalid 
value is applied, the 
default value (2000) is 
used

(Optional) This property provides the timeout value 
in milliseconds (ms) for CheckService activities 
between GenCommDrv and GenCommServer.

Log Subsystem Section

LogFile Default Value: 
GenCommDrv

Valid Values: Any 
non-empty string.

Note: If an invalid 
value is applied, the 
default value 
(GenCommDrv) is 
used.

(Optional) This property provides the GenCommDrv 
log file name prefix.
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LogDir Default Value: ./

Valid Values: A valid 
and accessible 
directory path.

Note: 
If an empty string is 
applied, then the 
default (./) will be 
used. 
If an invalid directory 
path is provided or is 
not accessible, then 
the file will not be 
created.

(Optional) This property provides the directory name 
where the logs will be stored.

LogExt Default Value: log

Valid Values: A non-
empty string.

Note: If an invalid 
value is applied, the 
default value (log) is 
used.

(Optional) This property provides the GenCommDrv 
log file name extension.

MaxLogKB Default Value: 10240

Valid Values: A 
positive integer 
greater than or equal 
to (>=) 100.

Note: If an invalid 
value is applied, the 
default value (10240) 
is used.

(Optional) This property provides the maximum 
GenCommDrv log file size in kilobytes.

LogFilesCount Default Value: 10

Valid Values: A 
positive integer 
greater than or equal 
to (>=) 2.

Note: If an invalid 
value is applied, the 
default value (10) is 
used.

(Optional) This property provides the number of log 
files.

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description



Gplus Adapter for Siebel CRM—Deployment Guide 47

Chapter 2: Configuration and Installation of the Gplus Communication Server for Siebel CRM Installation

LogLevel Default Value: 2

Valid Values: 0, 1, 2, 
3, 4, 5, 6

Note: If an invalid 
value is applied, the 
default value (2) is 
used.

(Optional) This property defines the trace level. 
Valid values for this parameter are:

• 0—All messages (log events of Standard, Trace, 
Interaction, and Debug levels) are logged.

• 1—The same as 0.

• 2—Messages of low priority are logged.

• 3—Messages of normal priority are logged.

• 4—Messages of high priority are logged.

• 5—Log alarm messages only are logged.

• 6—No messages are logged.

HTTP Client Connection Section

RetryAttempts Default Value: 1

Valid Values: A 
positive integer 
greater than or equal 
to (>=) 1.

Note: If an invalid 
value is applied, the 
default value (1) is 
used.

(Optional) This property is used to control the 
number of attempts to send a request from the Gplus 
Communication Driver to the Gplus Communication 
Server.

ConnectTimeout Default Value: 10000

Valid Values: A 
positive integer 
greater than or equal 
to (>=) 1000.

Note: If an invalid 
value is applied, the 
default value (10000) 
is used.

(Optional) This property provides the timeout value 
in milliseconds (ms) for connection to the Gplus 
Communication Server.

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description
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RequestTimeout Default Value: 30000

Valid Values: A 
positive integer that 
is greater than (>) the 
defined minimum 
value. Where, the 
minimum value is 
calculated, as 
follows:

(ConnectTimeout) x 
(RetryAttempts) x 
(2.5)

Note: If an invalid 
value is applied, the 
value will be 
calculated as defined 
for the valid value (it 
will not be set as the 
default value).

(Optional) This property provides the timeout value 
in milliseconds (ms) for handling an HTTP request 
submitted by the Gplus Communication Driver to 
the Gplus Communication Server.

MaxProcessingThreads Default Value: 50

Valid Values: An 
integer greater than or 
equal to (>=) 4.

Note: If an invalid 
value is applied, the 
default value (50) is 
used.

(Optional) This property provides the value for the 
maximum number of allowed threads that process 
incoming requests.

MaxClientConnections Default Value: 25

Valid Values: An 
integer greater than or 
equal to (>=) 4.

Note: If an invalid 
value is applied, the 
default value (25) is 
used.

(Optional) This property provides the value for the 
maximum number of allowed client connections to a 
particular endpoint (listening port on the server side).

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description
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ClientPortRangeStart Default Value: 0

Valid Values: A 
positive integer 
greater than or equal 
to (>=) 0.

Note: If an invalid 
value is applied, the 
default value (0) is 
used.

(Optional) This property provides the value for the 
start of the port range used to open a client 
connection to the Gplus Communication Driver. A 
value of 0 means that the server relies on the 
operating system to assign a unique port number to 
the application.

Security Properties of HTTP Connection Section

Certificate Default Value: “” (an 
empty string)

Valid Values: 
For Windows this 
should be a base64 or 
hex encoded string. 

For Unix, this should 
be the absolute path 
to the certificate file 
(see also 
“Connection to T-
Server” on page 157 
in Chapter 5). 

Note: If the value is 
an empty string (“”), 
an insecure 
connection will be 
used.

(Optional) This property identifies the certificate to 
be used. 

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description
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CertificateKey Default Value: “” (an 
empty string)

Valid Values: 
For Windows, this 
property is not used. 
Therefore, no valid 
values are defined. 

For Unix, this is the 
full path to the private 
key file:
<serial_#>_<host_nam
e>_priv_key.pem

(see “Connection to 
T-Server” on 
page 157 in 
Chapter 5).

(Optional) This property identifies the Certificate 
Key to be used.

TrustedCA Default Value: “” (an 
empty string)

Valid Values: 

For Windows, this 
property is not used. 
Therefore, no valid 
values are defined.

For Unix, this is the 
full path to the 
certificate authority 
file:
ca_cert.pem

(see “Connection to 
T-Server” on 
page 157 in 
Chapter 5). Default 
value is “” (empty 
string).

(Optional) This property identifies the full path to 
the certificate authority file.

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description
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The contents of the GenCommDrv.ini file are shown below:
// General

SiebelAPI           = 2

CheckServiceTimeout = 2000

// Log subsystem properties

LogFile             = GenCommDrv

LogDir              = ./

LogExt              = log

MaxLogKB            = 10240

LogFilesCount       = 10

LogLevel            = 2

// HTTP Client connection properties

RetryAttempts        = 1

ConnectTimeout       = 10000

RequestTimeout       = 30000

MaxProcessingThreads = 50

MaxClientConnections = 25

ClientPortRangeStart = 0

ADDP Parameters for HTTP Connections

ADDPTimeout Default Value: 0

Valid Values: non-
negative integers

(The value 0 turns the 
ADDP protocol off 
for all client 
connections.)

(Optional) Specifies the time interval (in seconds) 
that Gplus Communication Driver waits for a 
response from the Gplus Communication Server 
after sending a polling signal. This option is 
applicable for client connections from Gplus 
Communication Driver to the Gplus 
Communication Server.

ADDPRemoteTimeout Default Value: 0

Valid Values: non-
negative integers

(Optional) Specifies the time interval (in seconds) 
that the Gplus Communication Server waits for a 
response from Gplus Communication Driver after 
sending a polling signal. This option is applicable 
for client connections from Gplus Communication 
Driver to the Gplus Communication Server.

ADDPTrace Default Value: off

Valid Values: off, 
local, remote, both

(Optional) Specifies if the trace functionality is on 
or off. This option is applicable for client 
connections from Gplus Communication Driver to 
the Gplus Communication Server.

Table 4: GenCommDrv.ini Parameters (Continued) 

Property Name Values Description
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// Security properties of HTTP connection

Certificate          = ""

CertificateKey       = ""

TrustedCA            = ""

// ADDP parameters for HTTP connections

ADDPTimeout          = 0

ADDPRemoteTimeout    = 0

ADDPTrace            = off

Configuring Siebel
This section describes how to configure the Siebel part of the Communication 
Server.

Siebel CTI Configuration 

To Start using the Communication Server it is necessary to create a 
corresponding communication configuration and communication profile for 
GenCommDrv. Genesys provides the GenComm_universal.def configuration file as 
an example of configuration.

The following parameters are mandatory for the Communication driver:

Note: Additional parameters may be mandatory to use with voice or 
multimedia. Refer to the appropriate chapters in this manual

PrimaryGenCommServerURL

This should specify the URL of the Communication Server. For example:
PrimaryGenCommServerURL=http://cti.mycompany.com:9121

where cti.mycompany.com is the host name where the Gplus Communication 
Server is installed (must be resolvable from the Siebel host), and 9121 is an 
example of a port as configured in Genesys Configuration Manager.

Note: In Configuration Manager the port must be empty (the default) or have 
the value setup for the Connection Protocol option.

SCAPIServerURL

This should specify the local URL. The Communication driver will listen to 
this URL for incoming events. For example:
http://sbl.mycompany.com:11722

where sbl.mycompany.com is the host where the Siebel Server is running (must 
be resolvable from the Gplus Communication Server host), and 11772 is an 
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example of an unused port. The driver will listen to this port for incoming 
events. 
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Chapter

3 Configuration and 
Installation of the 
Configuration 
Synchronization 
Component
This chapter describes how to configure and install the Gplus Adapter 7.5 for 
Siebel CRM Configuration Synchronization Component, a server-based 
component. 

This chapter includes the following sections:
 Overview, page 55
 New in This Release, page 56
 Configuring Genesys, page 56
 Installation, page 69
 Configuring Siebel, page 71
 Run Time Events Used by the Configuration Synchronization Component, 

page 78
 Genesys Config Synchronization Business Service - User Properties, 

page 79
 Starting the Configuration Synchronization Component, page 81

Overview
The Gplus Adapter for Siebel CRM Configuration Synchronization 
Component is a server-based component. The process for configuring and 
installing this component is significantly different than the process for driver-
based components.
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The process of configuring and installing the Configuration Synchronization 
Component includes three general procedures: 

• Configuring Genesys

• Installation of the Configuration Synchronization Component

• Configuring Siebel.

Each of these procedures is explained in detail under a separate heading below.

Before importing agent configuration data from Siebel to Genesys, see the 
Gplus Adapter 7.5 for Siebel CRM User’s Guide and read the section 
“Synchronizing Siebel Extensions and ACD Queues with Genesys 
Configuration.”

New in This Release
Other than Adapter-wide support for Siebel 8.0/8.1, no new functionality was 
added for the 7.5 release of the Configuration Synchronization component.

Configuring Genesys
This section describes how to configure the Genesys section of the 
Configuration Synchronization Component. 

Prestart Information

Before starting the configuration process you should have the following 
applications running:

Genesys Framework:

• Configuration Database

• Configuration Server

• Configuration Manager

As a Configuration Manager user, you should have sufficient privileges to 
make changes to Configuration Layer objects.

Importing the Application Template

To import the Configuration Synchronization Component Application 
Template:

1. In Configuration Manager, under Environment, right-click the Application 
Templates folder.

2. Select Import Application Template.
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3. Browse to and select the Application Template for the Configuration 
Synchronization Component. This name varies slightly, depending on the 
version of CME being used, as follows:
 For versions 7.0 and earlier, use: 

Gplus_SiebelCRM_Config_Synch_750_for_CL_70.apd 

 For versions 7.1 and later, use:
Gplus_SiebelCRM_Config_Synch_750_for_CL_71_and_higher.apd 

4. Click Open. 
The Properties dialog box for the Application Template object displays.

5. Click OK to accept the default values.

The Application Template object has been imported to the Genesys 
Configuration Layer. Next, you will create the Configuration Layer 
Application object for the Configuration Synchronization Component.

Creating the Application Object

To create the Application object for the Configuration Synchronization 
Component:

1. In Configuration Manager, under Environment, right-click the 
Applications folder.

2. Select New > Application.

Select the Application Template that you just created:
Gplus_SiebelCRM_Config_Synch_750_for_CL_71_and_higher.apd 

or
Gplus_SiebelCRM_Config_Synch_750_for_CL_70.apd

3. Click OK.

The Properties dialog box for the Application appears.
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Below are instructions for configuring the tabs in the Properties dialog box, 
arranged in the order in which they display. The first tab is the General tab (see 
Figure 7).

Figure 7: View of General Tab in Multi-Tenant Environment

General Tab

Enter the name of the Application object you are configuring. If you are 
working in a multi-tenant environment, go to the Tenants tab; otherwise, go to 
the Server Info tab. 

Tenants Tab

The Tenants tab only displays if you are working in a multi-tenant 
environment.
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Select the Genesys Tenants under which the objects that are exported from 
Siebel will be created.

Next, select the Server Info tab.

Server Info Tab

1. Host field: Use the Browse button to select the host where you are 
installing the Configuration Synchronization Component and click OK. 

2. Ports list: Add a port with any valid port number.

Note: This option determines the HTTP port number used by the 
Configuration Synchronization Component to receive HTTP 
packets from Siebel. You will use the value that you enter for this 
option when you configure the Siebel part of the Configuration 
Synchronization Component.

3. Select the Start Info tab.

Start Info Tab

1. Working Directory field: Enter the full name of the Component installation 
directory on the host you specified on the Server Info tab. The value you 
enter in this field will be used as the default destination folder during 
installation.

2. Enter any valid value into each of the following fields:
 Command Line
 Command Line Arguments

The values you enter in these fields will be overwritten during installation; 
however, data must be present in these fields during the configuration 
process.

3. Leave the default values for the remaining fields.

4. Select the Options tab.

Options Tab

On the Options tab (see Figure 8 on page 60), in the Sections pane, the 
following sections are listed:

• AgentLoginFolders

• DNFolders

• Genesys

• Log

• PersonFolders
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• PlaceFolders

• SkillFolders

• SkillLevels

• Tenants

Double-click the Genesys section to start.

Figure 8: View of Options Tab in a Multi-Tenant Environment

Genesys Section

UseSeparatorsForSkillName Option
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This option specifies how skill names will be generated, and specifically how 
the names are separated. By default, this value is set to FALSE, signifying that 
separators will not be used. If you need to generate skill names as they were in 
version 6.5, set this value to TRUE.

SkipSkillItemTypeName Option

This option specifies how skill names will be generated, and specifically if 
Skill Item Type names (Skill names) will be written or not. By default, this 
value is set to FALSE, which means that Skill Item Type names (Skill names) 
will be written in Genesys CME during synchronization. If you need to omit 
Skill Item Type names (Skill names), set this value to TRUE.

ServerURL Option

This option specifies the URL of the web server that has the Siebel Web 
Engine installed. Initially, this option contains the template string:
ServerURL=<ServerUrl>/<path>/start.swe?SWEExtSource=<source>&SWEExtCmd=
Execute&UserName=<userName>&Password=<password>

where:

<ServerUrl> is the first part of the URL you use to access your Siebel Server 
through the Siebel Web Client.

<path> specifies a virtual path on the server referring to the specific Siebel Web 
Extension configuration. The default value for this option is eai_enu.

<source> refers to an entry in the [HTTP Services] section in the eai.cfg file 
within your Siebel Server installation. The entry provides the mapping to a 
Siebel Named Subsystem, which in turn describes the Business Service call. 
The default value for <source> is GplusConfSynchExportAlldata.

You have to edit this URL template string according to your Siebel Web 
Extension configuration. For example:
http://www.myserver.com/eai_enu/start.swe?SWEExtSource= 
GplusConfSynchExportAlldata 
&SWEExtCmd=Execute&UserName=<userName>&Password=<password>

For security reasons, you do not need to put <userName> and <password>

directly into the URL string. Use the username and password options instead.

username Option

This option specifies a Siebel user name for the Siebel Object Manager login to 
process a request from the Adapter. For example: GenesysAdapter.

This user name must be created in the Siebel environment. The user must have 
access to the Siebel database as Siebel Administrator.

Note: Genesys does not recommend using a common login ID for this 
process.
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For more information about Siebel user administration, refer to your Siebel 
documentation.

password Option

This option specifies the password for the login user name above. For 
example: GenesysAdapter. This user name should be created in the Siebel 
environment. The user must have access to the Siebel database as a Siebel 
Administrator.

Note: Genesys does not recommend using a common login for this process.

For more information about Siebel user administration, see your Siebel 
documentation.

xslTransformer Option

This configuration option is optional. Use this option if you want to transform 
some values of synchronized data such as Phone number by your own rules.

The Adapter provides a mechanism to customize the transformation rules 
through an xsl file. In this case you have to add this option to the Genesys 
section. The value of the option should be equal to the name of the xsl file. See 
the Gplus Adapter 7.5 for Siebel CRM Developer’s Guide for more information 
about this option.

Log Section

The Configuration Synchronization Component supports the unified set of log 
options (common log options) to allow precise configuration of the log file 
output. For a complete list of unified log options and their descriptions, see the 
“Common Log Options” chapter of the Framework 7 Configuration Options 
Reference Manual.

If you do not specify any log options, the default values apply.

PersonFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Person objects when importing information from Siebel.

For example, if you have a Tenant named myTenant defined in Genesys 
Configuration Manager and you want the Siebel user with the User ID user1 to 
create Person objects under the Configuration Manager folder Folder1, which 
is a subfolder of the Persons folder under Tenant myTenant. Create a new option 
in the PersonFolders section with user1 as the option name and 
/Persons/Folder1 as the option value. Make sure that the Siebel Organization 
or Division whose objects Siebel user user1 will import is mapped to Tenant 
myTenant (see “Tenants Section” on page 67).

All Configuration Manager folders referenced in this section should be created 
in Genesys Configuration Manager prior to importing information from Siebel.
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The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function using the options in this section, 
to assign different Configuration Manager folders in Genesys to 
various Siebel users. However, if the same Siebel data is imported into 
different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

PlaceFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Place objects when importing information from Siebel.

For example, if you have a Tenant, myTenant defined in Genesys Configuration 
Manager and you want the Siebel user with User ID user1 to create Place 
objects under Configuration Manager folder Folder1, which is a subfolder of 
the Places folder under Tenant myTenant. Create a new option in the 
PlaceFolders section with user1 as the option name and /Places/Folder1 as 
the option value. Make sure that the 
Siebel Organization or Division whose objects the Siebel user user1 will 
import is mapped to the Tenant myTenant (see “Tenants Section” on page 67).

All Configuration Manager folders referenced in this section should be created 
in the Genesys Configuration Manager prior to importing information from 
Siebel.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.



64 Gplus Adapter 7.5

Chapter 3: Configuration and Installation of the Configuration Synchronization Component Configuring Genesys

Note: You can configure the import function, using the options in this 
section, to assign different Configuration Manager folders in Genesys 
to various Siebel users. However, if the same Siebel data is imported 
into different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

SkillFolders Section

Note: If the SkillFolders application option contains an incorrect value (for 
example, a folder which does not exist), the Person, even without any 
skill, will not be exported from Siebel to Genesys.

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Skill objects when importing information from Siebel.

For example, if you have a Tenant, myTenant defined in Genesys Configuration 
Manager and you want the Siebel user with User ID user1 to create Skill 
objects under Configuration Manager folder Folder1, which is a subfolder of 
the Skills folder under Tenant myTenant. Create a new option in the 
SkillFolders section with user1 as the option name and /Skills/Folder1 as 
the option value. Make sure that the 
Siebel Organization or Division whose objects Siebel user user1 will import is 
mapped to Tenant myTenant (see “Tenants Section” on page 67).

All Configuration Manager folders referenced in this section should be created 
in Genesys Configuration Manager prior to importing information from Siebel.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.
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Note: You can configure the import function, using the options in this 
section, to assign different Configuration Manager folders in Genesys 
to various Siebel users. However, if the same Siebel data is imported 
into different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

AgentLoginFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Agent Login objects when importing information from Siebel.

For example, if you have a Switch, mySwitch defined in Genesys Configuration 
Manager and you want the Siebel user with User ID user1 to create Agent 
Login objects under Configuration Manager folder Folder1, which is a 
subfolder of the Agent Logins folder under switch mySwitch. Create a new 
option in the AgentLoginFolders section with user1 as the option name and 
/Agent Logins/Folder1 as the option value.

All Configuration Manager folders referenced in this section should be created 
in Genesys Configuration Manager prior to importing information from Siebel.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function, using the options in this 
section, to assign different Configuration Manager folders in Genesys 
to various Siebel users. However, if the same Siebel data is imported 
into different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

DNFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create DN objects when importing information from Siebel.
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For example, if you have a Switch, mySwitch defined in Genesys Configuration 
Manager and you want the Siebel user with User ID user1 to create DN objects 
under Configuration Manager folder Folder1, 
which is a subfolder of the DNs folder under switch mySwitch. Create a new 
option in the DNFolders section with user1 as the option name and 
/DNs/Folder1 as the option value.

All Configuration Manager folders referenced in this section should be created 
in Genesys Configuration Manager prior to importing information from Siebel.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function, using options in this section to 
assign different Configuration Manager folders in Genesys to various 
Siebel users. However, if the same Siebel data is imported into 
different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

SkillLevels Section

Options in this section define the mapping of Siebel Skill Expertise values to 
Genesys Skill Level values. To map a Siebel Skill Expertise value to a Genesys 
Skill Level value, create a new option within this section, where the option 
name is the value of the Siebel Skill Expertise and the option value is the value 
of the Genesys Skill Level. The default mapping is shown in Figure 9 on 
page 67.
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Figure 9: The Default Mapping of Siebel Skill Expertise Values to Genesys 
Skill Levels

After configuring the Application options, click OK to save the Application 
object.

Tenants Section

Options in this section define the mapping of Siebel Organizations or 
Divisions to Genesys Tenants. To map a Siebel Organization or Division to a 
Genesys Tenant, create a new option within this section, where the option 
name is the name of the Genesys Tenant and the option value is the name of 
the Siebel Organization or Division.

For example, if you have an Organization named myOrganization in Siebel and 
a Tenant named myTenant in Genesys, enter myTenant as the option name and 
myOrganization as the option value. Then all Siebel objects that belong to 
myOrganization Organization in Siebel will be created under myTenant Tenant 
in Genesys.

The relationship of Siebel Organizations or Divisions to Genesys Tenants is 
one-to-one.
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Note: If you are working in a single-tenant environment, this section will 
contain one option, where the option name is Resources and the option 
value is the name of your Siebel Organization or Division.

Configuring Security Settings

Security settings must be configured for the Configuration Synchronization 
Component so that the Component can make changes to the Genesys 
Configuration Layer objects. Follow the procedures outlined in the following 
sections to configure the security settings for the Application object you 
created in “Creating the Application Object” on page 57. 

Creating a New Person

In Configuration Manager:

1. Right-click the Persons folder under Environment if you are working in a 
multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Select New > Person. 
The new Person window displays.

3. Select the General tab and enter the following parameters:
 Employee ID: siebel7gplus
 User Name: siebel7gplus
 Is Agent: Clear

4. Click OK.

Adding Person to the Super Administrators Access 
Group

In Configuration Manager, to display the existing Access Groups:

1. Click the Access Groups folder under Environment if you are working in a 
multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Double-click Super Administrators Access Group to display its 
properties.

3. Click the Add button to add the Person you just created to the Users list.

4. Click OK.

Associating Person’s Account with the Application

In Configuration Manager, under Environment:
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1. Click the Applications folder to display the existing applications.

2. Double-click the Application object you just created to display its 
properties.

3. Select the Security tab, in the Log On As section, and select This Account. 
The Add User window displays.

4. Select the Person you just created and click Add. 

5. Click OK to close the Add User window.

6. Click OK to save the Application object.

This completes the Genesys part of the configuration process. Now you are 
ready to install the Configuration Synchronization Component.

Installation
This section describes the installation process for the Gplus Adapter 7.5 for the 
Siebel CRM Configuration Synchronization Component. Select one of the 
following sections depending on your environment.

Installation on Windows

To start the installation process, run the setup.exe file from the Configuration 
Synchronization Component installation package:

1. In the Welcome window, click Next.

2. In the Configuration Parameters for the Genesys Configuration Server 
window, enter the following:
 Host of Configuration Server
 Port of Configuration Server
 User Name
 Password

3. Click Next.

4. In the Select Application window, select the Application object you 
configured in the previous steps. 

5. Click Next.

6. In the Choose Destination Location window, click Next to accept the 
default destination folder or use the Browse button to select a different 
destination folder.
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Note: If you want to deploy both the Configuration Synchronization 
Component and the Campaign Synchronization Component, you 
must specify a unique destination folder for each component. This 
will prevent the installation package of one component from being 
overwritten by the installation package of the other component.

7. In the Ready to Install window, click Install.

8. In the Setup Complete window, click Finish. 

The Configuration Synchronization Component is now installed.

In the Gplus Adapter for Siebel CRM program folder in the Start menu, you 
can see that the installer created a shortcut for the Configuration 
Synchronization Component.

Installation on UNIX

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

To install the Configuration Synchronization Component on a UNIX system:

1. In the directory where the Component installation package was copied, 
locate a shell script named: 
install.sh

2. Run this script from the command prompt by typing sh and the file name: 
sh install.sh

3. When prompted, specify the host name of the computer on which the 
Component will be installed. 

4. Enter the host name of Configuration Server. 

5. Enter the port of Configuration Server. 

6. Enter the user name for Configuration Server. 

7. Enter the password for the user name. 

8. Choose the Configuration Server environment by its corresponding 
number.

9. Specify the application configured in the previous steps by its 
corresponding number.

10. Specify the full path to the destination directory where you want the 
Component to be installed.
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Note: If you want to deploy both the Configuration Synchronization 
Component and Campaign Synchronization Component, you must 
specify a unique destination folder for each component. This will 
prevent the installation package of one component from being 
overwritten by the installation package of the other component.

The process places the Component in the directory that you specified during 
installation. 

Configuring Siebel
This section describes how to configure the Siebel part of the Configuration 
Synchronization Component. 

Prestart Information

Before starting this part of the configuration process you must have the 
following application running.

• Siebel Tools

You should be connected to the local copy of the Siebel Server database and 
should have sufficient privileges to check in and check out projects from the 
Siebel Server Repository.

Configuring Siebel Using Siebel Tools

You will use Siebel Tools to compile an updated version of the Siebel 
Repository File for one or more of the Siebel applications you use on your 
Siebel Server, which you will then deploy on the server. For information about 
using Siebel Tools, see Siebel documentation.

Importing the GenesysConfigSynchronization.sif 
Archive

Note: If the Genesys Config Synchronization project already exists in your 
Siebel Repository File, lock it before importing the 
GenesysConfigSynchronization.sif archive. If this project does not 
exist before export, lock it after the export.
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Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript Engine 
(and not the ST eScript Engine). The default Siebel option is set to 
Enable ST Script Engine = TRUE, but for the Genesys component it 
should be set to Enable ST Script Engine = FALSE.

During this step, you will import objects into the Siebel Repository that are 
part of the Siebel implementation of the Configuration Synchronization 
Component. The objects will be added to Genesys Config Synchronization 
project in Siebel Tools.

To perform the import: 

1. In Siebel Tools, select Tools > Import from Archive... 

2. In the Select Archive to Import window, navigate to the 
GenesysConfigSynchronization.sif archive file. This file was created by 
the installation program in: <target directory>/XXX/tools/objects where 
XXX is the subfolder name (/7.5, /7.7, /8.0, or /8.1), depending on 
the Siebel version you use. 

3. Click Open. 
The Import Wizard–Preview window displays. 

4. In the Import Wizard–Preview window, in the Conflict resolution section, 
select Overwrite the object definition in the repository.

5. Click Next. 
The Import Wizard–Review Conflicts and Actions window displays.

6. Click Next. 
The “Do you wish to proceed?” window displays.

7. Click Yes. 
The objects from the archive are imported into the Siebel Repository.

8. Click Finish to complete the Import Wizard. 

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after importing the archive. This does not affect the 
functionality of the Configuration Synchronization Component in any 
way.

Checking Out Existing Project

The Siebel implementation of the Configuration Synchronization Component 
makes use of run time events. To automate the process of creating run time 
events, which are required for Configuration Synchronization Component, you 
must modify the Personalization Action Set Business Component. To modify 
this object, you must check out the corresponding project from the Siebel 
Repository.
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To check out a project from the Siebel Repository:

1. In Siebel Tools, select Tools > Check Out... 
The Check Out dialog box displays. 

2. In the Projects list, select the Personalizations project. 

3. Click Check Out. 

Next, import the PersonalizationActionSet.sif archive.

Defining the Export of Siebel Extensions of Type S as 
ACD Positions in Genesys

The Configuration Synchronization Component can export Siebel extensions 
of type S to Genesys as Extensions or ACD Positions. By default, Siebel 
extensions of type S will be exported as Genesys DNs of ACD Position.

To set up the export of Siebel extensions of type S as Extensions in Genesys, 
these steps should be performed:

1. In Siebel Tools, navigate to Object Explorer \ Business Service 
folder/applet.

2. Select <Genesys Config Synchronization> Business Service.

3. For this Business Service, go to the Business Service User Props applet.

4. Select the record with Name <ConvertExt2ACD>.

5. Instead of TRUE (default), set FALSE as a value for this record.

Importing the PersonalizationActionSet.sif Archive

To import the PersonalizationActionSet.sif archive: 

1. In Siebel Tools, select Tools > Import from Archive... 

2. In the Select Archive to Import window, navigate to the 
PersonalizationActionSet.sif archive file. This file was created by the 
installation program in: <target directory>/XXX/tools/objects where 
XXX is the subfolder name (/7.5, /7.7, /8.0, or /8.1), depending on 
the Siebel version you use. 

3. Click Open. 
The Import Wizard–Preview window displays. 

4. In the Import Wizard–Preview window, in the Conflict resolution section, 
select Merge the object definition from the archive file with the 
definition in the repository.

5. Click Next. 
The “Do you wish to proceed?” window displays.

6. Click Yes. 
The objects from the archive are imported into the Siebel Repository.
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7. Click Finish to complete the Import Wizard. 

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after importing the archive. This does not affect the 
functionality of the Component in any way.

Compiling the Siebel Repository File

To compile the Siebel Repository File: 

1. In Siebel Tools, select Tools > Compile Projects... 

2. Select Locked projects. 

3. In the Siebel Repository File edit box, enter the name of the Repository 
File. 

4. Click Compile. 
The status bar at the bottom of the Object Compiler window indicates 
when the compilation is finished. 

5. When the compilation is finished, close Siebel Tools.

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after compiling the Siebel Repository File. This 
does not affect the functionality of the Component in any way.

Next, configure the Siebel Server. 

Configuring Siebel Server

Complete the steps described in this section to configure the Component to 
work with the Siebel Server.

Updating Configuration Files

Update the eai.cfg file in the Siebel Server installation. To update this file, 
open it and add the following line to the [HTTP Services] section:
GplusConfSynchExportAllData = GplusConfSynchExportAllData

Configuring the Siebel Inbound HTTP Transport

The Configuration Synchronization Component uses the Siebel Inbound HTTP 
Transport.

For instructions on how to configure the Siebel Inbound HTTP Transport, refer 
to Siebel documentation.
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Deploying the Siebel Repository File

You need to deploy the compiled Siebel Repository File on your Siebel Server. 
Additionally, you may have to generate and deploy browser scripts for the new 
repository file.

For further information on deploying an updated repository file to the Siebel 
Server, refer to Siebel documentation.

Configuring Siebel Using the Siebel Web Client

Connect to your Siebel Server using the Siebel Web Client. You must be 
logged in as a Siebel Administrator.

This part of the configuration process includes the following procedures:

• Checking Enterprise Application Integration (EAI) Server Component 
Group Status

• Creating Named Subsystems

Checking EAI Server Component Group Status

Check the status of the EAI (Enterprise Application Integration) Server 
Component Group on your Siebel Server. There are slight variations in the 
navigation required by this process, depending on the version of Siebel with 
which you are working. 

To check the status of the EAI Server Component Group on your Siebel 
Server:

1. Navigate through the Site Map to get to the desired applet:
 In a Siebel 7.5.3 environment, select Site Map > Server Administration 

> Servers. Select Site Map > Server Administration > Servers. 
 In Siebel 7.7/7.8/8.0/8.1 environments, select Site Map > 

Administration - Server Configuration > Component Groups.

2. Select the Siebel Server you are working on. For the selected server, locate 
the Enterprise Application Integration Component Group in the Server 
Component Groups applet. Verify that the Enable State group has the value 
Enabled.

Creating Named Subsystems

Configure one Connection Subsystem that will be used by the Configuration 
Synchronization Component. There are slight variations in the navigation 
required by this process, depending on the version of Siebel with which you 
are working.

To start the process:

1. Navigate through the Site Map to get to your Siebel Server configuration:
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 In a Siebel 7.5.3 environment, select Site Map > Server Administration 
> Servers. Select Site Map > Server Administration > Enterprise 
Configuration. 

 In Siebel 7.7/7.8/8.0/8.1 environments, select Site Map > 
Administration - Server Configuration.

2. Select the Enterprise Profile Configuration (Profile Configuration in Siebel 
7.7/7.8/8.0/8.1) in the applet within the view.

Continue the process by completing the procedures below.

Creating EAI Transport Data Handling Subsystem

1. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

2. Specify the following parameters for the new record:
 Named Subsystem Alias (Alias in Siebel 7.7/7.8/8.0/8.1): 

GplusConfSynchExportAllData

 Description: Gplus Configuration Synchronization Component: 
ExportAllData

 Name (Profile in Siebel 7.7/7.8/8.0/8.1): Gplus Configuration 
Synchronization Component ExportAllData Parameters

 Subsystem Type: EAITransportDataHandlingSubsys

3. Save the new record.

4. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1) applet:
 DispatchMethod: ExportAllData
 DispatchService: Genesys Config Synchronization

Creating Connection Subsystems

1. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

2. Specify the following parameters for the new record:
 Named Subsystem Alias (Alias in Siebel 7.7/7.8/8.0/8.1): 

GplusConfSyncConnectionPrimary

 Description: Gplus Configuration Synchronization Component 
Primary Connection

 Name (Profile in Siebel 7.7/7.8/8.0/8.1): Gplus Configuration 
Synchronization Component Primary Connection Parameters

 Subsystem Type: HTTPSubSys

3. Save the new record.
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4. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1) applet:
 HTTPRequestMethod: POST
 HTTPRequestURLTemplate: http://<host>:<port>

where:

<host> is the host where you installed the Primary Configuration 
Synchronization Component.

<port> is the port you specified with the Communications Port option 
on the Server Info tab of the Primary Configuration Synchronization 
Component Application object.

5. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

6. Specify the following parameters for the new record:
 Named Subsystem Alias (Alias in Siebel 7.7/7.8/8.0/8.1): 

GplusConfSyncConnectionBackup

 Description: Gplus Configuration Synchronization Component Backup 
Connection

 Name (Profile in Siebel 7.7/7.8/8.0/8.1): Gplus Configuration 
Synchronization Component Backup Connection Parameters

 Subsystem Type: HTTPSubSys

7. Save the new record.

8. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1) applet:
 HTTPRequestMethod: POST
 HTTPRequestURLTemplate: http://<host>:<port>

where:

<host> is the host where you installed the Backup Configuration 
Synchronization Component.

<port> is the port you specified with the Communications Port option 
on Server Info Tab of the Backup Configuration Synchronization 
Component Application object.
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Run Time Events Used by the 
Configuration Synchronization Component

Note: The run time events used by the Configuration Synchronization 
component replace functions that are performed by scripts in the older 
versions of the component (7.0 and older).

To create Run Time Events required by the Configuration Synchronization 
Component, you have to run the InstallRunTimeEvents method of the Genesys 
Config Synchronization Siebel Business Service once using the Siebel 
Business Service Simulator applet. 

To run the method:

1. Navigate through the Site Map to Business Service Administration > 
Business Service Simulator.

2. In the Service Methods applet, create a new record. 

3. Specify the following parameters for the new record:
 Service Name: Genesys Config Synchronization
 Method Name: InstallRunTimeEvents

4. Click the Run button.

After that, navigate in the Siebel client to Runtime Events Administration > 
Events (Administration - Runtime Events > Events in Siebel 
7.7/7.8/8.0/8.1).

Select the Reload Personalization (Reload Runtime Events in Siebel 
7.7/7.8/8.0/8.1) system menu item.

This completes the creation of the Run Time Events required by the 
Configuration Synchronization Component.
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Genesys Config Synchronization Business 
Service - User Properties

This section describes the User Properties of this Business Service. 

Customers can redefine the default values of the User Properties specified in 
Table X. These values are used during configuration synchronization. Default 
values are useful when all configuration objects must have same values. 

Table 5: User Properties of Genesys Config Synchronization 
Business Service

Name Default Value Comments

ConvertExt2ACD TRUE

DefaultAgentLoginOverride Empty string

DefaultAgentLoginState 1 CfgObjectState 
(1 is Enabled)

DefaultAgentLoginSwitchSpecific 
Type

1

DefaultAgentLoginUseOverride 2 CfgFlag (2 is True)

DefaultAgentLoginWrapupTime 1

DefaultDnAssociation Empty string

DefaultDnLoginID Empty string

DefaultDnNumberOfTrunks 0

DefaultDnOverride Empty string

DefaultDnRegisterAll 2 CfgDNRegisterFlag 
(2 is True)

DefaultDnRouteType 1 CfgRouteType 
(1 is Default)

DefaultDnState 1 CfgObjectState
(1 is Enabled)

DefaultDnSwitchSpecificType 1

DefaultDnUseOverride 2 CfgFlag 
(2 is True)
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Data Type Definitions

Below are definitions of data types used in Table 5.

CfgObjectState:
0 - No Object State/CFGNoObjectState 

1 - Enabled/CFGEnabled      

2 - Disabled/CFGDisabled     

3 - Deleted/CFGDeleted

CfgDNRegisterFlag:
0 - Unknown/CFGDRUnknown

1 - False/CFGDRFalse

2 - True/CFGDRTrue

3 - OnDemand/CFGDROnDemand

CfgRouteType:
0 - Unknown/CFGNoRoute

1 - Default/CFGDefault

2 - Label/CFGLabel 

3 - Overwrite DNIS /CFGOverwriteDNIS

4 - DDD/CFGDDD

5 - IDDD/CFGIDDD

6 - Direct/CFGDirect

7 - Reject/CFGReject

8 - Announcement/CFGAnnouncement

9 - Post feature/CFGPostFeature

10 - Direct Agent/CFGDirectAgent

11 - Use external protocol/CFGUseExternalProtocol

12 - Get from DN/CFGGetFromDN

13 - Default/CFGXRouteTypeDefault       

HTTP Connection Subsystem 
(Primary)

GplusConfSyncC
onnectionPrimary

HTTP Connection Subsystem 
(Backup)

GplusConfSyncC
onnectionBackup

Library Name GenCommDrv The value of this 
parameter should 
NOT be changed. 

Table 5: User Properties of Genesys Config Synchronization 
Business Service (Continued) 

Name Default Value Comments
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14 - Route/CFGXRouteTypeRoute         

15 - Direct/CFGXRouteTypeDirect        

16 - Reroute/CFGXRouteTypeReroute       

17 - Direct UUI/CFGXRouteTypeDirectUUI     

18 - Direct ANI/CFGXRouteTypeDirectANI     

19 - Direct No Token/CFGXRouteTypeDirectNoToken 

20 - DNIS pooling/CFGXRouteTypeDNISPooling   

21 - Direct DNISn ANI/CFGXRouteTypeDirectDNISnANI

22 - Ext protocol/CFGXRouteTypeExtProtocol   

23 - Direct digits/CFGXRouteTypeDirectDigits  

24 - Forbidden/CFGXRouteTypeForbidden     

25 - ISCC protocol/CFGXRouteTypeISCCProtocol 

26 - Pullback/CFGXRouteTypePullBack

For more detailed info regarding these data types please use documentation of 
Genesys Configuration Server.

Starting the Configuration Synchronization 
Component

After the Configuration Synchronization Component has been deployed, it 
must always be running to ensure that the Genesys environment stays up-to-
date with the Siebel environment. Running the Component constantly will 
prevent error messages in the Siebel Web Client and will guarantee that the 
Genesys environment reflects the latest configuration updates made in the 
Siebel environment.

The Configuration Synchronization Component can be started from the 
command line. The name of the component is listed below:

• GplusConfSynch.exe for Windows

• GplusConfSynch for UNIX.

The component supports the following command line options:
-host <host> -port <port> -app <application> [ -clean_batch | -batch ]

where:

host is the name of the host where the Genesys Configuration Server is 
running.

port is the port of the Genesys Configuration Server.

application is the name of the Configuration Synchronization Component 
application.

The -batch option should be used to synchronize Siebel and Genesys agent 
data when the Configuration Synchronization Component is started for the first 
time. To remove all agent data from the Configuration Synchronization 
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Component folders in Configuration Manager and then export agent data from 
Siebel, use -clean_batch.

If you are using Windows, you can also start the Configuration 
Synchronization Component from the Start menu by going to Programs > 
Genesys Solutions > Gplus Adapter for Siebel CRM and selecting the 
component’s shortcut (the shortcut has the same name as the Configuration 
Synchronization Component application object). This will start the component 
with the default command line options (without -batch and -clean_batch 
options).

Note: Before starting the Configuration Synchronization Component with 
either -batch or -clean_batch options, you should make sure that all of 
the latest changes you made in the Siebel Web Client have been saved 
in the Siebel database. Usually, this can be done by switching to a view 
different than the one you used to make the last modification.

Note: For -batch and -clean_batch options to work correctly, different 
Siebel users should create Configuration Manager objects of the same 
type under the same Configuration Manager folder. When you use 
either -batch or -clean_batch options, the Configuration 
Synchronization Component uses folder mapping for the Siebel user, 
specified by the username option in the Genesys section of the 
Configuration Synchronization Component application.

Note: You can use Genesys Management Layer, and specifically the Solution 
Control Interface, to start or stop or switch between primary and 
backup Configuration Synchronization Components. If you want to do 
this, make sure that the Command Line Arguments in the application 
Start Info tab do not include the -service argument.
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Chapter

4 Configuration and 
Installation of the 
Campaign Synchronization 
Component
This chapter describes how to configure and install the Siebel CRM Campaign 
Synchronization Component of the Gplus Adapter. It includes the following 
sections:
 Overview, page 83
 New in This Release, page 84
 Configuring Genesys, page 84
 Time Zones, page 102
 Installation, page 104
 Configuring Siebel, page 105

Overview
The Gplus Adapter for Siebel CRM Campaign Synchronization Component is 
a server-based component. The process for configuring and installing this 
component is significantly different than the process for driver-based 
components.

The process of configuring and installing the Campaign Synchronization 
Component includes three general procedures: 

• Configuring Genesys

• Installation of the Campaign Synchronization Component

• Configuring Siebel.

Each of these procedures is explained in detail under a separate heading below.
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Before importing campaigns from Siebel to Genesys, see the Gplus Adapter 
7.5 for Siebel CRM User’s Guide and read the section “Importing Siebel 
Campaigns to Genesys.”

New in This Release
This section provides information about new features or functionality in this 
release of the Campaign Synchronization Component:

• Supports Siebel 8.0, 8.1

• Added flexibility to the customization procedure of synchronization data:
 Possibility to add custom fields with new data types: float and 

datetime

 Possibility to export different field values per record in the same chain 
depending on the phone type, in particular, setting the value of fields 
Daily From, Daily To, and Chain Number.

 Possibility to synchronize custom fields from the Campaign List 
Contact view

 Possibility to develop customer’s own synchronization procedure 
based on XML schema, which describes all messages supported by the 
Campaign Synchronization Component.

For more information about the new functionality mentioned above, refer to 
the Gplus Adapter 7.5 for Siebel CRM Developer’s Guide.

• The Campaign Synchronization Component now supports secure 
communication with Genesys servers.

Configuring Genesys
This section describes how to configure the Genesys section of the Campaign 
Synchronization Component.

Prestart Information

Before starting the configuration process you should have the following 
applications running:

Genesys Framework:

• Configuration Database

• Configuration Server

• Configuration Manager

As a Configuration Manager user, you should have sufficient privileges to 
make changes to Configuration Layer objects.
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Importing the Application Template

To import the Component’s Application Template:

1. In Configuration Manager, under Environment, right-click the Application 
Templates folder.

2. Select Import Application Template.

3. Browse to select the Application Template for the Campaign 
Synchronization Component. Select the proper template based on the 
version of Configuration Server used in your environment. If your version 
of Configuration Server is less than 7.1, select the first template listed 
below, otherwise select the second. 
Gplus_SiebelCRM_Camp_Synch_750_for_CL_70.apd 

Gplus_SiebelCRM_Camp_Synch_750_for_CL_71_and_higher.apd

4. Click Open. 
The Properties dialog box for the Application Template object displays.

5. Optional: Edit the Application Template name. Click OK to accept the 
default values.

The Application Template object has been imported to Genesys Configuration 
Layer. Next, you will create the Configuration Layer Application object for 
the Campaign Synchronization Component.

Creating the Application Object

To create the Application object for the Campaign Synchronization 
Component:

1. In Configuration Manager, under Environment, right-click the 
Applications folder.

2. Select New > Application.

3. Select the Application Template that you just created.

4. Click OK.

The Properties dialog box for the Application displays.

Below are instructions for configuring the tabs in the Properties dialog box, 
arranged in the order in which they display. The first tab is the General tab (see 
Figure 10 on page 86).
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Figure 10: View of General Tab in Multi-Tenant Environment

General Tab

Enter the name of the Application object you are configuring. 

Next, if you are working in a multi-tenant environment, go to the Tenants tab; 
otherwise, go to the Server Info tab.

Tenants Tab

The Tenants tab only displays if you are working in a multi-tenant 
environment.
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Select the Genesys Tenants under which the objects that are exported from 
Siebel will be created.

Next, select the Server Info tab.

Server Info Tab

1. Host field: Use the Browse button to select the host where you are 
installing the Campaign Synchronization Component and click OK.

2. Ports list: Add a port with any valid port number.

Note: This option determines the HTTP port number used by the 
Campaign Synchronization Component to receive HTTP packets 
from Siebel. You will use the value that you enter for this option 
when you configure the Siebel part of the Campaign 
Synchronization Component.

3. Select the Start Info tab.

Start Info Tab

1. Working Directory field: Enter the full name of the Component installation 
directory on the host you specified on the Server Info tab. The value you 
enter in this field will be used as the default destination folder during 
installation. 

2. Enter any valid value into each of the following fields:
 Command Line
 Command Line Arguments

The values you enter in these fields will be overwritten during installation; 
however, data must be present in these fields during the configuration 
process.

3. Leave the default values for the remaining fields. 

4. Select the Options tab.

Connections Tab

On the Connections tab, add the applications to which this application 
connects: 

• Database Access Point - used to provide access to the Outbound Contact 
database for storing Calling List tables (mandatory).

• Outbound Contact Server - required for DoNotCall notifications and 
CallResults synchronization in real-time mode.
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• T-Server - used by the Outbound Contact Server to communicate through a 
communication DN.

• Message Server - required if you plan to use the Management Layer for 
alarm-signaling and centralized-logging capabilities.

• Configuration Server – required if you plan to configure connections to 
this server.

Options Tab

On the Options tab (see Figure 11 on page 89), in the Sections pane, the 
following sections appear:

• CallingListFolders

• CampaignFolders

• DatabaseAccessPoints

• Genesys

• Log

• TableAccessFolders

• Tenants

You will configure options in these sections, starting with the Log section. 
Double-click a section to access its options.

Note: To synchronize campaign information using this release of the Gplus 
Adapter, you must map the Siebel User IDs (the Login Names) of the 
users who created campaigns in the Siebel environment to the 
DatabaseAccessPoints, TableAccessFolders, CallingListFolders, and 
CampaignFolders.
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Figure 11: View of Options Tab in a Multi-Tenant Environment

Log Section

The Campaign Synchronization Component supports the unified set of log 
options (common log options) to allow precise configuration of the log file 
output. For a complete list of unified log options and their descriptions, see the 
“Common Log Options” chapter of the Framework 7 Configuration Options 
Reference Manual.

If you do not specify any log options, the default values apply.
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Genesys Section

synchSummary Option

Change the value of this option to “True” if you need to collect 
synchronization summary information. See the Gplus Adapter 7.5 for Siebel 
CRM Developer's Guide for more information about Synchronization 
summary usage.

format Option

This option determines the name of a list import Format object in Genesys 
Configuration Layer, which is used by the Campaign Synchronization 
Component to create Genesys calling list tables. The default value for this 
option is GplusCampSynch. Leave the default value unchanged at the time of 
deployment. For more information about this option, see the Gplus Adapter 7.5 
for Siebel CRM Developer’s Guide.

communicationDN Option

This option determines the name of a communication DN, which is used for 
interactions with the Outbound Contact Server, and specifically for the Do Not 
Call option.

DNCUpdateTimeout

The default value for this option is 5000ms - the time interval that the Campaign 
Synchronization Component waits for a response about a DoNotCall list 
update.

pullDataTimeout Option

The default value for this option is 15000 ms, the time interval used by the 
Campaign Synchronization Component to reconnect to Siebel Server for a 
request of Synchronization data to be sending.

ServerURL Option

This option specifies the URL of the web server that has the Siebel Web 
Engine installed. Initially, this option contains the template string:
ServerURL=<ServerUrl>/<path>/start.swe?SWEExtSource=GplusCampSynch&SWEE
xtCmd=Execute&UserName=<userName>&Password=<password>

where: 

<ServerUrl> is the first part of the URL you use to access your Siebel Server 
through the Siebel Web Client.

<path> specifies a virtual path on the server referring to the specific Siebel Web 
Extension configuration. The default value for this option is eai_enu.

You have to edit this URL template string according to your Siebel Web 
Extension configuration. For example: 

http://www.myserver.com/eai_enu/start.swe?SWEExtSource=GplusCampSynch&S
WEExtCmd=Execute&UserName=<userName>&Password=<password>

For security reasons, you do not need to put <userName> and <password> 
directly into the URL string. Use the username and password options instead.
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synchCallResults Option

Change the value of this option to True if you need to synchronize Call Results 
from Genesys to Siebel in real-time mode.

pushDataTimeout Option

The default value for this option is 11000 ms, the time interval used by the 
Campaign Synchronization Component to reconnect and send to Siebel Server 
all Call Results Data received by the Adapter from Outbound Contact Server 
for this interval (backward synchronization in real-time mode).

username Option

This option specifies a Siebel user name for the Siebel Object Manager login to 
process a request from the Gplus Adapter. For example: GenesysAdapter. This 
user name must be created in the Siebel environment. The user must have 
access to the Siebel database as Siebel Administrator. 

Note: Genesys does not recommend using a common login ID for this 
process. 

For more information about Siebel user administration, refer to your Siebel 
documentation. 

password Option

This option specifies the password for the login user name above. For 
example: GenesysAdapter. This user name should be created in the Siebel 
environment. The user must have access to the Siebel database as a Siebel 
Administrator. We do not recommend the use of a common login for this 
process! For more information about Siebel user administration, see your 
Siebel documentation.

xslTransformer Option

This configuration option is optional. Use this option if you want to transform 
some values of synchronized data such as Phone number by your own rules. 
The Adapter provides a mechanism to customize the transformation rules 
through an xsl file. In this case you have to add this option to the Genesys 
section. The value of the option should be equal to the name of the xsl file. See 
the Gplus Adapter 7.5 for Siebel CRM Developer’s Guide for more information 
about this option.

Tenants Section

Options in this section define the mapping of Siebel Organizations or 
Divisions to Genesys Tenants. To map a Siebel Organization or Division to a 
Genesys Tenant, create a new option within this section, where the option 
name is the name of the Genesys Tenant and the option value is the name of 
the Siebel Organization or Division.

For example, if you have an Organization named myOrganization in Siebel and 
a Tenant named myTenant in Genesys, enter myTenant as the option name and 
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myOrganization as the option value. Then all Siebel objects that belong to 
myOrganization Organization in Siebel will be created under myTenant Tenant 
in Genesys.

The relationship of Siebel Organizations or Divisions to Genesys Tenants is 
one-to-one.

Note: If you are working in a single-tenant environment, this section should 
contain one option, where the option name is Resources and the option 
value is the name of your Siebel Organization or Division.

DatabaseAccessPoints Section

The options in this section allow you to designate where selected Siebel users 
can create Genesys calling list tables when exporting campaigns from Siebel to 
Genesys. 

To provide Campaign Synchronization functionality, the Siebel Login Names 
of the users who created campaigns in the Siebel environment must be mapped 
to the DatabaseAccessPoints. These login names are the User ID’s stored in the 
“Created By” field of corresponding campaigns. In Siebel 7.7/7.8/8.0/8.1, you 
can find these login names in the Campaign List applet. In any Siebel version, 
you can find these login names by querying the Siebel database. For example, 
a database query similar to this one should work: SELECT T2.LOGIN FROM 
S_SRC T1 LEFT OUTER JOIN S_USER T2 ON T1.CREATED_BY = 
T2.ROW_ID.

For example, if you want the Siebel user (who created the relevant campaigns) 
with User ID user1 to create calling list tables in a database defined by 
Database Access Point DAP1 in Genesys, then you would create a new option in 
this section, where the option name is user1 and the option value is DAP1.

Prior to importing information from Siebel, you must use Genesys 
Configuration Manager to create the Database Access Points referenced in this 
section.

The relationship of Siebel User IDs to Genesys Database Access Points in this 
section is many-to-one.

TableAccessFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Table Access objects when importing information from Siebel.

To provide Campaign Synchronization functionality, the Siebel Login Names 
of the users who created campaigns in the Siebel environment must be mapped 
to the TableAccessFolders. These login names are the User ID’s stored in the 
“Created By” field of corresponding campaigns. In Siebel 7.7/7.8/8.0/8.1, you 
can find these login names in the Campaign List applet. In any supported 
Siebel version, you can find these login names by querying the Siebel 
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database. For example, a database query similar to this one should work: 
SELECT T2.LOGIN FROM S_SRC T1 LEFT OUTER JOIN S_USER T2 ON 
T1.CREATED_BY = T2.ROW_ID.

For example, suppose that you have a Tenant, myTenant, defined in Genesys 
Configuration Manager and you want the Siebel user (who created the relevant 
campaigns) with User ID user1 to create Table Access objects under 
Configuration Manager folder Folder1, which is a subfolder of the Table 
Access folder under Tenant myTenant. To do this, create a new option in the 
TableAccessFolders section with user1 as the option name and /Table 
Access/Folder1 as the option value. The Siebel Organization or Division, 
whose objects the Siebel user user1 will import, must be mapped to Tenant 
myTenant. For information about tenants, see “Tenants Section” on page 91.

Prior to importing information from Siebel, you must use Genesys 
Configuration Manager to create the Configuration Manager folders referenced 
in this section.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function using the options in this section, 
to assign different Configuration Manager folders in Genesys to 
various Siebel users. However, if the same Siebel data is imported into 
different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

CallingListFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Calling List objects when importing information from Siebel.

To provide Campaign Synchronization functionality, the Siebel Login Names 
of the users who created campaigns in the Siebel environment must be mapped 
to the CallingListFolders. These login names are the User ID’s stored in the 
“Created By” field of corresponding campaigns. In Siebel 7.7/7.8/8.0/8.1, you 
can find these login names in the Campaign List applet. In any supported 
Siebel version, you can find these login names by querying the Siebel 
database. For example, a database query similar to this one should work: 
SELECT T2.LOGIN FROM S_SRC T1 LEFT OUTER JOIN S_USER T2 ON 
T1.CREATED_BY = T2.ROW_ID.
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For example, if you have a Tenant, myTenant defined in Genesys Configuration 
Manager and you want the Siebel user (who created the relevant campaigns) 
with User ID user1 to create Calling List objects under Configuration Manager 
folder Folder1, which is a subfolder of the Calling Lists folder under Tenant 
myTenant. Create a new option in the CallingListFolders section with user1 as 
the option name and /Calling Lists/Folder1 as the option value. Make sure 
that the Siebel Organization or Division whose objects Siebel user user1 will 
import is mapped to Tenant myTenant (see “Tenants Section” on page 91).

Prior to importing information from Siebel, you must use Genesys 
Configuration Manager to create the Configuration Manager folders referenced 
in this section.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function using the options in this section, 
to assign different Configuration Manager folders in Genesys to 
various Siebel users. However, if the same Siebel data is imported into 
different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors result in Siebel and Genesys data 
being desynchronized. To avoid such errors, different Siebel users 
should import the same Siebel data into the same set of Configuration 
Manager folders. Alternatively, if each Siebel user has a unique folder 
assignment, different Siebel users should not import the same Siebel 
data into Genesys.

CampaignFolders Section

Each option in this section controls the mapping of a Siebel User ID to a 
Configuration Manager folder, where the Siebel user with this User ID will 
create Campaign objects when importing information from Siebel.

To provide Campaign Synchronization functionality, the Siebel Login Names 
of the users who created campaigns in the Siebel environment must be mapped 
to the CampaignFolders. In Siebel 7.7/7.8/8.0/8.1, you can find these login 
names in the Campaign List applet. In any Siebel version, you can find these 
login names by querying the Siebel database. For example, a database query 
similar to this one should work: SELECT T2.LOGIN FROM S_SRC T1 LEFT 
OUTER JOIN S_USER T2 ON T1.CREATED_BY = T2.ROW_ID.

For example, if you have a Tenant, myTenant defined in Genesys Configuration 
Manager and you want the Siebel user (who created the relevant campaigns) 
with User ID user1 to create Campaign objects under Configuration Manager 
folder Folder1, which is a subfolder of the Campaigns folder under Tenant 
myTenant. Create a new option in the CampaignFolders section with user1 as the 
option name and /Campaigns/Folder1 as the option value. Make sure that the 
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Siebel Organization or Division whose objects Siebel user user1 will import is 
mapped to Tenant myTenant (see the topic “Tenants Section” on page 91).

Prior to importing information from Siebel, you must use Genesys 
Configuration Manager to create the Configuration Manager folders referenced 
in this section.

The relationship of Siebel User IDs to Genesys Configuration Manager folders 
in this section is many-to-one.

Note: You can configure the import function using the options in this section, 
to assign different Configuration Manager folders in Genesys to 
various Siebel users. However, if the same Siebel data is imported into 
different Configuration Manager folders, errors during import will 
occur due to uniqueness constraints imposed by the Genesys 
Configuration Layer. These errors will cause Siebel and Genesys data 
to become de-synchronized. To avoid such errors, different Siebel 
users should import the same Siebel data into the same set of 
Configuration Manager folders. Alternatively, if each Siebel user has a 
unique folder assignment, different Siebel users should not import the 
same Siebel data into Genesys.

After configuring the Application options, click OK to save the Application 
object.

Configuring Security Settings

Security settings must be configured for the Campaign Synchronization 
Component so that the Component can make changes to Genesys 
Configuration Layer objects. Follow the procedures outlined in the following 
sections to configure the security settings for the Application object you 
created in “Creating the Application Object” on page 85.

Creating a New Person

In Configuration Manager:

1. Right-click the Persons folder under Environment if you are working in a 
multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Select New > Person. 
The new Person window displays.

3. Select the General tab and enter the following parameters:
 Employee ID: siebel7gplus
 User Name: siebel7gplus
 Is Agent: Clear

4. Click OK.
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Adding Person to the Super Administrators 
Access Group

In Configuration Manager, to display the existing Access Groups:

1. Click the Access Groups folder under Environment if you are working in a 
multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Double-click Super Administrators Access Group to display its 
properties.

3. Click the Add button to add the Person you just created to the Users list.

4. Click OK.

Associating a Person's Account with the Application

In Configuration Manager, under Environment:

1. Click the Applications folder to display existing Applications.

2. Double-click the Application object you just created to display its 
properties.

3. Select the Security tab, in the Log On As section, and select This Account. 
The Add User window displays.

4. Select the Person you just created and click Add.

5. Click OK to close the Add User window.

6. Click OK to save the Application object.

Creating the List Import Format

In this step of the configuration process, you create a list import Format object. 
The list import Format object determines the structure of the calling list tables 
that the Campaign Synchronization Component will create when importing 
Siebel campaigns. Creating the list import Format object involves three 
processes:

• Creating Field Objects

• Updating Field Objects

• Creating the Format Object

• Copying the Format Object

The first step of the process is to create several Field objects that are 
mandatory for each list import Format.

Before you create the Field objects, however, make sure that the Annex tab 
will be displayed in the Configuration object properties window:

1. In Configuration Manager, from the View menu, select Options. 
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2. Select Show Annex tab in object properties. 

3. Click OK to close the window. 

Creating Field Objects

To create a new Field object, in Configuration Manager:

1. Right-click the Fields folder. If you are working in a multi-tenant 
environment, this is located under Environment; if you are working in a 
single-tenant environment, this is located under Resources.

The New Field Properties window appears.

2. Select New > Field. 
The new Field window displays. 

3. On the General tab, for the Field you are creating, enter the Name field 
value from Table 6, “Field Object Properties,” on page 99. 

For example, to complete the first instance, enter crm_campaign_id.

4. On the Annex tab, create a new section called default. See Figure 13 on 
page 100.

5. In the default section, create an option with the option name 
send_attribute and the option value from Table 7 on page 99, which 
corresponds to the Field object you are creating.

6. Click OK. 

Repeat Steps 1–6 for each Field shown in Table 6.
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Figure 12: Creating a New Field Object 
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Table 6 contains properties you need to enter on the General tab for each Field 
object.

Table 7 shows the values for the send_attribute option, which you use when 
creating Field objects. 

Table 6: Field Object Properties

Field Name Data 
Type

Description Length Field 
Type

Primary 
Key

Nullable

crm_campaign_id varchar  Campaign ID 20 User-
Defined 
Field

Cleared Cleared

crm_camp_con_id varchar Campaign List 
Contact ID

20 User-
Defined 
Field

Selected Cleared

crm_contact_id varchar Contact ID 20 User-
Defined 
Field

Cleared Cleared

Table 7: Values for send_attribute Option

Field Name send_attribute Option Value

crm_campaign_id CRM_CAMPAIGN_ID

crm_camp_con_id CRM_CAMP_CON_ID

crm_contact_id GSW_CUSTOMER_ID
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Figure 13: Creating send_attribute Option

Updating Field Objects

If you need to synchronize Call Results from Genesys to Siebel in real-time 
mode, you have to update certain Field Objects:
• call_result
• call_time
• attempt
• crm_campaign_id
• crm_camp_con_id
• crm_contact_id

The new option icon_attribute = 1 must be added to the default section for all 
of these fields, as shown in Figure 14 on page 101.
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Figure 14: Adding the icon_attribute Option

Creating the Format Object

Now you are ready to create the Format object. Follow these steps, in 
Configuration Manager:

1. Right-click the Formats folder under Environment if you are working in a 
multi-tenant environment or under Resources if you are working in a 
single-tenant environment.

2. Select New > Copy of existing Format. 

3. In the Browse window, select the default format for Outbound Contact:
Default_Outbound_70
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4. Click OK. 
The Properties dialog box for the Format copy that you are about to create 
displays. 

5. Enter the following values on the General tab: 
 Name: GplusCampSynch
 Description: Default list import format for the Gplus Adapter 7.5 for 

Siebel CRM Campaign Synchronization Component.

6. Click OK. 

7. In Configuration Manager, in the object tree view, right-click the Format 
object you just created.

8. Select New > Shortcut to Field.
The Browse window displays.

9. Select the Field objects you just created.

10. Click OK. 

Copying the Format Object

If you work in a multi-tenant environment, create a copy of the list import 
Format object under each Tenant mapped to a Siebel Organization or Division.

To make a copy of the Format object:

1. In Configuration Manager, under a tenant that is mapped to a Siebel 
Organization or Division, right-click the Formats folder. 

2. Select New > Copy of existing Format. 
The Browse window displays.

3. Select the Format object you just created.

4. Click OK. 
The Properties dialog box appears for the Format copy that you are about 
to create. 

5. Click OK to copy the Format. 

Time Zones
You have to synchronize the names of Time Zones in Genesys and Siebel 
environments. This means that you must make the Time Zone names used in 
your Genesys environment match those in your Siebel environment. When you 
are finished, all Time Zones used in reference to contacts or prospects in your 
Siebel environment must be present in Genesys.

The procedure below explains how to copy Time Zone names from the Siebel 
to Genesys Configuration Manager, and specifically to an individual tenant 
that is mapped to a Siebel Organization or Division. For additional information 
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about setting and using the Time Zone definitions in Configuration Manager, 
refer to the Configuration Manager documentation.

To define time zones for a tenant: 

1. Open both applications, Siebel and Configuration Manager.

2. In Configuration Manager, under a tenant that is mapped to a Siebel 
Organization or Division, right-click the Time Zones folder. 

3. Select New > Time Zone.

The new Time Zone window displays. 

4. In Siebel, navigate through the Site Map to get to Time Zone 
administration:
 In a Siebel 7.0.x or 7.5.x environment, select Site Map > Application 

Administration > Time Zone Administration. 
 In a Siebel 7.7/7.8/8.0/8.1 environment, select Site Map > 

Administration - Data > Time Zone Administration.

 Note the time zone names in the column labeled Name.

5. In Configuration Manager, select the General tab and enter the parameters 
listed below. A cut-and-paste approach may minimize errors.
 Name: <the exact name of Time Zone from the Siebel environment>. 
 Description: < A brief description of the Time Zone>.
 Offset: <The time difference between local time and GMT>.
 Specific Zone Name in Netscape: <the time zone name used by 

Netscape Navigator browser>.
 Specific Zone Name in Microsoft Explorer: <the time zone name used 

by Microsoft Explorer>.

6. Click OK. 

Notes: It is also possible to modify the names of Time Zones in the Siebel 
environment so that they match the Time Zone names in the Genesys 
environment. The instructions above assume that the Siebel Time 
Zones have been defined first. 

If Time Zones have been imported into the Genesys environment while 
the Genesys Adapter was running (that is, after the deployment of this 
Adapter), then you must restart the Genesys Adapter to accept these 
changes. 

For more information about Time Zone Administration in Siebel, see 
your Siebel documentation.
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Installation
This section describes the installation process for the Gplus Adapter 7.5 for 
Siebel CRM Campaign Synchronization Component. Select one of the 
following sections depending on your environment.

Installation on Windows

To start the installation process, run the setup.exe file from the Campaign 
Synchronization Component installation package:

1. In the Welcome window, click Next.

2. In the Configuration Parameters to the Genesys Configuration Server 
window, enter the following:
 Host of Configuration Server
 Port of Configuration Server
 User Name
 Password

3. Click Next.

4. In the Select Application window, select the Application object you 
configured in the previous steps.

5. Click Next.

6. In the Choose Destination Location window, click Next to accept the 
default destination folder or use the Browse button to select a different 
destination folder. 

Note: If you want to deploy both the Configuration Synchronization 
Component and the Campaign Synchronization Component, you 
must specify a unique destination folder for each component. This 
will prevent the installation package of one component from being 
overwritten by the installation package of the other component.

7. In the Ready to Install window, click Install.

8. In the Setup Complete window, click Finish.

The Campaign Synchronization Component is now installed.

In the Gplus Adapter for Siebel CRM program folder in the Start menu, you 
can see that the installer created a shortcut for the Campaign Synchronization 
Component.
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Installation on UNIX

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

To install the Campaign Synchronization Component on a UNIX system:

1. In the directory where the Component installation package was copied, 
locate a shell script named:
install.sh

2. Run this script from the command prompt by typing sh and the file name:
sh install.sh

3. When prompted, specify the host name of the computer on which the 
Component will be installed.

4. Enter the host name of Configuration Server.

5. Enter the port of Configuration Server.

6. Enter the user name for Configuration Server.

7. Enter the password for the user name.

8. Choose the Configuration Server environment by its corresponding 
number.

9. Specify the application configured in the previous steps by its 
corresponding number.

10. Specify the full path to the destination directory where you want the 
Component to be installed.

Note: If you want to deploy both the Configuration Synchronization 
Component and the Campaign Synchronization Component, you 
must specify a unique destination folder for each component. This 
will prevent the installation package of one component from being 
overwritten by the installation package of the other component.

The process places the Component in the directory that you specified during 
installation. 

Configuring Siebel
This section describes how to configure the Siebel part of the Campaign 
Synchronization Component.
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Prestart Information

Before starting this part of the configuration process, you must have the 
following application running.

• Siebel Tools

Note: Campaign Synchronization functionality is intended for use with the 
Outbound Campaign feature, which requires Siebel Marketing. Siebel 
Marketing is required to manage outbound campaign interactions. As a 
logical consequence, Campaign Synchronization effectively requires 
Siebel Marketing.

You should be connected to the local copy of the Siebel Server database and 
should have sufficient privileges to check in and check out projects from the 
Siebel Server Repository.

Configuring Siebel Using Siebel Tools

You will use Siebel Tools to compile an updated version of the Siebel 
Repository File for one or more of the Siebel applications on your Siebel 
Server, which you will then deploy on the server. For information about using 
Siebel Tools, see Siebel documentation.

Importing the GenesysCampaignSynchronization.sif 
Archive

Note: If the Genesys Campaign Synchronization project already exists in 
your Siebel Repository File, lock it or check it out before importing the 
GenesysCampaignSynchronization.sif archive. Otherwise, lock the 
project after the import.

Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript Engine 
(and not the ST eScript Engine). The default Siebel option is set to 
Enable ST Script Engine = TRUE, but for the Genesys component it 
should be set to Enable ST Script Engine = FALSE.

In this step, you import objects into the Siebel Repository that are part of the 
Siebel implementation of the Campaign Synchronization Component. The 
objects will be added to the Genesys Campaign Synchronization project.

To perform the import: 

1. In Siebel Tools, select Tools > Import from Archive... 
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2. In the Select Archive to Import window, navigate to the 
GenesysCampaignSynchronization.sif archive file. This file was created by 
the installation program in: <TargetDirectory>/XXX/tools/objects where 
XXX is the subfolder name (/7.5, /7.7, /8.0, or /8.1), depending on 
the Siebel version you use. 

3. Click Open. 
The Import Wizard–Preview window displays.

4. In the Import Wizard–Preview window, in the Conflict resolution section, 
select Overwrite the object definition in the repository.

5. Click Next. 
The Import Wizard–Review Conflicts and Actions window displays.

6. Click Next. 
The “Do you wish to proceed?” window displays.

7. Click Yes. 
The objects from the archive are imported into the Siebel Repository.

8. Click Finish to complete the Import Wizard. 

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after importing the archive. This does not affect the 
functionality of the component in any way.

Next, select the campaign mapping mode.

Selecting the Campaign Mapping Mode

The Campaign Synchronization Component can be configured to support one 
of the following campaign mapping modes: Regular Mode or Compatibility 
Mode. For more information about the campaign mapping modes, see the 
Gplus Adapter 7.5 for Siebel CRM User’s Guide.

To configure support for either of the campaign mapping modes:

1. In Siebel Tools, in the Project field of the Object Explorer, select Genesys 
Campaign Synchronization.

2. In the Object Explorer, select the Business Service folder. 
The Business Services window displays.

3. Select Genesys Campaign Synchronization Business Service.

4. Select the Business Service User Prop folder under the Business Service 
folder using the Types tab of the Object Explorer. 
The Business Service User Props window displays.

5. Select Mapping Mode Business Service User Property.

6. In the Value column, enter Regular for the Regular Mode or Compatibility 
for the Compatibility Mode.
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The mapping mode has been selected. 

Selecting the Genesys Do Not Call Field

The Campaign Synchronization Component can be configured to update the 
Genesys Do Not Call list with either IDs or phone numbers of Siebel Contacts 
or Prospects marked as Do Not Call.

To configure whether IDs or phone numbers are used to update the Do Not 
Call list in the Genesys environment:

1. In Siebel Tools, in the Project field of the Object Explorer, select Genesys 
Campaign Synchronization.

2. Select the Business Service folder. 
The Business Services window displays.

3. Select Genesys Campaign Synchronization Business Service.

4. Select the Business Service User Prop folder under the Business Service 
folder using the Types tab of the Object Explorer. 
The Business Service User Props window displays.

5. Select Genesys DNC Field Business Service User Property.

6. In the Value column, enter Customer Id to use IDs or Phone to use phone 
numbers.

The Genesys Do Not Call field has been selected.

Setting Up the Correct Path to the Siebel File System

Provide the proper path to your Siebel File System directory in the user 
property named FileSystem of the Genesys Campaign Synchronization 
Business Service.

See the Siebel System Administration Guide for more information about the 
Siebel File System.

To do this:

1. In Siebel Tools, in the Project field of the Object Explorer, select Genesys 
Campaign Synchronization.

2. Select the Business Service folder. 
The Business Services window displays.

3. Select Genesys Campaign Synchronization Business Service.

4. Select the Business Service User Prop folder under the Business Service 
folder using the Types tab of the Object Explorer. 
The Business Service User Props window displays.

5. Select the FileSystem Business Service User Property.

6. In the Value column, enter the correct path to the Siebel File System as it is 
defined in your Siebel environment. For example:
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 For Unix: /siebel/filesystem/
 For Windows: C:\sea\filesystem\

If no value is defined, the siebsrvr\bin directory will be used for temporary 
files.

Setting Max Records in XML-Messages

The user property Max Records in Message allows customizing XML-message 
size for big Campaign Lists. The Adapter splits Campaign List records on the 
sequence of XML-messages with size <= Max Records in Message. The default 
value is 100 records. You must also update the Siebel Server parameter 
MaxPageSize >= Max Records in Message, when changing this user property for 
a larger value.

Note: When changing Max Records in Message to a larger value, keep in 
mind that the Siebel parameter HTTPSleepTime for the Genesys HTTP 
connection (with default value of 120000 ms) should be enough for 
processing any request on the Genesys side. Practically speaking, if a 
message contains more then 500 records it could take longer time for 
processing, and in this case the HTTPSleepTime parameter should be 
increased as well.

Checking Out Existing Projects

The Siebel implementation of the Campaign Synchronization Component 
makes use of a number of objects provided by Siebel. To be able to modify 
these objects, you will need to check out the corresponding projects from the 
Siebel Repository.

To check out projects from the Siebel Repository:

1. In Siebel Tools, select Tools > Check Out... 
The Check Out dialog box displays.

2. In the Projects list, select the following projects: 
 Campaign
 Personalization

3. Click Check Out.

Next, import the Campaign.sif archive.

Importing the Campaign.sif Archive

To import the Campaign.sif archive:

1. In Siebel Tools, select Tools > Import from Archive... 
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2. In the Select Archive to Import window, navigate to the Campaign.sif 
archive file. This file was created by the installation program in: <target 
directory>/XXX/tools/objects where XXX is the subfolder name (/7.5, 
/7.7, /8.0, or /8.1), depending on the Siebel version you use.

3. Click Open. 
The Import Wizard–Preview window displays.

4. In the Import Wizard–Preview window, in the Conflict resolution section, 
select Merge the object definition from the archive file with the 
definition in the repository.

5. Click Next. 
The Import Wizard–Review Conflicts and Actions window displays.

6. In the Conflicting Objects pane, select the Business Component category.

7. In the Object differences pane, select Campaign if available (on some 
Siebel versions such as 7.7/7.8/8.0/8.1, there will not be a Campaign 
option in the Object differences pane). If there are any attributes in the 
Attribute differences pane, make sure that the Resolution column for 
each attribute is set to Repository. To do this: Right-click on an attribute 
and select Repository from the drop-down menu.

8. In the Object differences pane, select Campaign List Contact. If there 
are any attributes in the Attribute differences pane, make sure that the 
Resolution column for each attribute is set to Repository. To do this: 
Right-click on an attribute and select Repository from the drop-down 
menu.

9. If you use the Siebel 7.5.x environment, in the Object differences pane, 
select Campaign Lists. If there are any attributes in the Attribute 
differences pane, make sure that the Resolution column for each attribute 
is set to Repository. To do this: Right-click on an attribute and select 
Repository from the drop-down menu.

10. Click Next. 
The “Do you wish to proceed?” window displays.

11. Click Yes. 
The objects from the archive are imported into the Siebel Repository.

12. Click Finish to complete the Import Wizard. 

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after importing the archive. This does not affect the 
functionality of the Component in any way.

Importing the PersonalizationActionSet.sif Archive

To import the PersonalizationActionSet.sif archive:

1. In Siebel Tools, select Tools > Import from Archive... 
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2. In the Select Archive to Import window, navigate to the 
PersonalizationActionSet.sif archive file. This file was created by the 
installation program in: <target directory>/seaXXX/tools/objects where 
XXX is the subfolder name (/7.5, /7.7, /8.0, or /8.1), depending on 
the Siebel version you use.

3. Click Open. 
The Import Wizard–Preview window displays.

4. In the Import Wizard–Preview window, in the Conflict resolution section, 
select Merge the object definition from the archive file with the 
definition in the repository.

5. Click Next. 
The “Do you wish to proceed?” window displays.

6. Click Yes. 
The objects from the archive are imported into the Siebel Repository.

7. Click Finish to complete the Import Wizard. 

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after importing the archive. This does not affect the 
functionality of the Component in any way.

Compiling the Siebel Repository File

To compile the Siebel Repository File:

1. In Siebel Tools, select Tools > Compile Projects... 

2. Select Locked projects.

3. In the Siebel Repository File edit box, enter the name of the 
Repository File.

4. Click Compile. 
The status bar at the bottom of the Object Compiler window indicates 
when the compilation is finished. 

5. When the compilation is finished, close Siebel Tools.

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after compiling the Siebel Repository File. This 
does not affect the functionality of the Component in any way.

Next, configure the Siebel Server.

Configuring the Siebel Server

Complete the steps described in this section to configure the Campaign 
Synchronization Component to work with the Siebel Server.
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Updating Configuration Files

Update the eai.cfg file in the Siebel Server installation. To update this file, 
open it and add the following line to the [HTTP Services] section: 
GplusCampSynch = GplusCampSynchDispatch

The Configuration Synchronization Component uses the Siebel Inbound HTTP 
Transport. For instructions on how to configure the Siebel Inbound HTTP 
Transport, refer to Siebel documentation.

Deploying the New Genesys Projects to the Siebel 
Server

To deploy the new Genesys projects to the Siebel Server Repository, you have 
to check in several projects, as follows:

1. In Siebel Tools, select Tools > Check In... 

The Check In dialog box displays.

2. In the Projects list, select the following projects: 
 Campaign
 Genesys Campaign Synchronization
 Personalization

3. Click Check In.

Creating New Tables in a Genesys Project on a Server 
Database

The Genesys project requires its own tables, which do not exist in the original 
Siebel database. To create these tables, Siebel Tools must be connected to the 
Siebel Server database. Perform this procedure after deploying the Genesys 
project to the Siebel Server.

To create the Genesys-related tables on a Siebel Server database:

1. In Siebel Tools, in the Table field of the Object Explorer make a query to 
select two new Genesys tables: CX_GEN_QUEUE_ITM and CX_GEN_SYN_SUM. You 
can use the first six characters common to both of the table names 
(CX_GEN*) to select both.

2. Click Apply. A pop-up warning appears.

3. Click OK to accept the warning. 

4. In the new Apply Schema window, from the Tables drop down list, select 
Current Query. Enter correct values for the Database user, Database user 
password and ODBC data source. Refer to Figure 15, “Creating New 
Tables in a Siebel Database,”  on page 113. See Siebel documentation for 
more information about creating custom tables.

5. Click Apply to start the creation process.
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6. The message “Changes successfully applied” appears, indicating that 
tables were created.

7. Click Activate to activate these tables.

Note: Siebel Tools must be connected to the Siebel Server database instead 
the local database. Perform this procedure after deploying Genesys 
project to the Siebel Server.

Figure 15: Creating New Tables in a Siebel Database
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Deploying the Siebel Repository File

You must deploy the compiled Siebel Repository File on your Siebel Server. 
Additionally, you may have to generate and deploy browser scripts for the new 
repository file (see “Scripts” on page 435).

For further information on deploying an updated repository file to the Siebel 
Server, refer to Siebel documentation.

Configuring Siebel Using the Siebel Web Client

To connect to your Siebel Server using the Siebel Web Client. You must be 
logged in as a Siebel Administrator.

This part of the configuration process includes the following procedures:

• Checking EAI Server Component Group Status

• Creating Named Subsystems

• Creating Run Time Events

• Creating Genesys Campaign Export Position

Checking EAI Server Component Group Status

Check the status of the EAI (Enterprise Application Integration) Server 
Component Group on your Siebel Server. There are slight variations in the 
navigation required by this process, depending on the version of Siebel with 
which you are working.

1. Navigate through the Site Map to get to the desired applet:
 In a Siebel 7.0.x or 7.5.x environment, select Site Map > Server 

Administration > Servers. 
 In Siebel 7.7/7.8/8.0/8.1 environments, select Site Map > 

Administration - Server Configuration > Component Groups.

2. Select the Siebel Server you are working on. For the selected server, locate 
the Enterprise Application Integration Component Group in the Server 
Component Groups applet. The group Enable State attribute should have 
the value Enabled.

Creating Named Subsystems

Configure one Connection Subsystem that will be used by the Campaign 
Synchronization Component. There are slight variations in the navigation 
required by this process, depending on the version of Siebel with which you 
are working.

To start the process:

1. Navigate through the Site Map to get to your Siebel Server configuration:
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 In a Siebel 7.0.x or 7.5.x environment, select Site Map > Server 
Administration > Enterprise Configuration. 

 In Siebel 7.7/7.8/8.0/8.1 environments, select Site Map > 
Administration - Server Configuration.

2. Select the Enterprise Profile Configuration (Profile Configuration in Siebel 
7.7/7.8/8.0/8.1) applet within the view.

Creating Connection Subsystem

1. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

2. Specify the following parameters for the new record:
 Named Subsystem Alias (Alias in Siebel 7.7/7.8/8.0/8.1): 

GplusCampSyncConnectionPrimary

 Description: Gplus Campaign Synchronization HTTP Connection
 Name (Profile in Siebel 7.7/7.8/8.0/8.1): Gplus Campaign 

Synchronization HTTP Connection Parameters

 Subsystem Type: HTTPSubSys

3. Save the new record.

4. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1) applet:
 HTTPRequestMethod: POST
 HTTPRequestURLTemplate: http://<host>:<port>

where:

<host> is the host where you installed the Campaign Synchronization 
Component.

<port> is the port you specified in the Communication Port field in the 
Configuration Manager’s Server Info Tab of the Campaign 
Synchronization Component Application object.

Creating a Backup Connection Subsystem

1. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

2. Specify the following parameters for the new record:
 Named Subsystem Alias (Alias in Siebel 7.7/7.8/8.0/8.1): 

GplusCampSyncConnectionBackup

 Description: Backup Gplus Campaign Synchronization HTTP 
Connection

 Name (Profile in Siebel 7.7/7.8/8.0/8.1): Backup Gplus Campaign 
Synchronization HTTP Connection Parameters

 Subsystem Type: HTTPSubSys
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3. Save the new record.

4. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1)applet:
 HTTPRequestMethod: POST
 HTTPRequestURLTemplate: http://<host>:<port>

where:

<host> is the host where you installed the Campaign Synchronization 
Component.

<port> is the port you specified in the Communication Port field in the 
Configuration Manager’s Server Info Tab of the Campaign 
Synchronization Component Application object.

Creating Transport Subsystem

1. In the Component Profiles (Profile Configuration in Siebel 7.7/7.8/8.0/8.1) 
applet, create a new record.

2. Specify the following parameters for the new record:
 Named Subsystem Alias Component Profiles (Alias in Siebel 

7.7/7.8/8.0/8.1) applet: GplusCampSynchDispatch
 Description: Gplus Campaign Synchronization Dispatch
 Name (Profile in Siebel 7.7/7.8/8.0/8.1) applet: Gplus Campaign 

Synchronization Dispatch Parameters

 Subsystem Type: EAITransportDataHandlingSubsys

3. Save the new record.

4. For the Named Subsystem record you just created, enter the following 
parameters in the Enterprise Profile Configuration (Profile Parameters in 
Siebel 7.7/7.8/8.0/8.1) applet:
 CharSetConversion: UTF-8
 Service to Execute: Genesys Campaign Synchronization
 Service Method to Execute: GetGenesysMessage

Note: In Siebel 7.8 and higher, the CharSetConversion parameter is not 
available from applets (GUI). In this case you have to set it via Siebel 
Server Manager (srvrmgr) using a command:
change parameter CharSetConversion = UTF-8 for named subsystem 

GplusCampSynchDispatch

See the Siebel documentation for more information about Siebel 
Server Manager.
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Run Time Events Used by the Campaign 
Synchronization Component

Note: The run time events used by the Campaign Synchronization 
component replace functions that are performed by scripts in the older 
versions of the component.

To create Run Time Events required by the Campaign Synchronization 
Component, you have to run the InstallRunTimeEvents method of the Genesys 
Campaign Synchronization Siebel Business Service once using the Siebel 
Business Service Simulator applet. 

To run the method:

1. Navigate through the Site Map to Business Service Administration > 
Business Service Simulator. 

2. In the Service Methods applet, create a new record. 

3. Specify the following parameters for the new record:
 Service Name: Genesys Campaign Synchronization
 Method Name: InstallRunTimeEvents

4. Click the Run button.

After running the method, you should navigate in Siebel client to Runtime 
Events Administration > Events (Administration – Runtime Events > Events 
in Siebel 7.7/7.8/8.0/8.1), and select Reload Personalization (Reload Runtime 
Events in Siebel 7.7/7.8/8.0/8.1) system menu item.

Creating the Genesys Campaign Export Position

To perform campaign export function, you will need to create a special 
position within your Siebel Division.

To create this position:

1. Select Site Map > Group Administration > Positions.

2. Click New on the Positions applet to create a new record.

3. Specify the following parameters for the new record:
 For Division field, select the division this position will belong to
 For Position, enter Genesys Campaign Export

4. Save the new record.

To assign one or more employees to the position that you just created, use the 
Last Name field of the position. For further information on adding positions 
and assigning employees to positions, see the Siebel documentation.

You have completed the configuration and installation of the Gplus Adapter 
7.5 for Siebel CRM Campaign Synchronization Component.
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Chapter

5 Configuration and 
Installation of the Voice 
Component
This release of the Gplus Voice Component supports several major features, 
including: 

• Basic Voice

• Expert Contact

• Outbound Campaign

• Universal Callback (Web and Voice features)

You must configure the Voice Component, including all of the Voice features 
you intend to use, before adding any other driver-based Adapter Component. 

Server-based components, such as Campaign Synchronization and 
Configuration Synchronization, must be configured before the Voice 
Component.

The Genesys Gplus Communication Server is a prerequisite for the Voice 
Component.

This chapter includes the following sections:
 Overview, page 120
 New in This Release, page 123
 Installation, page 123
 Configuring Genesys, page 127
 Gathering Genesys Settings, page 133
 Updating the Siebel Repository File, page 136
 Configuring the Siebel Call Center Application, page 147
 Advanced Customization of Voice Component Configurations, page 164
 Checking Installations, page 196
 Driver Settings, page 203
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 Agent Work Modes Emulation, page 225
 Agent States on Telesets with Multiple Positions and ACD Queues, 

page 226
 Log Files, page 227
 Driver Commands and Events, page 227
 Support for the Emergency/Supervisor Key, page 231
 Detailed Descriptions of Device Commands, page 240
 Detailed Descriptions of Device Events, page 286

The Voice Component functionality can be used in any or all of the following 
configurations:

• Voice only call centers (inbound calls)

• Expert Contact functionality (CTI-Less T-Server support)

• Outbound Campaigns (outbound campaign calls)

• Universal callback functionality (voice and web callback requests)

See the Gplus Adapter 7.5 for Siebel CRM User’s Guide for additional 
information about using this component.

Overview
The Gplus Adapter 7.5 for Siebel CRM Voice Component provides a single, 
consistent user interface for customer relationship management, telephony 
control, outbound campaign calls, expert contact, and voice callback 
functionality.

Features and Enhancements

The Voice Component supports the following features, any or all of which can 
be implemented based on the needs of your contact center:

• Basic Voice (inbound and outbound call functions)

• Expert Contact with CTI-Less T-Server support

• Outbound Campaigns (outbound campaign calls)

• Universal Callback (voice and web callback requests)

Each of these options is described below.

Basic Voice

The Basic Voice feature is intended for call centers that work with inbound 
calls. This feature must be imported first, because it defines the Genesys Voice 
Project in Siebel.
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Expert Contact

The Expert Contact feature serves to establish connections with associates, 
known as experts or knowledge workers, who are not regular call center agents 
and whose phones are not directly monitored by T-Server. Usually this expert 
is a person who has the advanced skills required to handle specific customer 
requests or to solve customer problems. The expert has the option to preview 
data about an incoming call in Preview Interaction mode, and to manually 
notify the CTI-less T-Server about an incoming call and the progress of that 
call. Because the T-Server has no CTI-link to the switch, it does not necessarily 
receive notification of the expert’s phone interactions, so the expert must use 
the Agent Desktop Toolbar to manually update the status of the interaction.

For additional details about Expert Contact, refer to the Genesys Expert 
Contact 7 Getting Started Guide, or the Genesys Expert Contact 7 Deployment 
Guide.

Outbound Campaign

The Outbound Campaign feature is intended for call centers that primarily 
work with outbound campaign calls. It supports Genesys Outbound Desktop 
Protocol version 7.0. The Outbound Campaign feature provides integration of 
Siebel CRM with the Genesys Outbound Contact Server capabilities. The 
Outbound Campaign feature operates with the Voice Component and 
implements full functionality of the Outbound Contact desktop on the Siebel 
CRM Communications Toolbar for outbound campaign functionality. For more 
information about the Siebel CRM Communications Toolbar, see the Gplus 
Adapter 7.5 for Siebel CRM User’s Guide.

Universal Callback

The Universal Callback feature is used with the Voice Component to provide 
voice and web callback functionality. For example, using voice callback 
functionality in your company's Call Center IVR, a customer can request that a 
representative from your company call the customer back. The customer 
simply selects the “Call Back” option in the IVR menu and then enters a 
telephone number with an approximate callback time. In the section titled 
“Checking the Voice Callback Installation” on page 198, Voice Callback 
scenarios provide additional details about using this feature.

Each incoming voice callback interaction creates an activity record in the 
Siebel application and a new work item on the agent Communications Toolbar.

The Description field from the activity record is used for storing User Data 
fields passed from the Universal Callback Server. The set of user data fields 
that are stored can be modified to meet contact center requirements.
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Overview of Voice Component Installation

The processes involved in installing the Voice Component and setting up its 
standard features are summarized below:

1. Install the Adapter from the installation package.

2. Using Genesys Configuration Manager, update the Genesys configuration 
and collect the required information.

3. Using Siebel Tools, import the Siebel .sif archive files from the 
installation package.

4. Customize the Siebel Communications Toolbar.

5. Recompile the Siebel .srf file.

6. Deploy the .srf file on Siebel Server

7. Configure the Siebel Call Center application

8. Synchronize Time Zone names in Siebel and Genesys. Refer to “Time 
Zones” on page 102 in Chapter 4, “Configuration and Installation of the 
Campaign Synchronization Component,” on page 83 for detailed 
instructions.

9. Customize and import the Communications configuration file 
GenComm_universal.def.

10. Create and administer call center agents.

11. Start a test session for each feature, based on instructions in the section 
titled, “Checking Installations” on page 196.

Each of the processes listed above are explained in the sections below, and 
explanations are accompanied with step-by-step instructions for completing 
each task in the process.

Note: Customization of the Siebel application and the Gplus Adapter is very 
common. No overview, including the one provided above, could 
encompass all possible customizations of the Gplus Adapter. However, 
some of the more common Gplus Adapter customizations, and some 
general information related to Gplus Adapter customization, is 
provided in the section titled “Advanced Customization of Voice 
Component Configurations” on page 164. Refer also to the Gplus 
Adapter section of the Genesys Migration Guide and to the associated 
HTML file., 70gp-sl7_GenComm7_universal_migration.html. This 
HTML file documents the changes to the .def file that differentiate 
version 7.5 from version 7.2.
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Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript Engine 
(and not the ST eScript Engine). The default Siebel option is set to 
Enable ST Script Engine = TRUE, but for the Genesys component it 
should be set to Enable ST Script Engine = FALSE.

New in This Release
This section provides information about new features or functionality in this 
release of the Voice Component:

• Supports Siebel 8.0, 8.1

• Supports an optional feature whereby, in network transfer scenarios where 
the second agent is not available, the agent performing the transfer will 
automatically reconnect with the customer upon expiration of the time out 
period

• Supports new description of connection to the T-Server

• Supports secure connection between the Gplus Adapter and T-Server 
(Genesys Framework 7.5 feature)

• Supports the Genesys Outbound 7.5 feature to allow agents to be involved 
in multiple active call campaigns at the same time

• Supports selective protection of sensitive data in UserData, Extensions, 
and Reasons in logs (feature provided and configured in GenCommServer).

• Supports enhanced logging. If the log level is set to DEBUG, then incoming 
and outgoing statistics connections will be logged.

Installation
This section describes the installation process for the Gplus Adapter 7.5 for 
Siebel CRM Voice Component. The Gplus Adapter can be installed on 
Windows or UNIX platforms. On UNIX, you can use either Solaris or AIX.

Setup Types

This version of the Adapter is compatible with the following versions of Siebel 
CRM Server: 7.5.3, 7.7/7.8/8.0/8.1. 

For information about the files that you install and their location, see the 
section “Target Directory Structure and File Locations”.
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Installation and Uninstallation Options

Since the 7.2 release, the Adapter is installed on the host where the Genesys 
Gplus Communication Server (GenCommServer) is running. GenCommServer 
invokes the Adapter and then uses its functionality on the requests from Siebel 
Communication Server directed by the Gplus Communication Driver 
(GenCommDrv) to GenCommServer.

Installation of GenCommServer is a prerequisite for installation of the Gplus 
Adapter components. It is important to note that installation of GenCommServer 
may run on a computer with or without Siebel Server.

Target Directory Structure and File Locations

The following generic directory and host names are used in the description of 
the directories structure:

• <Gplus Communication Server directory> is the Gplus Communication 
Server installation directory.

• <Destination Directory> is the destination directory for installation used 
by the installation script to copy the Adapter for Siebel CRM Voice files.

• Files in subdirectories <Destination Directory>/images/7.5 and 
<Destination Directory>/objects/7.5 are related to Siebel version 7.5.3. 

• Files in subdirectories <Destination Directory>/images/7.7 and 
<Destination Directory>/objects/7.7 are related to Siebel versions 7.7 
/7.8.

• Files in subdirectories <Destination Directory>/images/7.7 and 
<Destination Directory>/objects/8.0 are related to Siebel version 8.0.

• Files in subdirectories <Destination Directory>/images/7.7 and 
<Destination Directory>/objects/8.1 are related to Siebel version 8.1.

• <Web Server Host> is the Web Server host name where the Siebel Web 
Server extension was installed.

• <SWEIconImages directory> is the Siebel Web Server extension icon 
images directory.

Installation on Windows

Note: Before you install the Voice Component, stop the Gplus 
Communication Server. 

To install the Voice Component on Windows:

1. Double-click setup.exe from the installation package 
(windows\setup.exe). 
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2. When prompted, Genesys Installation Wizard will install the Gplus 
Adapter for Siebel CRM Voice in the following Destination Folder, 
choose the location of this destination folder.

For example:
C:\Program Files\GCTI\Gplus Adapter for Siebel CRM Voice

3. When prompted, Genesys Installation Wizard has collected all 
required information and is ready to install Gplus Adapter for 

Siebel CRM Voice on your computer, click Install.

4. When Genesys Installation Wizard completes its execution, you must 
manually copy the following files to their proper locations:

Depending on your version of Siebel Server, copy files representing icon 
images from either <Destination Directory>/images/7.7 or from 
<Destination Directory>/images/7.5 to the following directories:
< Web Server Host>/< SWEIconImages directory >

Files for Siebel 7.7 /7.8/8.0/8.1 must be taken from 
<Destination Directory>/images/7.7

Files for Siebel 7.5.3 must be taken from 
<Destination Directory>/images/7.5

Note: The installation package contains new complementary pairs of icons 
for Ready/Not Ready buttons. During the installation process, standard 
Siebel icons for the Not Ready button are overwritten with new ones 
from the installation package. To preserve the standard Siebel icons, 
Genesys recommends that you back up image files 
icon_notready_enabled.gif and icon_notready_disabled.gif in a safe 
location. These files should be restored manually if the Gplus Adapter 
is uninstalled.

Installation on UNIX

This section describes how to install the Voice Component on Solaris and AIX.

The user running the installation script must have proper permissions to create 
and write to the directories where the Gplus Communication Server 
(GenCommServer) is installed.

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

Prerequisites for Solaris

The Voice Component must be installed on a computer where Gplus 
Communication Server (GenCommServer) is installed on Solaris. Before starting 
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the installation of the Voice Component on Solaris, you must have the 
following dynamically linked runtime libraries installed on the computer 
where Siebel CRM is installed: 
• libsocket.so

• libnsl.so

• librt.so

• libdl.so

• libintl.so

• libmp.so

• libaio.so

• libc.so

• libw.so

• libelf.so

• libc_psr.so

• libCrun.so

Follow the instructions under the heading, “Running the Installation Shell” on 
page 126 to continue with the installation process.

Prerequisites for AIX

The Voice Component must be installed on a computer where Gplus 
Communication Server (GenCommServer) is installed on an AIX platform. 
Before starting the installation of the Voice Component on AIX, you must have 
the following dynamically linked runtime libraries installed on the computer 
where Siebel CRM is installed:
• libpthreads.a

• libC_r.a

• libc_r.a

• librtl.a

Follow the instructions under the heading, “Running the Installation Shell” to 
continue with the installation process.

Running the Installation Shell

To install the Voice Component on Solaris or AIX:

1. Stop the GenCommServer. 

2. At the Solaris or AIX prompt, execute install.sh.

3. When prompted, Please enter the full path to your Gplus 
Communication Server for Siebel CRM directory =>, enter the full path to 
the Gplus Communication Server for Siebel CRM installation directory, 
for example:
/data/GplusCommunicationServerFolder

4. When a message appears:
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Note that path to "Gplus Communication Server for Siebel CRM 
directory" directory can't be used as input to the "Destination 
directory for installation" prompt.

Please enter full path of the destination directory for installation

=>

enter the full path of the destination directory for installation, for example:
/data/inst_dest

Files are extracted from the installation package to the destination 
directory for installation and then will be copied into the correct folders.

5. When the installation script completes its execution, you must manually 
copy the following files to their proper locations.

Depending on your version of the Siebel Server, copy files representing 
icon images from either < Destination Directory>/images/7.7 or from 
<Destination Directory>/images/7.5 to the following directories:
< Web Server Host>/< SWEIconImages directory >

Files for Siebel 7.7 /7.8/8.0/8.1 must be taken from 
<Destination Directory>/images/7.7

Files for Siebel 7.5.3 must be taken from 
<Destination Directory>/images/7.5

Note: The installation package contains new complementary pairs of icons 
for Ready/Not Ready buttons. During the installation process, standard 
Siebel icons for the Not Ready button are overwritten with new ones 
from the installation package. To preserve the standard Siebel icons, 
Genesys recommends that you back up image files 
icon_notready_enabled.gif and icon_notready_disabled.gif in a safe 
location. These files should be restored manually if the Gplus Adapter 
is uninstalled.

Uninstallation

Complete information about uninstalling the Gplus Adapter and its 
components is provided in Chapter 9, “Uninstallation Instructions,” on 
page 393. 

Configuring Genesys
This section describes the configuration of the Genesys requirements of the 
Voice Component. It includes information and instructions for configuring 
Voice Component functionality.
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Prestart Information

Before starting the configuration process for each Gplus Adapter component or 
feature listed below, you must have the listed applications installed and 
running:

Required for All Components

Genesys Framework

• Configuration Database

• Configuration Server

• Configuration Manager

• T-Servers

Expert Contact Feature

Genesys Expert Contact 

• CTI-Less T-Server

Outbound Campaign Feature

Genesys Outbound Campaign

• Outbound Contact Server

• Outbound Contact Manager

Universal Callback Feature

Genesys Framework

• Universal Router

• Universal Callback Server

Modifying Genesys Settings

Genesys Configuration Manager provides access to most of this information 
mentioned in this section.

Basic Voice Feature

The Basic Voice feature does not require any Genesys settings update. No 
mandatory modifications are needed.
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Expert Contact Feature

You may need to change configuration settings when a Network T-Server is 
used with respect to CTI-Less T-Server. Most configuration changes must be 
done in the Network T-Server configuration object. Refer to the Genesys 
Expert Contact 7 Deployment Guide for specific information and instructions.

Outbound Campaign Feature

Several Outbound Contact Server (OCS) installation settings must be changed 
after the default installation of the Outbound Campaign feature. You can make 
these changes in Configuration Manager using the Options tab of OCS’s 
application properties.

To modify the Genesys Outbound Contact Server settings:

1. In Configuration Manager, select Environment > Applications and right-
click the Outbound Contact Server Application. 

2. Select Properties. 
The Properties dialog box displays.

3. Select Options > OCServer (see Figure 16 on page 130). 

To change the default value of the key, double-click the line you want to 
change: 
login_action > hard_not_ready 

outbound_release_action > hard_not_ready 
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Figure 16: Modifying Outbound Contact Server Settings

4. Check to make sure the record_processed option is set to the value yes. If 
not, change the value to yes. For more information about the 
record_processed option, see the Genesys Outbound Contact 7.0 Reference 
Manual.

5. If you are using Outbound Contact release 7.0 or later, you can add the 
option customer_id, value = crm_contact_id (for more information, see 
the topics “Configuration Changes” on page 132 and “Setting 
DoNotCall Based on Customer ID” on page 132).

If you are using an earlier version of Outbound Contact, continue 
to Step 6. 

6. Click Apply to submit changed values. 

7. Click OK. 

Modifying the Outbound Contact Manager Component Settings

After default installation, no further changes are required for Outbound 
Contact Manager.
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For further information on how to install Outbound Contact Manager, see the 
Genesys Outbound Contact Getting Started Guide.

Setting Send Attribute Values in the Calling List Format

The key-value pair send_attribute equal to GSW_ATTEMPTS must be 
specified for the Attempt field in the calling list format. You must specify this 
value because after default installation, Outbound Contact Server does not 
send the number of attempts to the client and vice versa.

To set up the GSW_ATTEMPTS attribute:

1. In the Configuration Manager, select the section Formats, used by your 
campaign. 

2. Browse to the appropriate Format record.

3. Right-click the Attempt field and select Properties from the shortcut 
menu.

4. Select the Annex tab.

5. Create the section default and under this section create a new record 
send_attribute = GSW_ATTEMPTS (see Figure 17, “Setting the Send 
Attribute,”  on page 132).

6. Click OK to save the record. 
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Figure 17: Setting the Send Attribute

Setting DoNotCall Based on Customer ID

The Campaign Synchronization Component supports Do Not Call requests 
based on the Siebel Customer ID (this requires Genesys Outbound Contact 
Server release 7.0 or later). The Do Not Call request is based on the Siebel 
Customer ID and is an extension of the OCS desktop protocol. You can also 
use the Do Not Call request based on record handle and phone number. Setting 
Do Not Call based on the Customer’s ID resolves the problem of more than 
one customer sharing the same phone number. For more information about the 
Do Not Call request, see the Outbound Contact Deployment Guide.

Configuration Changes

To support Do Not Call by Customer ID, the Outbound Contact Server 
associates a calling list’s field with their Customer ID. The name of the calling 
list’s fields that will be used for the CustomerID is defined by the option 
customer_id, see “To Specify DoNotCall Command Attributes” on 
page 189. If this option is not present in the calling list or application object or 
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if it contains a field name that does not exist in the calling list table, by default, 
OCS uses the phone number to determine the records that should not be dialed. 

Gathering Genesys Settings
You must locate and record several Genesys object settings in Genesys 
Configuration Manager before you proceed further with the installation of the 
Voice Component. The data identified in this section is required to complete 
the installation! 

The specific Genesys data you require depends on the Gplus Adapter 
components and features that you plan to implement for your Contact Center. 
Data requirements for each configuration are listed under the corresponding 
heading below.

Data Required for All Voice Configurations

For all Voice configurations, complete the following:

• Gather T-Server connection information.

The required information includes:
 T-Server application name

For the pre-7.5 description scheme of connection to the T-Server, the 
required information includes:
 T-Server host name
 T-Server connection port
 Switch type information
 Backup T-Server host name (if applicable)
 Backup T-Server connection port (if applicable)

T-Server Connection Information

To find the T-Server connection information:

1. In Configuration Manager, under Environment > Applications, select the 
T-Server application configured for use with Outbound Contact Server.

2. Select Properties.
The Properties dialog box displays. 

3. Select the Server Info tab.

4. Note the T-Server connection information (which you will need later for 
the Gplus Outbound Campaign feature and for configuring the Siebel Call 
Center application):
 Host: Host name
 Communication port: Communication port number
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Basic Voice Feature Data

If your configurations are set to receive network calls and to use the Network 
Attended Transfer feature, then the following information is required:

• Premise switches names as they are defined in Genesys Configuration 
Manager

Expert Contact Feature Data

For the Expert Contact feature, find and record the following CTI-less T-
Server connection information:

 T-Server host name
 T-Server connection port
 Switch type information
 Backup T-Server host name
 Backup T-Server connection port

• Based on the actual configuration of Genesys Expert Contact, find the 
CTI-Less T-Server, and note the corresponding virtual switch name.

Outbound Campaign Feature Data

For the Outbound Campaign feature, find and record the following:

• Gather T-Server connection information

• Gather Outbound Contact Server configuration information

• Check T-Server settings

The required information includes:
 T-Server host name
 T-Server connection port
 Switch type information
 Backup T-Server host name
 Backup T-Server connection port
 Name of the voice queue on which the Outbound Campaign is running
 Version of the Outbound Contact Server you use. See“OCS Version” 

on page 135.

Outbound Contact Server Configuration Parameters

ACD/PBX Data

To find the Outbound Contact Server (OCS) ACD/PBX information:

1. In Configuration Manager, select Tenant > Agent Groups or Tenant > 
Place Groups.
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2. Select a particular Group.

3. Select Properties.
The Properties dialog box displays.

4. Select the Advanced tab 
(see Figure 18).

Figure 18: Outbound Properties Dialog Box

5. From the Origination DNs pane, make note of the ACD/PBX information, 
which is used later for the Gplus Voice Component configuration. 

For example, in Figure 18, the Origination DNs information required 
includes: DN Number (8000), Type (ACD Queue), Switch (SwitchG3). 
For further information, see “Configuring the Siebel Call Center 
Application” on page 147 and “Associating Agents with the 
Communications Profile and Genesys Settings” on page 160. 

OCS Version

To find the version of Outbound Contact Server (OCS) that you use:
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1. Start at the command prompt window from Windows or from a terminal 
window in UNIX.

2. Navigate to the OCS installation home folder (for example, C:\GCTI\OCS on 
the Windows platform).

3. Run the OCS executable with -V switch: > ocs_server -V

4. Note the Outbound Contact Server version.

Universal Callback Feature Data

The Voice and Web Callback Configuration does not require Genesys settings 
update. Time Zone synchronization is a mandatory modification for this 
configuration. Refer to “Time Zones” on page 102 in Chapter 4, 
“Configuration and Installation of the Campaign Synchronization 
Component,” on page 83 for detailed instructions.

For this feature:

• Gather T-Server connection information

• Gather Universal Callback server information

The required information includes:

For T-Server:

• T-Server host name

• T-Server connection port

• Switch type information

• Backup T-Sever host name

• Backup T-Server connection port

For Universal Callback server:

• Switch name of Voice T-Server

• Routing Points list on this switch

Updating the Siebel Repository File
This section explains how to modify the Siebel Repository File (.srf) with 
new Voice archive (.sif) file data or with data from other archives with 
extended functionality, and how to recompile the Siebel Repository File. It also 
explains how to modify the .srf file with data from other archives with 
extended functionality. 

Information is covered under the following topic headings:

• Requirements for Starting

• Overview of Siebel Repository File Preparation

• Locking Existing Projects
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• Importing Voice Component Archive (.sif) Files and Resolving Conflicts

• The Siebel Communications Toolbar

• Compiling the Siebel Repository File

• Deploying the Repository File

For information on how to use Siebel Tools, see the Siebel documentation.

Requirements for Starting

Before starting this part of the configuration process, you should have the 
following Siebel CRM and Genesys Gplus applications installed and running:

Siebel CRM Applications

• Siebel Tools

• Siebel Server

• To use the Outbound Campaign feature and the Outbound Contact Server 
product, you must have Siebel eMarketing.

Note: To configure Siebel, you must have access to the local copy of the 
Siebel Server database and have sufficient privileges to check in and 
check out projects from the Siebel Server Repository.

Genesys Gplus Applications

• Gplus Configuration Synchronization Component for Siebel CRM; 
optional, may be used with any Voice Component feature.

• Gplus Campaign Synchronization Component for Siebel CRM; optional, 
designed to be used with the Outbound Campaign feature.

Overview of Siebel Repository File Preparation

You use Siebel Tools to compile an updated version of the Siebel Repository 
File (SRF or .srf file), which serves to define the Siebel Contact Center 
application on the Siebel Server. 

When compiled, the Siebel Repository File integrates information from the 
various Gplus Adapter Voice Component archives (the .sif files) that you 
import. 

For each Voice Component feature that you wish to implement, you must 
import a Voice Component .sif file and resolve any data conflicts introduced 
by the imported file. The Voice Component features and their associated .sif 
files are listed in Table 8. The .sif files are provided with the Gplus Adapter 
installation disk.
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Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript Engine 
(and not the ST eScript Engine). The default Siebel option is set to 
Enable ST Script Engine = TRUE, but for the Genesys component it 
should be set to Enable ST Script Engine = FALSE.

Note: Depending on the Siebel Server version, appropriate .sif files should 
be imported from folder <destination folder>/objects/7.5 for Siebel 
7.5.3; <destination folder>/objects/7.7 for Siebel 
7.7/7.8;<destination folder>/objects/8.0 for Siebel 8.0; or 
<destination folder>/objects/8.1 for Siebel 8.1. See installation 
sections for more information

* In some circumstances, you may have to manually update certain objects to 
resolve data conflicts. 

Order of Deployment

There is one constraint on the order in which you deploy the .sif files: 
installing GenSymbolicStrings.sif (for Siebel 7.8 and higher) and then 
GenComm.sif, which provides Basic Voice functionality, is mandatory for any 
and all configurations, and this file must be deployed first. 

There are no restrictions on order in which you deploy the rest of the archive 
files. These other files are technically optional, and there is no restriction on 
order of their deployment. Each is responsible for a particular feature’s 
functionality. 

Deployment of GenesysTools.sif is mandatory. It will be used during 
configuration of the Siebel Call Center application

Table 8: Voice Component Features and Associated .sif Files

Feature Voice Component archive (.sif) file

Basic Voice GenComm.sif and GenSymbolicStrings.sif for Siebel 
7.8 and higher

Genesys Tools GenesysTools.sif

Expert Contact GenComm_ECS.sif

Outbound Campaign GenComm_OCS.sif *

 Universal Callback 
(Voice and Web)

GenComm_VCB.sif
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Procedures for Siebel Repository File Preparation

To import the necessary .sif files and prepare the Siebel Repository File for 
compiling, you must complete the following tasks:

1. Start Siebel Tools against the local database.

2. Lock the projects common for all features and the projects for selected 
optional features. Projects are described in Table 9.

3. For Siebel 7.8 and higher, import the mandatory GenSymbolicStrings.sif 
file.

4. Lock the Genesys Symbolic Strings project.

5. Import the mandatory GenComm.sif file.

6. Lock the Genesys Voice Project.

7. Import the mandatory GenesysTools.sif file.

8. Lock the Genesys Tools Project.

9. For every selected optional feature do the following:
 Import the corresponding .sif file
 Resolve conflicts between Siebel Server applications, as necessary. 

Use Table 10, “Features with Conflicts to be Resolved,” on page 142 to 
check for potential conflicts.

10. If you are deploying the Universal (Voice) Callback feature:

a. Import the corresponding .sif file

b. Resolve conflicts between Siebel Server applications, as necessary. 
Use Table 10, “Features with Conflicts to be Resolved,” on page 142 to 
check for potential conflicts.

c. Manually copy the script as follows:
 From the Object Explorer, go to the Application objects.
 From the Applications window, select the application on which the 

Adapter is deployed (for example, Siebel Universal Agent for 
Siebel Horizontal versions, or Siebel Financial Services for Siebel 
Vertical versions).

 Right-click the application record and select Edit Server Script 
from the drop-down menu.

 Edit the Application_PreNavigate method for the selected Server 
Script with the code provided in the file 
<InsDir>/<OBJECTS>/Application_PreNavigate_VCB.es. If there are 
no server scripts associated with the application object, you will be 
asked to select the scripting language. Please select eScript in this 
case. Refer to “Updating the Application's Application_PreNavigate 
Event Server Script” on page 436 in the Appendix.

11. Compile the updated .srf file. 

12. Deploy the new .srf file.
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Instructions for completing each of these tasks are provided below, with step-
by-step details. Start with the “Locking Existing Projects”section. 

Locking Existing Projects

Before working with projects, you must start Siebel Tools against the local 
database.

To lock existing projects:

1. In Siebel Tools, in the Object Explorer, select Project category.

2. In the Projects list, select the appropriate projects. 
 Select projects listed below in Table 9. 
 Select the projects to be locked based on the features you want to 

install. 
 Always lock the projects that are common to all components. 
 In addition, lock any other projects that are specific to the features 

you are installing.

Note: The project named Genesys Voice is created when you import the 
GenComm.sif file, as explained in the instructions below. When you 
first open the Projects list, the Genesys Voice project does not yet 
exist and so is not available to be locked.
The project named Genesys Tools is created when you import the 
GenesysTools.sif file. Lock the project after import of 
GenesysTools.sif.
The project named Genesys Symbolic Strings is created when you 
import the GenSymbolicStrings.sif file. Lock the project after 
import of GenSymbolicStrings.sif.
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* Lock the project after import of the corresponding .sif file.

** This project is locked when deploying the Universal Callback feature as 
described in “Procedures for Siebel Repository File Preparation” on page 139. 
This is the project related to an application on which the Adapter is deployed. 
For example: Siebel Universal Agent (for Siebel Horizontal version) or Siebel 
Financial Services (for Siebel Vertical versions).

Importing Voice Component Archive (.sif) Files and Resolving 
Conflicts

By importing the Voice Component archives, you import the fundamental data 
required to update the Siebel Repository File for the Voice Component. 

Be aware that import starts from GenSymbolicStrings.sif (for Siebel 7.8 and 
higher), then GemComm.sif and GenesysTools.sif files, and requires locking 
some projects after import of these files, as described above.

Some of the archive data that you import is in conflict with the current Siebel 
application data. The following type of conflict may require resolution: 

Table 9: Projects for All Supported Siebel Versions - Common for all Components and 
Feature-Specific

Feature Archive File Common Projects
(for all components)

Feature-Specific 
Projects

Basic Voice GenComm.sif

GenesysTools.sif

GenSymbolicStrings.sif

• Command

• Communication

• Communication 
Administration

• Persistent Customer 
Dashboard

• Genesys Voice*

• Genesys Tools*

• Genesys Symbolic 
Strings*

Expert Contact GenComm_ECS.sif None

Outbound Campaign GenComm_OCS.sif • Campaign

Universal Callback 
(Voice and Web)

GenComm_VCB.sif • Activity

• Contact

• Contact (SSE)

• Table Activity

• <Project related to an 
application on which 
the Adapter is 
deployed with the 
Universal Callback 
feature >**
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• Conflicts between the Siebel application for which the .sif file was 
originally prepared and the Siebel application on which the .sif file is being 
deployed

The Siebel Tools processes that help you resolve these conflicts are explained 
below.

Importing .sif Files and Resolving Conflicts

You must import the .sif file for each Voice feature and resolve any conflicts 
created. 

Complete the steps below to import the archive file with symbolic strings, 
GenSymbolicStrings.sif,  that are used across the Siebel archive files provider 
within the Adapter. 

Note: The GenSymbolicStrings.sif file must be imported first.

1. In Siebel Tools, select Tools > Import from Archive.

2. In the Select Archive to Import window, select the symbolic strings 
archive file, GenSymbolicStrings.sif.

The Voice Component installation program created this file in its destination 
directory. Navigate to the appropriate directory in your environment, as 
follows:

• For Windows: <Destination directory>\objects\<Siebel Version>.

• For UNIX: <Destination directory>/objects/<Siebel Version>.

3. Click Open.

The Import Wizard-Preview window appears.

4. Click Next.

The Review Conflicts and Actions screen displays.

Table 10: Features with Conflicts to be Resolved

Feature Voice Component 
archive (.sif) file

Conflict with 
Gplus 
Components

Conflict with 
Siebel 
Applications

New Table 
Fields

Basic Voice GenComm.sif No Yes No

GenesysTools.sif No No No

GenSymbolicStrings.sif No No No

Expert Contact GenComm_ECS.sif No No No

Outbound Campaign GenComm_OCS.sif No Yes No

Universal Callback GenComm_VCB.sif No Yes Yes
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5. Click Finish.

Complete the steps below to import the fundamental archive file, GenComm.sif, 
and resolve its conflicts.

Proceed with GenesysTools.sif and each additional Voice Component feature 
that you wish to implement; repeat the import and conflict resolution steps 
below, substituting for GenComm.sif the .sif file associated with that feature. 
Refer to Table 10 on page 142. 

1. In Siebel Tools, select Tools > Import from Archive. 

2. In the Select Archive to Import window, select the Voice Component 
archive file, GenComm.sif.

The Voice Component installation program created this file in its 
Destination directory. Navigate to the appropriate directory for your 
environment, as follows:
 For Windows:

<Destination directory>\objects\<Siebel Version>
 For UNIX:

<Destination directory>/objects/<Siebel Version>
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3. Click Open. 
The Import Wizard–Preview window appears (see Figure 19).

Figure 19: Import WizardPreview Window

Note: In the Conflict resolution area, the button “Merge the object 
definition from the archive file with the definition in the 
repository” is selected by default (see Figure 19). 

4. Click Next. 
The Review Conflicts and Actions screen displays. 

5. In the Review Conflicts and Actions screen, from the Conflicting Objects 
panel, navigate to Business Component, and select it so that the list of 
business components appears. 
 If there is no Business Component, skip to Step 7.

6. For each business component in the list, select it in the Conflicting Objects 
panel. 
 In the Attribute Differences panel, right click on each of the following 

attributes (if it exists) and re-set the Resolution to Repository:
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 Class
 Search Specification
 Sort Order
 Sort Specification

Note: A business component does not necessarily have any of these 
attributes (Class, Search Specification, Sort Order, Sort 
Specification). 

7. In the Review Conflicts and Actions screen, from the Conflicting Objects 
panel, navigate to Applet, and select it so that the list of Applets appears.
 If Applet is not listed, skip Step 8. 

8. For each applet in the list with conflicts with Siebel applications, perform 
the following procedure: 
 In the Attribute Differences panel, right click on each of the following 

attributes (if it exists) and re-set the Resolution to Repository:
 Search Specification
 Sort Order

9. After import of GenComm.sif, lock the Genesys Voice project.

After import of GenesysTools.sif, lock the Genesys Tools project.

No project needs to be locked after import of other .sif files.

For each additional Voice Component feature that you wish to implement, 
repeat the import and conflict resolution steps above; but note the special 
requirement for Outbound Campaign below.

The Siebel Communications Toolbar

Note: Each communications toolbar item has its own position specified by an 
appropriate field. You must ensure that after importing new toolbar 
items there are no conflicts for the position field that appears. Siebel 
does not check this, and conflicts may cause issues with the 
communications toolbar appearance.

Importing a Voice Component archive (.sif) file effectively modifies the 
Siebel Communications Toolbar so that it provides the standard toolbar buttons 
for the Voice Component feature associated with that .sif file. The Toolbar, 
including these modifications and any customizations, is not created until the 
Siebel Repository File is compiled.

Importing the primary Voice Component file, the GenComm.sif file, creates the 
fundamental Siebel Communications Toolbar. Each of the other Voice 
Component archive files that you import modifies the toolbar, as appropriate, 
for the corresponding Voice Component features.
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Note: As with the Voice Component archive files, each of the other Gplus 
Adapter archive (.sif) files modifies the Toolbar as appropriate. That 
is, each of the archive files associated with the other Gplus Adapter 
components also includes code that modifies the toolbar to provide the 
buttons and controls necessary to work with the installed features.

Compiling the Siebel Repository File

To compile the Siebel repository file:

1. In Siebel Tools, select Tools > Compile Projects.

2. Select Locked projects.

3. In the Siebel Repository File edit box, select the name of the repository 
file.

4. Click Compile. 
The status bar at the bottom of the Object Compiler window indicates 
when compilation is finished.

Updating New Tables in a Genesys Project on a Server 
Database

This procedure is required only for deployment of the Universal Callback 
feature, in which .srf updates the standard S_EVT_ACT_X table. This is a two-
step procedure:

1. Deploy the changed table to the Siebel Server Repository

2. Apply changes to the Siebel database tables.

Deploying the Changed Table to the siebel Server 
Repository

To deploy the changed table to the Siebel Server Repository, check in projects 
as follows:

1. In Siebel Tools, select Tools > Check In.

The Check In dialog box displays.

2. In the Projects list, select the following project:

Table Activity

3. Click Check In.

Applying Changes to the Siebel Database Tables

To update a table on a local Siebel database (or on the Siebel Server database):
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1. Connect Tools to the server database.

2. In Siebel Tools, in the Object Explorer, navigate to the Table object.

3. Navigate to the List of Tables pane.

4. Locate the table S_EVT_ACT_X.

5. Click Apply.

A pop-up Warning window appears.

6. Click OK to accept the warning.

7. In the new Apply Schema window, from the Tables drop down list, select 
Current Row.

8. Enter the correct values for the Database user, Database user password, 
and ODBC data source.

You must enter the user name and password for a Database user who has 
an administrator's privileges in the Siebel environment.

Refer to Figure 15, “Creating New Tables in a Siebel Database,”  on 
page 113. See the Siebel documentation for more information about 
creating custom tables.

9. Click Apply.

The message Changes successfully applied appears, indicating that tables 
were created.

10. Click the Activate button to propagate database changes and make them 
available to all users.

Deploying the Repository File

To deploy the .srf file, stop the Siebel Server, copy the new repository file to a 
specific location within the server installation, and restart the server. 
Additionally, you may have to generate and deploy browser scripts for the new 
repository file (see “Scripts” on page 435).

For further information on deploying an updated repository file to the Siebel 
Server, refer to Siebel documentation.

Configuring the Siebel Call Center 
Application

To configure the Siebel Call Center application on the Siebel Server, you must 
be logged in as a Siebel Administrator.

This part of the configuration process includes the following procedures:

• Update the associated List of Values (LOV) table(s).
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• Create a customized Communications configuration with the Gplus Voice 
driver and profiles.

• Create agents with appropriate rights and permissions.

• For Outbound Campaign, associate campaigns with the proper employees.

• For Outbound Campaign or Voice Callback, you must manually 
synchronize the Time Zones names in Siebel and Genesys. For detailed 
instructions, see “Time Zones” on page 102 in Chapter 4.

This section explains the specific processes required to complete this 
configuration for each Voice component feature. Configuration processes 
related to a feature are listed below the heading for that feature.

Importing Lists of Values

To perform these imports:

1. Log in as Siebel administrator.

2. Open the Site Map, then navigate to Administration - Business Service, 
Simulator (in 7.5.3, Business Service Administration, Service 
Simulator).

3. Specify Genesys Tools as the Service Name, ImportAll as the Method 
Name, and set Iterations to 1.
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4. In the Input Arguments (in 7.5.3, Input Property Set) applet, click the 
Load From File button, browse for <InsDir>/OBJECTS/GenComm_LOV.xml and 
load this file as shown in Figure 20 on page 149.

Figure 20: Importing Lists of Values

5. Click Run on the Service Methods applet. Import results can be checked in 
the Output Arguments (in 7.5.3, Output Property Set) applet.

6. If only the Voice Component, but not the Multimedia Component, is 
deployed, then create a new List of Values (LOV) and populate it with 
values manually, as described below:
 In Administration Data > List of Values (in Siebel 7.5.3, Application 

Administration > List of Values), create a new LOV with the 
following parameters:
 Display Value OpenMedia
 Lang-Indep Code OpenMedia
 Lang Name English-American Parent LIC COMMON
 Order N/A (leave empty)
 Active On
 Translate On
 Replic Level All
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Creating a Customized Communications Configuration, 
Drivers, and Profiles

The Communications Configuration, drivers, and profiles are all created by 
importing data from the configuration definition file, GenComm_universal.def. 
The Gplus Adapter supplies this file, which is also called the (.def) file. It 
includes profiles and drivers (one per profile), and command and event 
definitions for: Gplus Voice and Gplus OpenMedia. 

Before importing data from the configuration definition file, the sample 
configuration parameters defined in this file must be customized to reflect your 
actual contact center configuration. Then you can import the edited 
configuration definition file. You can selectively import the following data 
from the configuration parameters file: profiles, drivers, commands, and 
events. 

The GenComm_universal.def file comes with the Gplus Adapter, and it is 
typically worthwhile to create a copy and familiarize yourself with it.

Overview

Three processes are involved in creating a configuration:

1. Editing the configuration definition file. This may include editing to create 
additional profiles for the same media type.

2. Creating the configuration record in Siebel.

3. Importing the configuration.

Each of these processes is described below.

Note: The Outbound Campaign feature uses a Siebel view that has a different 
name in Siebel versions 7.5.3 and lower than it does in version 
7.7/7.8/8.0/8.1. By default, the .def file is set up for use with Siebel 
version 7.7/7.8/8.0/8.1.
Find and modify all occurrences of that string to prepare the file for use 
with Siebel Server version 7.5.3 and lower as in the example provided 
below:
; Uncomment following line for use with Siebel version 7.5.3
; View               = "Campaign Detail"

; Uncomment following line for use with Siebel version 7.7/7.8/8.0/8.1
; View               = "Campaign Detail - Position"

Note: When the import task is completed, remove any unused profiles or 
profiles. It is important to remove unused profiles if you do not plan to 
use the full line of Gplus Components. 
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Editing the Configuration Definition File 

The configuration definition (.def) file must be edited to:

• Supply the correct values for required driver’s fields.

• Customize commands and events definitions.

• Make version-specific for the Outbound Campaign feature.

• Create additional profiles for the same Media Type (for example, a second 
Voice profile). 

Use the appropriate path to access the .def file: 

For Windows
<Voice Component folder>\Objects\GenComm_universal.def

For UNIX
<Voice Component folder>/objects/GenComm_universal.def

To modify and prepare the definition file for import:

1. Locate the appropriate definition file and open it for editing.

2. Make a copy of the definition file.

Note: Always make a copy of the definitions file in case you need to 
return to the original settings. Use the Notepad application for 
Windows, or a vi editor for UNIX. 

3. You must define the location parameters for each configuration:

a. in the [Configuration Parameters] section, define the ConnectString 
parameter as a premise switch name exactly as it is defined in Genesys 
Configuration Manager for T-Server. For example:
ConnectString = "Prem-1-G3_72"

b. in the [Driver: …] section, define the LocalConnString parameter as a 
premise switch name exactly as it is defined in Genesys Configuration 
Manager for T-Server. For example:
Driver:LocalConnString = "Prem-1-G3_72"

4. Locate and modify the following parameters for each profile:

a. Driver:TServerAppName—the T-Server application name, as it 
appears in Genesys Configuration Manager. The corresponding T-
Server should be included in the Connections section of the 
GenCommServer application in Configuration Manager. Parameters of the 
connection, such as secure connection, should be configured in the 
GenCommServer application in Configuration Manager, according to the 
Genesys 7.5 Security Deployment Guide. 

This scheme of connection to T-Server was introduced in Release 7.5. To 
keep backward compatibility with previous releases, it is allowed to leave 
this parameter unchanged, as in Driver:TServerAppName = "CHANGE_ME", or 
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to remove it from the configuration. In this case, use the previously-
allowed set of parameters shown in b. through f. below:
b. Driver:ServerHost—the host name of the machine, where T-Server is 

running (for example, myhost1). You must provide a value for this 
parameter. 

c. Driver:ServerPort—the port number for T-Server in decimal form, for 
example: 5443. You must provide a value for this parameter. 

d. Driver:BackupServerHost—the host name of the machine where the 
backup T-Server is running (for example, myhost1bk). This parameter is 
optional. 

e. Driver:BackupServerPort—the port number for the backup T-Server in 
decimal form (for example: 5445). This parameter is optional. 

f. Driver:SwitchType—numeric value, which defines the type of the 
switch. For the list of available (supported) values, see “Driver 
Parameters” on page 203. 

That approach, however, does not allow usage of new security features in 
Genesys 7.5.

5. For the Expert Contact feature, specify the following parameters:

a. Service:HasKWProtocol = TRUE.
This enables protocol support.

6. For the Outbound Campaign feature (with its OSC functionality), specify 
the following parameters:

a. Service:HasOCSProtocol = TRUE
This enables protocol support.

b. OCSEnableOutOfCampaignOperations. For more information, see 
“Transferring Outbound Calls to Agents Who Are Not in a 
Campaign” on page 169.

Note: See the table “Driver Parameters” on page 203 for information 
about other OCS driver parameters.

7. For the Universal Callback feature, specify the following parameters:

a. Service:HasVCBProtocol = TRUE
This enables protocol support.

b. Service:SwitchName = <Voice Switch Name>

c. Service:VCBDefaultRoutingPoint = <Routing Point>

d. Parameter Service:VCBProcessedOnCallRelease must be synchronized 
with the Genesys VCB Server option callback_processed on the 
appropriate <Routing Point> or VCB Server instance, if not specified 
on the <Routing Point>.

For callback_processed = TRUE, 

set VCBProcessedOnCallRelease = FALSE.
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For callback_processed = FALSE, 

set VCBProcessedOnCallRelease = TRUE.

8. If you are preparing the .def file for use with Siebel version 7.5.3 or lower 
with the Outbound Campaign feature, follow these steps:

a. Locate string SingleView = “Campaign Detail”:
[EventResponse:OnEventCurrentWorkItemChanged]

; Uncomment following line for use with Siebel version 7.5.3

;      SingleView = "Campaign Detail"

; Uncomment following line for use with Siebel version 
7.7/7.8/8.0/8.1

SingleView = "Campaign Detail - Position"

b. Make the required changes according to the Siebel version and the 
corresponding instructions in the .def file. The default state of this 
Event Response code (as shown above) is set up for Siebel version 
7.7/7.8/8.0/8.1.

c. Locate all occurrences of that string and make changes described in 
Steps a and b.

9. Save the definition file.

If you are preparing the definition file for non-English versions of Siebel 
CRM, please proceed to the text immediately below that is labeled, “For Non-
English Versions of Siebel CRM.” 

If you are not preparing the definition file for non-English versions of Siebel 
CRM, then the definition file is ready to import. 

Be aware that you can create additional .def files if you want to use additional 
profiles for the same media type.

If you are not going to create multiple Profiles for the same Media type, please 
proceed with “Creating a New Configuration Record in Siebel” on page 155. 
Otherwise, use the instructions under “Creating Additional Profiles for the 
Same Media Type” on page 154. 

For Non-English Versions of Siebel 7

If you are working with a non-English version of Siebel CRM, you must 
properly import the GenComm_universal.def file parameter’s Channel type 
values for Voice and E-mail. These names should be replaced with their 
corresponding non-English names. To change the names:

1. Locate the GenComm_universal.def file.

2. Open the file for editing.

3. Locate the string Channel type = "Voice" and Channel type = "Email".

4. Replace values "Voice" and "Email" with the same names that correspond 
to the language you use.

5. Save the file.
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The definition file supporting non-English versions is ready to import. If you 
are not going to create multiple Profiles for the same Media type, you can skip 
next section and proceed with “Creating a New Configuration Record in 
Siebel” on page 155. 

Creating Additional Profiles for the Same Media Type

To use additional profiles for the same media type, you need to prepare 
separate configurations in Siebel and corresponding .def files for those 
configurations. 

Note: The definition file includes commands and events, linked to the 
appropriate profile. As a rule, you should only group commands that 
are not associated with profiles and that are common for all drivers. 
This approach was introduced to support multiple T-Servers.

To prepare an additional .def file:

1. Important: First make a copy of the original or customized .def file. 

2. Rename the profile and driver.

3. Throughout the text of the commands and events, replace the name of the 
profile with the new name. 

4. Rename the Driver and Driver Parameters, updating the “Driver” 
parameter in the Profile with the new name.

5. Proceed with other .def file modifications, if required.

6. Save changes.

Example

The following sample fragment of a modified definition file illustrates the 
preparation of an additional new profile, “Gplus Voice B,” with the driver 
“Gplus_Voice_B”. Modified text in this example is highlighted in bold type. 
[Profile:Gplus Voice B]

   Driver            = “Gplus_Voice_B”

   Driver:ServerPort = “3620”

   Driver:ServerHost = “crmserver”

   DriverAlias       = “ ”

   MediaType          = “ ”

[Driver: Gplus_Voice_B]

…

[Driver Parameters: Gplus_Voice_B]

…

[Command:InitiateWorkGroup]

   SubCommand_0  = “MakeCallGroup”
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   SubCommand_1  = “SendGEmailGroup”

   SubCommand_2  = “SendSEmailGroup”

   SubCommand_3  = “InitiateCallbackGroup”

   Description   = “Initiate work item”

   Hidden        = “TRUE”

.[Command:MakeCallToPhone]

   FilterSpec    = “NOT [$GetCommandStatus(IsInteractionView)] = 
‘Enabled’”

   DeviceCommand = “MakeCall”
   Description   = “Make Call to “{@Phone}””

   CmdData       = “MakeCallToPhone”

   OnEditControl = “TRUE”

   Hidden        = “TRUE”

   Profile       = “Gplus Voice B”

[CmdData:MakeCallToPhone]

      RequiredField.@Phone = “?*”

      Param.PhoneNumber    = “{@Phone:PhoneTypeLookup}”

      Param.CallNotifyText = “Call from {@UserName}...”

.[EventHandler:CallRinging]

   Comments    = “Handles ringing call event”

   Order       = “3”

   DeviceEvent = “EventRinging”

   Profile     = “Gplus Voice B”

Creating a New Configuration Record in Siebel

To create a new configuration record: 

1. Select Site Map > Administration - Communications > All 
Configurations. 

A list of the existing configurations displays. 

2. Click New to create a new configuration.

3. Enter a name for the new configuration, for example, Lucent 
Configuration. 

4. Click Save.

Importing a Configuration

Note: Before importing configuration, check “Advanced Customization of 
Voice Component Configurations” on page 164 for possible additional 
configuration to support desired functionality.
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To import a new configuration:

1. Select a configuration record you have created, for example Lucent 
Configuration.

2. Click the Import Configuration button.

3. Click Next.

4. In the Next window, define the configuration file that you want to import, 
and select one or more of the four data parts. Your selection depends on 
your requirements. Select all for an initial import.
 drivers & profiles
 commands
 events
 configuration parameters

5. Use the Browse button to select the Gplus Adapter configuration file: 
GenComm_universal.def, or a customized version of it.

6. Click OK to start importing.

When the import task is completed, remove any unused profiles or profiles 
with insufficient connection information. It is important to remove unused 
profiles if you do not plan to use the full line of Gplus Components. 

Example: Removing Unused Profiles in the Voice-only Lucent Configuration

For example if you are using a Voice-only configuration, then the Gplus 
OpenMedia profile should be removed from the sample configuration named 
Lucent Configuration. 

Before changing the .def file, always create and keep a backup copy. 

To remove unused profiles and drivers:

1. Select Site Map > Administration - Communications > All Configurations. 
A list of the existing configurations displays. 

2. Select the Lucent Configuration record.

3. Switch to the Profiles tab.

4. Remove the unused profile in our Lucent configuration example: Gplus 
OpenMedia.

After this operation, the Gplus Voice profile will be the only remaining profile 
in the Lucent Configuration.

During the import operation, new driver(s) and profile(s) were created. Also, 
profile(s) are automatically linked to the appropriate driver(s). Next, add 
agents to the Configuration and make adjustments to communication specific 
settings.

After importing the configuration, add agents to the Configuration and make 
adjustments to communication specific settings.
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Connection to T-Server

Connection to the T-Server can be defined in two different ways:

• T-Server connection using the Connections tab of the Gplus 
Communication Server. Siebel configuration refers to this connection via 
the Driver:TServerAppName parameter. In this case it is possible to define 
advanced connection parameters, such as security. 

• T-Server connection using the Siebel configuration from pre-7.5 
versions of the Adapter. If the Driver:TServerAppName parameter was not 
defined in the Siebel configuration, or if its value is CHANGE_ME, then all 
connection parameters are taken from the Siebel configuration as they 
were in pre-7.5 versions of the Adapter. In this case security settings can 
not be defined.

Connection to T-Server Defined in Genesys 
Configuration Manager

In this configuration, connection to the T-Server object should be added to the 
list of Gplus Communication Server connections, and in the Siebel 
configuration, the Driver:TServerAppName parameter should be configured to 
specify the T-Server application name of the primary T-Server exactly as it is 
configured in Configuration Manager. If the value of the TServerAppName 
parameter is defined in the Siebel configuration, the Adapter searches 
connection parameters in Configuration Manager and uses these parameters to 
establish connection with the T-Server. If this connection is found here, then T-
Server connection parameters (including advanced parameters) will be taken 
from Configuration Manager, and the parameter AdapterAppName will be 
ignored (the Gplus Communication Server application name will be used 
instead).

Also, the switch type will be taken from the T-Server application object. If 
connection to the related T-Server is not found in the Connections tab of the 
Gplus Communication Server Application Object, the Adapter will not open a 
connection to the T-Server. Configuration of the Gplus Communication Server 
Application Object must be corrected in Configuration Manager to define the 
connection to the related T-Server.

Using this method, it is possible to define a secure connection between the 
Adapter and T-Server. If secure connection is defined, the Adapter and T-
Server will use Transport Layer Security (TLS) when exchanging data. For 
details on configuration of security in Genesys, please refer to the Genesys 
Security Deployment Guide.
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Connection to T-Server Defined in the Siebel 
Configuration

In this configuration, the Driver:TServerAppName parameter is not defined in 
the Siebel configuration, or has the value CHANGE_ME. All connection parameters 
are taken from the Siebel configuration as they were in pre-7.5 versions of the 
Adapter. Secure connection can not be defined using this method.

Agent Administration

This section explains the processes involved in creating agents and agent-
related records.

Before starting to work with the Gplus Voice Adapter, you must create Agents, 
Groups of Agents, Positions, Telesets, and Queues. By creating Positions, 
Telesets, and Queues, you create the data structures that support agents. If you 
are using the Outbound Campaign feature, agents should be associated with 
Voice queues, and newly created campaigns should be associated with agent 
groups. For more information on agents, campaigns, and groups, see the Siebel 
documentation.

Creating Positions

To create a new position:

1. Select Site Map > Groups Administration > Positions.

2. Click New on the Positions applet.

3. Specify the following parameters for the new record:
 Division: select Default Organization
 Position: Telemarketing

4. Save the record.

Adding ACD Queues

An agent should be associated with an ACD queue, which is configured for 
operations with Outbound Contact Server (OCS). 

To create an ACD queue:

1. Navigate to the List of Values table, using one of the following options:
 For Siebel versions 7.5.3 and lower, select Site Map > Application 

Administration > LOV Explorer

 For Siebel version 7.7/7.8/8.0/8.1, select Site Map > Administration-
Data > LOV Explorer

2. For each ACD queue in your call center you must add a new item from the 
list of items. Select the Item Type CTI_ACD_QUEUES.
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3. Provide the following information for this item:
 For both Display Value and Language Independent, include the Queue 

DN number.
 For the language, select English-American (for other languages, see 

Siebel documentation).

Creating Telesets

A Teleset is a set of DNs that represent a single workplace. 

To create telesets:

1. In the Siebel Site Map, navigate to All Telesets.
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 

Communications> All Telesets.
 For earlier versions of Siebel, select Site Map > Communications 

Administration > All Telesets.

2. For each teleset, provide the following information:

a. Create a new Teleset in the Telesets list.

b. Add your agents’ extensions.

3. Give the teleset a unique name. For example, you may want to name the 
teleset based on the cubicle number or the location of the teleset.

4. Select the Extensions tab.

5. Add all the teleset DNs in the list (one or more DNs). For each DN you 
must define the DN type:

S—Standard DN

A—ACD Position

6. Follow Steps 2 to 5 above for each teleset.

Note: If a teleset has only ACD position DNs, then you must configure in 
Siebel at least one of these DNs as a DN of type S.

Creating Agents

To create an agent, you must re-define an existing employee (as defined in 
Siebel) to function as an Agent with the Gplus Adapter. 

To be an agent, the employee must:

• Have a proper responsibility and position

• Be associated with a relevant profile.

• For Outbound Voice and Voice Callback configurations, it is essential to 
specify the proper Time Zone.

To assign an employee to a proper responsibility and position:
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1. Select Site Map > Users Administration > Employees.

2. Select an employee who is supposed to function as an agent with respect to 
the Adapter. 

3. Specify the following parameters for the employee record:
 Responsibility: 

 Click on the field.
 Click Add new from the drop-down menu.
 Select Universal Agent.
 Click OK.
 Click OK to return to the main screen.

 Position: 
 Click the field.
 Click New from the drop-down menu.
 Browse to Telemarketing position.
 Click OK.
 Mark the position as Primary.
 Click OK to return to main screen.

 Time Zone: 
 Click the field.
 Browse to desired Time Zone.
 Click OK.

4. Save the record.

Associating Agents with the Communications Profile 
and Genesys Settings

To associate agents with an existing Communications profile:

1. In the Siebel Site Map, navigate to All Configurations.
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 

Communications> All Configurations.
 For earlier versions of Siebel, select Site Map > Communications 

Administration > All Configurations.

2. On the Configurations applet locate the Gplus Outbound Contact 
configuration.

3. Click the applet to make it active.

4. Select the Agents tab.

5. Click New.

6. On the Add Agents screen, browse to and select an agent.

7. Click OK to add the agent into the profile.

8. Save the agent’s record.
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9. Select the agent’s record from Communications Administration (in Siebel 
7.7/7.8/8.0/8.1, Administration - Communications) > Agent General 
Profile.

10. Specify the following values for the record:
 Agent Login: Agent login ID into ACD/PBX from Genesys 
 Password: Agent login password into ACD/PBX

11. Save the record.

12. Select the Telesets tab.

13. Click New.

14. Navigate to a particular Teleset on the Add Teleset drop-down menu. (The 
Teleset value should match the one specified in Genesys.)

15. Select the teleset to make it active and click OK.

16. Optional step: To select ACD queues for agent:
 Select the ACD Queues tab.
 For each agent add zero or more ACD Queues for the agent to log into.
 Select the ACD queue configured for operation in Genesys, and mark 

the queue as Primary.

17. Save the record.

Creating Campaigns and Associating Agents with 
Campaigns (“campaign agents”)

The instruction in this section are required only if you use the Outbound 
Campaign feature. To create a campaign and associate agents with a campaign, 
follow the appropriate steps based on the version of Siebel you use. Sometimes 
this step is called creating a “campaign agent”.

If You Use Siebel 7.5.3

1. Select Site Map > Campaign Administration > All Campaigns Across 
Organization.

2. Click New on the Campaigns applet.

3. Specify the following value for the new record:
Name: Gplus Outbound Campaign

4. Click the Team field.

5. On the Team Members drop-down menu, click New.

6. Save the record.

7. Select the Team tab.

8. Click New.
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9. On the Add Employees drop-down menu, select the Telemarketing 
position.

10. Click OK.

11. Select the Primary field.

If You Use Siebel 7.7/7.8/8.0/8.1

Add “Campaign Agent” responsibility to the list of Employee responsibilities. 
To assign an employee to a proper responsibility: 

1. Select Site Map > Administration Users > Employees. 

2. Select an employee who is supposed to function as a Campaign agent with 
respect to the Adapter.

3. Click the field Responsibility. 

4. On the left side of the pop-up window, select Campaign Agent. 

5. Click Add. 

6. Click OK to return to the main screen. 

For further information on how to create campaign’s Contacts/Prospects and 
synchronize this data with Genesys Outbound Contact, see Chapter 4, 
“Configuration and Installation of the Campaign Synchronization 
Component,” on page 83 of this document. Refer also to the Siebel 
documentation.

Using Genesys Framework to Synchronize Agent Information

After you have created Agents in the Siebel Call Center application and agent 
information has appeared in Genesys Framework, check the corresponding 
Persons properties in Genesys Framework. If necessary, use Genesys 
Framework to make corrections.

For every Employee (Agent) configured in Siebel to work with the Voice 
component of the Adapter, there must be in the Genesys configuration an 
equivalent Person with the same Agent Login. The Genesys Configuration 
Synchronization component of the Adapter should automatically perform this 
synchronization. 

If the Configuration Synchronization Adapter is not deployed, you must 
manually duplicate Siebel's agents and places (telesets) in Genesys 
configuration.

After creating Persons and Places in the Genesys environment, automatically 
or manually, check the Persons properties in Genesys Framework to verify that 
the corresponding configuration is correct. 

The default place must be defined for newly created Persons.
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Assigning a Default Place to a Person

If no default places are assigned for an agent, you must perform this step 
manually. 

To assign a default Place to a person:

1. In Configuration Manager, select Environment > Tenant > Persons.

2. Click Persons.

3. Right-click a specific Person and select Properties from the drop-down 
menu.

The Properties dialog box displays.

4. Select the Agent Info tab.

5. Locate the Default Place drop-down menu.

6. Click Browse.

7. Click Places and select the appropriate place for the Person.

8. Click OK to add the Place.

9. Click Apply to submit changes.

10. Click OK to close the Properties dialog box.

11. Repeat steps 3–10 for all agents.

Outbound Campaign Agent Configuration

There are additional requirements for Agents working with the Outbound 
Campaign functionality. Agents must be assigned to the Agent Group 
configured to work with Outbound Contact Server (OCS), which is associated 
with the Outbound Campaign feature. If an agent is not assigned to a group, 
you should manually perform this task, as explained below. 

Assigning an Agent Group

To assign agents to a group:

1. In Configuration Manager, select Environment > Tenant > Agent Groups.

2. Right-click a particular Agent Group configured to work with OCS and 
from the drop-down menu, select New > Shortcut to access an agent.

3. Go to the agent entry on which you are working.

4. Click OK to add the agent.

5. Repeat Steps 2–4 for all agents that must be configured to work with OCS.

You have completed the configuration and installation of the Outbound 
Campaign feature of the Gplus Adapter 7.5 for Siebel CRM.

The configuration steps mentioned above are related to the synchronization of 
information between Siebel and Genesys. For more detailed information about 
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the configuration of Genesys Outbound Contact Server product, refer to 
Genesys’ Outbound Contact documentation. 

Universal Callback Agent Configuration

All agents working with Universal Callback must be assigned to an Agent 
group configured to work with the Universal Callback server. If an agent is not 
assigned to a group, you should manually perform this step. 

To assign agents to a group: 

1. In Configuration Manager, select Environment > Tenant > Agent Groups.

2. Right-click a particular Agent Group configured to work with Universal 
Callback and from the drop-down menu, select New > Shortcut to access an 
Agent.

3. Navigate to the agent entry with which you are working.

4. Click OK to add the agent.

5. Repeat Steps 2–4 for all agents that must be configured to work with 
Universal Callback.

You have competed the configuration and installation of the Universal 
Callback configuration of the Gplus Voice Component for Siebel CRM.

Advanced Customization of Voice 
Component Configurations

This section provide information and instructions for advanced customization 
of the Adapter.

This section includes information under the following headings:

• “Activity Creation”

• “Voice Component Common Configuration Information”

• “Customizations for Basic Voice”

• “Customizations for Expert Contact”

• “Customizations Involving Universal Callback”

• “Customizations Involving Outbound Campaign or OCS”
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Note: Before attempting to make any modification or customization, review 
the basic deployment procedures for information that may apply to the 
kind of changes you are making. For example, if your modification 
requires changes to the configuration (.def) file, refer to “Editing the 
Configuration Definition File” on page 151. The information in this 
section assumes that you understand the context of the implementation 
procedures and any associated requirements or constraints that apply.

Activity Creation

Each incoming and outgoing interaction initiates an activity creation in the 
Siebel application and creates a new work item on the Communications (CTI) 
Toolbar.

Many customization projects involve working with activities.

Activity creation and handling logic are implemented in the Siebel .def file 
using standard methods. See the Siebel Communications Server Administrator 
Guide for more information on this topic. 

Warning! Activity creation affects performance. If you are not using Activity 
records, remove the activity creation code from event handlers. 

Basic Voice Feature Activity Creation

Activity records for inbound and outbound calls are created on 
EventEstablished. Activity Creation is handled by the 
EventHandler:OutboundCallReceived for outbound calls and by the 
EventHandler:InboundCallReceived for inbound calls. Log creation logic and 
the set of information fields used are defined in the appropriate Event 
Response; post call release actions are defined in the same Event Response in 
the AfterWork elements.

For an inbound call, the InboundCallReceived event handler creates an activity 
for an Inbound call on EventEstablished and displays contact information on 
the agent’s dashboard. The event handler queries the Contact Business 
Component and depending on the number of rows returned by the Query 
specification ‘Work Phone #’ LIKE ‘*{OtherDN}’ depending on the 
specification, and executes three different log handlers; one each for Multiple 
contacts, Single contact, and No contacts found.

For an outbound call, the OutboundCallReceived event handler creates an 
activity on EventEstablished and displays contact information on the agent’s 
dashboard. The handler queries the Contact Business Component and 
depending on the number of rows returned, it executes three different log 
handlers; one each for Multiple contacts, Single contact and No contacts 
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found. If you want to enable the Contact popup screen, uncomment the Display 
= “true” option.

Expert Contact Feature Activity Creation

Activity record creation scenarios are different, depending upon whether the 
CTI-Less T-Server Preview-interaction option is turned on or off, as explained 
below.

If Preview-interaction mode is OFF:
Activity records for inbound and outbound calls are created in the same 
manner as for the Basic Voice feature. See“Basic Voice Feature Activity 
Creation” on page 165.

If Preview-interaction mode is ON:
An Activity record is created on event EventKwPreviewIntRequest with status 
“Requested”. An established call reuses the same WorkItem on the 
Communication Toolbar and the same activity record. Log creation logic and 
the set of information fields used are defined in the associated Event Response; 
OnEventKwPreviewIntRequest, post call release actions are defined in the 
same Event Response in the AfterWork elements. 

Table 11 shows the name of the event handlers and their status in activity 
creation.

Outbound Campaign Feature Activity Creation

Activity records are created for all incoming Outbound Contact Server 
interactions. Activity creation logic for Preview records and Scheduled calls 
are defined in the Event response “OnOCSRecord”. Activity creation logic for 
Predictive and Progressive calling modes is implemented in the event response 
“OnPredictOCSRecord” and the event handler

[EventHandler:OutboundOCSCallEstablished].

Event handler [EventHandler:PreviewOCSCallEstablished] prevents 
duplicating activity creation for Preview calls.

Currently, Preview records (as well as Scheduled calls, and Predictive calls) 
are incoming interactions and they create their own activity record. 

Table 11: Event Handlers and Their Status in Activity Creation

Event Handler Status in Activity

EventKwPreviewIntRequest Requested

All WorkItem releasing events. See Basic Voice 
section for more information.

Done
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Depending on an agent’s response, the appropriate status is set in the activity 
record. Table 12 shows the name of the event handlers and their status in 
activity creation.

Universal Callback Feature Activity Creation

The EventCallBackRequest event handler creates an activity for Callback 
requests on EventCallBackRequest and displays contact information on the 
agent's dashboard. The handler queries the Contact Business Component and, 
depending on the number of rows returned, executes three different Log 
handlers; one each for Multiple contacts, Single contact, and No contacts 
found.

Also, the event handlers shown in Table 13 update activity records (created in 
[EventHandler:EventCallBackRequest]) and must be commented out or 
removed from the code if you want to disable activity creation for the 
CallBackRequest.

Table 12: Event Handlers and Their Status in Activity Creation

Event Handler Status in Activity

EventPreviewRecord

EventScheduledCall

EventEstablished (for Predictive and Progressive 
Dialing modes)

EventUpdCallComplStatsAck

In Progress

EventRecordRescheduleAck Scheduled

EventDoNotCallAck

EventRecordRejectAck

Declined

EventRecordCancelAck

EventRecordCancel

EventRecordRemove

Canceled

EventRecordProcessedAck Done

EventReleased Unassigned
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Table 13 shows a list of supported event handlers and the status that they set.

Modifying the Definition File and Related Performance 
Issues

Creating activity records affects overall Siebel Server performance. Genesys 
recommends that you review the requirements for activity records creation 
during the implementation phase. Make sure to comment or remove code that 
you are not using from the GenComm_universal.def file. 

For your convenience, activity creation code is marked as follows:

Start:
Lines below are activity creation code <<<<<<<<<<<<<<<<<<<<<<<<<<<<<

End:
Lines above are activity creation code >>>>>>>>>>>>>>>>>>>>>>>>>>>>>

When you query the Campaign Business Component for Smart Script, 
performance is also affected. If you are not using Smart Script, the following 
code, related to Smart Script handling must be commented out or removed 
from the GenComm_universal.def file. 

For your convenience, Smart Script related code is marked as follows:
Start:

; Lines below are Smart Script related code <<<<<<<<<<<<<<<<<<<<<<<<<<

End:

; Lines above are Smart Script related code >>>>>>>>>>>>>>>>>>>>>>>>>>

Table 13: Supported Event Handlers for Universal Callback

Event Handler Status

EventCallBackRequest Requested

EventCallBackAccepted In-Progress

EventCallBackRejected Declined

EventCallBackCancel Canceled

EventCallBackDone Done

EventVCBPreview Requested

EventAddVCBRequest Scheduled

EventVCBReject Declined

EventVCBCancel Canceled

EventVCBProcessed Done
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Transfer Functionality

The transfer functionality for agent-to-agent transfers using Outbound Contact 
Server (OCS) is described below.

• Only two-step and blind (mute transfers) are allowed from agent-to- agent. 
Genesys recommends that when making agent-to-agent transfers, the first 
agent make a consult call to the second agent before making a transfer. If 
the agent receiving the transfer has a current call and record on his-her 
desktop, the transfer may not be successful.

• User data should be attached to a call after the agent completes a transfer.

• Call transfer is correct to and from agents and to agents logged into a 
loaded or active campaign group. Also, by setting the option 
OCSEnableOutOfCampaignOperations you can transfer to agents not 
participating in the campaign. This option requires that you use Outbound 
Contact 7.x.

• Genesys recommends that the number of transferred outbound calls not 
exceed 5 to 10 percent of all outbound calls.

Because of the constraints imposed by CTI-Less T-Server, the transfer 
functionality for the Expert Contact feature is limited by the following 
restrictions:

• Blind transfer is supported only as external reroute to the GenSpec 
Network T-Server.

• Two step transfers work for both internal CTI-Less T-Server operations 
and for external transfers between CTI-Less T-Servers. 

• Maximum number of active calls is 2.

Transferring Outbound Calls to Agents Who Are Not in 
a Campaign

The Gplus Adapter supports Outbound Preview, Predictive, and Progressive 
campaign transfer calls to agents not participating in an active campaign. This 
feature requires Genesys Outbound Contact version 7.x. To enable support for 
transfers to these agents, set the option OCSEnableOutOfCampaignOperations 
= “True.” To disable support for such transfers, set the option 
OCSEnableOutOfCampaignOperations to “False.” When this option is 
enabled, an agent who is not in the campaign can do the following:

• reschedule record as a campaign callback

• set a new Call Status

• update Number of Attempts

• request chain

• cancel record
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• mark contact Do Not Call

• process records 

Voice Component Common Configuration Information

This section describes configuration information that applies to all Voice 
Component features. 

Switch-Specific Configuration Instructions

You must make the following configuration changes for the Alcatel A4400 
switch, the Nortel DMS-100 switch and the Rockwell Spectrum switch.

Alcatel A4400

The Adapter supports the operation of the Alcatel 4400 T-Server and switch 
with the Agent Substitute feature set to either: 

• on or true

• off or false

In either of these two modes, the set of DNs for the agent Teleset in the 
configuration must define:

• Extension DN, type S (Standard DN)

• ACD position, type A

When you use the Agent Substitute feature set to on or true, you must define 
two parameters in the Gplus Adapter 7.5 for Siebel CRM configuration:
Service:AgentSubstitute = “TRUE”

Service:ACDDNList = “{@ACDDNList }”

If you use the Agent Substitute Feature set to off or false, you must define the 
following values for two parameters:
Service:AgentSubstitute = “False”

Service:ACDDNList = “{@AgentID}”

Nortel DMS-100

In order to allow agents to make outbound calls using the Siebel 
Communications Toolbar, the Nortel DMS-100 switch must be configured to 
make outbound calls from both ACD positions and extensions.

Nortel Symposium and Nortel Meridian

When using the Nortel Symposium or the Nortel Meridian switch, the T-Server 
option, nrdy-after-login, must be set in accordance with your switch 
configuration, otherwise T-Server will not send the right notifications to its 
clients regarding the Ready/NotReady state of agents.
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Communication DN

The Communication DN is used to send a user event and broadcast a user 
event.

Sending User Events via a Communication DN

The Siebel CRM configuration for Gplus Adapter can define a special DN, 
which is called a Communication DN. Third-party applications (for example, 
T-Server clients) can communicate with the Gplus Adapter using this 
Communication DN to send user events with attached user data to all agents 
currently logged in to the Adapter. Third-party applications are defined as any 
client application other than the Gplus Voice Component.

The Communication DN is configured in Siebel by defining the following 
Communications Driver parameter:
Driver:CommunicationDN <DN>

The value of this parameter must be a DN that is configured in Configuration 
Server as a Communication DN for the same T-Server and switch.

Based on this configuration, whenever any third-party application registered to 
the CommunicationDN sends a user event with attached user data to this 
CommunicationDN, T-Server will distribute this user event (with the same 
attached user data). The user event appears on the Communication DN to all 
Siebel CRM agent desktops (see Figure 21 on page 172). The user event is 
then received in Siebel if the corresponding event handler with the device 
event, EventUserEvent is defined in the Siebel Communications 
Configuration.

In this configuration, an EventUserEvent is distributed by T-Server to all 
Siebel CRM Agent desktops that have the same Communication DN 
configuration as the third-party application. Figure 21 on page 172 shows the 
data flow for this configuration.
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Figure 21: Data Flow of User Event Sent via a Communication DN

Broadcasting User Events via a Communication DN

You can generate an EventUserEvent (there is a command 
SendUserEventToCommDN in Gplus Adapter and you can define additional 
parameters with this command) with the Voice Component and broadcast it to 
both third-party applications as well as all agents logged in to the Siebel CRM 
Gplus Voice Component with the same Communication DN configuration. See 
Figure 22 on page 173 for the data flow of broadcasting user events.

Third-Party
Client

Communication DN

Siebel 7
Agent 1
Client

Siebel 7
Agent 2
Client

Siebel 7
Agent N
Client

User Event
with Attribute

UserData

EventUserEvent
UserData

UserData

EventUserEvent

EventU
serE

ve
nt

Use
rD

ata



Gplus Adapter for Siebel CRM—Deployment Guide 173

Chapter 5: Configuration and Installation of the Voice Component Advanced Customization of Voice Component 

Figure 22: Data Flow for Broadcasting a User Event via a 
Communication DN

To make this feature available, you must configure the Communication DN 
and set the driver parameter BroadcastCommdnUserEvents2Agents to True:
Driver:BroadcastCommdnUserEvents2Agents = “TRUE”

Siebel can send this user event with attached user data with the command:
SendUserEventToCommDN

This command is defined in the sample GenComm_universal.def file shown on 
“Editing the Configuration Definition File” on page 151. If the 
BroadcastCommdnUserEvents2Agents is not defined or if its value is False, then 
EventUserEvent will be delivered by T-Server to third-party applications only, 
see Figure 23 on page 174.
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Figure 23: Data Flow for Broadcasting User Events to Third-Party 
Applications Only

After you configure the Communication DN and set 
BroadcastCommdnUserEvents2Agents to True, then you must define the driver 
command in Siebel CRM that is associated with the SendUserEventOnCommDN 
device command. The file GenComm_universal.def contains a sample of the 
configuration command SendUserEventToCommDN.

The SendUserEventOnCommDN device command is used in the 
GenComm_universal.def to define [Command:SendUserEventToCommDN] and the 
corresponding [CmdData:ConnDataForSendUserEventToCommDN].

The device command must be defined in order to distribute EventUserEvent 
with user data to the Communication DN. For example, in the 
GenComm_universal.def file, the Siebel CRM command 
[Command:SendUserEventToCommDN] is configured to invoke the adapter device 
command SendUserEventOnCommDN with the attached user data key-value list:
AdditionParam1/This is Param1

AdditionParam2/This is Param2

In the GenComm.def file this configuration is shown below:
[Command:SendUserEventToCommDN]
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Description = “Send UserData To Comm DN”

DeviceCommand = “SendUserEventOnCommDN”

Hidden = “true”

Profile = “ ”

Comments = “ ”

CmdData = “ConnDataForSendUserEventToCommDN”

[CmdData:ConnDataForSendUserEventToCommDN]

Param.AdditionParam1 = “This is Param1”

Param.AdditionParam2 = “This is Param2”

Comments = “ ”

When you import the above definitions into the configuration, Siebel can use 
the command SendUserEventToCommDN to deliver EventUserEvent (with 
Attached user data as the key-value pair AdditionParam1/This is Param1, 
AdditionParam2/This is Param2) to other applications that have been 
registered to receive the same Communication DN events.

AttributeExtensions Parameter

The AttributeExtensions parameter allows you to send an 
AttributeExtensions with a request to T-Server. In this scenario, you define 
the AttributeExtensions parameter in the Command Data (in Siebel 
configuration). To define this parameter, two additional parameters must be 
defined as shown in Table 14.

The following describes how you can define the command MakeCallToPhone 
with the AttributeExtensions parameter in the 
.def file. 

[Command:MakeCallToPhone]

   DeviceCommand = “MakeCall”

   Description   = “Make Call to “{@Phone}””

   CmdData       = “MakeCallToPhone”

   OnControl = “TRUE”

   Hidden        = “TRUE”

Table 14: Additional Parameters for AttributeExtensions 
Parameter

Parameter Value

AttributeExtensions <NameOfAttributeExtensionsValue>

NameOfAttributeExtensionsValue <ValueOfExtension> where the value 
of the extension is a number
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   [CmdData:MakeCallToPhone]

      AttachContext= “TRUE”

      RequiredField.@Phone= “?*”

      Param.PhoneNumber= “{@Phone}”

      Param.CallNotifyText= “Call from {@UserName}...”

      Param.AttributeExtensions           = “GCTI_PARAMETER”

      Param.GCTI_PARAMETER= “111”

In this example, Param.AttributeExtensions parameter defines the name of the 
key-value pair GCTI_PARAMETER, and Param.GCTI_PARAMETER defines the 
value of the key-value pair “111”.

As a result, whenever Siebel calls the command MakeCallToPhone, the Adapter 
will send the request to T-Server with the AttributeExtensions key-value pair:

GCTI_PARAMETER/111.

Attribute Extensions of Type String and/or Integer

The Gplus Adapter can send Attribute Extensions with multiple extensions, 
using values of type string and/or integer in requests to T-Server. 

Attribute Extensions of Type String

To send Attribute Extensions with multiple extensions, using values of type 
string, Siebel configuration must use command data with the parameter 
StringAttributeExtensions, and its associated parameters. 

The parameter StringAttributeExtensions defines the list of parameters which 
are used as extensions in requests to T-Server. The names and values of the 
associated parameters are used as keys and values of the extensions included in 
the requests to T-Server. If a parameter that is included in the 
StringAttributeExtensions list does not exist, this parameter will be ignored 
by the Adapter.

In the StringAttributeExtensions list, you should separate each parameter by 
a comma, “,” and optional spaces (that is, spaces or tabs). For example:
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[CmdData:CmdDataExample]

Param.StringAttributeExtensions = "str1 , Str2 ,String3,string4"

Param.str1 = "String_str1"

Param.Str2 = "String_Str2"

Param.String3 = "String_String3"

Param.string4= "String_String4"

The following example shows a command that includes the ReasonCode 
extension with the string value 7623 in the Attribute Extensions of a request to 
T-Server:

; ////////////Not Ready command

[Command:NotReadyForGVoice]

FilterSpec = "[$GetCommandStatus(NotReady)] = 'Enabled'"

Hidden = "TRUE"

DeviceCommand = "NotReady"

Description = "Set not ready for Voice"

Profile = "Gplus Voice"

CmdData = "NotReadyWithReasonCode"

[CmdData: NotReadyWithReasonCode]

Param.ReasonCode = "7623"

Param.StringAttributeExtensions = "ReasonCode"

Attribute Extensions of Type Integer

Multiple Attribute Extensions with values of type integer in requests to T-
Server can be sent in the same way. Siebel configuration must use command 
data with the parameter IntAttributeExtensions, and its associated 
parameters.

The parameter IntAttributeExtensions defines the list of parameters which 
are used as extensions in requests to T-Server. The names and values of the 
associated parameters are used as keys and values of the extensions included in 
the requests to T-Server. If a parameter that is included in the 
IntAttributeExtensions list does not exist, then default value -1 is used.

In the IntAttributeExtensions list, you should separate each parameter by a 
comma, “,” and optional spaces (that is, spaces or tabs). For example:

; ////////////SendDTM command

[Command:SendDTMFComm]

   DeviceCommand = "SendDTMF"

; "Description" is provided by driver
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   CmdData       = "DTMFData"

   Hidden        = "TRUE"

   Profile       = "Gplus Voice"

   CmdChannelOnFocus = "TRUE"

[CmdData:DTMFData]

      Param.Digits    = "12345"

      Param.AttributeExtensions = "GCTI_SendDTMF"

      Param.GCTI_SendDTMF= "111"

      Param.IntAttributeExtensions = "ToneDuration , Int2,PauseDuration "

      Param.ToneDuration = "12"

      Param.Int2 = "222"

      Param.PauseDuration = "8"

The length of the StringAttributeExtensions or IntAttributeExtensions 
parameter is defined by the length of the Siebel field Param.* and can be a 
maximum of 251 characters. The number of associated parameters in the list 
cannot be more than 40. The rest of the parameters will be ignored.

Both types of AttributeExtension can be mixed in the same request. The earlier 
approach to define Attribute Extension for the single integer value was kept 
(see the description of “AttributeExtensions Parameter” on page 175). It can be 
used for backward compatibility (please see Param.AttributeExtensions and 
the corresponding Param.GCTI_SendDTMF in the example below).

In addition to this, two parameters in a command data define the names of 
integer and string extensions which are going to be included as Attribute 
Extensions in the request to T-Server. For example:

[Command:SendDTMFComm]

   DeviceCommand = "SendDTMF"

; "Description" is provided by driver

   CmdData       = "DTMFData"

   Hidden        = "TRUE"

   Profile       = "Gplus Voice"

   CmdChannelOnFocus = "TRUE"

[CmdData:DTMFData]

      Param.Digits    = "12345"

      Param.AttributeExtensions = "GCTI_SendDTMF"

      Param.GCTI_SendDTMF= "111"

      Param.IntAttributeExtensions = "ToneDuration , Int2 ,PauseDuration "

      Param.ToneDuration = "12"

      Param.Int2 = "222"

      Param.PauseDuration = "8"

      Param.StringAttributeExtensions = "str1 , Str2 ,String3,String4"

      Param.str1 = "String_str1"
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      Param.Str2 = "String_Str2"

      Param.String3 = "String_String3"

      Param.String4 = "String_String4" 

Another Method to Define Attribute Extensions of Type 
String and/or Integer

Where requests to T-Server could be sent with attached UserData, 
AttributeReasons or AttributeExtensions, the Gplus Adapter is able to attach 
integer and/or string type values in these parameters when invoking the 
corresponding Device Commands.

These parameters are defined in a [CmdData:…] section of the corresponding 
DeviceCommand. 

The names of parameters that must be included as AttributeReasons are 
provided by the parameter Reasons. For example: 
Param.Reasons = "reason_i1, reason_str1,reasons_i2" 

The names of parameters that must be included as AttributeExtensions are 
provided by the parameter Extensions. For example: 
Param.Extensions = "Int2, Str4, Str1, reason_i1"

The way to define integer or string values with Param.IntAttributeExtensions 
and Param.StringAttributeExtensions described earlier in this section can also 
be used to define AttributeExtensions. 

The rest of the CmdData parameters with prefix Param are treated as attached 
UserData.

How to Differentiate Integer Values from String

The backslash symbol (“\”) in first position of the parameter value is used as 
mark of integer value. Any other symbol in first position means that this is a 
string. If the string needs to have a backslash in its first position, then use a 
double backslash, such as \\StringValue.

If the value of a parameter defined in a Command Data with Param.* begins 
with a single “\” (backslash), then this value will be treated as an integer. A 
single backslash is considered as a string and its value will be single backslash 
("\").

In the following examples:
Param.res-Bslash  = "\" in [CmdData:NotReadyWithPopup]

will be included in AttributeReasons as the string res-Bslash      \ .
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If the value of a parameter is defined by ”\” as an integer type, but cannot be 
converted to an integer value, then the parameter value will be zero (0). For 
example:
Param.reasons_i2 = "\i453" 

will have the value 0.

[Command:MakeCallToPhone]

   Description   = "Make Call to "{@Phone}""

DeviceCommand = "MakeCall"
FilterSpec    = "NOT [$GetCommandStatus(IsInteractionView)] = 'Enabled'"

   Hidden        = "TRUE"

   OnEditControl = "TRUE"

   Comments      = ""

   Profile       = "GPlus Voice"

   CmdData       = "MakeCallToPhone"

[CmdData:MakeCallToPhone]

      Param.CallNotifyText            = "Call from {@UserName}..."

      Param.Extensions                = "Int2, Str4, Str1, reason_i1"

      Param.Int1                      = "\9832"

      Param.Int2                      = "\12678"
      Param.IntAttributeExtensions = "Int1, Int2,Str1,  reasons_i2,   Str4"

Param.PhoneNumber               = "{@Phone:PhoneTypeLookup}"
      Param.Reasons                   = "reason_i1, reason_str1,reasons_i2"

      Param.Str1                      = "\\Str With 1 backslash"

      Param.Str2                      = "_Without Backslashes"

      Param.Str4                      = "\\OneMoreBack"

      Param.StringAttributeExtensions = "Int1,Int2,Str1"

      Param.reason_i1                 = "\8645"

      Param.reason_str1               = "qwerty"

      Param.reasons_i2                = "\i453"

      Param.str3                      = "again w\ithout"

      RequiredField.@Phone            = "?*"

      Comments                        = ""

[Command:NotReadyForGVoiceGroup]

   Description   = "Set not ready for Voice"

   DeviceCommand = "NotReady"

   FilterSpec    = "[$GetCommandStatus(NotReady)] = 'Enabled'"

   Hidden        = "TRUE"

   Comments      = ""

   Profile       = "GPlus Voice "
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   CmdData       = "NotReadyWithPopup"

[CmdData:NotReadyWithPopup]

      Param.ReasonCode  = "[Name]"

      Param.ReasonValue = "[Value]"
      Param.Reasons     = "Res1_int, Res3_str,   Res2_str,res-Bslash,   res5"

      Param.Res1_int    = "\1237"

      Param.Res2_str    = "//r2_str"

      Param.Res3_str    = "r3_str"

      Param.res-Bslash  = "\"

      Param.res5        = "\\with\\baslash"

      SelectApplet      = "Value Type Pick Applet"

      SelectBusComp     = "List Of Values"

      SelectBusObj      = "List Of Values"

      SelectParam       = "TRUE"

      SelectQuerySpec   = "[Type] = 'REASON_CODE' AND [Active] = 'Y'"
      SelectTitle = "Please select the reason for changing status to Not-Ready"

      Comments          = ""

How to Invoke the Device Command 
“UpdateUserData”

This section provides an example of the definition of device commands that 
can be used for call attached data modification:
;////////////////////////////////////////////////;// "TestAttachData" 
would be called from EventResponse 

;//of some EventHandler:

;// for test purposes only

[Command:TestAttachData]

Description   = "Attach UserData To call"

; DeviceCommand = "AttachData"

; DeviceCommand = "DeleteUserData"

DeviceCommand = "UpdateUserData"

   Hidden        = "true"

;// Please define real Profile how it is defined in real 
;//configuration instead of  "Gplus Voice"

Profile       = "Gplus Voice"

Comments      = ""

CmdData       = "AssociateAttachData"

[CmdData:AssociateAttachData]

Param.AdditionParam1 = "This is Param1"

Param.AdditionParam2 = "This is Param2"
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Param.AdditionParam3 = "This is Param3"

Comments             = ""

For testing purposes you may create a new button on the Siebel 
Communications Toolbar and associate this button with the TestAttachData 
command defined above. For detailed information about how to create this 
button on the Siebel Communications Toolbar, see the Siebel documentation. 

Note the following when working with attached data:

• For incoming calls the Adapter enables the following device commands 
after EventEstablished. For outgoing calls the same device commands are 
available after EventDialing: 
 AttachData
 UpdateUserData
 DeleteUserData

• The device command AttachData should not be used to update already 
existing call attached data. In this scenario, the command will simply add 
the specified parameters, which can lead to duplicated entries in call 
attached data. The device command UpdateUserData will create a new 
entry or update an existing one. For more information, see the T-Server 
documentation related to the switch you are using.

• You may also use other device commands (MakeCall, TransferMute, 
TransferInit, TransferSStep) to attach data to a call by defining additional 
parameters for these commands. All additional parameters for these 
commands are considered as user data that has to be attached to a call.

Network Attended Transfer

This release supports the Network Attended Transfer feature in the Gplus 
Adapter 7.5 for Siebel CRM Voice Component. In these scenarios, network 
calls are received on the Premise T-Server (Premise A) and then transferred to 
another Premise T-Server (Premise B) using Network Attended Transfer 
requests to Premise A T-Server. The Network call is initially routed to a 
Premise A T-Server. This state is considered as the starting point for the 
Network Transfer on Premise A. 

When the original party has established connection with an Agent1 on Premise 
A, network multi-party functionality can be invoked.

In this state, Agent1 can initiate Network Attended Transfer to another Agent 
on Premise B. Network Attended Transfer is initiated on the Premise A T-
Server with the required parameter of the remote location. When answered on 
Premise B, the consult Leg is created on the network. 

With the consult leg initiated, Agent1 is able to swap voice connection 
between Agent2 and the originating party, with network alternate. Agent2 also 
can swap the voice connection, but in any case the connection will be either 
between Agent1 and Agent2 or between Agent1 and the originating party.

With the initiated consult leg call, an agent can:
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• Complete the transfer of the network call to a remote location (Premise B), 
or

• Reconnect the network call to Premise A, or 

• Merge the network call into a conference.

Network Attended Transfer can be initiated when the DeviceCommands 
TransferInit or ConferenceInit are invoked. Remote location information is 
described by the command data parameter RemoteConnectStr.

The value of command data parameter Param.RemoteConnectStr defines the 
name of the premise switch where the destination DN resides. This premise 
switch name is the name of the remote call center and must be exactly defined 
as it is in the Genesys Configuration Manager.

Two other Siebel Configuration parameters define the name of the local 
premise switch where the initiator DN resides (switch for T-Server, defined in 
current Siebel configuration).

These parameters are: 

ConnectString in the [Configuration Parameters] section 

and 

Driver:LocalConnString in the [Driver: …] section

Both parameters are the same and must be defined as follows:

• In the [Configuration Parameters] section, define the ConnectString 
parameter as a premise switch name exactly as it is defined in Genesys 
Configuration Manager for T-Server.

For example:
ConnectString = "Prem-1-G3_72"

• In the [Driver: …] section, define the ConnectString parameter as a 
premise switch name exactly as it is defined in Genesys Configuration 
Manager for T-Server.

For example:
Driver:LocalConnString = "Prem-1-G3_72"

If the RemoteConnectStr parameter of DeviceCommands TransferInit or 
ConferenceInit and LocalConnString define different switches (remote call 
centers), and there is a network call on the DN, the Adapter tries to initiate a 
Network Attended Transfer when one of these DeviceCommands is invoked. 

If the RemoteConnectStr parameter and the LocalConnString are the same, the 
Adapter initiates a local Consultation call on the same switch.

To invoke this functionality with a received network call from an originating 
party, the Adapter uses the approach recommended in the Siebel 
Communications Server Administration Guide.
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If the parameter ConnectString was defined in the Siebel configuration, then 
the Siebel macro $RemoteConnectStr2 allows retrieval of the name of the 
remote call center from the Business Component Employee.

As described in the Siebel Communications Server Administration Guide:

“$RemoteConnectStr2. Name of the remote call center. This macro, which can 
be used with transfers and conference calls between call centers, derives the 
name of a remote call center’s communications configuration from either:

• The ConnectString configuration parameter (if defined), or

• The employee ID of the agent to be called “

In a sample GenComm_universal.def file, the [CmdData:…] section of the 
following Commands defines the value of the parameter RemoteConnectStr as a 
macro $RemoteConnectStr2 (see an example below):
• Command:ConsultativeTransferToEmployee

• Command:ConsultativeTransferToPopupEmployee

• Command:ConferenceTransferToEmployee

• Command:ConferenceTransferToPopupEmployee

When two-step transfer or conference is initiated, the Adapter compares the 
name of the call center of the initiator as defined by the parameter 
Driver:LocalConnString with the value of the parameter RemoteConnectStr. If 
these values are not equal and not NULL, and there is a network call on the 
initiator DN, then the Adapter initiates a network call transfer to the remote 
call center defined by the value of RemoteConnectStr parameter. Otherwise a 
local consult call is initiated.

Completion of the transfer on the network call, reconnection of the network 
call, or merge of the network call into a conference is invoked in the Adapter 
from the Communications Toolbar when clicking the same buttons as for local 
consult calls. If the active workitem is a network call and the call state enables 
the related feature, then the network call, reconnect network call, or merge 
network call will be invoked.

Because there is only one call on Premise switch/T-Server in a Network 
Attended Transfer scenario, there is only one workitem in Siebel. The network 
alternate is invoked by clicking the button NtwkAlternateConsultCall on the 
Communications Toolbar when the call state enables this operation.

An example of how to define the RemoteConnectStr2 parameter in the 
CommandData can be found in the sample GenComm_universal.def file provided 
with the Adapter:
[Command:ConsultativeTransferToPopupEmployee]

   DeviceCommand     = "TransferInit"

   Description       = "Consultative transfer to employee selected from 
popup list"

   Title             = "Consultative Transfer"

   CmdData           = "ConsultativeTransferToPopupEmployee"

   Hidden            = "TRUE"
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   CmdChannelOnFocus = "TRUE"

   Profile           = "Gplus Voice"

[CmdData:ConsultativeTransferToPopupEmployee]

      AttachContext        = "TRUE"

      SelectParam          = "TRUE"

      SelectBusObj         = "Employee"

      SelectBusComp        = "Employee"

      SelectApplet         = "ACD Transfer Call Applet"

      SelectTitle          = "Begin Consultative Transfer to:"

      Param.PhoneNumber    = "[Phone #:Lookup]"

      Param.CallNotifyText = "Consultative transfer from 
{@UserName}..."

      Param.TrackingID     = "{@SelectedWorkItem:DriverWorkTrackID}"

      Param.RemoteConnectStr      = "[$RemoteConnectStr2(Id)]"

Note: Macro $RemoteConnectStr2 returns the non-null name of a remote call 
center when an agent is logged in to Siebel. When a destination agent 
is not logged into Siebel or is in the same Siebel configuration that the 
initiator of the transfer or conference is, the Adapter initiates local 
consultation calls.

Network Transfer Optional Automatic Reconnection

When Network Transfer is initiated by the agent, but the consultation call has 
failed returning NetworkDestState of Network DestStateFailed with cause Busy 
or NoAnswer, then the network call should be reconnected back to the agent. 

This can be accomplished:

• Manually, by clicking the Resume work item button on the Siebel 
Communications Toolbar, or

• Automatically, by configuring a Profile in Siebel to perform an automatic 
reconnection of a network call after a specified timeout has elapsed.

The configuration parameter Driver:NtwkReconnectTimeout with a default 
value 0 defines whether automatic reconnection is configured and the value for 
the timeout.

If NtwkReconnectTimeout is greater than 0, then the value represents the timeout 
(in seconds) before the Adapter invokes a Network Reconnect request to the T-
Server. In this case, if an agent attempts to perform a manual reconnection for 
the network call from the Siebel Communications Toolbar during the timeout, 
the automatic reconnection is not invoked.

If NtwkReconnectTimeout is 0 (the default), then the Adapter does not invoke a 
Network Reconnect request automatically. The agent will need to invoke a 
manual reconnection as described above.
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Customizations for Basic Voice

Network Transfer Support

The premise T-Server uses SingleStepTransfer to route a call to the network T-
Server. So the Gplus Adapter uses SingleStepTransfer when it is performing a 
network transfer for all switches. 

To ensure that the Adapter uses the TransferSStep Device Command for 
network transfers, the parameter Service:useSStepTransferFor 
NetworkTransfer must be set to TRUE.

When performing a network transfer, the Device Command TransferSStep 
must be configured such that the value of Device Command parameter 
RemoteConnectStr defines the name of the Network Switch, as shown below: 
[Command: SingleStepTransferCallToNetworkTS]

DeviceCommand     = "TransferSStep"

CmdData = " SingleStepTransferCallToNetworkTS "

Hidden            = "TRUE"

CmdChannelOnFocus = "TRUE"

Profile           = "Profile Name Here"

[CmdData: SingleStepTransferCallToNetworkTS]

Param.RemoteConnectStr = "<AttributeLocation_Value>"

Param.TrackingID =
"{@SelectedWorkItem:DriverWorkTrackID}"

where <AttributeLocation_Value> is the name of the Network Switch as 
defined in a Genesys configuration.

Customizations for Expert Contact

Configuring the Set of User Data Available to an Agent

User Data attached to a call are stored in the Activity field “Description”. 
Required data are defined in the GenComm_universal.def file in the Event 
Handler EventKwPreviewIntRequest. A query searches the List of Contacts 
using this specification: Work Phone #' LIKE '*{ThisDN}. Depending on query 
results, the logic executes SingleLog, MultipleLog, or Log (for the case in 
which no contact is found) and displays the appropriate Siebel view to the 
agent. 

The set of fields available to the agent should be specified in the following line 
within each log handler:

LogField.'Description'   = "Preview interaction request 
to {ThisDN}"
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Customizations Involving Universal Callback

None for this release.

Customizations Involving Outbound Campaign or OCS

The Outbound Campaign feature is associated with the Genesys Outbound 
Contact Server (OCS) product. Refer to the Genesys Outbound Contact 
documentation for additional details about this product.

Logout Control for the Predictive Dialing Mode

To schedule agent logout time and to prevent abandoned calls in Predictive 
Dialing mode, use the AgentLogOutControl option in the 
GenComm_universal.def file. The default value of this option is FALSE. If you 
set this option to TRUE, you will enable Agent logout control functionality. 
This functionality notifies agents, who request logout, of the time left until 
their actual logout. Upon reaching this time, the agent is automatically Logged 
Out from Communication services. See Genesys Outbound Contact 
documentation for more information about this feature. Also 
see“Service:AgentLogOutControl” on page 211. This functionality is 
supported only by Genesys Outbound Contact version 7.x.

Time Out for Requests to OCS Server

The Gplus Adapter controls response time from Outbound Contact Server 
(OCS). When the request timeout is over, it erases obsolete records from the 
agent’s desktop. The timeout period is specified in the RequestTimeout option 
in the GenComm_universal.def file. Default value for this option is 
Service:RequestTimeOut = “30”.

Possible use cases include:

• Configurations with one OCS, when the primary OCS is down or not 
responding;

• Configurations with primary and backup servers, running in the Warm 
Standby Mode. For example: when an agent has records from the primary 
OCS and the backup server role switched to primary due to failure of 
Primary server.

OCS Smart Script Customization – Event Response 
and Event Handler Information

The handling and processing logic in Smart Script has changed. Siebel Smart 
Script ID is not delivered as the user data key-value pair 
CRM_SMART_SCR_ID. Instead it is extracted from the Campaign Business 
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Component. The Adapter assumes that the default Smart Script is used for 
handling all campaign records. 

SmartScript related code is included in the following Event Responses:

• [EventResponse:OnOCSRecord] —handler works for OCS records received 
on events 

PreviewRecord—(for Preview Dialing mode)

ScheduledCall—(for Scheduled records)

• [EventResponse:OnPredictOCSRecord]—handler works for OCS records 
received on events:

OutboundOCSCallEstablished—(for Predictive/Progressive Dialing 
Modes)

OCSPartyChanged—(for Transferred calls)

Both Event Responses perform the following operations:

1. Queries Business Component Campaign.

2. Stores Smart Script ID and Language Code in the Work Tracking Object.

3. Stores campaign information in the custom fields of the Work Tracking 
Object.

4. Creates an activity record.

See the GenComm_universal.def file for implementation details. The following 
placeholders mark the start of the code:

; Lines below are Smart Script related code 
<<<<<<<<<<<<<<<<<<<<<<<<<<

and the end 

; Lines above are Smart Script related code 
>>>>>>>>>>>>>>>>>>>>>>>>>>

of the SmartScript related code:

If you are not using Smart Script functionality, the related code should be 
removed from [EventResponse:OnOCSRecord] and 
[EventResponse:OnPredictOCSRecord]. Also, the event handler 
[EventHandler:EventCurrentSmartScriptWorkItemChanged] should be 
commented or removed from the universal.def file.

For an example of how to use Smart Script in the event handler 
EventCurrentSmartScriptWorkItemChanged, see “Event Handlers and Their 
Status in Activity Creation” on page 166 and see the GenComm_universal.def 
file for details and current implementation. This event handler is intended for 
SmartScript execution when an agent switches between Work Items on the 
Siebel Toolbar. If you are using Smart Script for screen pops, this handler 
should be uncommented. Also, the appropriate Smart Script should be 
developed and specified for use with a campaign. 
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To Specify DoNotCall Command Attributes

There are different ways to apply the DoNotCall command. The purpose of 
using the DoNotCall command is to modify a record so that associated phone 
numbers are not called. There are different ways to modify the DoNotCall 
command attributes so that it refers to either phone numbers or customer IDs 
and applies the DoNotCall command based on these keys.

The DoNotCall command can be modified by specifying the send attributes 
USE_RECORD_HANDLE, USE_PHONE, USE_CUSTOMER_ID and 
GSW_CHAIN_ATTR.

The default value for the GSW_CHAIN_ATTR attribute is defined in the 
GenComm_universal.def file by the parameter GService:OCSDoNotCallScope and 
is set to AllChain.

Options for the DoNotCall command can modify the scope of the DoNotCall 
request. You can specify one of the following keys:

• USE_RECORD_HANDLE

• USE_PHONE

• USE_CUSTOMER_ID

The keys USE_RECORD_HANDLE, USE_PHONE, and 
USE_CUSTOMER_ID correspond to the appropriate use cases from 
Outbound Contact Server Desktop Protocol definitions, and are described 
below: 

USE_RECORD_HANDLE

The Gplus Adapter sends a request to the Outbound Contact Server to mark a 
record DoNotCall based on the record handle ID. Additional attributes, 
GSW_CHAIN_ATTR = “RecordOnly” or “AllChain” can be specified to mark 
a chain or a record as DoNotCall. The default value for 
USE_RECORD_HANDLE is specified in the service parameter 
OCSDoNotCallScope = “AllChain” and effective for all agents under a 
specific profile. The resulting phone number from a record (or all phone 
numbers from a chain) will be marked as DoNotCall and will be included in 
the DoNotCall list.

USE_PHONE

The Gplus Adapter sends a request to the Outbound Contact Server to mark a 
record DoNotCall based on the phone number. As a result, the phone number 
will be included in the DoNotCall list and records and this phone number will 
never be called again. See Outbound Contact documentation for more 
information. 
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USE_CUSTOMER_ID

The Gplus Adapter sends a request to the Outbound Contact Server to mark a 
record DoNotCall based on Customer_id. As a result, the Customer ID will be 
included in the DoNotCall list and the records and this Customer ID will never 
be called again. See Outbound Contact 7 documentation for more information.

Setting the service parameter OCSEnableCustomerId = “FALSE” disables use 
of Contact ID for compatibility with releases earlier than 6.5.2 of Outbound 
Contact Server. If you set this option to “FALSE” and specify 
USE_CUSTOMER_ID key in the DoNotCall command, then the 
USE_RECORD_HANDLE scenario will be used instead. The default value of 
OCSEnableCustomerId is “TRUE”.

If None of These Keys Are Specified

If none of these keys (USE_RECORD_HANDLE, USE_PHONE, or 
USE_CUSTOMER_ID) are specified, then the Gplus Adapter assumes that the 
Adapter customer provided all the necessary attributes manually and passed all 
keys specified in the command description to the Siebel .def file without 
modifications to the Outbound Contact Server. See the OCS desktop protocol 
DoNotCall command definition on page 277 for information on the DoNotCall 
attributes.

For example, in the sample GenComm_universal.def file:

• Service:OCSDoNotCallScope defines the default value of the parameter 
GSW_CHAIN_ATTR for the Device Command DoNotCall. 

• The attribute GSW_CHAIN_ATTR is sent with the Do Not Call request in the 
case when the USE_RECORD_HANDLE   = "TRUE" parameter is defined for the 
Device Command DoNotCall.

• The Device Command DoNotCall can be invoked with valid attribute 
GSW_CHAIN_ATTR values AllChain or RecordOnly if it is defined in the 
CmdData section of command together with the USE_RECORD_HANDLE   = 
"TRUE" parameter.

• In the case when USE_RECORD_HANDLE   = "TRUE" but GSW_CHAIN_ATTR is not 
defined, the default value AllChain is used.

;   DoNotCall
[Command:DoNotCall]
   Description   = "Mark phone number as Do Not Call"
   DeviceCommand = "DoNotCall"
   Hidden        = "TRUE"
   Profile       = "Gplus Voice"
   Comments      = ""
   CmdData       = "DoNotCall"
   CmdChannelOnFocus = "TRUE"

[CmdData:DoNotCall]
;; Param.USE_CUSTOMER_ID     = "TRUE"



Gplus Adapter for Siebel CRM—Deployment Guide 191

Chapter 5: Configuration and Installation of the Voice Component Advanced Customization of Voice Component 

Param.GSW_CHAIN_ATTR      = "AllChain"
;; Param.GSW_CHAIN_ATTR      = "RecordOnly"
;; Param.USE_PHONE           = "TRUE"

Param.USE_RECORD_HANDLE   = "TRUE"
Comments                  = "Do Not Call"

To Specify Cancel Command Attributes 

The OCSCancelScope options for the OCSRequestRecordCancel command as it 
is defined in the sample GenComm_universal.def file can be used to modify the 
scope of the cancel request. The OCSRequestRecordCancel command behavior 
can be modified by specifying the Siebel send attributes USE_PHONE, 
USE_RECORD_HANDLE, and GSW_CHAIN_ATTR. If the 
GSW_CHAIN_ATT attribute is not specified in the .def file, the Adapter will 
use the default AllChain. In the configuration, the default OCSCancelScope 
value in the GenComm_universal.def is AllChain. Or you can change it to 
RecordOnly and that will cancel one record based on the cancel command. For 
more information see Outbound Contact Server documentation.

The keys USE_RECORD_HANDLE and USE_PHONE correspond to the 
appropriate use cases described in the following Outbound Contact Server 
Desktop Protocol definitions: 

USE_RECORD_HANDLE Use Case

The Gplus Adapter sends a request to the Outbound Contact Server to mark a 
record as Cancel based on the record handle. As a result, the phone number 
will be marked Cancel in the calling list and will not be called for this 
campaign. See Outbound Contact documentation for more information. An 
additional attribute GSW_CHAIN_ATTR = “RecordOnly” or “AllChain” can 
be specified to mark all records in a chain or a single record as DoNotCall. The 
default value for the USE_RECORD_HANDLE attribute is specified in the 
service parameter OCSCancelScope and effective for all agents under a 
specific profile. The resulting record (or whole chain) will be marked as 
Canceled and will not be called within a particular calling list.

USE_PHONE Use Case

The Gplus Adapter sends a request to the Outbound Contact Server to mark a 
record Cancel based on a contact’s phone number. As a result, the phone 
number will be marked Cancel in the calling list and will not be called for this 
campaign. See Outbound Contact documentation for more information. 

If neither USE_RECORD_HANDLE or USE_PHONE are specified, then the 
Gplus Adapter assumes that the customer provided all the necessary attributes 
manually and passed all keys specified in the command description to the 
Siebel .def file without modifications to the Outbound Contact Server. See 
OCS Desktop Protocol Cancel command definition on page 276 for 
information on the RequestRecordCancel attribute.
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For example, in the sample GenComm_universal.def file:

• Service:OCSCancelScope defines the default value of the parameter 
GSW_CHAIN_ATTR for the Device Command CancelInteraction. 

• The attribute GSW_CHAIN_ATTR is sent with the Cancel request in the case 
when the USE_RECORD_HANDLE   = "TRUE" parameter is defined for the 
Device Command CancelInteraction.

• [Command:OCSRequestRecordCancel_] defines the request to cancel the OCS 
record. 

• The Device Command CancelInteraction can be invoked with attribute 
GSW_CHAIN_ATTR valid values AllChain or RecordOnly if it is defined 
in the CmdData section of command together with the USE_RECORD_HANDLE   
= "TRUE" parameter.

• In the case when USE_RECORD_HANDLE   = "TRUE" but GSW_CHAIN_ATTR is not 
defined, the default value AllChain is used. 

[Command:OCSRequestRecordCancel_]
   Description   = "Cancel Interaction"
   DeviceCommand = "CancelInteraction"
   BusComp       = "Campaign List Contact"
   AllViews      = "FALSE"
; Uncomment following line for use with Siebel version 7.04-7.5x
;   View               = "Campaign Detail"
; Uncomment following line for use with Siebel version 7.7x
   View               = "Campaign Detail - Position"
   Hidden        = "TRUE"
   Profile       = "Gplus Voice"
   CmdData       = "OCSRequestRecordCancel_"
   CmdChannelOnFocus = "TRUE"

[CmdData:OCSRequestRecordCancel_]
Param.USE_RECORD_HANDLE   = "TRUE"

; Param.USE_PHONE           = "TRUE"
Comments = "Request Record Cancel - Cancel Current Work Item"
Param.GSW_CHAIN_ATTR      = "AllChain"
or 
Param.GSW_CHAIN_ATTR      = "RecordOnly"

Disabling Record Reschedule Beyond a Campaign’s 
Expiration Date

By default, Siebel CRM allows record rescheduling beyond the campaign’s 
expiration date. Genesys Outbound Contact can restrict record rescheduling by 
hours. Additionally, Outbound Contact prevents a record from being 
rescheduled in the past, which is also supported by default. To add more 
sophisticated rescheduling time and date control algorithms, you must 
customize the Siebel CRM application.
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You can implement extended functionality in the Business Component, 
Campaign List Contact, in the PreSetFieldValue server script function. A 
sample script is shown below (see the topic, “PreSetFieldValue Server Script 
Function – Example” on page 193).

(For further information about programming and customizing Siebel CRM, see 
Siebel Communications Server Guide, Siebel Tools Guide, and 
Siebel E-Script Manual.)

PreSetFieldValue Server Script Function – Example

In this example, Time_Is_Valid_Campaign_Date (FieldValue) is a customer 
defined function, which returns TRUE if a particular date is between the 
campaign Start and End dates.

function BusComp_PreSetFieldValue (FieldName, FieldValue)
{
/*
 BusComp_PreSetFieldValue (Campaign List Contact):
 
 Checks the name of the field being updated to see if is one
 of the fields that should be synchronized with the Genesys
 Outbound Framework. If so, the function calls UpdateGenesysOCS( )
 to attempt to connect to Genesys and change the value on the
 Genesys server. If a Genesys error occurs (for example, if 
Genesys
 cannot be contacted or does not recognize the field name) then
 this function returns CancelOperation so that the value of the 
field
 remains the same, signaling to the user that a problem has 
occurred.
 Otherwise ContinueOperation is returned and the update proceeds
normally.
 
 Generally no error message will be shown if there is a problem
 contacting Genesys, but the value of the field cannot be updated 
in
 this case.
*/
 var retVal = ContinueOperation;

var ViewName = TheApplication().ActiveViewName();
if ( (ViewName != "Campaign Detail" && ViewName != "Campaign 

Detail - Position" ))
{

return (ContinueOperation);
}

// Debug code to show calls to this function in the status bar
// CallCommunicationsCommand("ShowStatusText", "Text", FieldName 

+ " set to " + FieldValue);
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    switch(FieldName) {
    case "Dial Attempts":

if(gDialAttempts == null)
gDialAttempts = GetFieldValue("Dial Attempts");

        break;
case "Status":

if(gStatusValue == null)
gStatusValue = GetGenesysStatusCode("Status");

        break;

case "Reschedule Time":
 if ( Time_Is_Valid_Campaign_Date( FieldValue ) )
 {
 retVal = 
CallCommunicationsCommand("RecordRescheduleWithArg", 

"RSTime", FieldValue);
 }
 break;

case "CallCompleted":
  if (FieldValue == "Y") {
  //retVal = CallCommunicationsCommand("RecordProcessed", 
"", "");
  }
  break;
 }
 
 if (retVal != ContinueOperation) 
 {
 DisplayGenesysError();
 }

 return (retVal);
}
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Selecting an Alternative Destination Phone Number

It is possible to use an alternative destination phone number when making a 
call to the campaign contact. By default, the Gplus Outbound Contact feature 
places a call to the work phone number specified in the Siebel Campaign 
contact. Setting the key IgnorePhoneNumber = TRUE in the command definitions 
file (GenComm_universal.def) overwrites the default behavior and forces the use 
of a Genesys Outbound campaign phone number as the destination. The prefix 
to reach the outside phone network can be specified as the value of the 
OutsideCallPrefix key. See the following example:

;;/////////////////////////////////////////////////////////////////
///////
; MakeCall
; CRM_CAMP_CON_ID - Campaign List Contact
; IgnorePhoneNumber - if set to true, ignores PhoneNumber value and 
calls number 
; from Genesys campaign, otherwise calls PhoneNumber.
; OutsideCallPrefixæPrefix to reach outside phone network; if 
specified will be 
; added to Genesys campaign phone number.
[Command:MakeCallToCampaignContact]
Description = “Make call to campaign contact”
DeviceCommand = “MakeCall”
Hidden = “TRUE”
CmdData = “MakeCallToCampaignContact”
[CmdData:MakeCallToCampaignContact]
BusComp = “Campaign List Contact”
Param.CRM_CAMP_CON_ID = “{Id}”
Param.PhoneNumber = “{Work Phone #:Lookup}”
Param.IgnorePhoneNumber = “TRUE”
Param.OutsideCallPrefix = ““
RequiredField.‘Work Phone #’ = “?*”

Outbound Contact Multiple Campaigns Agents

In Outbound Contact, agents can be shared among multiple campaigns. 

In Predictive/Progressive modes, for every agent assigned to more than one 
active CampaignGroup, Outbound Contact designates only one CampaignGroup 
for this agent.

OCS will change the CampaignGroups designation depending on configured 
campaign priorities, the agent activity history, and campaign statistics, and 
notifies an agent about the new assignment by sending 
EventCampaignGroupAssigned. For details, see the Genesys Outbound Contact 
Solution 7.5 Deployment Guide.

Agents in Siebel can work in multiple campaigns.
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In Predictive/Progressive modes, EventCampaignGroupAssigned notifies an 
agent that of assignment to a new campaign. 

The Status text area on the Siebel desktop (which displays for a short time) is 
used for agent notification that a new campaign has been assigned to the agent.

The campaign name is displayed on the Siebel popup screen that shows 
campaign information and campaign contact.

For campaigns in Preview mode, an agent gets the records by clicking the 
Record Request button on the Communications Toolbar, and 
PreviewRecordRequest is sent to OCS. When the PreviewRecordRequest device 
command is invoked, an agent gets the record from the first campaign that was  
reported by T-Server to the Adapter as loaded and started in Genesys OCS in 
Preview mode.

Invoking the device command SetActiveCampaign can change the current 
Preview mode campaign. Subsequent PreviewRecordRequest commands will 
retrieve preview records from the new campaign. The graphical user interface 
(GUI) for Preview mode is not changed in this release.

If the current Preview mode campaign is unloaded, the Adapter will set as 
current (Active Campaign) the first Preview mode campaign found in the 
Adapter internal storage which has state loaded.

After an agent logs in to Siebel when one or more campaigns was already 
started in Outbound Contact, or after the Adapter reconnects to the T-Server, 
the current state of each campaign is reported when the agent logs in to the 
queue(s) associated with the corresponding Agent Group(s). For activation of 
Outbound Contact functionality in this case, Genesys recommends invoking 
the login (or logout, then login) command from the Communications Toolbar.

Checking Installations
This section includes preliminary information and instructions for checking 
your implementation of each Voice feature to verify that it is installed correctly 
and working correctly. 

Disclaimer

Only a thorough testing of every possible configuration and variation can 
provide a complete software application test. The tests listed below provide 
only a suggested starting point. If these tests are satisfactory, Genesys 
recommends that you test each individual feature and variations by applying 
the procedures listed for that feature in the Gplus Adapter 7.5 for Siebel CRM 
User’s Guide. In any case, such preliminary tests are not intended to substitute 
for a professionally designed and administered panel of tests.
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Checking the Basic Voice Installation

To check the functionality of the Basic Voice feature, perform the following 
steps:

1. Log in as an Agent and, if the agent is not ready, select the Ready button. 

2. Make a direct call to the agent teleset. The ringing icon on the Siebel 
Communication toolbar should start blinking, indicating that a new call is 
waiting for the agent to answer.

3. Press the Answer incoming call button to establish a connection.

4. Confirm that normal telephone or headset operations and CTI Toolbar 
buttons are present, and that basic voice functions are coordinated with 
basic voice controls on the toolbar.

5. After communication with caller is completed, press the Hangup call 
button to release the call.

6. Type a phone number into the edit field of the Communication toolbar and 
press the Make Call to “<Phone Number>” button. If this outgoing call is 
answered, then, after the communication is completed, press the Hangup 
call button to release the call. If this call is not answered, press the Hangup 
call button to release the call.

7. Try some other call scenarios, for example, a conference and a transfer 
call. Refer to the Gplus Adapter 7.5 for Siebel CRM User’s Guide for 
examples of these scenarios.

Checking the Expert Contact Installation

To check the functionality of the Expert Contact feature-enabled Siebel Call 
Center, perform the following steps:

1. Log in as an Agent and select the Ready button. 

2. Press the On Call button on the Siebel Communication toolbar. A new 
incoming call from an Unknown recipient will appear in the Work Items 
list on the Toolbar. Proceed with the call as if it were an incoming call so 
Genesys can track the call. From this point onward, use the same checking 
process applied to the Basic Voice feature, with the exception of testing of 
the confirm-status option.

3. If the Confirm-status option is implemented, then a pop-up window should 
appear after the defined time-out period. That is, if an expert is on the call 
after the length of time set by the timer, a dialog box appears asking if the 
expert is still on the call and if the agent wants to continue. 

4. To test the Preview-interaction option (Preview mod)e installation when 
Preview mode is turned ON:



198 Gplus Adapter 7.5

Chapter 5: Configuration and Installation of the Voice Component Checking Installations

 When an agent receives an incoming call, a new work item, Preview 
Request, is created on the Siebel Communication Toolbar, and the 
Accept Incoming Interaction button starts blinking. To accept the 
interaction, press the blinking button and use standard procedures for 
the call. Newly created call will reuse existing work item. 

 If the Siebel preview-bell option is implemented, then you can test it 
by sending a interaction to an expert. Confirm that a sound is played 
when the preview interaction dialog box appears.

5. To test the Preview mode installation when Preview mode is turned OFF:
 If the Preview mode is set to OFF, then the Agent's work flow options 

are exactly the same as in the Basic Voice feature. The agent can place 
outbound calls, receive incoming calls, and make transfers.

Checking the Voice Callback Installation

This section presents simple scenarios that show different ways of working 
with the Voice Callback Server from the Siebel application.

To check the functionality of the Universal Callback Server (UCB) -enabled 
Siebel Call Center, you must create a callback request from either the Siebel 
desktop or the IVR side. After creating the callback request, the next step is to 
make an agent ready and wait for a callback request to be distributed from the 
voice callback queue.

The following agent work flow scenarios could be used to check the 
installation:

• Initiate Callback session:
 Click Session start button on the Communication Toolbar

• Initiate Callback call (in Callback Preview mode)
 After the Callback interaction is delivered to agent and the Contact 

screen displayed, click the Initiate Callback button on the Toolbar. This 
will initiate a call to the number, which was specified in the 
VCB_CONTACT key. 

 To initiate Callback to a different number, 
 Enter a new phone in the Phone field on the Toolbar

or 
 Select and highlight any text on the agent's desktop and press 

Initiate Callback. These options will initiate a call to the selected 
number.

• Add callback:
 Create a new Activity record
 Set type to “Call”
 Set “Priority” 

 Set to “ASAP”

or
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 Set to other than “ASAP” and also set “Due” time
 Save record
 Click “Add” button

• Cancel Callback:
 Locate Callback record
 Save record
 Click Cancel button

• Reschedule Callback:
 Locate Callback record
 Set “Due” time
 Change Priority to non “ASAP”
 Save record
 Click Reschedule button

Checking the Outbound Contact Installation

To check the functionality of the Outbound Contact Server (OCS) -enabled 
Siebel Call Center, you must create campaign entries (which are exported by 
Gplus Campaign Synchronization into the Genesys OCS database), and start a 
particular campaign from the Genesys Outbound Management Console.

Next, you must log into the Siebel Call Center as one of the agents, which you 
created under the section “Creating Agents” on page 159. Depending on the 
OCS campaign mode, different scenarios are processed. For further 
information on how to work with Genesys OCS, refer to the Genesys 
Outbound Contact Getting Started Guide.

While in the Preview campaign mode, you must log into the Siebel Call 
Center, next log into PBX/ACD on the Communications Toolbar. You see the 
message Campaign [Campaign_Name] started on the status line. After you click 
Preview Mode Start, the campaign control buttons: Request Record, Request 
Chain, Reject Record, Record Processed, Record Cancel, Mark Phone Do Not 
Call, and Preview Mode Stop are available on the Communications Toolbar.

On every requested preview record, the Campaign Overview screen, with a 
particular Contact/Prospect is displayed and additional controls Make Call, 
Done, Reject, Do Not Call are available on the interface. Also, all changes to 
the fields: Call Result, Attempts, and Schedule Time are written to the Genesys 
Outbound Contact Server and the Siebel database.

The Done control (on the interface) and the Record Processed button (on the 
Communications Toolbar) write the operation and initiate the final OCS 
database update. After this command, the Preview Record is removed from the 
Communications drop-down Work Items list. An active call corresponding to 
this contact remains active and can be finished by clicking Release Call. 
Alternatively, the call can be released and the command, Record Processed, 
can be issued later.
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Figure 24 shows an OCS Preview record with an initiated outbound call. The 
Preview campaign name also displays.

Figure 24: OCS Preview Record Window

When a campaign is running in Predictive or Progressive Dialing Mode, and 
after you log into the Siebel Call Center application, and log into the 
PBX/ACD, the initial state is Agent Not Ready. A new outbound call will be 
delivered to the agent when the agent’s status changes from Not Ready to 
Ready. The campaign control buttons Record Processed, Request Chain, 
Record Cancel, and DoNotCall become available on the Communications 
Toolbar.

On every delivered call, the Campaign Contact Overview screen with a 
particular Contact/Prospect is displayed and additional controls Done and 
DoNotCall are active and available on the interface. Also, all changes to the 
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fields Call Result, Attempts, Schedule Time are written to the Genesys 
Outbound Contact Server (OCS) and the Siebel database.

The Done and DoNotCall controls (on the interface) and the Record Processed 
and DoNotCall controls (on the Communications Toolbar) save the operation 
and initiate the final OCS database update. After that, the active call command 
remains active and can be finished by clicking Release Call. Also, the call can 
be released and the Record Processed command can be issued later. In this 
scenario, a new work item 
Wrap Up Record ->[Phone number] appears on the Communications Toolbar 
drop-down list and is removed after the agent clicks Done, Record Processed, 
Record Cancel, or DoNotCall.

Figure 25 on page 201 shows the initial Siebel Call Center screen after the 
agent logs in. The campaign name also displays.

Figure 25: Siebel Call Center Window

Finally, Figure 26 on page 202 shows an outbound call delivered to the agent. 
The campaign name also displays.
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Figure 26: Siebel Call Center Window, Outbound Call
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Driver Settings

Driver Parameters

Driver parameters define the set of values used by the Siebel Communications 
Server to work with communications systems such as CTI middleware. The 
Gplus Adapter driver is one of these systems and an appropriate set of 
parameters must be defined for it. A sample configuration file 
GenComm_universal.def contains a set of parameters to be defined for the Voice 
Component.

Table 15 on page 204 lists the supported driver parameters for the Gplus 
Adapter driver for the Siebel Communications Server. The table indicates 
which parameters are required and displays applicable default values. You 
view and modify these driver parameters in the Communications Drivers and 
Profiles view in the Communications Administration screen of the Siebel 
application (in Siebel 7.7/7.8/8.0/8.1, the Administration - Communications 
screen). The Channel Type for this driver is Voice.

Note: A Siebel Administrator must configure the Siebel environment to work 
with Gplus Adapter.

Each parameter is prefaced with a keyword indicating how it will be used:

• Parameters prefaced with Driver: are sent to the driver handle when the 
driver is initialized. These parameters are sent to the 
CreateISCDriverInstance method.

• Parameters prefaced with Service: are sent to the driver handle when it 
requests a service (creates the service handle). These parameters are sent to 
the RequestService method.

You must change the value of each mandatory parameter with the default value 
CHANGE_ME as these parameters depend on your configuration and cannot 
be used with default values.

For more information about the driver handle and its methods, refer to Siebel 
documentation.
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Table 15: Driver Parameters

Parameter Name Default Value Required Comment

Driver:SampleName (sample) Genesys Gplus 
driver default value

No Purpose of the driver, and sometimes 
also the purpose of different valid 
values. 

Driver:AdapterAppName Gplus Adapter No The application name that will be 
sent to T-Server when the Adapter 
opens a connection to this T-Server.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Driver:AnswerCallDelay 500 milliseconds No Defines the delay between 
TMakeCall and TAnswerCall 
requests for outbound calls on a 
DMS-100 switch.

Driver:BackupGenCommServer
URL

No Specifies the URL of the backup 
Gplus Communication Server

Driver:BackupServerHost CHANGE_ME No Specifies the name of the host 
machine on which the backup 
Genesys T-Server is running.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Driver:BackupServerPort CHANGE_ME No Specifies the TCP/IP port number 
the client must use to establish a 
connection with the backup Genesys 
T-Server.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Driver: 
BroadcastCommdnUserEvents2
Agents

FALSE No The value True enables the 
distribution of the EventUserEvent. 

Driver:CommunicationDN empty string (““) No Determines the name of a 
communication DN. The 
communication DN is used to send 
and/or broadcast a user event. See 
“Communication DN” on page 171.
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Driver:HangupOnEventReleased TRUE No Applicable only when using the 
NEC NEAX switches (for example, 
NEC NEAX 2000 IPS, NEC NEAX 
ICS/IMS (7600, 7400)). 

If the switch configuration requires 
the phone to be put on hook after 
call is released on the other side, 
then the Gplus Adapter should send 
an additional Release request after 
receiving EventReleased, and the 
value of Driver: 
HangupOnEventReleased must be 
set to “TRUE” (default). 

Driver:HangupOnEventReleased    = 
“TRUE”

If the switch configuration does not 
require you to put the phone on the 
hook, then set this parameter to 
“FALSE”

Driver:InboundPartyContainer empty string (““) No Name of the TEvent attribute for 
substitution in the workitem name 
on the Siebel Toolbar for incoming 
calls

Driver:LibraryName - Yes The name of the remote driver 
module which will be loaded by 
Gplus Communication Server to 
handle requests for the Siebel 
Communication Driver.

Driver:LocalConnString empty string (““) Yes, if 
Network 
Attended 
Transfer is 
used.

Determines the name of this premise 
location when the Network Attended 
Transfer feature is used. 

The value of this parameter must be 
set as a premise switch name exactly 
as it is defined in the Genesys 
Configuration Manager for the T-
Server. See “Network Attended 
Transfer” on page 182.

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Driver:NtwkReconnectTimeout 0 No Defines whether automatic 
reconnection of the initiated 
Network Transfer is configured and 
sets the timeout value. See “Network 
Transfer Optional Automatic 
Reconnection” on page 185.

Driver:OutboundPartyContainer empty string (““) No Name of the TEvent attribute for 
substitution in the workitem name 
on the Siebel Toolbar for outgoing 
calls

Driver:PrimaryGenCommServer
URL

- Yes Specifies the Universal Resource 
Locator (URL) of the primary Gplus 
Communication Server

Driver:ReconnectTimeout 10 No Defines the time in seconds for 
reconnection to T-Server or if 
defined, to the backup T-Server 
when T-Server disconnects from the 
Adapter.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Driver:RemoteTimeout 10 No This parameter defines a time 
interval, in seconds, during which 
the T-Server waits for an ADDP 
response from the Adapter

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Driver:TraceMode 0 No This parameter defines an ADDP 
trace mode in T-Server and/or in 
Adapter log files. The value of this 
parameter affects log generation 
only. ADDP polling messages and 
the algorithm for disconnection 
detection remain the same, 
regardless of the value set here.

Valid values for this parameter as as 
follows:

0—No trace in a T-Server and/or 
Adapter log file (default).

1—Trace in the Adapter log file 
only.

2—Trace in a T-Server log file only.

3—Full trace (in both T-Server and 
Adapter log files).

Driver:SCAPIServerURL - Yes Specifies the URL to which the 
Gplus Communication Server will 
send events

Driver:ServerHost CHANGE_ME No Name of the host that runs Genesys 
T-Server.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Driver:ServerPort CHANGE_ME No TCP/IP port number for T-Server.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Driver:SupervisorExtensions Empty string
(No Supervisor 
Extensions)

No Defines a set of Supervisor 
Extensions which should not be 
shown on the agent desktop when a 
supervisor is connected to the 
agent’s current interaction. Valid 
values are:

a string parameter consisting of a set 
of DNs

a simple file name

(See information about this 
parameter below this table.) 

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Driver:SwitchType 0 Yes The type of switch for your contact 
center. Values include:
1Nortel Meridian
2Rockwell Spectrum
4Nortel DMS-100
5Lucent Definity G3
6Aspect Call Center
7Siemens Hicom 300E
8EADS PointSpan, EADS 
ESeries
9Ericsson MD110
12NEC NEAX 2400
12 NEC NEAX 3600i
14Teltronics 20-20 IXP
17Siemens Hicom 300
18Phillips Sopho IS3000
23Alcatel 4400
29Nortel Meridian Call Center 
Symposium
31Siemens Realitis DX (iSDX) 
49Avaya INDeX (Lucent SDX) 
50Siemens Hicom 300H
51Siemens HiPath 4000
52Alcatel A4200 OmniPCX 
Office (OXO) 
58Knowledge Worker Gateway
62Cisco CallManager 
67itel
69Siemens HiPath 
70eOn eQueue
72SIP Server
Also see the document, Genesys 6 
Supported Media Interfaces, which 
is available on the Genesys 
Technical Support website.

Contact Genesys for a current list of 
switches and SwitchType values.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only)

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Driver:Timeout 0 No This parameter defines a time 
interval, in seconds, during which 
the Adapter waits for an ADDP 
response from the T-Server. ADDP 
is disabled if this parameter is not 
defined or if the value is set to 0.

(For compatibility with the pre-7.5 
scheme of connection to T-Server 
only.)

Driver:TServerAppName "CHANGE_ME" Yes Defines the T-Server Application 
Name of the Primary T-Server as it 
is defined in the Genesys 
Configuration Manager. See 
“Connection to T-Server” on 
page 157.

DriverAlias <empty string> No Reserved for internal use.

When drivers with the same set of 
Device Commands and Device 
Events are in the same Siebel 
configuration, this parameter defines 
the suffix of the Device Command 
or Device Event to be processed.

This parameter should not be 
modified until explicitly suggested 
by Genesys Technical Support.

MediaType <empty string> No Reserved for internal use.

This parameter should not be 
modified until explicitly suggested 
by Genesys Technical Support.

Name Genesys Gplus 
driver

Yes Name of the driver. May be any 
suitable name.

Service:ACDDNList {@ACDDNList} No Uses the macro @ACDDNList to 
obtain a list of ACD DNs 
(extensions of type A) associated 
with the current agent.

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment
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Service:AgentId {@AgentId} No This parameter manages agent ID 
logging for server-side statistics on 
outgoing connections usage.

If log level is set to DEBUG and if 
this parameter is specified, the 
Agent ID is logged. Otherwise, the 
session ID is logged.

Service:AgentLogOutControl False No Applies only to the Predictive 
Dialing Mode. When this option is 
set to TRUE the Agent logout 
control functionality is enabled and 
all agents requesting logout will be 
notified regarding the time left until 
actual logout and upon reaching this 
time the agents will be automatically 
Logged Out from Communication 
services.

Service:AgentPreviewModeStart False Yes (when 
working 
with 
Outbound 
campaigns 
in Preview 
mode)

Defines whether the agent is able to 
receive preview records without first 
submitting a 
PreviewDialingModeStart request to 
OCS from the desktop. In the Siebel 
Configuration, the 
Service:AgentPreviewModeStart 
parameter must be set to correspond 
with the value of the OCS option 
agent_preview_mode_start in 
Configuration Manager.

See details in the Genesys Outbound 
Contact 7.5 Deployment Guide. 

Service:AgentSubstitute True Yes (when 
using the 
Alcatel 
A4400 
switch)

For the Alcatel A4400 switch, this 
option must be set in accordance 
with T-Server settings for the Agent 
Substitute option.

See more details in “Switch-Specific 
Configuration Instructions” on 
page 170.

Table 15: Driver Parameters (Continued) 
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Service:AgentWorkMode AgentWorkModeU
nknown

No Agent work mode. Should match 
one of the TLibrary 
TAgentWorkMode enumeration 
values:
0—AgentWorkModeUnknown
1—AgentManualIn
2—AgentAutoIn
3—AgentAfterCallWork
4—AgentAuxWork
5—AgentNoCallDisconnect

The parameter can be defined either 
as a number corresponding to 
TLibrary TAgentWorkMode 
enumeration values or as a string 
(for example, 1 or AgentManualIn).

Service:AutoLogout FALSE No If the value of this parameter is 
TRUE, when the agent logs out from 
Siebel or closes the browser, then 
first the agent logs out from the 
ACD group, and then the agent logs 
out from Siebel. When the value of 
this parameter is FALSE, the agent 
just logs out from Siebel.

Service:AutoRejectRecords TRUE No Defines whether the Adapter sends 
requests to reject records when an 
agent logs out from Siebel. If set to 
TRUE, when an agent logs out from 
Siebel, the Adapter sends requests to 
reject all records. If set to FALSE, the 
Adapter does not send requests to 
reject records.

Service:DNList “{@DNList}” Yes Uses the macro @DNList to obtain a 
list of DNs (standard extensions of 
type S) associated with the current 
agent.

Table 15: Driver Parameters (Continued) 
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Service:HasAgentBusy FALSE No Can be TRUE or FALSE. Specifies 
whether the connected switch 
supports the Do Not Disturb (DND) 
function. You can also disable the 
DND function if it is supported by 
the switch, but you do not want your 
agents to use it. If the value is 
FALSE, the associated feature is 
disabled. For a disabled feature, an 
administrator can remove the 
associated (DND) toolbar button 
from the Repository using Siebel 
Tools.

Service:HasAnswer TRUE No Upon an incoming call, if the value 
of this parameter is TRUE, the 
Answer Incoming call button on the 
toolbar will be available. If the value 
is FALSE, this button will be 
unavailable.

Service:HasDisconnect TRUE No For the current active call, if the 
value of this parameter is TRUE, the 
Hang-up call button on the toolbar 
will be available. If the value is 
FALSE, this button will be 
unavailable.

Service:HasForward TRUE No If both the switch and T-Server 
support call forwarding, and this 
value is set to TRUE, the button on 
the toolbar that turns call forwarding 
on or off will be available. If this 
value is FALSE, this button will be 
unavailable.

Service:HasGCNProtocol Not supported starting from version 
7.2.

Service:HasHold TRUE No If the value of this parameter is 
TRUE, the Hold button or Retrieve 
button will be available, depending 
on call state. If the value of this 
parameter is FALSE, the Hold or 
Retrieve button will not be available.

Table 15: Driver Parameters (Continued) 

Parameter Name Default Value Required Comment



214 Gplus Adapter 7.5

Chapter 5: Configuration and Installation of the Voice Component Driver Settings

Service:HasKWProtocol FALSE No Enables or disables Expert Contact 
functionality support

Service:HasOCSProtocol TRUE for 
Outbound Contact 
configurations

No Enables or disables Outbound 
Contact functionality support

Service:HasVCBProtocol FALSE No Enables or disables Voice Callback 
functionality support

Service:KwDefaultPartyStatus released No Used by Gplus adapter when Party 
status info is missing in the 
KwPartyStatusRequest from Siebel.

Service:KwPiProtocolVersion 6.5.000.01 No Preview Interaction protocol 
version. 

Service:KwProtocolVersion 6.5.000.01 No Knowledge Worker protocol 
version. 

Service:

OCSEnableOutOfCampaignOper
ations

FALSE No Allows transfers and record handling 
for agents that are not participating 
in any campaigns. Requires 
Outbound Contact version 7.x.

Service:
NetworkCallTransferMode

Network No This parameter has two valid values:

• Network 

• Local

If the value of this parameter is 
Network, the Adapter uses the 
Network T-Server operation 
(Network 
Consult/Transfer/Conference) for 
creating and completing two-step 
operations (consult, transfer and 
conference) for network calls; all 
other calls are processed using the 
standard T-Server operations.

If the value of this parameter is 
Local, the Adapter uses only the 
standard T-Server operations for 
two-step operations (consult, 
transfer and conference) for all types 
of calls.

Table 15: Driver Parameters (Continued) 
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Service:OCSCallBackType Personal No Specifies the callback type: 
Personal, or Campaign. These can be 
chosen from the Siebel popup list, 
and the corresponding strings will be 
sent as GSW_CALLBACK_TYPE values to 
OCS. For more information, see 
“Advanced Customization of Voice 
Component Configurations” on 
page 164.

Service:OCSCancelScope AllChain No Specifies the scope of a cancel: 
AllChain, or RecordOnly. For more 
information, see “Advanced 
Customization of Voice Component 
Configurations” on page 164 and 
“USE_RECORD_HANDLE Use Case” 
on page 191.

Service:OCSDoNotCallScope AllChain No Specifies the scope of a Do Not Call: 
AllChain, or RecordOnly. For more 
information, see “Advanced 
Customization of Voice Component 
Configurations” on page 164 and 
“To Specify DoNotCall Command 
Attributes” on page 189.

Service:OCSEnableCustomerId TRUE No Controls the use of Contact ID for 
compatibility with release 6.5.2 or 
earlier of Outbound Contact Server. 
For more information, see 
“Advanced Customization of Voice 
Component Configurations” on 
page 164.

Table 15: Driver Parameters (Continued) 
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Service:OCSTreatment RecordTreatPersonal No Specifies the treatment type: 
RecordTreatPersonal, 
RecordTreatCampaign, or None. 
These can be chosen from the Siebel 
popup list as Personal, Campaign, or 
None, and for the first two, the 
corresponding strings will be sent as 
GSW_CALLBACK_TYPE values to OCS. 
For None, GSW_CALLBACK_TYPE is not 
sent to OCS. For more information, 
see “Advanced Customization of 
Voice Component Configurations” 
on page 164.

Service:ReleaseCallOnAutoLogout TRUE No When the value of this parameter is 
set to FALSE, the Adapter will not 
release an active call if an agent 
closes the browser or logs out from 
Siebel. If the value of this parameter 
is TRUE and the option AutoLogout 
= “TRUE”, when the agent logs out 
from Siebel or closes the browser, 
then:

1. The Adapter will send a request to 
release the call if the ReleaseCall 
command is enabled in the current 
call state;

2. The Adapter will send a request to 
log out the agent from the ACD 
group if the LogOut command is 
enabled in the current state;

3. Only then does the agent log out 
from Siebel.

Note that this functionality is switch 
and T-Server dependent. Some T-
Servers may require changes to 
options in order to keep an active 
call on logout.

Table 15: Driver Parameters (Continued) 
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Service:

ReleaseEstablishedCallOnAuto
Logout

TRUE No When the value of this parameter is 
set to FALSE, the Adapter will not 
release an established call if an agent 
closes the browser or logs out from 
Siebel. If the value of this parameter 
is TRUE and the option AutoLogout 
= “TRUE”, when the agent logs out 
from Siebel or closes the browser, 
then:

1. The Adapter will send a request to 
release an established call if the 
ReleaseCall command is enabled in 
the current call state;

2. The Adapter will send a request to 
log out the agent from the ACD 
group if the LogOut command is 
enabled in the current state;

3. Only then does the agent log out 
from Siebel.

Note that this functionality is switch 
and T-Server dependent. Some T-
Servers may require changes to 
options in order to keep an active 
call on logout.

Service:RequestTimeOut 30 No Timeout period for requests to 
Outbound Contact Server.

Service:SelectDN {@SelectedDN} No Specifies a DN to be used to issue 
commands such as MakeCall and so 
forth. Otherwise, the first DN in the 
list specified with the parameter 
Service:DNList is used.

This parameter is also used for 
SendUserEvent command; it defines 
the DN on which the user event will 
be sent.

Service:SwitchName CHANGE_ME No Voice switch name, which Voice 
callabck server uses for submiting 
Voice callbacks

Table 15: Driver Parameters (Continued) 
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Service:UsePendingWorkmode FALSE No Applicable only when using the 
Avaya Definity G3 switch. 
Parameter Service: 
UsePendingWorkmode must be set 
according to the T-Server option 
use-pending-work-mode. Both 
parameters must be set to the same 
value: true or false. When the T-
Server option use-pending-work-
mode is set to true, the Pending 
Work Mode functionality is enabled.

Service:UseSStepTransferForNet
workTransfer

FALSE No To perform a network transfer with 
the Device Command TransferSStep 
for all switches, set this parameter to 
TRUE. The Device Command 
parameter RemoteConnectStr must 
define the name of the Network 
Switch where call should be 
transferred. 

When this parameter is set to 
FALSE, for the switches that support 
Mute Transfer and do not support 
Single Step Transfer, the Adapter 
will invoke the request to T-Server 
to perform Mute Transfer with the 
Device Command TransferSStep for 
the switches that support Mute 
Transfer and do not support Single 
Step Transfer. 

If you do not perform network 
transfers, leave the value set to 
FALSE (the default value).

Service: 
VCBDefaultCallbackType

ASAP No Default Callback Type which Gplus 
adapter uses in case Callback type 
information is missing in the request 
form Siebel.

Table 15: Driver Parameters (Continued) 
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Parameter Driver:SupervisorExtensions

The configuration parameter Driver:SupervisorExtensions defines a set of 
Supervisor Extensions which should not be shown on the agent desktop when 
the supervisor is connected to the agent’s current Voice interaction (call). 

Valid values for this parameter are defined by the following rules:

• A valid value is a string parameter consisting of: a set of DNs separated by 
commas, a range of DNs in which a hyphen (-) is used as a separator and 
the first number is less than the last number, or a mix of both. 

• The maximum length of the string parameter is 250 characters. 

• Spaces are allowed after commas, and before and after a hyphen. 

For example: 

2201, 2205, 2300 - 2374 

• A valid value can also be a simple file name, or a path and a file name. In 
any environment, you can use a simple filename, such as 
SupervisorExtensions.txt, for example. Other examples are: 
 On a Windows platform - C:\siebsrvr\SupervisorExtensions.txt. 
 On a UNIX platform - /opt/siebsrvr/SupervisorExtensions.txt 
 The named file itself must contain the set of SupervisorExtensions. The 

file must contain a set of DNs separated by commas, or a range of 
DNs, or a mix, with valid values as defined in the rules above; and in 
addition: 
 New lines can also serve as separators. 
 The maximum number of SupervisorExtensions is limited by the 

allowed size of the file in the operating system. 
For example:

Service: 
VCBDefaultRoutingPoint

CHANGE_ME No Default routing point, which Gplus 
adapter uses in case routing point 
information is missing in the request 
from Siebel

Service:

VCBProcessedOnCallRelease

FALSE No Indicates that the Work Item will be 
kept on Call release event and the 
agent must manually click the 
Interaction Processed button on the 
communication Toolbar. This must 
be synchronized with the VCB 
server option callback_processed. 

Table 15: Driver Parameters (Continued) 
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2201,2210

2211, 2212

3

2213-2220,

2303 - 2310

7123

8234

9345 

 If the file name is provided without a path, then the Gplus Adapter will 
search for the file in locations defined by the operating system 
environment variable ‹path›. If the file is not found, then the Gplus 
Adapter will search for the file in the following locations:
 On a Windows platform - ‹Siebel Server folder›\BIN\ 
 On a UNIX platform - ‹Siebel Server folder›/lib/

Parameter Driver: HangupOnEventReleased

The configuration parameter Driver:HangupOnEventReleased is used only 
when the Gplus Adapter works with NEC NEAX switches (NEC NEAX 2000 
IPS, NEC NEAX ICS/IMS (7600, 7400)...). This configuration parameter must 
be set up accordingly when a NEC NEAX switch is used.

If the switch configuration requires the phone to be put on the hook after a call 
is released on the other side, then the Gplus Adapter must send an additional 
Release request after receiving EventReleased. In this case, the value must be 
set to “TRUE” (the default value), as follows: 

Driver:HangupOnEventReleased    = “TRUE”

If the switch configuration does not require the phone to be put on the hook, 
then set this parameter to “FALSE”, as follows: 

Driver:HangupOnEventReleased    = “FALSE”

Note that the default value is TRUE.

Parameter Service:UsePendingWorkmode

This parameter is used to enable or disable Ready/NotReady Device 
Commands when an agent has a call on the Avaya Definity G3 switch.

When using the Avaya Definity G3 switch, the configuration parameter 
Service:UsePendingWorkmode must be set according to the T-Server option 
use-pending-work-mode. Both parameters must be set to the same value: true 
or false. When the T-Server option use-pending-work-mode is set to true, the 
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Pending Work Mode functionality is enabled. This functionality allows agents 
to change their Ready/NotReady state when a call is in progress.

Parameters Driver:InboundPartyContainer and 
Driver:OutboundPartyContainer

The Gplus Adapter allows (with some TEvents) to display an adjusted 
(modified) workitem name on the Siebel Toolbar by using the value of some 
other TEvent Attribute.

Siebel configuration parameters Driver:InboundPartyContainer and 
Driver:OutboundPartyContainer allow adjustments depending on their value. 
The implemented functionality for both parameters is the same, the only 
difference is that Driver:InboundPartyContainer defines the adjustment (if 
any) for incoming calls, while Driver:OutboundPartyContainer defines the 
adjustment (if any) for outgoing calls.

If the Driver:InboundPartyContainer or Driver:OutboundPartyContainer 
parameter is defined in Siebel configuration and if the value described by the 
parameter was found in the incoming TEvent attributes, then the value defined 
by this attribute is shown in a Work Item on the Communications Toolbar.

If parameters Driver:InboundPartyContainer and/or 
Driver:OutboundPartyContainer define the attribute name for an adjustment, 
but this attribute is not in the TEvent, then the OtherDN attribute is used.

Acknowledged values for Driver:InboundPartyContainer and 
Driver:OutboundPartyContainer and their actions are shown in Table 16:

Table 16: Driver:InboundPartyContainer and 
Driver:OutboundPartyContainer Values and Actions

Value Action

No parameter in the 
configuration, or <empty 
string>

Keeps the representation of the Work Item list 
without substitution of the value defined by the 
Driver:InboundPartyContainer or 
Driver:OutboundPartyContainer 
configuration parameter

OtherDN, or Native Keeps the representation of the Work Item list 
without substitution of the value defined by the 
Driver:InboundPartyContainer or 
Driver:OutboundPartyContainer 
configuration parameter

ANI Substitutes the value of TEvent ANI attribute 
in a Work Item representation on the 
Communications Toolbar
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DNIS Substitutes the value of TEvent DNIS attribute 
in a Work Item representation on the 
Communications Toolbar

<Name of parameter defined 
in UserData of TEvent>

Substitutes the value of <string or integer 
parameter defined in UserData of TEvent> 
in a Work Item representation on the 
Communications Toolbar.

Table 16: Driver:InboundPartyContainer and 
Driver:OutboundPartyContainer Values and Actions (Continued) 

Value Action
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Important note!

Driver:InboundPartyContainer and/or Driver:OutboundPartyContainer  
parameter substitution in the Work Item name is not performed in the 
conference scenarios when number of parties displayed is greater than one.

When using the UserData parameter to make a substitution in the Work Item 
name, the parameter described by Driver:InboundPartyContainer and/or 
Driver:OutboundPartyContainer must be included as a string or an integer pair 
in the UserData list, not hidden in the inner lists. For example:

If parameters are defined in Siebel configuration as follows:
Driver:OutboundPartyContainer = "Destination"

Driver:InboundPartyContainer  = "Originator" 

UserData:

(Int) Destination 43262

(Int) Originator 87654

And/Or
(Str) Destination str_43262

(Str) Originator str_87654

Important note!

If the modification of the Work Item name is going to be used and if DNIS and 
ANI attributes are represented in the TEvents, then it is recommended to use 
the following values:
InboundPartyContainer ANI

OutboundPartyContainer DNIS

It is possible to use modification of the appearance of the Work Item name on 
the Communications Toolbar with single commands with Command Data.

See the following example of Command:ConferenceTransferToPhone.

If parameters are defined in Siebel configuration as follows:
Driver:OutboundPartyContainer = "Destination"

Driver:InboundPartyContainer  = "Originator" 

then Param.Originator and Param.Destination can be defined in a CmdData to 
define destination and originator of the call. 

So, Command:ConferenceTransferToPhone can be defined as follows:

[Command:ConferenceTransferToPhone]
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   DeviceCommand     = "ConferenceInit"

   Description       = "Conference Transfer to "{@Phone}""

   CmdData           = "ConferenceTransferToPhone"

   OnEditControl     = "TRUE"

   Hidden            = "TRUE"

   CmdChannelOnFocus = "TRUE"

   Profile           = "Sergo Voice"

[CmdData:ConferenceTransferToPhone]

      AttachContext        = "TRUE"

      RequiredField.@Phone = "?*"

      Param.PhoneNumber    = "{@Phone:PhoneTypeLookup}"

      Param.CallNotifyText = "Conference transfer from {@UserName} ..."

      Param.TrackingID     = "{@SelectedWorkItem:DriverWorkTrackID}"

      Param.Originator     = "{@SelectedDN}"

      Param.Destination     = "{@Phone:PhoneTypeLookup}"

When conference is initiated from the Siebel Toolbar, then phone number from 
EditControl box on the Toolbar and SelectedDN will be the call destination 
and call originator.

When using Parameters in a Command Data (User Data) for substitution, T-
Server option consult-user-data must be set to separate (not joint). It 
separates UserData attached to the call and this attached data is kept separate 
and not overwritten by the other data from consult calls.

Gplus Adapter Application Name

The Configuration parameter Driver:AdapterAppName defines the application 
name that will be sent to T-Server when the Adapter opens a connection to this 
T-Server.

If the parameter was not defined in the Siebel configuration, then the default 
value is used, which is Gplus adapter. For example:

Driver:AdapterAppName=   "GP Adapter"

ADDP Support

The Gplus Adapter supports the Advanced Disconnect Detection Protocol 
(ADDP). ADDP allows the Adapter to detect disconnections from T-Server. To 
enable this protocol and configure it in the Gplus Adapter, you must define the 
following parameters in the Adapter's configuration. (These parameters are 
also described in Table 15 on page 204.)



Gplus Adapter for Siebel CRM—Deployment Guide 225

Chapter 5: Configuration and Installation of the Voice Component Agent Work Modes Emulation

• Driver:Timeout - This parameter defines a time interval, in seconds, during 
which the Adapter waits for an ADDP response from the T-Server. ADDP 
is disabled if this parameter is not defined or if the value is set to 0. 

• Driver:RemoteTimeout - This parameter defines a time interval, in 
seconds, during which the T-Server waits for an ADDP response from the 
Adapter.

• Driver:TraceMode - This parameter defines an ADDP trace mode in 
T-Server and/or in Adapter log files. The value of this parameter affects 
log generation only. ADDP polling messages and the algorithm for 
disconnection detection remain the same, regardless of the value set here.

Warning! To avoid false detection of disconnect states that might occur 
because of normal delays in the data network, Genesys 
recommends that you set the ADDP timeouts to values greater than 
10 seconds, and that you set all local ADDP timeouts to the same 
value.

Agent Work Modes Emulation
The Gplus Adapter can emulate the work modes AgentManualIn and 
AgentAutoIn for some switches that normally do not support these modes. For 
such switches, the value of parameter Service:AgentWorkMode can be set to 
allow emulation of an agent work mode. 

Emulation means that the an agent state could be changed by GPlus Adapter 
according to the work mode defined in a Siebel configuration. Agent work 
mode is defined in a Siebel configuration by the value of parameter 
Service:AgentWorkMode or AgentWorkMode parameter sent with NotReady, 
Ready, ChangeNotReadyState or Login Device Commands.

The default value of parameter Service:AgentWorkMode is 
AgentWorkModeUnknown. 

Agent work mode could be changed when an agent invokes Device Command 
NotReady, Ready, ChangeNotReadyState or Login with parameter 
AgentWorkMode set to the new value.

The valid values of AgentWorkMode and corresponding desktop behavior can 
be summarized as follows:

• If AgentWorkMode is equal to AgentWorkModeUnknown, then the Gplus 
Adapter does not change the agent state after login or when an agent has a 
a call on a the agent teleset. It is possible that some switches may change 
the agent’s state by distributing T-Events according to the switch 
configuration and functionality.
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• If AgentWorkMode is equal to AgentManualIn, then (if the agent state is 
Ready) the Adapter sets an agent state to Not Ready after login or after an 
the agent answers a call on the agent’s teleset. This happens only if the 
switch and T-Server are allowed to set the agent to the NotReady state 
when the agent has a call on the DN. 

• If AgentWorkMode is equal to AgentAutoIn, then (if the agent state is Not 
Ready) the Adapter changes an agent state to Ready immediately after 
login and after a call is released. The Adapter changes the state only if the 
state after login was NotReady or if the agent state on call was NotReady.

For the switches that do not support emulation of the work modes, the value of 
the configuration parameter Service:AgentWorkMode must be set to either 
“CHANGE_ME” or “AgentWorkModeUnknown”. The Ericsson MD-110, the 
Siemens Realtis-DX (iSDX), and Aspect Call Center are examples of such 
switches.

Agent States on Telesets with Multiple 
Positions and ACD Queues

Some switches, such as the Ericsson MD-110, support telesets with multiple 
positions and ACD Queues. 

In such environments, an agent can be logged into multiple Queues. Also, 
before login into Siebel, an agent can be in different and even opposite states 
on different Positions residing on the same teleset. 

Siebel cannot support and maintain an Agent state, DN Forwarding Status, and 
DoNotDisturb state individually for each DN for such switches. 

For such switches, the Agent state, DN Forwarding Status, and DoNotDisturb 
(DND) status are maintained by the Gplus Adapter only for the whole teleset.

The general rules for this environment are as follows: 

• An agent is considered to be in a Ready(NotReady) state if the agent is in 
the Ready(NotReady) state on at least one of the Agent’s teleset DNs.

• The forwarding state of the Agent’s teleset is considered to be “ON” if 
forwarding is set on one of the Agent’s teleset DNs.

• The DoNotDisturb (DND) state of the Agent’s teleset is considered to be 
“ON” if DND is set on one of the Agent’s teleset DNs.

If, before logging into Siebel, an agent has different Ready states on different 
DNs that belong to the same teleset, then, after login to Siebel, the agent can 
synchronize his or her state on all telesets DNs by using the Ready/NotReady 
Commands on the Communications Toolbar. This is generally recommended. 
When you perform this synchronization of agent states on different DNs, you 
may get an error message such as “Set is in target state”. This indicates that 
you were already in the requested state on some DN or DNs on this teleset.
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If, before logging into Siebel, an agent has a DN forwarding state set on any 
DN that belongs to the same teleset, then the DN forwarding state on all teleset 
DNs can be synchronized. This is generally recommended. After logging into 
Siebel, you can do this by invoking the ForwardCall or CancelForwardCall 
device commands on the Communications Toolbar.

If, before logging into Siebel, an Agent has set DoNotDisturb (DND) states on 
any DN that belongs to the same teleset, then the DoNotDisturb (DND) states 
on all teleset DNs can be synchronized. This is generally recommended. After 
logging into Siebel, the agent can do this by invoking the SetBusy or 
CancelBusy device commands on the Communications Toolbar. 

Log Files 
All Gplus Adapter for Siebel CRM Voice Log messages are now processed by 
the Genesys Gplus Communication Server. File names of the log files are 
defined in the log section of the Genesys Gplus Communication Server 
application in Genesys Configuration Manager. See details for configuration of 
the log file output in “Log Section” on page 40 of Chapter 2, “Configuration 
and Installation of the Gplus Communication Server for Siebel CRM.” 

Driver Commands and Events
This section provides a complete list of all driver commands and events for the 
Voice Component, including the Outbound Contact feature, and Expert 
Contact feature. For additional information, refer also to deployment guides 
and developer’s guide for related products.

Driver Commands for the Voice Component

Table 17 contains a complete list of all of the driver commands for the Voice 
Component. These commands may be used in the Siebel Communications 
Configuration as device commands for communication commands.  

Table 17: Driver Commands

Name Component/ 
Feature Description

AnswerCall Voice Answer incoming call

ReleaseCall Voice Release call

TransferSStep Voice Single-step transfer of the selected call

TransferMute Voice Mute transfer of the selected call
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TransferInit Voice Initiate two-step transfer

TransferComplete Voice Complete two-step transfer

ReconnectCall (previously, 
RetrieveCall)

Voice Reconnects the original call initiated using 
ConferenceInit or TransferInit before 
ConferenenceComplete or TransferComplete

HoldCall Voice Places the selected call on hold

ResumeCall Voice Reconnects a call that was on hold

ResumeInactiveCall Voice Reconnects a callback that was on hold

MakeCall Voice Make an outbound call

ConferenceSStep Voice Initiate a single-step conference

ConferenceInit Voice Initiate a two-step conference

ConferenceComplete Voice Complete a two-step conference

DeleteFromConference Voice Deletes a party from a conference call

LogIn Voice Logs in an agent

LogOut Voice Logs out an agent

Ready Voice Switches an agent’s readiness state to Ready 
on all agent DNs if agent’s state was 
NotReady.

NotReady Voice Switches an agent’s readiness state to 
NotReady on all agent DNs if the agent’s state 
was Ready.

ChangeNotReadyState Voice Switches the agent’s readiness state from 
Ready to NotReady or from NotReady to 
Ready on all agent DNs. 

SetActiveCall Voice Notify driver that currently selected call has 
changed

ForwardCall Voice Initiates call forwarding

CancelForwardCall Voice Cancels call forwarding

ToggleForward Voice Turns call forwarding on or off

Table 17: Driver Commands (Continued) 

Name Component/ 
Feature Description
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SetBusy Voice Sets Do Not Disturb mode for all of an agent’s 
DNs

CancelBusy Voice Cancels Do Not Disturb mode for all of an 
agent’s DNs

ChangeBusyState Voice Turns Do Not Disturb mode on or off

AttachData Voice Attaches user data to the selected call

SendUserEvent Voice Sends User Event to the selected DN

UpdateUserData Voice Updates the user data that is attached to the 
selected call

DeleteUserData Voice Removes specified user data from the attached 
data for the selected call

QueryAddress Voice Sends query to T-Server to return information 
about a specified DN and ACD Queue

SendUserEventOnCommDN Voice Sends a user event to a Communication DN

CallSupervisor Voice When the agent is on an ACD call, this 
command initiates a conference leg to the 
agent’s supervisor. The supervisor must push 
the “Answer Agent” key to complete the call 
leg to the supervisor. 

EmergencyKey Voice When the agent is on an ACD call, this 
command initiates a conference leg to the 
agent’s supervisor and to a recording device, if 
such a device is installed. The supervisor must 
push the “Answer Emergency” key to 
establish the call leg.

Expert Contact Feature

KwOnCall Expert Contact Informs CTI-Less T-Server that the Expert is 
On Call

KwPreviewIntReject Expert Contact Rejects incoming Preview interaction

Table 17: Driver Commands (Continued) 

Name Component/ 
Feature Description
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KwPartyStatusResponse Expert Contact Agent provides current call status in response 
to KwPartyStatusRequest. Configurable on 
the CTI-Less T-Server side. 

Outbound Contact Feature

PreviewDialingModeStart Outbound Contact Starts the Preview Dialing Mode

PreviewDialingModeOver Outbound Contact Ends the Preview Dialing Mode

PreviewRecordRequest Outbound Contact Requests a Preview record

UpdateCallCompletionStats Outbound Contact Updates call statistics and values

RecordProcessed Outbound Contact Completes record processing

RecordReject Outbound Contact Rejects record

RequestRecordCancel Outbound Contact Cancels a record for a particular campaign

RecordReschedule Outbound Contact Reschedules a record

ScheduleRecordReschedule Outbound Contact Reschedules a record (same as 
RecordReschedule)

DoNotCall Outbound Contact Marks phone, record, chain, or customer as 
Do Not Call

ChainedRecordRequest Outbound Contact Requests the rest of the chain

AddRecord Outbound Contact Adds record to the chain

Web Callback Feature
(Not supported starting from version 7.2)

CALLBACK_REJECTED Web Callback Reject a web callback request

CALLBACK_ACCEPTED Web Callback Accept a web callback request

CALLBACK_DONE Web Callback Web callback request was successfully made

Voice Callback Feature

VCBServiceStatus Voice Callback Starts the Voice Callback session

Table 17: Driver Commands (Continued) 

Name Component/ 
Feature Description
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Support for the Emergency/Supervisor Key
The Gplus Adapter 7.5 for Siebel CRM has the capability to create a no-hold 
conference call leg to a supervisor or emergency DN. This feature is supported 
only on the Nortel Symposium switch. 

With a properly customized Communications Toolbar, an agent can press a 
button to initiate a special type of conference request. By doing so, the agent 
issues a TPrivateService to initiate a no-hold conference. The no-hold 
conference allows the agent to dial and conference without putting the 
customer on hold. 

Invoking the CallSupervisor feature when the agent is in an ACD call initiates 
a conference leg to the agent’s supervisor. The supervisor must click the 
Answer Agent button on the phone, which establishes that call leg to the 
supervisor. Invoking the EmergencyKey feature initiates a conference leg to the 
agent’s supervisor, and, if installed, to a recording device. The acting 
supervisor must answer the call by clicking the Answer Emergency button on 
the supervisor’s phone set.

Note: This command is supported by the Adapter; but the customer must 
create a custom button to implement this feature.

This new functionality includes two device commands, CallSupervisor and 
EmergencyKey, to invoke corresponding functions. These are described below.

VCBCancel Voice Callback Cancels Voice Callback and deletes request 
from Voice Callback server

VCBReschedule Voice Callback Reschedules Voice Callback

VCBAdd Voice Callback Creates new Voice callabck and submits for 
processing 

VCBProcessed Voice Callback Marks Callback record as done

VCBReject Voice Callback Rejects Callback record for rerouting to other 
agents

Table 17: Driver Commands (Continued) 

Name Component/ 
Feature Description
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Note: Both device commands (CallSupervisor and EmergencyKey) can be 
invoked without parameters. Parameter TrackingID can be defined in 
the [CmdData: ] section of Command. For details about this 
functionality, see “Parameter TrackingID” on page 233.

CallSupervisor

Invoking the CallSupervisor DeviceCommand when the agent is in an ACD 
call initiates a conference leg to the agents supervisor. The supervisor must 
press the “Answer Agent” button, which establishes that call leg to the 
supervisor. For details about CallSupervisor configuration, refer to the 
configuration sample below.

If the CallSupervisor service is invoked:

• If the Agent releases the call, call is released from the Agent DN. The call 
between the contact and supervisor phones persists

• If the customer releases the call, an EventReleased message is received on 
Agent DN, but the call between the agent and supervisor phones persists.

• Calls through the ACD queue are not distributed to the agent. 

• After this call is released, ACD queue will continue to distribute calls to 
the agent DN. 

CallSupervisor Configuration Sample

[Command:CallSupervisor]

; For Nortel Meridian CallCenterSymposium ONLY!

   DeviceCommand     = "CallSupervisor"

   Description       = "Call Supervisor request"

   CmdData           = "CallSupervisor"

   Hidden            = "TRUE"

   CmdChannelOnFocus = "TRUE"

   Profile           = "Gplus Voice"

[CmdData:CallSupervisor]

Param.TrackingID          = 
"{@SelectedWorkItem:DriverWorkTrackID}"

EmergencyKey

Invoking the EmergencyKey DeviceCommand initiates a conference leg to the 
agent’s supervisor, and, if installed, to a recording device. The acting 
supervisor must answer the call by pressing the “Answer Emergency” button 
on the supervisor’s phone set. For details about EmergencyKey configuration, 
refer to the configuration sample below.
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If the EmergencyKey service is invoked:

• If the Agent releases the call, then the call is released on the supervisor’s 
phone, the contact’s phone, and the Agent’s phone; 

• If the contact releases the call, there is no CTI messaging, and the call 
between the agent and supervisor phones persists. After releasing this call, 
an EventReleased message is received on the Agent DN.

EmergencyKey Configuration Sample

[Command:EmergencyKey]

; For Nortel Meridian CallCenterSymposium ONLY!

   DeviceCommand     = "EmergencyKey"

   Description       = "Emergency request"

   CmdData           = "EmergencyKey"

   Hidden            = "TRUE"

   CmdChannelOnFocus = "TRUE"

   Profile           = "Gplus Voice"

[CmdData:EmergencyKey]

Param.TrackingID          = 
"{@SelectedWorkItem:DriverWorkTrackID}"

Parameter TrackingID

Both device commands (CallSupervisor and EmergencyKey) can be invoked 
without parameters. Parameter TrackingID can be defined in the [CmdData: ] 
section of Command or it can be omitted. If parameter TrackingID is defined 
in the [CmdData: ] section, then the Gplus Adapter will use this value to 
identify the call to which the CallSupervisor or EmergencyKey Device 
Command is applicable. If Parameter TrackingID is not defined or if Siebel 
Communication Server supplies the empty string value for this parameter, then 
CallSupervisor or EmergencyKey Device Command is called for the current 
call.

DoNotDisturb Status

DoNotDisturb (DND) status can be set to ON or OFF on the DN with these 
Device Commands: SetBusy, CancelBusy, and ChangeBusyState. 

When the DND status is established for a DN, then calls are not distributed to 
or received by this DN. 

Some switches and T-Servers (Avaya INDeX, for example) do not provide this 
information about DND status when they register DNs. When these switches 
are used, if a DND state was set to “ON” on the DN, and then an agent logs in 
to Siebel, the Communications Toolbar indicates that the DND state is OFF 
(the default value). In order to synchronize the DND state on the switch for this 
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DN with the DND state shown on the Siebel Communications Toolbar, the 
agent must use the phone to switch off the DND state.

When the Gplus Adapter works with such switches, the agent must perform the 
same synchronization of the DND state if a T-Server restarts after the DND 
state was set to “ON” on the switch.

Driver Events for the Voice Component

This section describes the device events implemented by the Voice 
Component. A device event is a notification of a communications occurrence 
that the Siebel client receives from the Communications driver (the Gplus 
Adapter in this case) along with some data fields (parameters).

For example, when a connection between the agent’s phone and the destination 
is established for an incoming or outbound call, the Siebel client can be 
notified with the EventEstablished device event with associated data 
(parameters), such as OtherDN, ANI and others shown in Table 19, “Parameters 
Used with Device Events of the Voice Component,” on page 238. For further 
information, see the Siebel Communications Server Administration Guide.

The parameters used with the device events are listed in Table 19 on page 238. 
Descriptions of the device events begin with the topic, “Detailed Descriptions 
of Device Events” on page 286.

The following table contains the description of Communications driver events. 
These events may be used in Siebel Communications Configuration as device 
events for communications events.

Table 18: Communications Driver Events

Name Feature/ 
Configuration Description

Voice Component

EventDialing Voice Dialing notification when making a call.

EventRinging Voice Incoming call ringing.

EventEstablished Voice Call established (inbound or outbound).

EventReleased Voice Call released or abandoned.

EventHeld Voice Call is held.

EventRetrieved Voice Call is retrieved.

EventUserDataChanged Voice Call user data changed.

EventRegistered Voice DN is registered.

EventUnregistered Voice DN is unregistered.
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EventCallForwardSet Voice Call forwarding is set.

EventCallForwardCancel Voice Call forwarding is canceled.

EventAgentBusy Voice Do Not Disturb mode has been set.

EventAgentNotBusy Voice Do Not Disturb mode has been canceled.

EventAgentLogin Voice Agent is logged in.

EventAgentLogout Voice Agent is logged out.

EventAgentReady Voice Agent became ready.

EventAgentNotReady Voice Agent became not ready.

EventServerConnected Voice Connection to T-Server is established.

EventServerDisconnected Voice Connection to T-Server is lost.

EventError Voice Error received from T-Server.

EventACK Voice T-Server has acknowledged a request 
received from a client application. The 
event is a response to TSendUserEvent.

EventUserEvent Voice User event from another client application.

EventPartyChanged Voice Call party was replaced by another party.

EventPartyAdded Voice Party was added to the conference call.

EventPartyDeleted Voice Party was deleted from the conference 
call.

EventPartyInfo Voice Information about call parties.

Expert Contact Feature

EventKwPreviewIntError Expert Contact Preview Interaction error

EventKwPreviewRequest Expert Contact Preview interacting request

EventKwPreviewIntCancel Expert Contact Preview interaction canceled by T-Server

EventKwPreviewIntAccepted Expert Contact Response from T-Server that interaction 
was accepted 

Table 18: Communications Driver Events (Continued) 

Name Feature/ 
Configuration Description
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EventKwPreviewIntRejected Expert Contact Response from T-Server that interaction 
was rejected

EventKwError Expert Contact CTI-Less T-Server error

EventKwAck Expert Contact T-Server response

EventKwOnCallResponse Expert Contact Response from CTI-Less T-Server after 
agent clicks On Call button.

EventKwPartyStatusRequest Expert Contact Request from CTI-Less T-Server to 
provide current call status. 

EventKwPartyStatusAck Expert Contact Acknowledge that party status request was 
submitted to CTI-less T-Server

Outbound Contact Feature

EventAddRecordAck Outbound Contact Record has been added.

EventCampaignLoaded Outbound Contact Campaign has been loaded.

EventCampaignModeChanged Outbound Contact Campaign mode has been changed.

EventCampaignStarted Outbound Contact Campaign has started.

EventCampaignStopped Outbound Contact Campaign has stopped.

EventCampaignUnloaded Outbound Contact Campaign has been unloaded.

EventChainedRecord Outbound Contact Chained record delivered.

EventChainedRecordDataEnd Outbound Contact Whole chain delivered.

EventChainedWorkItemChanged Outbound Contact Chained work item in the Work Items list 
changed.

EventCurrentWorkItemChanged Outbound Contact Work item in the Work Items list changed.

EventOCSError Outbound Contact Outbound Contact Server error.

EventScheduleCall Outbound Contact Scheduled record delivered.

EventPreviewModeOverAck Outbound Contact Preview Dialing session is over.

EventPreviewModeStartAck Outbound Contact Preview Dialing session has been started.

EventPreviewRecord Outbound Contact Preview record delivered.

Table 18: Communications Driver Events (Continued) 

Name Feature/ 
Configuration Description
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Parameters of the T-Library Event

Table 19 on page 238 lists parameters of the T-Library Event that can be used 
by the Voice Component as parameters sent to Siebel when the event handler is 
invoked. Use this list in combination with the topic, Device Events for the 

EventPreviewRecordEmpty Outbound Contact No more records exists in the Outbound 
Contact Server database.

EventRecordProcessedAck Outbound Contact Record has been processed.

EventRecordRejectAck Outbound Contact Record has been rejected.

EventRecordCancelAck Outbound Contact Record has been canceled.

EventRecordRemove Outbound Contact Request to remove record from desktop.

EventRecordRescheduleAck Outbound Contact Record has been rescheduled.

EventSchRecordRescheduleAck Outbound Contact Scheduled record has been rescheduled 
(same as 
RecordRescheduledAcknowledge).

EventUpdCallComplStatsAck Outbound Contact Call statistics and values have been 
updated.

EventLogOutTime Outbound Contact Notification from Outbound Contact 
Server about the time left until an agent 
logs out in Predictive Dialing mode.

EventLogOutAck Outbound Contact Automatic logout acknowledge.

Web Callback Feature
(Not supported starting from version 7.2)

EventCallBackRequest Web Callback Request for a web callback.

EventCallbackCancel Web Callback Record has been canceled.

EventCallBackRejected Web Callback Record has been rejected.

EventCallBackDone Web Callback Record call back was successfully made.

Table 18: Communications Driver Events (Continued) 

Name Feature/ 
Configuration Description
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Voice Component under “Detailed Descriptions of Device Events” on 
page 286.

Table 19: Parameters Used with Device Events of the Voice Component

Parameter 
Name Type Description

ConnID Mandatory ConnectionID.

CallType Mandatory Call types are Incoming, Outbound, Internal, 
ConsultTransfer, ConsultConference, Consult or 
Unknown. See Table 20 on page 239 for a description of 
call types.

ThisDN Optional ThisDN TEvent attribute (agent’s DN, which received 
the call).

OtherDN Optional OtherDN TEvent attribute, OriginationDN in case of 
internal call.

ThirdPartyDN Optional ThirdPartyDN TEvent attribute, origination of the 
transferred or conferenced call.

ANI Optional ANI (Automatic Number Identification).

DNIS Optional DNIS (Dialed Number Identification Service).

PreviousConn
ID

Optional Previous ConnectionID: The ConnectionID of the held 
call, if any.

ErrorCode Optional Error Code if TEvent is EventError.

ErrorMessage Optional Error message if TEvent is EventError.

AgentID Optional This parameter uniquely identifies the agent.

ThisQueue Optional The directory number of the most significant ACD group 
in relation to a specific event.

CollectedDigits Optional The digits that have been collected by the device 
collecting the digits (for example, an IVR).

Server Version Optional The version (release umber) of the running T-Server.

CustomerID Optional A pointer to the string containing the assigned Customer 
(Tenant) identifier through which the processing of the 
call was initiated. 

HomeLocation Optional A pointer to the name of the host where T-Server is 
running.
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Call Types

The Gplus Adapter reports call types to Siebel using, CallType and 
CallTypeExt fields. Original information about call types comes in a CallType 
Attribute of TEvent. The Gplus Adapter defines the CallTypeExt field based 
on the CallType and call flow. In the CallType field, the Adapter sends integer 
values, while the CallTypeExt field sends values of type string. In this release 
the way Gplus Adapter reports call types to Siebel has changed. Table 20 lists 
the possible call types for the Gplus Adapter.

AccessNumber Optional A pointer to a number derived when a client application 
dials from the specified switch, and allows the user to 
reach a specific External Routing Point.

Place Optional Place attribute of TEvent.

ReferenceID Optional ReferenceID is a unique identifier generated by a T-
Server client and attached to the request this client sends 
to T-Server.

CallState Optional The current status of the call the event relates to.

WorkMode Optional Agent work mode.

ThisTrunk Optional The identifier or the most significant trunk in relation to 
a specific event.

ThisDNRole Optional The role of the telephony object specified by ThisDN.

MediaType Optional The MediaType attribute of TEvent.

All others Optional The call’s user data.

Table 19: Parameters Used with Device Events of the Voice Component (Continued) 

Parameter 
Name Type Description

Table 20: Call Type Fields

CallType CallTypeExt Description

0 (for Unknown) Unknown or any other 
CallTypeExt value

Call type is unknown. The Adapter cannot define call 
type based on call flow.

1 (for Internal) InternalTo Internal call (for example, agent-to-agent call).

1 (for Internal) InternalFrom Internal call (for example, agent-to-agent call).

1 (for Internal) Internal An agent is on a call with another agent. The Adapter 
cannot define who initiated the call.
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Detailed Descriptions of Device 
Commands

This section provides detailed descriptions of device commands that are 
supported by the Gplus Adapter Voice Component. A device command is a 
feature of the Communications driver (Gplus Adapter in this case) that can 
execute a particular function, implemented in a driver.

Usually the command is a request from the Siebel client to the 
Communications driver to make a call, accept a call, transfer a call or make a 
conference with another Agent and so on.

The following tables use the terms <datasetParam>, <AttributeExtensions>, 
and <Other parameters>, which are defined below:

The term <datasetParam> is used in the tables to describe the set of parameters 
for a particular device command. The <datasetParam> is a set of parameters 
that are defined in the command data with the prefix Param. 

The term <AttributeExtensions> designates a specific subset of the 
<datasetParam>. This subset of the parameters is defined in a <datasetParam> 

1 (for Internal) Conference There are more than two parties on the call.

2 (for Inbound) Inbound Inbound call from customer.

2 (for Inbound) Conference There are more than two parties on the call.

3 (for Outbound) Outbound Outbound call to customer.

3 (for Outbound) Conference There are more than two parties on the call.

4 (for Consult) ConsultTransfer Consult call when an agent tries to transfer a call to 
another agent.

4 (for Consult) ConsultConference Consult call when an agent tries to initiate a conference 
call with another agent.

4 (for Consult) ConsultTo When an agent initiates a Transfer/Conference by using 
the phone (not the Siebel Communications Toolbar). 
When the Consult call type is used, the Gplus Adapter is 
not notified by T-Server of the specific action in progress, 
for example, if it is a Transfer or a Conference or if an 
agent put the current call on hold and made another call.

4 (for Consult) ConsultFrom Consult call to the agent’s DN.

Table 20: Call Type Fields (Continued) 

CallType CallTypeExt Description
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in a specific way. See the description of “AttributeExtensions Parameter” on 
page 175. If <AttributeExtensions> are defined in a <datasetParam>, then 
these parameters are sent as attribute extensions with request to T-Server 
invoked by this device command.

The term <Other parameters> designates a subset of the <datasetParam>. The 
subset of the parameters defined in a <datasetParam> is included as user data 
(with some exclusions) in the T-Server request. Any exclusions in these 
parameters are identified in the command descriptions.

The following commands are implemented in the Gplus Adapter and may be 
used in the Siebel Communications Configuration as device commands. For 
information about Siebel device commands, see Siebel documentation.

Basic Voice Device Commands

This section provides detailed descriptions of the Basic Voice feature 
device commands.

AnswerCall

Description Answers incoming call.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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ReleaseCall

Description Releases (disconnects) current call.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

TransferMute

Description

Performs a mute transfer of the selected call. The CallNofifyText 
parameter conveys status information to the second agent. The 
RemoteConnectStr parameter is required for transfers to another 
contact center. For the switches that do not support Mute Transfer, 
but do support Single Step Transfer, the Adapter will invoke the 
request to TServer to perform Single Step Transfer.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.
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datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used.

ReasonCode Optional The value of the ReasonCode 
will be sent to the T-Server as 
a reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

<Other
parameters>

Optional Exclusion from user data:

RemoteConnectStr,
PhoneNumber, ThisDN,
Digits, MonitorType,
ReasonCode,
HeldCallID,
AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.



244 Gplus Adapter 7.5

Chapter 5: Configuration and Installation of the Voice Component Detailed Descriptions of Device Commands

TransferInit

Description

Initiates a two-step transfer of the selected call. The caller is put on 
hold, and the current agent dials another agent’s extension. The 
CallNofityText parameter conveys status information to the second 
agent. The RemoteConnectStr parameter is required for transfers 
to another contact center.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

<Other
parameters>

Optional Exclusion from user data:

RemoteConnectStr,
PhoneNumber, ThisDN,
Digits, MonitorType,
ReasonCode,
HeldCallID,
AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.
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TransferComplete

Description
Completes a two-step transfer of the selected call. Completes the 
consultative transfer. The current agent is disconnected and the 
caller is connected to the agent to whom the call was transferred.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ReconnectCall

Description
Reconnects the original call initiated using ConferenceInit or 
TransferInit before ConferenenceComplete or TransferComplete.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

HoldCall

Description Places the selected call on hold.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ResumeCall

Description Reconnects a call that was on hold.
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stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ResumeInactiveCall

Description Reconnects a callback that was on hold.

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

MakeCall

Description
Places an outbound call. The CallNotifyText parameter is used 
only for internal calls. 

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used instead.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

<Other
parameters>

Optional Exclusion from user data:

RemoteConnectStr,
PhoneNumber, ThisDN,
Digits, MonitorType,
ReasonCode,
HeldCallID,
AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.
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ConferenceSStep

Description

Begin a single-step conference. The CallNofityText parameter 
conveys status information to the second agent. The 
RemoteConnectStr parameter is required for conferences between 
contact centers.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used instead.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

<Other
parameters>

Optional Exclusion from user data:

RemoteConnectStr,
PhoneNumber, ThisDN,
Digits, MonitorType,
ReasonCode,
HeldCallID,
AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.
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ConferenceInit

Description

Initiates a two-step conference. The caller is put on hold, and the 
current agent dials another agent’s extension. The CallNofityText 
parameter conveys status information to the second agent. The 
RemoteConnectStr parameter is required for conferences between 
contact centers.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used instead.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

<Other
parameters>

Optional Exclusion from user data:

RemoteConnectStr,
PhoneNumber, ThisDN,
Digits, MonitorType,
ReasonCode,
HeldCallID,
AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.
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ConferenceComplete

Description
Completes a two-step conference. The caller and the agents in 
conference can now talk to each other at the same time. 

stringParam Not used

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

DeleteFromConference

Description
Deletes a party that is specified by the parameter PhoneNumber 
from a conference call. If parameter PhoneNumber is not defined, 
then stringParam will be used instead.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

Defines the party to be deleted 
from a conference call.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.
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PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Defines the party to be deleted 
from a conference call. If not 
present, the stringParam will 
be used instead.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

LogIn

Description
Logs in an agent to one or multiple queues. If an agent’s teleset 
contains multiple DNs, the agent will only be logged into the first 
DN.

stringParam Not used

datasetParam

ACDQueue Optional List of ACD queue numbers, 
separated by commas.

AgentID Mandatory AgentID
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AgentPin Optional Agent password

AgentWork
Mode

Optional Work mode that is to be set for 
an agent. AgentWorkMode 
will be sent to T-Server as a 
workmode parameter. Default 
value is 0.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

LogOut

Description
Logs out an agent from one or all of the queues. If the agent’s 
teleset contains multiple DNs, the agent will only be logged out of 
the first DN.

stringParam Not used

datasetParam

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.
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Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

ACDQueue Optional The ACD queue an agent logs 
out from.

Ready

Description
Switches an agent’s readiness state to NotReady on all agent DNs 
if agent’s state was Ready.

stringParam Not used

datasetParam

AgentWork
Mode

Optional Work mode that is to be set for 
the agent. AgentWorkMode 
will be sent to T-Server as a 
workmode parameter. Default 
value is 0.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

ACDQueue Optional A list of ACD queue numbers, 
separated by commas.
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NotReady

Description
Switches an agent’s readiness state to NotReady on all agent DNs 
if the agent’s state was Ready.

stringParam Not used

datasetParam

AgentWork
Mode

Optional Work mode that is to be set for 
the agent. AgentWorkMode 
will be sent to T-Server as a 
workmode parameter. Default 
value is 0. 

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

ACDQueue Optional A list of ACD queue numbers, 
separated by commas.
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ChangeNotReadyState

Description
Switches an agent’s readiness state from Ready to NotReady or 
from NotReady to Ready on all agent DNs.

stringParam Not used

datasetParam

AgentWork
Mode

Optional Work mode that is to be set for 
the agent. AgentWorkMode 
will be sent to T-Server as a 
workmode parameter. Default 
value is 0. 

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

ACDQueue Optional A list of ACD queue numbers, 
separated by commas.

SetActiveCall

Description
Notifies the driver that a call, currently selected in the 
Communications Toolbar, has been changed. The Driver will 
update all command statuses for the new selected call.

stringParam Not used

datasetParam TrackingID Mandatory Work item TrackingID.
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ForwardCall

Description Initiates call forwarding.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used.

Mode Optional Call-Forwarding Mode 
(numeric value). Default value 
is 1.

CancelForwardCall

Description Cancels call forwarding.

stringParam Not used

datasetParam
Mode Optional Call-Forwarding Mode 

(numeric value). Default value 
is 1.

ToggleForward

Description Turns call forwarding on or off.

stringParam

Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.
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datasetParam

PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used instead.

Mode Optional Call-Forwarding mode 
(numeric value). Default value 
is 1.

SetBusy

Description Initiates Do Not Disturb mode for all DNs an agent is logged in to.

stringParam Not used

datasetParam Not used

CancelBusy

Description Cancels the Do Not Disturb mode.

stringParam Not used

datasetParam Not used

ToggleForward

Description Turns call forwarding on or off.

stringParam Destination 
number

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

Destination number. If not 
present, the stringParam will 
be used instead.

Mode Optional Call-Forwarding mode 
(numeric value). Default value 
is 1.
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ChangeBusyState

Description Turns the Do Not Disturb mode on or off.

stringParam Not used

datasetParam Not used

AttachData

Description
Attaches user data to the selected call. Note that the user data name 
TrackingID is invalid.

stringParam N/A N/A

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

<Other
parameters>

Optional Exclusion from user data: 
PhoneNumber
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SendUserEvent

Description

Sends a user event to the Selected DN. Selected DN is either 
currently selected extension in the Communications view in the 
User Preferences screen or taken from stringParam.

Can be configured to send AgentID and ConnID attributes in the 
related SendUserEvent. To configure this, the CmdData section of 
the SendUserEvent device command must include parameters 
Attribute.AgentID and Attribute.ConnID, for example:
[Command:SendUserEvent]
Hidden = "TRUE"
Description = "Send user event"
DeviceCommand = "SendUserEvent"
CmdData = "SendUserEvent"

[CmdData:SendUserEvent]
AttachContext = "TRUE"
Param.ThisDN = "{@SelectedDN}"
Param.Attribute.AgentID = "Attribute_AgentID"
Param.Attribute.ConnID = "12340d0000000000"

The Attribute.ConnID value is a 16 digit hexadecimal that defines 
the ConnID.

If it is required to set the Attribute.AgentID and Attribute.ConnID 
parameters in the UserData of the UserEvent, then a backslash (\) 
must be used as an escape symbol before the parameter name.

The backslash (\) directs the Adapter to send a parameter with the 
name beginning after the backslash as UserData with a 
SendUserEvent request. A single backslash without a string is 
treated as a UserData parameter with key \, for example:

[CmdData:SendUserEvent]
AttachContext = "TRUE"
Param.ThisDN = "{@SelectedDN}"
Param.Attribute.AgentID = "Attribute_AgentID"
Param.Attribute.ConnID = "12340d0000000000"
Param.\Attribute.AgentID = "UserData_Attribute.AgentID"
Param.\Attribute.ConnID = "UserData_84321"
Param.\ = "This_Is_\"
Param.AgentID = "UserData_AgentID"

Then the UserEvent will include the attributes AgentID and 
ConnID:
UserData;
(Str) \                   This_Is_\
(Str) Attribute.ConnID    UserData_84321
(Str) Attribute.AgentID   UserData_Attribute.AgentID
(Str) AgentID             UserData_AgentID
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stringParam
Selected DN 
(see 
“Description”)

Optional

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

<Other
parameters>

Optional Exclusion from user data: 
ThisDN
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UpdateUserData

Description
Updates user data that is attached to the selected call. Note that 
user data name “TrackingID” is invalid.

stringParam N/A N/A

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

<Other
parameters>

Optional Exclusion from user data: 
PhoneNumber

DeleteUserData

Description
Removes user data, specified by <Other parameters> from the user 
data attached to the selected call. Note that user data name 
TrackingID is invalid.

stringParam N/A N/A

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

<Other
parameters>

Optional Exclusion from user data: 
PhoneNumber

CallSupervisor

Description

When the agent is on an ACD call, this command initiates a 
conference leg to the agent’s supervisor. For that call leg to be 
established, the supervisor must push the “Answer Agent” key to 
complete the call leg to the supervisor. For more details, see 
“CallSupervisor” on page 232.

stringParam Not Used
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datasetParam TrackingID Either 
PhoneNumber 
or stringParam 
must be 
defined.

If the Siebel Communication 
Session Manager invokes a 
particular command with an 
empty tracking ID, the Gplus 
Adapter will try to use the 
value of Param.TrackingID 
defined in Command Data.

<Other 
parameters>

Optional Exclusion from user data:

AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.

EmergencyKey

Description

Initiates conference leg to the agent’s supervisor and, if installed, 
to a recording device. The supervisor must push the “Answer 
Emergency” key to establish the call leg. For more details, see 
“EmergencyKey” on page 232.

stringParam Not Used
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datasetParam TrackingID {@SelectedWo
rkItem:Driver
WorkTrackID}

If the Siebel Communication 
Session Manager invokes a 
particular command with an 
empty tracking ID, the Gplus 
Adapter will try to use the 
value of Param.TrackingID 
defined in Command Data.

<Other 
parameters>

Optional Exclusion from user data:

AttributeExtensions,
StringAttributeExtensions,
IntAttributeExtensions 

And corresponding to the 
AttributeExtensions set of 
parameters,

See descriptions on Page 175 
and Page 176.

QueryAddress*

Description

Sends query to T-Server to return information about DN specified 
by command parameters ThisDN and ACDQueue. If ThisDN 
parameter is not defined in the configuration, the default 
configured DN is used instead.The type of information requested 
is defined by command parameters: AddressType and 
AddressInfoType.

stringParam Not Used

datasetParam

ThisDN Optional T-Server will be inquired 
about the telephony object 
specified by the this 
parameter. If not present, 
default configured DN 
(Teleset of type S) is used 
instead.

ACDQueue Optional List of ACD queue numbers, 
separated by commas 

AddressType 
(AddressType
Position)

Optional Type of telephony object in 
question. Default value is 2.
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*The Device Command, QueryAddress together with the set of Command 
Data Parameters that are defined in a sample GenComm_universal.def file, 
synchronize the state of the Communications Toolbar and the state of the 
agent on a Lucent Definity G3 switch. For information about other switches 
and how to define the corresponding Command Data Parameters for the 
QueryAddress device command, see the T-Server documentation related to 
the switch you are using.

AddressInfo
Type

Optional Type of the requested 
information. Default value is 
17.

Attribute 
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

SendUserEventOnCommDN

Description Sends a user event to the Communication DN.

stringParam
Destination 
number

Optional

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

<Other
parameters>

Optional Exclusion from user data: No 
exclusions

AlternateCall

Description
Places the active call on hold and reconnects the previously held 
call. 

stringParam

datasetParam
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ActiveCallID Optional Active work item TrackingID. 
If not defined, the internally 
maintained TrackingID will be 
used.

HeldCallID Mandatory TrackingID of the work item 
that is currently on hold.

ReasonCode Optional The value of the ReasonCode 
will be sent to T-Server as a 
reasons parameter. Default 
value is -1.

Attribute 
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

Send DTMF

Description
Sends digits that are interpreted by an interactive voice response 
system.

stringParam

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

Digits Mandatory The digits that are sent.
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ReasonCode Optional The value of the ReasonCode 
that will be sent to T-Server as 
a reasons parameter. Default 
value is -1.

Attribute 
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

Monitor Next Call

Description

Enables the supervisor’s monitoring of the next call that comes to 
the agent. The supervisor’s DN is either the currently selected 
extension in the Communications view in the User Preferences 
screen (Selected DN) or taken from the parameter ThisDN.

stringParam

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ThisDN Optional Supervisor’s DN. If not 
present, the Selected DN will 
be used (see “Description”).

PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

The agent’s DN that will be 
monitored. If not present, the 
stringParam will be used.
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Monitor Type Optional Indicates whether the 
supervisor wants to monitor 
one call or subsequent calls. 
Default value is -1. Other 
possible values are:

0 = MonitorOneCall
1 = MonitorAllCalls

ReasonCode Optional The value of the ReasonCode 
that will be sent to T-Server as 
a reasons parameter. Default 
value is -1.

Attribute 
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.
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Cancel Monitoring

Description

Cancels the supervisor’s monitoring of the next call that comes to 
the agent. The supervisor’s DN is either the currently selected 
extension in the Communications view in the User Preferences 
screen (Selected DN) or taken from the parameter ThisDN.

stringParam

Either 
stringParam or 
PhoneNumber 
must be 
defined.

datasetParam

TrackingID Optional Work item TrackingID. If not 
defined, the internally 
maintained TrackingID will be 
used.

ThisDN Optional Supervisor’s DN. If not 
present, the Selected DN will 
be used (see “Description”).

PhoneNumber Either 
PhoneNumber 
or stringParam 
must be 
defined.

The agent’s DN that will be 
monitored. If not present, the 
stringParam will be used.

Monitor Type Optional Indicates whether the 
supervisor wants to monitor 
one call or subsequent calls. 
Default value is -1. Other 
possible values are:

0 = MonitorOneCall
1 = MonitorAllCalls
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Expert Contact Device Commands

This section lists the Expert Contact feature Device Commands:

• KwOnCall

• KwPreviewIntReject

• KwPartyStatusResponse

For details, contact Genesys Technical Support.

Outbound Contact Device Commands

This section provides detailed descriptions of the Outbound Campaign feature 
Device Commands:

• PreviewDialingModeStart

ReasonCode Optional The value of the ReasonCode 
that will be sent to T-Server as 
a reasons parameter. Default 
value is -1.

Attribute 
Extensions

Optional Attribute Extensions will be 
sent with request to T-Server 
as described in the following 
sections:

“AttributeExtensions 
Parameter” on page 175 and 

“Attribute Extensions of Type 
String and/or Integer” on 
page 176.

SetActiveCampaign

Description Sets Active Campaign for Preview mode.

stringParam

Either 
stringParam or 
CampaignName 
must be 
defined.

Name of Campaign in Preview 
mode as it is defined in 
Configuration Manager.

datasetParam

CampaignName Either 
stringParam or 
CampaignName 
must be 
defined.

Name of Campaign in Preview 
mode as it is defined in 
Configuration Manager.
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• PreviewDialingModeOver

• PreviewRecordRequest

• UpdateCallCompletionStats

• RecordProcessed

• RecordReject

• RequestRecordCancel

• RecordReschedule

• ScheduledRecordReschedule

• DoNotCall

• ChainedRecordRequest

• AddRecord

Mandatory fields GSW_APPLICATION_ID and GSW_CAMPAIGN_NAME 
are assigned internally by the OCS protocol instance, depending on the mode 
and campaign currently running.

The Outbound Contact Server device commands are described below.

PreviewDialingModeStart

PreviewDialingModeOver

Command 
Name

PreviewDialingModeStart

Description
Request to activate preview session for the agent. (Needed if option 
agent_preview_mode_start is set to true.)

OCS Action Link Agent DN and Campaign ID

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Additional 
Fields

Not specified

Command 
Name

PreviewDialingModeOver

Description Request to terminate preview session for the agent

OCS Action Remove a link between Agent DN and Campaign ID
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PreviewRecordRequest

UpdateCallCompletionStats

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Additional 
Fields

Not specified

Command 
Name

PreviewRecordRequest

Description Request to send preview record

OCS Action
If agent_preview_mode_start is set to false or there is a link between the 
agent DN and campaign

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Additional 
Fields

Not specified

Command 
Name

UpdateCallCompletionStats

Description Desktop sends to update record details. Intermediate update.

OCS Action Update record fields internally, wait for next requests.

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_RECORD_HANDLE

Additional 
Fields

Can be specified updatable Genesys fields and user defined fields.
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RecordProcessed

RecordReject

Command 
Name

RecordProcessed

Description
Desktop sends event to indicate that record is processed. OCS should 
update record information if it is provided.

OCS Action

Update a record and it’s chain in database; use all changes made by 
previous requests regarding the records in the chain. If a RecordProcessed 
event has GSW_TREATMENT field correctly specified, OCS applies a 
treatment to the record.

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Additional 
Fields

Can be specified updatable. Genesys fields and user-defined fields.

Command 
Name

RecordReject

Description
Desktop sends request to indicate that preview record or scheduled 
callback will not be dialed by this agent. Record should be re-sent to 
another agent.

OCS Action
Mark a record as Ready and the rest of a chain if GSW_CHAIN_ATTR = = 
“AllChain”

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Additional 
Fields

Not specified
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RequestRecordCancel

RecordReschedule

Command 
Name

RequestRecordCancel

Description
Desktop sends request to indicate that a preview record or scheduled 
callback should not be dialed. Record should not be re-sent to another 
agent. Should be marked in the database as Canceled.

OCS Action Change record 

Mandatory 
Fields

GSW_APPLICATION_ID

if (GSW_RECORD_HANDLE is specified){

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

}

else

{

GSW_PHONE

GSW_CAMPAIGN_NAME (optional)

}

Additional 
Fields

GSW_CHAIN_ATTR = “AllChain” 

Or

GSW_CHAIN_ATTR = “RecordOnly” 

Command 
Name

RecordReschedule

Description Request reschedule preview record, predictive call, or scheduled call.

OCS Action Update a record chain and reschedule the record

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_RECORD_HANDLE

GSW_DATE_TIME

GSW_CALLBACK_TYPE
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ScheduledRecordReschedule

DoNotCall

Additional 
Fields

Not specified

Command 
name

ScheduledRecordReschedule

Description Request reschedule preview record, predictive call, or scheduled call.

OCS Action Update a record chain and reschedule the record.

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_RECORD_HANDLE

GSW_DATE_TIME

GSW_CALLBACK_TYPE

Additional 
Fields

Not specified

Command 
Name

DoNotCall

Description Agent requests this number not to be called again.

OCS Action
If GSW_RECORD_HANDLE is specified update a record or whole chain 
as DoNotCall if GSW_CHAIN_ATTR == “AllChain”. 
Add phone(s) (GSW_CHAIN_ATTR == “AllChain”) in a DoNotCall list.
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ChainedRecordRequest

Mandatory 
Fields

GSW_APPLICATION_ID

1) if (GSW_RECORD_HANDLE is specified){

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

}

else

{

2) GSW_PHONE 

}

else

{

3) GSW_CUSTOMER_ID

}

Additional 
Fields

Not specified

Comments

You can specify in the Siebel.def file these attributes as command 
parameters: A specific set of mandatory fields will be sent to Outbound 
Contact Server.

1) USE_RECORD_HANDLE, 2) USE_PHONE, 3) 
USE_CUSTOMER_ID Tells the Adapter which set of mandatory fields 
will be sent to Outbound Contact Server. 

Command 
Name

ChainedRecordRequest

Description Request to send all records from the chain defined by record handle.

OCS Action Send rest of a chain to the desktop.
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AddRecord

Mandatory 
Fields

GSW_AGENT_REQ_TYPE

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_RECORD_HANDLE

Additional 
Fields

Not specified

Command 
Name

AddRecord

Description Request to add record to the particular list.

OCS Action Verify data and create new record in the list.

Mandatory 
Fields

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_PHONE

GSW_TZ_NAME

Additional 
Fields

Any user-defined fields. Note that the key in a key-value pair should be 
equal to send_attribute of the field required to add.

Default field values (if not specified in a request):

GSW_PHONE_TYPE: 2, “DirectBusinessPhone”

GSW_RECORD_TYPE: 2, “General”

GSW_RECORD_TYPE: 2, “General”

GSW_RECORD_STATUS: 1, “Ready”

GSW_CALL_RESULT: 28, “Unknown” 

GSW_ATTEMPTS: 0

GSW_DATE_TIME: 0

GSW_CALL_TIME: 0

GSW_FROM: 28800 (8 AM)

GSW_UNTIL: 64800 (6 PM)

GSW_AGENT_ID: 0
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Web Callback Device Commands

Note: These commands are not supported starting from version 7.2 of the 
Adapter.

ACCEPT_CALLBACK

REJECT_CALLBACK

Command 
Name

ACCEPT_CALLBACK

Description Notifies Callback Server that a callback request has been accepted.

Callback Server 
Action

Upon receiving this event, Callback Server starts counting timeout until 
the request is executed.

Mandatory 
Fields

CALLBACK_PDU

REQUEST_ID

CALLBACK_ACCEPTED

request identifier

Additional 
Fields

Not specified

Command 
Name

REJECT_CALLBACK

Description Notifies Callback Server that a callback request has been rejected.

Callback Server 
Action

Upon receiving this event, Callback Server routes the callback request to 
another agent.

Mandatory 
Fields

CALLBACK_PDU

REQUEST_ID

CALLBACK_ACCEPTED

request identifier

Additional 
Fields

Not specified
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CALLBACK_DONE

Voice Callback Device Commands

This section provides detailed descriptions of the Voice Callback feature 
device commands (see Table 21).

Command 
Name

CALLBACK_DONE

Description Notifies Callback Server that a callback request is done.

Callback Server 
Action

Upon receiving this event, Callback Server considers the request to be 
executed.

Mandatory 
Fields

CALLBACK_PDU

REQUEST_ID

CALLBACK_DONE

request identifier

Additional 
Fields

Not specified

Table 21:  VCB Commands

Gplus Adapter Name Genesys VCB Server Name

VCBServiceStatus RequestCallbackServiceStatus

VCBQuery RequestCallbackQuery

VCBQueryResult RequestCallbackQueryResult

VCBCancel RequestCallbackCancel

VCBReschedule RequestCallbackReschedule

VCBAdd RequestCallbackAdd

VCBPreview RequestCallbackPreview

VCBProcessed RequestCallbackProcessed

VCBReject RequestCallbackReject
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VCBServiceStatus

VCBQuery

Command 
Name

VCBServiceStatus

(RequestCallbackServiceStatus)

Description
Client sends this request to VCB Server to determine the availability of 
Voice Callback service.

Callback Server 
Action

Sends back corresponding response with requested information.

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_REFERENCE_ID

VCB_STATUS: 0

Additional 
Fields

VCB_ROUTING_POINT

VCB_LOCATION

Command 
Name

VCBQuery

(RequestCallbackQuery)

Description
Client sends this request to VCB Server to find Callback Requests what 
are satisfying search conditions.

Callback Server 
Action

Sends back corresponding UserEvent (CallbackQueryAcknowledge) with 
query result (number of Callback Requests found).

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

At least one of the following:

VCB_CONTACT

VCB_TYPE

VCB_ROUTING_POINT

VCB_LOCATION

Additional 
Fields

Any fields that have to be included in search conditions.
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VCBQueryResult

VCBCancel

Command 
Name

VCBQueryResult

(RequestCallbackQueryResult)

Description
Client sends this request to VCB Server to retrieve Callback Request by 
index in Query Result Set.

Callback Server 
Action

Sends Callback Request back to Client (CallbackQueryResult).

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_QUERY_INDEX

Additional 
Fields

Not specified

Command 
Name

VCBCancel

(RequestCallbackCancel)

Description Client sends this request to VCB Server to cancel Callback Request.

Callback Server 
Action

Deletes Callback Request and sends back confirmation 
(CallbackCancelAcknowledge).

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RECORD_HANDLE (or VCB_CONTACT)

Additional 
Fields

Not specified
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VCBReschedule

VCBAdd

Command 
Name

VCBReschedule

(RequestCallbackReschedule)

Description Client sends this request to VCB Server to reschedule Callback Request.

Callback Server 
Action

Reschedules Callback Request and sends back confirmation 
(CallbackRescheduleAcknowledge). Callback will be rescheduled ASAP 
if VCB_DATE_TIME key doesn’t exist in UserData.

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RECORD_HANDLE

VCB_CALL_RESULT

Additional 
Fields

VCB_DATE_TIME (if Scheduled)

VCB_TZ_NAME (if Scheduled)

Command 
Name

VCBAdd

(RequestCallbackAdd)

Description Client sends this request to add a Callback Request.

Callback Server 
Action

Creates Callback Request object. Processes as Scheduled Callback 
Request (immediately if ASAP).

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_CONTACT

VCB_TYPE: 1, “ASAP”

VCB_ORIGIN

VCB_ROUTING_POINT

VCB_LOCATION

Additional 
Fields

Any user defined fields and Default field values (if not specified in a 
request):

VCB_DATE_TIME (if Scheduled)

VCB_TZ_NAME (if Scheduled)
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VCBPreview

VCBProcessed

Command 
Name

VCBPreview

(RequestCallbackPreview)

Description VCB Server sends Callback Request to Agent’s Desktop.

Desktop Action Sends back acknowledgement.

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID = 0 (if Desktop)

VCB_REFERENCE_ID

VCB_RECORD_HANDLE

VCB_CONTACT

VCB_CALL_RESULT

All UserData attributes from Callback Request

Additional 
Fields

Any user defined fields

Command 
Name

VCBProcessed

(RequestCallbackProcessed)

Description Agent’s Desktop submits record processing results to VCB Server.

Callback Server 
Action

Sends back acknowledgement. Applies treatment if specified in 
configuration.

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID = 0 (if Desktop)

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RECORD_HANDLE

VCB_CALL_RESULT

Additional 
Fields

Any user defined fields
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VCBReject

Detailed Descriptions of Device Events
This section provides detailed descriptions of device events for the Voice 
Component including the Basic Voice feature, and Outbound Campaign 
feature.

Basic Voice Device Events

The following section provides descriptions of the device events for Basic 
Voice feature.

Command 
Name

VCBReject

(RequestCallbackReject)

Description Agent’s Desktop rejects record.

Callback Server 
Action

Sends back acknowledgement. Submits Callback Request to other Agent.

Mandatory 
Fields

VCB_ORIGIN_APPLICATION_ID = 0 (if Desktop)

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RECORD_HANDLE

Additional 
Fields

Any user defined fields

EventDialing

Siebel CRM 
DeviceEvent 
Name

EventDialing

Desktop 
Action

Displays dialed call information

TEvent Name EventDialing

Description
An attempt to make a call on behalf of the telephony 
object specified by ThisDN is in progress.
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TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.

EventRinging

Siebel CRM 
DeviceEvent 
Name

EventRinging

Desktop 
Action

Displays ringing call information

TEvent Name EventRinging

Description
An attempt to make a call on behalf of the telephony 
object specified by ThisDN is in progress.

TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.

EventEstablished

Siebel CRM 
DeviceEvent 
Name

EventEstablished

Desktop 
Action

Displays received call information

TEvent Name EventEstablished

Description
The connection has been established for an incoming or 
outbound call.

TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.
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EventReleased

Siebel CRM 
DeviceEvent 
Name

EventReleased

Desktop 
Action

Removes related information from Work Item or removes 
related Work Item

TEvent Name EventReleased

Description A call was released.

TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.

EventHeld

Siebel CRM 
DeviceEvent 
Name

EventHeld

Desktop 
Action

Enables Resume Work Item and disables Pause Work 
Item button (command)

TEvent Name EventHeld

Description A call was placed on hold.

TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.
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EventRetrieved

Siebel CRM 
DeviceEvent 
Name

EventRetrieved

Desktop 
Action

Disables Resume Work Item and enables Pause Work 
Item button (command)

TEvent Name EventRetrieved

Description A call that was on hold has been retrieved.

TrackingID Not applicable.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.

EventUserDataChanged

Siebel CRM 
DeviceEvent 
Name

EventUserDataChanged

Desktop 
Action

N/A

TEvent Name EventAttachedDataChanged

Description The call’s user data has been changed.

TrackingID TrackingID of the work item.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.
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EventRegistered

Siebel CRM 
DeviceEvent 
Name

EventRegistered

Desktop 
Action

N/A

TEvent Name EventRegistered

Description The agent’s DN was registered with T-Server.

TrackingID Not applicable.

Attributes ThisDN, Mandatory, RegisteredDN

EventUnregistered

Siebel CRM 
DeviceEvent 
Name

EventUnregistered

Desktop 
Action

N/A

TEvent Name EventUnregistered

Description The agent’s DN was unregistered with T-Server.

TrackingID Not applicable.

Attributes ThisDN, Mandatory, UnregisteredDN

EventCallForwardSet

Siebel CRM 
DeviceEvent 
Name

EventCallForwardSet

Desktop 
Action

Disables Set Forward and enables Cancel Forward button

TEvent Name EventForwardSet

Description Call forwarding has been set to on.
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TrackingID Not applicable.

Attributes
ThisDN, Mandatory. DN on which call forwarding has 
been set.

EventCallForwardCancel

Siebel CRM 
DeviceEvent 
Name

EventCallForwardCancel

Desktop 
Action

Disables Cancel Forward and enables Set Forward button

TEvent Name EventForwardCancel

Description Call forwarding has been set to off.

TrackingID Not applicable.

Attributes
ThisDN, Mandatory, DN on which call forwarding has 
been canceled.

EventAgentBusy

Siebel CRM 
DeviceEvent 
Name

EventAgentBusy

Desktop 
Action

N/A

TEvent Name EventDNDOn

Description Do Not Disturb mode has been set to on.

TrackingID Not applicable.

Attributes ThisDN, Mandatory. DN on which DND has been set.

EventAgentNotBusy

Siebel CRM 
DeviceEvent 
Name

EventAgentNotBusy
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Desktop 
Action

N/A

TEvent Name EventDNDOff

Description Do Not Disturb mode has been set to off.

TrackingID Not applicable.

Attributes
ThisDN, Mandatory. DN on which DND has been 
canceled.

EventAgentLogin

Siebel CRM 
DeviceEvent 
Name

EventAgentLogin

Desktop 
Action

Disables Login to Voice and enables Logout from Voice 
button (command)

TEvent Name EventAgentLogin

Description Agent has been logged in.

TrackingID Not applicable.

Attributes
ThisDN, Mandatory. DN on which agent was logged in

AgentID, Mandatory, AgentID
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EventAgentLogout

Siebel CRM 
DeviceEvent 
Name

EventAgentLogout

Desktop 
Action

Disables Logout from Voice and enables Login to Voice 
button (command)

TEvent Name EventAgentLogout

Description Agent has been logged out.

TrackingID Not applicable.

Attributes
ThisDN, Mandatory. DN on which agent was logged out

AgentID, Mandatory, AgentID

EventAgentReady

Siebel CRM 
DeviceEvent 
Name

EventAgentReady

Desktop 
Action

Disables Set Ready for Voice button (command)

TEvent Name EventAgentReady

Description Agent has been set to the Ready state.

TrackingID Not applicable.

Attributes

ThisDN, Mandatory. DN on which agent became ready.

AgentID, Mandatory, AgentID

Workmode, Mandatory, Agent’s work mode
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EventAgentNotReady

Siebel CRM 
DeviceEvent 
Name

EventAgentNotReady

Desktop 
Action

Enables Set Ready for Voice button (command)

TEvent Name EventAgentNotReady

Description Agent has been set to the Not Ready state.

TrackingID Not applicable.

Attributes

ThisDN, Mandatory. DN on which agent became not 
ready.

AgentID, Mandatory, AgentID

Workmode, Mandatory, Agent’s work mode

EventServerConnected

Siebel CRM 
DeviceEvent 
Name

EventServerConnected

Desktop 
Action

Communications Toolbar becomes active

TEvent Name EventLinkConnected

Description Connection with T-Server has been established.

TrackingID Not applicable.

Attributes None



Gplus Adapter for Siebel CRM—Deployment Guide 295

Chapter 5: Configuration and Installation of the Voice Component Detailed Descriptions of Device Events

EventServerDisconnected

Siebel CRM 
DeviceEvent 
Name

EventServerDisconnected

Desktop 
Action

Communications Toolbar becomes inactive

TEvent Name EventLinkDisconnected

Description Connection with T-Server has been terminated.

TrackingID Not applicable.

Attributes None

EventError

Siebel CRM 
DeviceEvent 
Name

EventError

Desktop 
Action

Displays an Error in a Status Text area for a few seconds

TEvent Name EventError

Description EventError has been received from T-Server.

TrackingID TrackingID of the work item, if applicable.

Attributes ErrorCode

EventUserEvent

Siebel CRM 
DeviceEvent 
Name

EventUserEvent

Desktop 
Action

N/A

TEvent Name EventUserEvent

Description
A user event from another client application has been 
received.
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TrackingID Not applicable

Attributes
TEvent UserData is received in Siebel as 
ISC_KVParamList.

EventPartyChanged

Siebel CRM 
DeviceEvent 
Name

EventPartyChanged

Desktop 
Action

Shows changes in the displayed Work Item

TEvent Name EventPartyChanged

Description

The telephony object specified by OtherDN has replaced 
the telephony object specified by OtherDN in the 
previously received T-Server event or the previous 
ConnID of the call has been given a new ConnID value.

TrackingID TrackingID of the work item, if applicable.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.

EventPartyAdded

Siebel CRM 
DeviceEvent 
Name

EventPartyAdded

Desktop 
Action

Shows changes in the displayed Work Item

TEvent Name EventPartyAdded

Description
The telephony object specified by OtherDN has been 
added to the conference call. 

TrackingID TrackingID of the work item, if applicable.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.
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Expert Contact Device Events

This section lists the device events for Expert Contact feature, as follows:

• EventKwPreviewIntError

• EventKwPreviewRequest

• EventKwPreviewIntCancel

• EventKwPreviewIntAccepted

• EventKwPreviewIntRejected

• EventKwError

• EventKwAck

• EventKwOnCallResponse

• EventKwPartyStatusRequest

• EventKwPartyStatusAck

For details about these events, contact Genesys Technical Support.

Outbound Campaign/OCS Device Events

This section provides detailed descriptions of device events for the Outbound 
Campaign feature, which is associated with the Genesys Outbound Contact 
Server (OCS) product. 

Listed here are the Outbound Contact Server (OCS) device events for the 
Gplus Outbound Campaign feature. This section provides details for each of 
these events in a separate table below.

EventPartyDeleted

Siebel CRM 
DeviceEvent 
Name

EventPartyDeleted

Desktop 
Action

Shows changes in the displayed Work Item

TEvent Name EventPartyDeleted

Description
The telephony object specified by OtherDN has been 
deleted from the conference call. 

TrackingID TrackingID of the work item, if applicable.

Attributes
See Table 19, “Parameters Used with Device Events of 
the Voice Component,” on page 238.
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• EventAddRecordAck

• EventCampaignGroupAssigned

• EventCampaignLoaded

• EventCampaignModeChanged

• EventCampaignStarted

• EventCampaignStopped

• EventCampaignUnloaded

• EventChainedRecord

• EventChainedRecordDataEnd

• EventChainedWorkItemChanged

• EventCurrentWorkItemChanged

• EventOCSError

• EventDoNotCallAck

• EventRecordCancel

• EventScheduledCall

• EventPreviewModeOverAck

• EventPreviewModeStartAck

• EventDoNotCallAck

• EventPreviewRecord

• EventPreviewRecordEmpty

• EventRecordCancelAck

• EventRecordProcessedAck

• EventRecordRejectAck

• EventRecordCancelAck

• EventRecordRemove

• EventRecordProcessedAck

• EventRecordRejectAck

• EventRecordRescheduleAck

• EventSchRecordRescheduleAck

• EventUpdateCallCompletionStatsAck

• EventLogOutTime

• EventLogOutAck
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EventAddRecordAck

EventCampaignGroupAssigned

EventCampaignLoaded

Siebel CRM DeviceEvent Name: EventAddRecordAck

OCS Protocol User Event: AddRecordAcknowledge

Description OCS sent insert request to DB

TrackingID TrackingID of the Work Item

Desktop Action Continue session.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

Siebel CRM DeviceEvent Name: EventCampaignGroupAssigned

OCS Protocol User Event: CampaignGroupAssigned

Description
Notification that an Agent assignment was changed to a new campaign in 
auto dial mode.

TrackingID TrackingID of the Work Item

Desktop Action Displays Campaign Name as it is defined in Configuration Manager

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_GROUP_NAME

GSW_CAMPAIGN_GROUP_DESCRIPTION

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_DESCRIPTION

Siebel CRM DeviceEvent Name: EventCampaignLoaded

OCS Protocol User Event: CampaignLoaded

Description
Sent by OCS when a campaign is loaded. 

Note this event is specific to OCS 6.5, Desktop Protocol 6.5 only.

TrackingID TrackingID of the Work Item
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EventCampaignModeChanged

EventCampaignStarted

Desktop Action Store application ID and campaign name.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_DESCRIPTION

Siebel CRM DeviceEvent Name: EventCampaignModeChanged

OCS Protocol User Event: CampaignModeChanged

Description Should be sent when mode of running campaign is changed

TrackingID TrackingID of the Work Item

Desktop 
Action

In Preview Mode outbound traffic is usually more intensive.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_MODE

Siebel CRM DeviceEvent Name: EventCampaignStarted

OCS Protocol User Event: CampaignStarted

Description
Should be sent when dialing of campaign is started or resumed, or as a 
response of event agent login if campaign is started.

TrackingID TrackingID of the Work Item

Desktop Action Store a campaign name and an application ID.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_MODE

GSW_CAMPAIGN_DESCRIPTION
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EventCampaignStopped

EventCampaignUnloaded

EventChainedRecord

Siebel CRM DeviceEvent Name: EventCampaignStopped

OCS Protocol User Event: CampaignStopped

Description
Should be sent when dialing for campaign is started or resumed, or as a 
response of event agent login if campaign is started.

TrackingID TrackingID of the Work Item

Desktop Action Stop sending requests to a campaign.

Attributes
GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Siebel CRM DeviceEvent Name: EventCampaignUnloaded

OCS Protocol User Event: CampaignUnloaded

Description
Sent by OCS when a campaign is unloaded. 

Note this event is specific to OCS 6.5, Desktop Protocol 6.5 only.

TrackingID TrackingID of the Work Item

Desktop Action Consider campaign as not active.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_DESCRIPTION

Siebel CRM DeviceEvent Name: EventChainedRecord

OCS Protocol User Event: ChainedRecord

Description Chain record delivered.

TrackingID TrackingID of the Work Item

Desktop Action Continue Call Work.
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EventChainedRecordDataEnd

EventChainedWorkItemChanged

Attributes

GSW_USER_EVENT

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_PHONE

GSW_CALL_RESULT GSW_CHAIN_ID

Genesys and user-defined fields having send attributes.

Siebel CRM DeviceEvent Name: EventChainedRecordDataEnd

OCS Protocol User Event: ChainedRecordDataEnd

Description All chain has been delivered.

TrackingID TrackingID of the Work Item

Desktop 
Action

Continue call work.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_CHAIN_ID

Siebel CRM DeviceEvent Name: EventChainedWorkItemChanged

OCS Protocol User Event: N/A

Description
Gplus Adapter sends notification that the current work item has changed, 
and that the previous and the current work items belong to the same chain. 
Sent in response to the command SetActiveCall.

TrackingID TrackingID of the Work Item

Desktop Action

Attributes N/A
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EventCurrentWorkItemChanged

EventOCSError

EventDoNotCallAck

Siebel CRM DeviceEvent Name: EventCurrentWorkItemChanged

OCS Protocol User Event: N/A

Description
Gplus Adapter sends notification that the current work item has changed. 
Sent in response to the command SetActiveCall.

TrackingID TrackingID of the Work Item

Desktop Action

Attributes N/A

Siebel CRM DeviceEvent Name: EventOCSError

OCS Protocol User Event: Error

Description OCS sends notification about error on the server side.

TrackingID TrackingID of the Work Item

Desktop Action Continue session.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CAMPAIGN_NAME

GSW_ERROR_NAME

Siebel CRM DeviceEvent Name: EventDoNotCallAck

OCS Protocol User Event: DoNotCallAcknowledge

Description Confirmation that DoNotCall was accepted.

TrackingID TrackingID of the Work Item

Desktop 
Action

Kill the record and the chain if DoNotCallAcknowledge contains 
GSW_CHAIN_ATTR != “RecordOnly”.



304 Gplus Adapter 7.5

Chapter 5: Configuration and Installation of the Voice Component Detailed Descriptions of Device Events

EventRecordCancel

Attributes

GSW_APPLICATION_ID

if (GSW_RECORD_HANDLE is specified){

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

}

else

{

GSW_PHONE

else 

{

GSW_CONTCT_ID

}

Siebel CRM DeviceEvent Name: EventRecordCancel

OCS Protocol User Event: RecordCancel

Description
OCS sends to desktop to indicate that this record should not be dialed.
Applicable to preview records and scheduled callbacks.

TrackingID TrackingID of the Work Item

Desktop Action
Kill the record and the chain if the RecordCancel contains 
GSW_CHAIN_ATTR = “AllChain”.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE
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EventScheduledCall

EventPreviewModeOverAck

Siebel CRM DeviceEvent Name: EventScheduledCall

OCS Protocol User Event: ScheduledCall

Description
OCS sends to agent to indicate that scheduled callback should be 
executed.

TrackingID TrackingID of the Work Item

Desktop Action Perform call work.

Attributes

GSW_USER_EVENT

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_PHONE

GSW_CALL_RESULT

GSW_CALLBACK_TYPE

Genesys and user-defined fields having send attributes.

Siebel CRM DeviceEvent Name: EventPreviewModeOverAck

OCS Protocol User Event: PreviewDialingModeOverAcknowledge

Description OCS accepts a desktop request to close the preview session.

TrackingID TrackingID of the Work Item

Desktop Action
Desktop is unable to send requests to OCS and receive callbacks (see 
“agent_preview_mode_start” option).

Attributes
GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME



306 Gplus Adapter 7.5

Chapter 5: Configuration and Installation of the Voice Component Detailed Descriptions of Device Events

EventPreviewModeStartAck

EventDoNotCallAck

Siebel CRM DeviceEvent Name: EventPreviewModeStartAck

OCS Protocol User Event: PreviewDialingModeStartAcknowledge

Description OCS accepts a desktop request to initiate the preview session.

TrackingID TrackingID of the Work Item

Desktop 
Action

Desktop can send requests to OCS and receive callbacks (see 
“agent_preview_mode_start” option).

Attributes
GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Siebel CRM DeviceEvent Name: EventDoNotCallAck

OCS Protocol User Event: DoNotCallAcknowledge

Description Confirmation that DoNotCall was accepted.

TrackingID TrackingID of the Work Item

Desktop 
Action

Kill the record and the chain if DoNotCallAcknowledge contains 
GSW_CHAIN_ATTR != “RecordOnly”.

Attributes

GSW_APPLICATION_ID

if (GSW_RECORD_HANDLE is specified){

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

}

else

{

GSW_PHONE

else 

{

GSW_CONTCT_ID

}
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EventPreviewRecord

EventPreviewRecordEmpty

EventRecordCancelAck

Siebel CRM DeviceEvent Name: EventPreviewRecord

OCS Protocol User Event: PreviewRecord

Description Preview record to dial

TrackingID TrackingID of the Work Item

Desktop Action Perform call work

Attributes

GSW_USER_EVENT

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_PHONE

GSW_CALL_RESULT

Genesys and user-defined fields having send attributes.

Siebel CRM DeviceEvent Name: EventPreviewRecordEmpty

OCS Protocol User Event: PreviewtRecordEmpty

Description No more records in OCS internal buffer.

TrackingID TrackingID of the Work Item

Desktop Action Try to send a request later.

Attributes
GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Siebel CRM DeviceEvent Name: EventRecordCancelAck

OCS Protocol User Event: RecordCancelAcknowledge

Description OCS accepts a desktop request to cancel a record.

TrackingID TrackingID of the Work Item
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EventRecordProcessedAck

EventRecordRejectAck

Desktop Action
Kill the record and the chain if RecordCancelAcknowledge contains 
GSW_CHAIN_ATTR == “AllChain”.

Attributes

GSW_APPLICATION_ID

if (GSW_RECORD_HANDLE is specified) {

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

}

else

{

GSW_PHONE 

}

Siebel CRM DeviceEvent Name: EventRecordProcessedAck

OCS Protocol User Event: RecordProcessedAcknowledge

Description OCS confirms that record has been executed.

TrackingID TrackingID of the Work Item

Desktop Action Kill the record and the chain if requested.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Siebel CRM DeviceEvent Name: EventRecordRejectAck

OCS Protocol User Event: RecordRejectAcknowledge

Description OCS accepts PredictRejectRecord request.

TrackingID TrackingID of the Work Item
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EventRecordCancelAck

EventRecordRemove

Desktop Action
Kill the record and the chain if RecordCancelAcknowledge contains 
GSW_CHAIN_ATTR == “AllChain”.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Siebel CRM DeviceEvent Name: EventRecordCancelAck

OCS Protocol User Event: RecordCancelAcknowledge

Description OCS accepts a desktop request to cancel a record.

TrackingID TrackingID of the Work Item

Desktop Action
Kill the record and the chain if RecordCancelAcknowledge contains 
GSW_CHAIN_ATTR == “AllChain”.

Attributes

GSW_APPLICATION_ID

if (GSW_RECORD_HANDLE is specified) {

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

}

else

{

GSW_PHONE 

}

Siebel CRM DeviceEvent Name: EventRecordRemove

OCS Protocol User Event: N/A

Description Gplus Adapter sends a request to remove record from desktop.

TrackingID TrackingID of the Work Item
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EventRecordProcessedAck

EventRecordRejectAck

Desktop Action Removes record from desktop.

Attributes N/A

Siebel CRM DeviceEvent Name: EventRecordProcessedAck

OCS Protocol User Event: RecordProcessedAcknowledge

Description OCS confirms that record has been executed.

TrackingID TrackingID of the Work Item

Desktop Action Kill the record and the chain if requested.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Siebel CRM DeviceEvent Name: EventRecordRejectAck

OCS Protocol User Event: RecordRejectAcknowledge

Description OCS accepts PreviewRejectRecord request.

TrackingID TrackingID of the Work Item

Desktop Action
Kill the record and the chain if RecordCancelAcknowledge contains 
GSW_CHAIN_ATTR == “AllChain”.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE
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EventRecordRescheduleAck

EventSchRecordRescheduleAck

EventUpdCallComplStatsAckn

Siebel CRM DeviceEvent Name: EventRecordRescheduleAck

OCS Protocol User Event: RecordRescheduleAcknowledge

Description Confirmation that record was rescheduled

TrackingID TrackingID of the Work Item

Desktop Action Continue Call Work

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_DATE_TIME

GSW_CALLBACK_TYPE

Siebel CRM DeviceEvent Name: EventSchRecordRescheduleAck

OCS Protocol User Event: ScheduledRecordRescheduleAcknowledge

Description Confirmation that record was rescheduled.

TrackingID TrackingID of the Work Item

Desktop 
Action

Continue call work.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

GSW_DATE_TIME

GSW_CALLBACK_TYPE

Siebel CRM DeviceEvent Name: EventUpdCallComplStatsAck

OCS Protocol User Event: UpdateCallCompletionStatsAcknowledge
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EventLogOutTime

Description OCS accepts a desktop request to update a record’s fields.

TrackingID TrackingID of the Work Item

Desktop Action Continue call work.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_CALLING_LIST

GSW_RECORD_HANDLE

Siebel CRM DeviceEvent Name: EventLogOutTime

OCS Protocol User Event: UpdateEventLogOutTime

Description Response for logout request.

TrackingID TrackingID of the Work Item

Desktop Action Displays time left until automatic logout.

Attributes

GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

GSW_LOGOUT_TIME
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EventLogOutAck

Web Callback Device Events

Note: These events are not supported starting from version 7.2 of the 
Adapter.

EventCallBackRequest

Siebel CRM DeviceEvent Name: EventLogOutAck

OCS Protocol User Event: UpdateEventLogOutAcknowledge

Description Automatic logout acknowledge.

TrackingID TrackingID of the Work Item

Desktop Action Logs out an agent. Displays agent’s status change.

Attributes
GSW_APPLICATION_ID

GSW_CAMPAIGN_NAME

Siebel CRM DeviceEvent Name: EventCallBackRequest

Web Callback Device Event: UpdateEventCallBackRequest

Description Request for callback from Callback Server.

TrackingID TrackingID of the Work Item

Desktop Action Displays fields attached to an event on an agent’s desktop.

Attributes

CALLBACK_PDU=REQUEST_CALLBACK

REQUEST_ID

CUSTOMER_NUMBER

CALLBACK_END_TIME

CALLBACK_ATTMEPT

CONTACT_ID

CONTACT_TITLE

CONTACT_FIRST_NAME

CONTACT_LAST_NAME
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EventCallBackCancel

EventCallBackRejected

EventCallBackDone

Siebel CRM DeviceEvent Name: EventCallBackCancel

Web Callback Device Event: UpdateEventCallBackCancel

Description Request from Callback Server to cancel callback.

TrackingID TrackingID of the Work Item

Desktop Action Removes callback from an agent’s desktop.

Attributes
CALLBACK_PDU=CANCEL_CALLBACK

REQUEST_ID

Siebel CRM DeviceEvent Name: EventCallBackRejected

Web Callback Device Event: UpdateEventCallBackRejected

Description Callback request rejected.

TrackingID TrackingID of the Work Item

Desktop Action Removes callback from an agent’s desktop.

Attributes
CALLBACK_PDU=CALLBACK_REJECTED

REQUEST_ID

Siebel CRM DeviceEvent Name: EventCallBackDone

Web Callback Device Event: UpdateEventCallBackDone

Description Callback request completed.

TrackingID TrackingID of the Work Item

Desktop Action Removes callback from an agent’s desktop.

Attributes
CALLBACK_PDU=CALLBACK_DONE

REQUEST_ID
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Voice Callback Device Events

This section provides a detailed description of device events for the Voice 
Callback configuration. Following are the device events for the Gplus Voice 
Callback configuration (see Table 22).

EventAddVCBRequest

Table 22:  VCB Events

Gplus Adapter Name Genesys VCB Server Name

EventAddVCBRequest RequestCallbackAdd

EventVCBServiceStatus RequestCallbackServiceStatus

EventVCBQuery RequestCallbackQuery

EventVCBQueryResult RequestCallbackQueryResult

EventVCBCancel RequestCallbackCancel

EventVCBReschedule RequestCallbackReschedule

EventVCBPreview RequestCallbackPreview

EventVCBProcessed RequestCallbackProcessed

EventVCBReject RequestCallbackReject

EventVCBError RequestCallbackError

Gplus Adapter Event Name: EventAddVCBRequest

VCB Protocol User Event: AddCallbackRequest

Description
VCB Server sends this response to VCB Client to confirm that request 
has been processed.

Client Action Not specified

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_ERROR_CODE

VCB_ERROR_NAME
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EventVCBServiceStatus

Gplus Adapter Event Name: EventVCBServiceStatus

VCB Protocol User Event: RequestCallbackServiceStatus

Description
VCB Server sends this response to VCB Client to confirm the 
availability of Voice Callback service.

Client Action Perform Callback Request processing.

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_STATUS: 0 or 1

If Routing Point was specified in request:

VCB_RESPONSE_TYPE = 1 “SingleResult”

If Routing Point was not specified:

VCB_RESPONSE_TYPE = 2 “MultipleResult”

or

VCB_RESPONSE_TYPE = 3 “MultipleResultEnd”

VCB_LOCATION

VCB_ROUTING_POINT

VCB_ROUTING_POINT_DESCR

VCB_ERROR_CODE

VCB_ERROR_NAME
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EventVCBQuery

EventVCBQueryResult

Gplus Adapter Event Name: EventVCBQuery

VCB Protocol User Event: RequestCallbackQuery

Description
VCB Server sends this response back to Client to acknowledge query 
execution and to provide number of Callback Requests in result set.

Client Action
Sends back UserEvent (CallbackQueryGetResult) to request Query 
Result by index.

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_QUERY_COUNT

VCB_ERROR_CODE

VCB_ERROR_NAME

Gplus Adapter Event Name: EventVCBQueryResult

VCB Protocol User Event: RequestCallbackQueryResult

Description VCB Server sends to Client Callback Request for Callback Query.

Client Action Collect data.

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 1 “SingleResult”

VCB_RECORD_HANDLE

VCB_CURRENT_DN

VCB_QUERY_INDEX

VCB_ERROR_CODE

VCB_ERROR_NAME

UserData
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EventVCBCancel

EventVCBReschedule

Gplus Adapter Event Name: EventVCBCancel

VCB Protocol User Event: RequestCallbackCancel

Description
VCB Server sends this request to VCB Client to confirm cancellation of 
Callback Request.

Client Action Wait for next Callback Request.

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_RECORD_HANDLE (or VCB_CONTACT)

VCB_ERROR_CODE

VCB_ERROR_NAME

Gplus Adapter Event Name: EventVCBReschedule

VCB Protocol User Event: RequestCallbackReschedule

Description
VCB Server sends this request to VCB Client to confirm rescheduling 
of Callback Request.

Client Action Wait for next Callback Request.

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_RECORD_HANDLE

VCB_ERROR_CODE

VCB_ERROR_NAME
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EventVCBPreview

EventVCBProcessed

Gplus Adapter Event Name: EventVCBPreview

VCB Protocol User Event: RequestCallbackPreview

Description
Desktop confirms that Callback Request has been received and 
accepted.

Callback Server 
Action

Not specified

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_RECORD_HANDLE

Gplus Adapter Event Name: EventVCBProcessed

VCB Protocol User Event: RequestCallbackProcessed

Description
VCB Server sends this request to Desktop to confirm that corresponding 
request has been processed.

Desktop Action Not specified

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_RECORD_HANDLE
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EventVCBReject

EventVCBError

Error Codes and Descriptions

This section describes Voice Callback error codes, error numbers, and 
descriptions (see Table 23).

Gplus Adapter Event Name: EventVCBReject

VCB Protocol User Event: RequestCallbackReject

Description
VCB Server sends this request to Desktop to confirm that corresponding 
request has been rejected.

Desktop Action Not specified

Attributes

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID

VCB_REFERENCE_ID

VCB_RESPONSE_TYPE = 0 “Acknowledge”

VCB_RECORD_HANDLE

Gplus Adapter Event Name: EventVCBError

VCB Protocol User Event: RequestCallbackError

Description
VCB Server sends this request to Desktop to inform about an error 
condition.

Desktop Action
Removes Work Item from desktop when ERR# is {100, 102, 103, 104, 
108} and keeps it when ERR# is {101, 105, 106 }

Attributes

VCB_ERROR

VCB_ ERROR_ NUMBER

VCB_ORIGIN_APPLICATION_ID

VCB_TARGET_APPLICATION_ID = 0

VCB_REFERENCE_ID

VCB_ RESPONSE _TYPE= 4 “Error”
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Predefined Attributes
Table 24 represents the reserved attribute names.

Table 23:  VCB Error Codes and Descriptions

VCB_ERROR VCB_ERROR_
NUMBER

Description

Invalid Request 100 Invalid request type

Invalid Request Data 101 Some mandatory keys are missing

Call not found 102 Call not found on the server

Record not found 103 VCB received request regarding non-
existing or already-processed record

Request Already 
Processed

104 Received request refers to Callback 
Request already processed

DB Error 105 Can not execute the request due to DB 
error

AddRecordError 106 Can not add the record

ScheduleRecordError 108 Error rescheduling a record

Table 24:  Predefined Attributes

Key Value Type Description

VCB_USER_EVENT_REQUEST Request identifier for 
any request

String Request (procedure) name

VCB_USER_EVENT_RESPONSE Response identifier for 
any response

String Name of corresponding request 
(procedure)

VCB_ RESPONSE _TYPE 0, “Acknowledge”

1, “SingleResult”

2, “MultipleResult”

3, “MultipleResultEnd”

4, “Error”

Int Type of response

VCB_TARGET_APPLICATION_ID Application ID Int

VCB_ORIGIN_APPLICATION_ID Application ID Int
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VCB_REFERENCE_ID Session-wide unique 
request identifier

Int Maintained by requestor

VCB_CALL_RESULT 0, "Ok" 
3, "General Error"
4, "System Error"
6, "Busy" 
7, "No Answer" 
8, "SIT Detected"
9, "Answering Machine"
10, "All Trunks Busy" 
11, "SIT Invalid Num" 
12, "SIT Vacant" 
13, "SIT Oper Intercept" 
14, "SIT Unknown" 
15, "SIT No Circuit" 
16, "SIT Reorder" 
17, "Fax Detected" 
21, "Abandoned" 
26, "Dropped" 
27, "Dropped No 
Answer" 
28, "Unknown" 
32, "Silence"
33, "Answer"
34, "NuTone"
35, "NoDialTone"
36, "NoProgress"
37, "NoRingBack"
38, "NoEstablishe"
39, "Pager Detected"
40, "Wrong Party"
41, "Dial Error"
42, "Call Drop Error"
43, "Switch Error"
44, "No Free Port Error"
45, "Transfer Error"
46, "Stale"
47, "Agent CallBack 
Error"
48, "Group CallBack 
Error

Int Call Result from previous dial 
attempt or Call Result Agent 
sends to change automatically 
detected one.

Table 24:  Predefined Attributes (Continued) 

Key Value Type Description
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VCB_ERROR_CODE Error Code, see Error 
Codes table.

Int Must be present when 
VCB_RESPONSE_TYPE = 4 
“Error”

VCB_ERROR_NAME Error Name String Must be present when 
VCB_RESPONSE_TYPE = 4 
“Error”

VCB_CURRENT_DN DN Number String DN that Callback Request 
currently resides on

VCB_CONTACT String of digits String Contact number (for example, 
phone number)

VCB_TYPE 0, ”Unknown”

1, “ASAP”

2, “Scheduled”

String Callback Type

VCB_QUEUE String To define search condition by 
Queue

VCB_STAGE 0, “Unknown”

1, “Queued”

2, “NotQueued”

Int To define search condition by 
stage of Callback Request 
processing.

“Queued” means that Callback 
Request is in queue awaiting 
distribution.

VCB_ROUTING_POINT Name of Routing Point 
associated with Voice 
Callback Service

String To specify Routing Point in 
request to VCB Server

VCB_ROUTING_POINT_DESCR Description of Routing 
Point associated with 
Voice Callback Service

String Description which Agent may 
use to assign Agent-created 
Callback Request to most 
appropriate queue

VCB_LOCATION Name of Switch String To specify Location in request to 
VCB Server

VCB_DATE_TIME “MMDDYYYYHHMM” String Date/Time to schedule callback

VCB_EWT “HHMM” String EWT estimated during Callback 
offering

Table 24:  Predefined Attributes (Continued) 

Key Value Type Description
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VCB_EWT_TIME “MMDDYYYYHHMM” String Date/Time when EWT was 
estimated

VCB_ATTEMPTS 0... Int Number of attempts

VCB_ORIGIN 0, “Unknown”

1, “IVR”

2, “WEB”

3, “Desktop”

String Callback origination

VCB_TZ_NAME String Config Server TZ Name (usually 
standard three letter abbreviation 
such as PST)

VCB_STATUS 0, “Unknown”

1, “Not Available”

2, “Available”

String Availability of Callback service

VCB_QUERY_COUNT 0... Int Number of Callback Requests 
returned by Query

VCB_QUERY_INDEX 1... Int Index of Callback Request in 
Query Result Set

CRM_RECORD_MODE "Preview"

"Auto"

String VCB delivery mode, “Auto dial” 
or “Manual”

CRM_REFERENCE_ID String

CRM_IS_VCB_VIEW “TRUE”

“FALSE”

String Indicates that current Siebel 
view is VCB view.

CRM_PROTOCOL_EXT “OCS” 

“WCB” 

“VCB”

String Genesys protocols shortcuts for 
Outbound Contact Server and 
Voice Callback Solution

Table 24:  Predefined Attributes (Continued) 

Key Value Type Description
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6 Configuration and 
Installation of the Gplus 
UCS Gateway
This chapter describes how to configure and install the Gplus UCS Gateway. 

This chapter includes the following sections:
 Overview, page 325
 New in This Release, page 325
 Configuring Genesys, page 326
 Installation, page 329
 Configuring Siebel, page 330

Overview
The UCS Gateway is a back-end component used by the Gplus Multimedia 
Component to access data stored in the Genesys Universal Contact Server.

New in This Release
This section provides information about new features or functionality in this 
release of the Gplus UCS Gateway Component:

• Supports Siebel 8.0

• Allows the option to start the Gplus UCS Gateway using Windows services
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Configuring Genesys
This section describes how to configure the Genesys section of the UCS 
Gateway. 

Importing the Application Template

To import the UCS Gateway Application Template:

1. In Configuration Manager, under Environment, right-click the Application 
Templates folder.

2. Select Import Application Template.

3. Browse to and select the Application Template for the UCS Gateway. The 
name of this template is:
Gplus_UCS_Gateway_for_SiebelCRM_750.apd

4. Click Open. 
The Properties dialog box for the Application Template object displays.

5. Click OK to accept the default values.

The Application Template object has been imported to the Genesys 
Configuration Layer. 

Creating the Application Object

To create the Application object for the UCS Gateway:

1. In Configuration Manager, under Environment, right-click the 
Applications folder.

2. Select New > Application.

Select the Application Template that you just created:
Gplus_UCS_Gateway_for_SiebelCRM_750.apd

3. Click OK.

The Properties dialog box for the Application appears.

Below are instructions for configuring the tabs in the Properties dialog box, 
arranged in the order in which they display. The first tab is the General tab (see 
Figure 27 on page 327).
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Figure 27: View of General Tab in Single-Tenant Environment

General Tab

1. Enter the name of the Application object you are configuring.

2. Select the Server Info tab.
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Server Info Tab

1. Host field: Use the Browse button to select the host where you are 
installing the UCS Gateway and click OK. 

2. Communications Port field: Enter any valid port number. The port number 
must match the port specified in the URL of the Genesys Gplus 
WebService in Siebel.

Note: This option determines the HTTP port number used by the UCS 
Gateway to receive HTTP packets from Siebel. You will use the 
value that you enter for this option when you configure the Siebel 
part of the UCS Gateway.

3. Select the Start Info tab.

Start Info Tab

1. Working Directory field: Enter the full name of the Component installation 
directory on the host you specified on the Server Info tab. The value you 
enter in this field will be used as the default destination folder during 
installation.

2. Enter any valid value into each of the following fields:
 Command Line
 Command Line Arguments

The values you enter in these fields will be overwritten during installation; 
however, data must be present in these fields during the configuration 
process.

3. Leave the default values for the remaining fields.

4. Select the Connections tab.

Connections Tab

1. Add a connection to the Universal Contact Server.

2. Select the Options tab.

Options Tab

On the Options tab (see Figure 28 on page 329), in the Sections pane, the 
following section is listed:

• Log
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Figure 28: View of Options Tab

Log Section

The UCS Gateway supports the unified set of log options (common log 
options) to allow precise configuration of the log file output. For a complete 
list of unified log options and their descriptions, see the “Common Log 
Options” chapter of the Framework 7 Configuration Options Reference 
Manual.

If you do not specify any log options, the default values apply.

Installation
This section describes the installation process for the Gplus Adapter 7.5 UCS 
Gateway.
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UCS Gateway Memory Allocation

If you intend for your environment to handle large e-mails (which usually 
means working with with large attachments to e-mails), you may need to 
increase the amount of memory you allocate for the UCS Gateway. 
(Insufficient memory may cause the UCS Gateway to return an HTTP 500 
error when the driver makes a request to add attachments to EmailOut.)

Use the -Xmx option to set the maximum memory size for the UCS Gateway. 
You can change this option in the starter.ini file on Windows platforms, or in 
startup.sh file on UNIX platforms. For example, to set the maximum memory 
size to 512 MB, change the -Xmx option to 512M.

Performing the Installation

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

• To start the installation process, run the setup.exe file (for Windows) or 
install.sh file (for UNIX) from the UCS Gateway installation package 
and follow the setup instructions.

Configuring Siebel
For the description of how to configure Siebel for the UCS Gateway Server, 
please see “Configuring the Definition of the UCS Gateway in Siebel” on 
page 343.
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 Updating and Deploying the Siebel Repository File, page 335
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 Configuring Multimedia Agents, page 347
 Driver and Configuration Parameters, page 349
 Device Commands, page 356
 Device Events, page 365
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Overview
Installation and configuration of the Multimedia Component includes:

• Installing Genesys Open Media Communication Driver (itx_scdrv) on the 
Gplus Communication Server

• Compiling and deploying the Siebel Repository

• Configuring business services access permissions

• Deploying web templates and browser scripts

• Configuring Siebel.

See the Gplus Adapter 7.5 for Siebel CRM User’s Guide for additional 
information about using this component.

New in This Release
This section provides information about new features or functionality in this 
release of the Multimedia Component:

• Supports Siebel 8.0, 8.1.

• Supports transfer of chat interactions through a user interface enhancement

• Allows the agent to perform spell checking on a chat response before 
sending out the response

• Displays chat responses with the most recent on the bottom of the 
transcript

Installing the Multimedia Component
The Multimedia Component can be installed on either Windows or UNIX 
platforms.

Installation Prerequisites

The following are prerequisites for installation of the Multimedia Component:

• Back up the Siebel database and .srf file.

• Install the Gplus Communication Server (see Chapter 2, “Configuration 
and Installation of the Gplus Communication Server for Siebel CRM,” on 
page 31).

• Install the Gplus UCS Gateway (see Chapter 6, “Configuration and 
Installation of the Gplus UCS Gateway,” on page 325).
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Installation and Uninstallation Guidelines

On Windows, the target computer may have only one installation of the Gplus 
Adapter 7.5 for Siebel CRM. On UNIX, more than one installation of the 
Adapter is allowed, but on any single computer, you can only have one 
Adapter for every Siebel Server.

If the Adapter is already installed on the target computer, a new installation is 
considered as a reinstallation on that computer. Before you reinstall, you will 
be asked to uninstall the Gplus Adapter on Windows or confirm the 
reinstallation on UNIX platforms. 

The installation package contains complementary pairs of icons for the 
Ready/NotReady buttons. During the installation process, standard Siebel 
icons for the NotReady button are overwritten with new ones from the Genesys 
installation package. To preserve the standard Siebel icons, Genesys 
recommends that you backup the Siebel image files 
icon_notready_enabled.gif and icon_notready_disabled.gif in a safe 
location. If you uninstall the Gplus Adapter, you can manually restore the 
original buttons with these files.

Note: Genesys recommends backing up the Siebel Web Template file 
CCHtmlType.swf before starting the installation procedure. For Siebel 
7.5 users Genesys recommends backing up the Siebel Web Template 
file CCFrameToolbar.swt as well.

Installation Procedure

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

1. Start the Multimedia Component setup program on the host where the 
Gplus Communication Server is installed.

2. Setup will ask about the path to the Gplus Communication Server. (For 
Windows installation, skip to the next step.) Provide the correct path. The 
setup will install the files necessary for running the Open Media 
Communication Driver (itx_scdrv) in this folder.

3. Setup will ask about the path to the main installation directory. The 
installation program will put the Siebel archive, scripts, images, and 
general production information in this folder
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Note: In the case where the Voice component is not installed, you must 
manually copy files representing icon images depending on your 
version of the Siebel Server: from <Destination 
Directory>/images/7.7 (for Siebel 7.7/7.8/8.0/8.1), or from 
<Destination Directory>/images/7.5 (for Siebel 7.5.3) to the 
following directory:

< Web Server Host>/< SWEIconImages directory >



Gplus Adapter for Siebel CRM—Deployment Guide 335

Chapter 7: Configuration and Installation of the Multimedia Component Updating and Deploying the Siebel Repository 

Updating and Deploying the Siebel 
Repository File

Updating the Siebel Repository File

1. Start Siebel Tools.

2. If not done previously for the Voice component, import the 
GenSymbolicStrings.sif (for Siebel 7.8 and higher), GenComm.sif, and 
GenesysTools.sif archives from
<Installation Directory>/OBJECTS/<Siebel Version>, where <Siebel 
Version> is 7.5, 7.7, 8.0 or 8.1.

3. Create the Genesys Multimedia project, if it does not exist. Lock it.

4. Choose one of the Action-related Siebel BCs that you use and that 
corresponds with the following conditions.

The BC must have the following fields:
 Attachment Flag
 Attachment Id
 Call Id
 Comment
 Description
 Email BCC Line
 Email Body
 Email CC Line
 Email Sender Address
 Email To Line
 Parent Activity Id
 Primary Contact Id
 Short Comment
 Started
 Status
 Type

The BC should not have the following fields:
 Attachment File Name
 Attachment Flag 2
 Interaction Id

For example, you might use the Action Home Page or Action BC.

5. Make three copies of the chosen BC and name them:
Action - Genesys MCR.

Action - Genesys MCR(EmailOut).
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Genesys Action(Chat).

Put them in the Genesys Multimedia project.

6. Make a copy of the Action Attachment BC and name it Action Attachment 
- MCR EmailOut. Put it in the Genesys Multimedia project.

7. Choose one of the Contact-related Siebel BCs that you use and that 
corresponds with the following conditions:

The BC must have the following fields:
 Comment
 Email Address
 Employee Flag
 First Name
 Job Title
 Last Name
 Login Name
 Status

The BC should not have the following fields:
 IsBCC
 IsCC
 IsTo

For example, the BC might be the Contact(All) BC.

8. Make three copies of the chosen BC and name them:
Contact - Genesys MCR(EmailOut)

Inbound Interaction Contact List

Outbound Interaction Contact List

Put them in the Genesys Multimedia project.

9. Import the GplusMCR_Email_Chat_nested.sif archive from 
<InstallationDirectory>/OBJECTS/<Siebel Version>, where <Siebel 
Version> is 7.5, 7.7, 8.0 or 8.1. It will update the BCs you just created.

In the Import Wizard-Preview window, locate the Conflict resolution 
section, and select “Merge the object definition from the archive file with 
the definition in the repository.”

Then carefully merge changes, keeping the following rules in mind:

a. The tables that follow contain the meaningful objects and attributes for 
Genesys adapter functionality (relating to the cloned BCs). All other 
objects and attributes MUST be taken from the original BCs. For 
example, the value of the Resolution option must be set to Repository.

b. For each object or attribute that is listed in the tables, the value of the 
Resolution option must be set to File, as long as no conflict exists.

c. If there are conflicts for a given attribute or object, the conflicts must 
be resolved manually.
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Table 25: Action - Genesys MCR BC Objects and Resolutions

Object Type Object Name Resolution

BC Attribute INACTIVE File

BC Attribute NO_DELETE File

BC Attribute NO_INSERT File

BC Attribute NO_MERGE File

BC Attribute NO_UPDATE File

BC Attribute SCRIPTED File

Server Script BindActivityContacts File

Server Script BusComp_PreWriteRecord File

Server Script BusComp_SetFieldValue File

Server Script UpdateEmailInfo File

Field Attachment File Name File

Field Interaction Id File

Multi Value link Attachment File

Table 26: Action - Genesys MCR(EmailOut) BC Objects and 
Resolutions

Object Type Object Name Resolution

BC Attribute INACTIVE File

BC Attribute NO_DELETE File

BC Attribute NO_INSERT File

BC Attribute NO_MERGE File

BC Attribute NO_UPDATE File

BC Attribute SCRIPTED File

Server Script BindActivityContacts File

Server Script BusComp_PreWriteRecord File

Server Script BusComp_SetFieldValue File
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Server Script PrintPropertySet File

Server Script SkipMETA File

Server Script UpdateEmailInfo File

Field Attachment File Name File

Field Attachment Flag 2 File

Field Interaction Id File

Multi Value link Attachment File

Table 27: Genesys Action(Chat) BC Objects and Resolutions

Object Type Object Name Resolution

BC Attribute INACTIVE File

BC Attribute NO_DELETE File

BC Attribute NO_INSERT File

BC Attribute NO_MERGE File

BC Attribute NO_UPDATE File

Field Type File

Table 28: Action Attachment - MCR EmailOut BC Objects and 
Resolutions

Object Type Object Name Resolution

BC Attribute INACTIVE File

BC Attribute NO_DELETE File

BC Attribute NO_INSERT File

BC Attribute NO_MERGE File

BC Attribute NO_UPDATE File

BC Attribute SCRIPTED File

Table 26: Action - Genesys MCR(EmailOut) BC Objects and 
Resolutions (Continued) 

Object Type Object Name Resolution
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10. For the Action - Genesys MCR and Action - Genesys MCR(EmailOut) BCs, 
set the field attribute Force Active to the checked state (or true in the 
Property window) for the following fields:
 Email Sender Address
 Email To Line
 Email BCC Line
 Email CC Line
 Description
 Email Body

Server Script BusComp_NewRecord File

Server Script BusComp_PreDeleteRecord File

Server Script BusComp_PreInvokeRecord File

Server Script BusComp_WriteRecord File

Field ActivityIsNew File

Table 29: Contact - Genesys MCR(EmailOut) BC Objects and 
Resolutions

Object Type Object Name Resolution

BC Attribute INACTIVE File

BC Attribute NO_UPDATE File

BC Attribute SCRIPTED File

Server Script (declarations) File

Server Script BusComp_PreGetFieldValue File

Server Script BusComp_PreInvokeRecord File

Server Script BusComp_PreSetFieldValue File

Server Script ClearIntArrays File

Field IsBCC File

Field IsCC File

Field IsTo File

Table 28: Action Attachment - MCR EmailOut BC Objects and 
Resolutions (Continued) 

Object Type Object Name Resolution
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 Interaction Id
 Type
 Started
 Status

11. For the Action Attachment - MCR EmailOut BC, set the field attribute Force 
Active to the checked state (or true in the Property window) for the 
following fields:
 Activity Id
 ActivityFileExt
 ActivityFileName
 ActivityFileSize

12. For the Inbound Interaction Contact List and Outbound Interaction 
Contact List BCs, set the attribute No Update to the unchecked state (or 
false in the Property window).

13. Import the GplusMCR_Email_Chat.sif archive from <Installation 
Directory>/OBJECTS/<Siebel Version>, where <Siebel Version> is 7.5, 
7.7, 8.0, or 8.1.

14. Apply and activate the following tables:
 CX_AGNT_WB_CNT
 CX_GEN_ACT_CHAT
 CX_GEN_ACT_X

15. Make sure the following web templates exist:
 Applet Form Grid Layout
 Applet Popup Form Grid Layout

If they do not exist, create them by importing the gridlayout.sif file from 
<Siebel Tools root directory>\OBJECTS. To do this, the Siebel Tools and 
Common Components projects need to be locked.

If there is no gridlayout.sif file available, create these web templates:
 <Name = Applet Form Grid Layout, Type = Applet Template - Grid 

Layout, Project = <Any Locked Project>

then create a new record on the Web Template Files applet:
filename=CCAppletFormGridLayout.swt, Name = Generic Form Applet 
(Base)

 <Name = Applet Popup Form Grid Layout, Type = Applet Template - 
Grid Layout, Project = <Any Locked Project>

then create a new record on the Web Template Files applet:
filename=CCAppletPopupFormGridLayout.swt, Name = Generic Form 
Applet (Base)

16. Add the Genesys tab (screen = Genesys) to the Siebel application being 
used (such as Siebel Universal Agent (for Siebel Horizontal version) or 
Siebel Financial Services (for Siebel Vertical version)).

For Siebel Servers 7.7/7.8/8.0/8.1, when inserting the tab record, in 
addition to the Screen column you also need to define the column Text - 
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String Override or provide Text - String Reference. If you want to use 
Text - String Reference, then you must first create a symbolic string for a 
name of Genesys and enter it in the text field. To create a symbolic string:

a. Click Symbolic String in the Object Explorer view

b. Click on Symbolic String view and press Ctrl+N to create a new 
record.

c. Set the Name field to a X_Genesys value.

d. Set the Current String Value field to a name of Genesys.

e. Set Project Filed to any locked project.

f. Set the Type field to a Conversion value.

For Siebel Server 7.5.3, when inserting the tab record, in addition to the 
Screen column you also need to define the column “Text” = Genesys.

17. Add or modify (if it already exists) the Server script handler for the 
Application_PreNavigate event for the Siebel application being used. The 
content of the event handler is provided in the <InsDir>/OBJECTS/ 
Application_PreNavigate.es file. To do this:

a. Refer to “Updating the Application's Application_PreNavigate Event 
Server Script” on page 436 in the Appendix for general instructions.

b. Select the application object, open the context menu by clicking the 
right mouse button, and choose Edit Server Scripts. If there are no 
server scripts associated with the application object, you will be asked 
to select the scripting language. Please select eScript in this case.

c. Double-click the Application_PreNavigate event. Siebel Tools will 
show the content of the corresponding event handler.

d. If the content consists only of return (ContinueOperation), just 
replace all content with the content of the 
<InsDir>/OBJECTS/Application_PreNavigate.es file. 

e. If the Universal Callback feature of the Voice Component was 
deployed, the Application_PreNavigate event handler was already 
changed, and now needs to be merged with the 
Application_PreNavigate.es file. 

f. If Application_PreNavigate is already customized, you will need to 
merge Application_PreNavigate.es with your customized code, 
depending on your original customization logic. 

g. Save changes in the server script and close the script window.

18. For users of Siebel 8.0 and higher:

Allow access to the Genesys Chat and Communications Client Business 
Services from the browser script by adding the following user properties to 
the application you use:
 ClientBusinessServiceN = Genesys Chat
 ClientBusinessServiceM = Communications Client where N and M must 

be sequential integers, starting at 0 and incrementing by one. These 
integers should be different from existing integers.
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19. Compile the .srf and browser scripts.

Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript 
Engine (and not the ST eScript Engine). The default Siebel option 
is set to Enable ST Script Engine = TRUE, but for the Genesys 
component it should be set to Enable ST Script Engine = FALSE.

Deploying the Siebel Repository File, Browser Scripts, Web 
Templates, and Changing Siebel Server Configuration

To deploy the Repository File, use the compiled Repository File as the Siebel 
Server Repository File. To do this:

1. Stop the Siebel Server.

2. Back up the original Siebel Repository File.

3. Copy the compiled repository file instead of the original Siebel Repository 
File.

4. Deploy (copy) browser scripts from the <Browser script compilation 
folder> as set in Siebel Tools to the corresponding Siebel Web Server 
extension folder (<SWEApp>/public/language_code).

5. Deploy (copy) the content of <Installation Directory>/WEBTEMPL/<Siebel 
Version> into the Siebel Server WEBTEMPL directory.

where <Siebel Version> is 7.5, 7.7, 8.0 or 8.1.

6. Add the content of the <Installation 
Directory>/WEBTEMPL/<SiebelVersion>/ToMerge/GenesysHtmlType.swf file 
to the CCHtmlType.swf from the Siebel Server WEBTEMPL directory.

7. Deploy (merge if the file was customized) commToolbar_shared.js from 
<Installation Directory>/SCRIPTS/<Siebel Version> with Siebel Server 
commToolbar_shared.js, which should be located in the corresponding 
Siebel Web Server extension folder 
(<SWEApp>/public/language_code\latest system browser folder (the 
folder with the name = largest number)\scripts).

<Siebel Version> is 7.5, 7.7, 8.0 or 8.1.

8. For Siebel versions prior to 8.0:

Allow access to the Genesys Chat Business Service from the browser 
script:

a. Open the application configuration file (for instance, for Siebel 
Universal Agent—for Siebel Horizontal version—or Siebel Financial 
Services—for Siebel Vertical version—the uagent.cfg, or for Financial 
Services, the fins.cfg) with a text editor.

b. Find the [SWE] Section.
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c. Add the following lines:
ClientBusinessServiceN = Genesys Chat 

ClientBusinessServiceM = Communications Client

where N and M must be sequential integers, starting at 0 and 
incrementing by one. These integers should be different from integers 
in existing ClientBusinessService lines.

d. Save and close the file

9. Start the Siebel Server.

10. Set up business service query access for:
Genesys Chat,MCR Activity manager,MCR 

TopActiveWorkItem,GplusMediaRoute (if the Media Routing Component 
will be deployed)
Services in the Siebel Server configuration.

For Siebel Web Client 7.7 and higher, the business service name has to be 
specified as the value for the Business Service Query Access List Server 
Component parameter.

a. Log in to the Siebel Server as Siebel administrator.

b. Navigate to Administration > Server Configuration > Enterprises.

c. On the Component Groups tab, select the required component, for 
example: Siebel Financial Services.

d. Switch to the Parameters tab.

e. Navigate to the Business Service Query Access List.

f. If the value is empty, set it to:
Genesys Chat,MCR Activity manager,MCR 
TopActiveWorkItem,GplusMediaRoute
Otherwise add it to the end, separated by a comma.

Note that there are no empty spaces after the commas in the value.
g. Restart the Siebel Server.

Configuring the Definition of the UCS 
Gateway in Siebel

To configure the definition of the UCS Gateway in Siebel:

1. Log in as Siebel administrator.

2. Navigate to the Outbound Web Services configuration view (Web Services 
administration).

3. Import OBJECTS/<Siebel Version>/Gplus.xml.

This should create the Genesys Gplus WebService outbound web service.
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4. Configure the Genesys Gplus WebService by changing the URL in the 
Address field of the Gplus Service port. The URL should point to the 
installed UCS Gateway.

For example:
http://cti-ucs:2006/gateway
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Performing Certain Imports
To import “List of Value,” View Definitions, Responsibilities, and Predefined 
Queries:

1. Log in as Siebel administrator.

2. Open the Site Map, then navigate to Administration - Business Service, 
Simulator (in 7.5.3, Business Service Administration, Service 
Simulator).

3. Specify Genesys Tools as the Service Name, ImportAll as the Method 
Name, and set Iterations to 1.

4. In the Input Arguments (in 7.5.3, Input Property Set) applet, click the 
Load From File button, browse for <InsDir>/OBJECTS/GplusMCR_LOV.xml 
and load this file as shown in Figure 29 on page 345.

Figure 29: Importing Lists of Values, View Definitions, Responsibilities, and Predefined Queries

5. Click Run on the Service Methods applet. Import results can be checked in 
the Output Arguments (in 7.5.3, Output Property Set) applet.

Adding Responsibility to Agents
To create a new responsibility:
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1. Log in as Siebel administrator.

2. Navigate to Application Administration, Responsibilities.

3. Find the Genesys Multimedia Agent Responsibility.

4. Use the Users applet to add agents who will use Multimedia views.

5. Log out.

Importing Configurations
To create a new configuration import:

1. Log in as Siebel administrator.

2. Navigate to Communication Administration, All Configurations view. 

3. Create a New Configuration import OBJECTS/GenComm_universal.def from 
the installation directory.

For more information, refer to the section “Universal Definition File” on 
page 22 in Chapter 1, “System Requirements.” 

Configuring the CTI Connection
Using the Gplus Communication Server:

1. Log in as Siebel administrator.

2. Navigate to Communication Administration, All Configurations view. 

3. Find the target configuration.

4. Click the Profiles tab, then click on the Gplus_OpenMedia driver. 

5. Specify the Driver:PrimaryGenCommServerURL parameter, by providing the 
location of the Gplus Communication Server.

For example, if the Gplus Communication Server is installed on host cti, 
and port 18000 is specified in the Genesys Configuration Layer as the 
Server port, then:
Driver:PrimaryGenCommServerURL=” http:://cti:18000”

Notice that the specified name must be resolvable from the host where the 
Siebel Communication Server is running.

6. If you have a backup Gplus Communication Server, enter information for 
the Driver:BackupGenCommServerURL, otherwise leave it empty.

7. Specify the Driver:SCAPIServerURL. This URL should contain the host of 
the Siebel Communication Server and any free port on this host. For 
example:
Driver:SCAPIServerURL=” http:://siebel:18081”
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The host name provided must be resolvable from the host where the Gplus 
Communication Server is running.

8. Specify the Service:ConnectionName. This should contain the Connection 
name (Application of Interaction Server) as specified in the Connections 
tab for the Gplus Communication Server. For example:
Service:ConnectionName= InteractionServer_Switch_122 

9. Log out.

Configuring Multimedia Agents
Agent configuration consists of:

• Adding Genesys Multimedia Agent responsibility to each target agent

• Configuring agent telesets

• Assigning agents to the Multimedia configuration

Adding Genesys Multimedia Agent Responsibility

1. Log in as Siebel administrator.

2. Navigate to Application Administration, Responsibilities.

3. Find the Genesys Multimedia Agent Responsibility.

4. Use the Users applet to add agents who will use Multimedia views.

Configuring Agent Telesets

Table 30 shows how an example scenario would be defined.

1. Navigate to Communication Administration, All Telesets view.

Table 30: Siebel Telesets

Genesys Siebel

Object Type Name Object Type Name

Place MyTeleset Teleset MyTeleset

S MyTeleset@GP

Extension 1001 S 1001

ACD Position 2001 A 2001



348 Gplus Adapter 7.5

Chapter 7: Configuration and Installation of the Multimedia Component Configuring Multimedia Agents

2. Find the teleset the agent already uses, or create a new one for the new 
agent.

3. For a new agent, add the agent on the Agents tab.

4. Navigate to the Extensions tab and add the S type extension with name 
<Genesys Place>@GP.

Notice that if you use the Gplus Configuration Synchronization 
component, then the Genesys Place name is the same as the name of teleset 
in Siebel. For example:

Teleset Name= T_CUBE_0001 

then extension should be:

T_CUBE_0001@GP 

Assigning Agents to the Multimedia Configuration

1. Navigate to the Agent General Profile view.

2. Find the Agent, then add the multimedia configuration as the primary 
configuration for this Agent.

3. If Siebel-Genesys synchronization is not used, then it is necessary to 
manually define the Agent Login value the same as the “Employee ID” 
value from the Genesys Configuration layer.

Workbin Parameters

Workbins are available for use by an agent in Siebel defined as List of Value 
of type MCR_WORKBIN_TYPE, where the Language-Independent Code field defines 
the Siebel name of the workbin. The Display value should correspond to the 
workbin name as defined in Genesys Interaction Workflow Designer. It may be 
necessary to change Display value to correlate with a pre-existing Genesys 
Multimedia configuration.
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Driver and Configuration Parameters
Table 31 contains a list of the driver parameters for the Multimedia 
Component, which includes the Genesys Chat and Genesys E-mail drivers. 

Table 31: Driver Parameters

Parameter Name Default Value Must Be 
Defined 
in 
Profile?

Comment

Driver:BackupGenCommServerURL No Specifies the URL of 
the backup Gplus 
Communication Server

Driver:LibraryName itx_scdrv No The name of the remote 
driver module which 
will be loaded by Gplus 
Communication Server 
to handle requests for 
the Siebel 
Communication Driver.

Driver:PrimaryGenCommServerURL CHANGE_ME Yes Specifies the Universal 
Resource Locator 
(URL) of the primary 
Gplus Communication 
Server

Driver:SCAPIServerURL CHANGE_ME Yes Specifies the URL to 
which the Gplus 
Communication Server 
will send events

Name Gplus_OpenMedia No Driver name

Service:AgentId {@AgentID} No Uses the macro 
{@AgentID} to obtain 
Agent Login of the 
current agent
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Table 32 contains a list of the communications drivers properties for the 
Multimedia Component.

Service:ConnectionName CHANGE_ME Yes Specifies the name of 
the Interaction Server 
to be used

Service:DNList {@DNList} Yes Uses the macro 
{@DNList} to obtain a 
list of DNs (standard 
extensions of type S) 
associated with the 
current agent

Table 31: Driver Parameters (Continued) 

Parameter Name Default Value Must Be 
Defined 
in 
Profile?

Comment

Table 32: Communications Drivers Properties

Property Name Default Value Required Comment

Name Gplus_OpenMedia Yes The name of the driver; 
Should not be changed.

Channel Type OpenMedia Yes Driver’s channel type; 
should not be changed

Inbound True Yes Driver capability: can 
work with inbound 
interactions; should not be 
changed

Outbound True Yes Driver capability: can 
work with outbound 
interactions; should not be 
changed

Interactive True Yes Driver capability: 
designed for interactive 
work; should not be 
changed
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Table 33 contains a list of the configuration parameters for the Multimedia 
Component. 

Channel String email, chat, 
SiebelEmail, 
BackgroundEmail

Yes Specifies a comma-
separated list of supported 
Genesys media types

Library Name GenCommDrv Yes Name of local driver 
module; should not be 
changed

Table 32: Communications Drivers Properties (Continued) 

Property Name Default Value Required Comment

Table 33: Configuration Parameters

Parameter Name Default Value Required Comment

ChatTranscriptDirection TopToBottom No This value determines 
chat the transcript 
direction. Valid values 
are TopToBottom and 
BottomToTop.

CheckPopupBeforeExecute FALSE Yes Checks for presence of 
the popup window 
before navigation. 
Genesys recommend 
leaving this parameter 
set to FALSE.
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EmailInboundDoneQueue __STOP__ Yes MCR Queue where 
inbound e-mails will be 
placed after “Mark 
done” or “Reply” 
operations. __STOP__ 
means that processing 
of the interaction will 
be stopped completely. 
If post-processing for 
inbound e-mails is 
needed, this value 
should be changed to 
the post processing 
queue as defined in 
your business process 
workflow. (For details 
on post processing, see 
the Genesys 
Multimedia 
documentation).

EmailOutboundDoneQueue __STOP__ Yes MCR Queue where 
outbound e-mails will 
be placed after “Delete” 
operation. __STOP__ 
means that processing 
of the interaction will 
be stopped completely. 
If post-processing for 
deleted outbound 
e-mails is needed, this 
value should be 
changed to the post 
processing queue as 
defined in your 
business process 
workflow. (For details 
on post processing, see 
the Genesys 
Multimedia 
documentation).

Table 33: Configuration Parameters (Continued) 

Parameter Name Default Value Required Comment
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ExceptionLogPrefix exclog_ No This value determines 
the prefix of a log file 
(full name will be 
constructed as 
“< ExceptionLogPrefix 
>+<Agent Name>.log”) 
for storing error 
messages which may 
appear during CTI calls 
to Business Service 
methods.

FromAddress CHANGE_ME Yes This value must be 
changed. The value of 
this option is used to fill 
out the From field in 
outbound and reply e-
mails (for example, 
support@mycompany.com)

MediaRoutingDefaultQueue E-mails for agent 
processing

No If the queue is not 
explicitly specified in 
the submit request, then 
Siebel eMails and other 
open media workitems 
will be submitted into 
this queue.

Table 33: Configuration Parameters (Continued) 

Parameter Name Default Value Required Comment
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MediaRoutingDoneQueue __STOP__ No MCR Queue where 
Siebel eMails and/or 
other open media 
interactions will be 
placed after an agent 
completes handling of 
the interaction.

__STOP__ means that 
processing of the 
interaction will be 
stopped completely.

If post-processing for 
Siebel eMails and/or 
open media interactions 
is needed, this value 
should be changed to 
the post processing 
queue as defined in 
your business process 
workflow. (For details 
on post processing, see 
the Genesys 
Multimedia 
documentation).

NewOutboundEmailQueue E-mails for processing 
by agents

Yes MCR Queue where 
new outbound e-mail 
will be created

NoteEmailBodyTruncated ...Message is too large... 
whole content is 
attached as 
<EmailBodyAttachment
Name>

Yes Text which will be 
added to the end of an 
inbound e-mail if the 
size of the e-mail body 
exceeds the limit 
(16008 bytes).  
<EmailBodyAttachment
Name> is a special tag 
which will be replaced 
by the name of 
attachment containing 
the whole original 
message.

Table 33: Configuration Parameters (Continued) 

Parameter Name Default Value Required Comment
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NoteReplyBodyTruncated ...Source message is too 
large... skipped.

Yes Text which will be 
added (instead of the 
body of the original e-
mail) to the end of the 
reply e-mail, if the 
content of the reply e-
mail generated by 
default is greater than 
16008 bytes.

ReplyOutboundEmailQueue E-mails for processing 
by agents

Yes MCR Queue where 
outbound reply e-mail 
will be created

SendEmailNewDefaultQueue Outbound queue Yes MCR Queue where 
outbound e-mail will be 
placed as a result of the 
Send operation.

SendEmailReplyDefaultQueue Outbound queue Yes MCR Queue where 
reply e-mail will be 
placed as a result of the 
Send operation.

Table 33: Configuration Parameters (Continued) 

Parameter Name Default Value Required Comment
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Device Commands
The Interaction Server driver supports the following commands (different set 
of commands than the Voice driver supports):

OpenMediaLogin

Description Performs a Login request

stringParam Not Used

datasetParam Reason

(ReasonCode)

Optional Reason for login

Description

(ReasonValue)

Optional Description of reason

OpenMediaLogout

Description Performs a Logout operation

stringParam Not Used

datasetParam Reason

(ReasonCode)

Optional Reason for logout

Description

(ReasonValue)

Optional Description of reason

@some-media@OpenMediaReady

Description Set agent status to Ready for ‘some-media’ media type

stringParam Not Used

datasetParam Reason

(ReasonCode)

Optional Reason for becoming Ready, if any

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

@some-media@OpenMediaNotReady
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Description Set agent status to Not-Ready for ‘some-media’ media type.

stringParam Not Used

datasetParam Reason

(ReasonCode)

Optional Reason for becoming Not-Ready, if any

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

@some-media@OpenMediaChangeMediaStateReason

Description Change the agent media state reason for ‘some-media’ media type at any 
time while the agent is logged in.

stringParam Not Used

datasetParam Reason

(ReasonCode)

Optional Reason for media state, if any

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

OpenMediaAccept

Description Accept interaction (inbound or outbound) offered to the agent

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the item to be 
accepted. If not specified, the driver 
will choose ‘offered’ interaction based 
on built-in list of priorities.

ChatUsrNickName Optional Nickname of the agent to be used for 
chat (ignored for other interactions). If 
not provided, the value of 
Service:AgentId will be used instead.

TimeZoneOffset Optional Offset of agent time zone, used only 
for chat interactions. The default value 
is 0.
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OpenMediaReject

Description Rejects (declines) the offered but not accepted interaction back to the 
router

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the item to be 
rejected. If not specified, the driver will 
choose ‘offered’ interaction based on 
built-in list of priorities.

Reason

(ReasonCode)

Optional Reason for decline

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

OpenMediaPlaceInQueue

Description Places the interaction handled by agent into the specified queue and 
removes from the desktop. If queue name is __STOP__, then this command 
will completely stop processing of the interaction.

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the interaction. If not 
specified, the driver will use by default 
the currently selected interaction.

Reason

(ReasonCode)

Optional Reason for placing in queue or stopping 
processing

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

OpenMediaLeave

Description Declines the interaction currently handled by the agent. Similar to 
OpenMediaReject but acts for accepted interaction(s).

stringParam Not Used
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datasetParam TrackingID Optional Driver identifier of the interaction. If not 
specified, the driver will use by default 
the currently selected interaction.

Reason

(ReasonCode)

Optional Reason for declining the interaction

Description

(ReasonValue)

Optional Human-readable description of specified 
reason

OpenMediaSelect

Description Marks the specified interaction as selected (such as the default interaction 
if the command does not contain interaction id). This command should be 
used to synchronize the state of the Siebel communication toolbar which 
has one active (selected) interaction and the driver. If this command 
changes the selected interaction, the driver will send to Siebel the 
corresponding OpenMediaSelected event with interaction information 

stringParam Not Used

datasetParam TrackingID Mandatory Driver identifier of the item to be selected

OpenMediaDeselect

Description Deselects the specified interaction and sends an OpenMediaDeselected 
event to Siebel. If the specified interaction was not selected, no action is 
taken.

stringParam Not Used

datasetParam TrackingID Mandatory Driver identifier of the item to be 
deselected

OpenMediaSubmit

Description Creates a new interaction with the specified attributes in the specified queue

stringParam Not Used
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datasetParam InteractionId Mandatory Interaction ID of the interaction to be 
created

InteractionSubtype Mandatory Interaction subtype, such as 
OutboundNew, OutboundReply.

A list of possible Attribute Values is 
defined in Genesys Configuration 
under the corresponding Business 
Attribute.

InteractionType Mandatory Interaction type, such as Outbound, 
Inbound.

A list of possible Attribute Values is 
defined in Genesys Configuration 
under the corresponding Business 
Attribute.

MediaType Mandatory Media type of the new interaction, such 
as email, chat.

SubmitQueue Mandatory Queue where the new interaction is 
created

Properties Optional Additional attributes (user data). Notice 
that all unknown key-value pairs in 
datasetParam will be also treated as 
user data.

ParentId Optional ID of parent interaction

OpenMediaReply

Description Places in queue or stops processing of the specified interaction (parent) and 
creates a child interaction with the specified ID. This command combines 
OpenMediaPlaceInQueue and OpenMediaSubmit requests for convenience 
purposes. If more advanced logic is required, the base commands should be 
used instead.

stringParam Not Used



Gplus Adapter for Siebel CRM—Deployment Guide 361

Chapter 7: Configuration and Installation of the Multimedia Component Device Commands

datasetParam TrackingID Mandatory Driver ID of source item

Queue Mandatory Target queue for source interaction (can 
be __STOP__)

Reason

(ReasonCode)

Optional Reason for reply

Description

(ReasonValue)

Optional Human readable description of 
specified reason

InteractionId Mandatory Interaction Server Interaction ID of the 
interaction to be created

InteractionSubtype Mandatory Interaction subtype, such as 
OutboundNew, OutboundReply.

A list of possible Attribute Values is 
defined in Genesys Configuration 
under the corresponding Business 
Attribute.

InteractionType Mandatory Interaction type, such as Outbound, 
Inbound.

A list of possible Attribute Values is 
defined in Genesys Configuration 
under the corresponding Business 
Attribute.

MediaType Mandatory Media type of the new interaction, such 
as email, chat.

SubmitQueue Mandatory Queue where the new interaction is 
created

Properties Optional Additional attributes (user data). Notice 
that all unknown key-value pairs in 
datasetParam will be also treated as 
user data.

ParentId Optional ID of parent interaction

OpenMediaChangeProperties

Description Changes user properties associated with the specified interaction

stringParam Not Used
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datasetParam TrackingID Optional Driver identifier of the interaction. If not 
specified, the driver will use by default 
the currently selected interaction.

Properties Optional Properties to be updated

DeletedProperties Optional Properties to be removed from the 
interaction

<Unrecognized> Optional All pairs from the provided dataset 
which are not recognized as predefined 
attributes will be treated similarly to the 
value of the Properties parameter - 
updated.

OpenMediaPlaceInWorkbin

Description Places the specified interaction in the specified workbin. Upon successful 
completion, the interaction will be removed from the CTI toolbar.

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the 
interaction. If not specified, the 
driver will use by default the 
currently selected interaction.

Workbin Mandatory Name of the workbin as 
defined in the Genesys 
Interaction Workflow Designer

WorkbinAgentId

WorkbinPlaceId

WorkbinPlaceGroypId

WorkbinAgentGroupId

Depending on 
the type of 
workbin, one 
of these 
attributes will 
be mandatory.

Properties to be removed from 
the interaction

Reason

(ReasonCode)

Optional Operation reason

Description

(ReasonValue)

Optional Description of reason
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OpenMediaPullInteractionById

Description Pulls the specified interaction

stringParam Not Used

datasetParam InteractionId Mandatory ID of the interaction to be pulled

Reason

(ReasonCode)

Optional Operation reason

Description

(ReasonValue)

Optional Description of reason

OpenMediaTransfer

Description Transfers the interaction to another agent

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the item. If not 
specified, the driver will use by default 
the currently selected item.

WorkinAgentId Mandatory Target agent login ID (employee ID in 
Genesys terms)

ChatSend

Description Sends a chat message. Applicable only for chat interactions.

stringParam Not Used

datasetParam TrackingID Optional Driver identifier of the item. If not 
specified, the driver will use by default 
the currently selected item.

ChatMsgText Mandatory Text to be sent

ChatReleaseParty

Description Removes the specified party from the chat session

stringParam Not Used
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datasetParam TrackingID Optional Driver identifier of the item. If not 
specified, the driver will use by default 
the currently selected item.

ChatAfterAction Optional Action to be performed with chat 
session after removing the specified 
party. This can be:

KEEP_ALIVE

CLOSE_IF_NO_AGENTS

FORCE_CLOSE

See the Multi-Channel Routing Chat 
Development Guide for more 
information.

Default value is KEEP_ALIVE.

ChatUsrId Optional Assumes self if this is not provided

ChatMsgText Optional Text to be sent (if any)
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Device Events
This section provides detailed descriptions of device events for the Multimedia 
Component. For information about the use and syntax of the device events, 
refer to the Siebel Communications Server Administration Guide for your 
version of the Siebel Server.

Logged In

Device Event OpenMediaLoggedIn

Description Agent has been logged in

TrackingID Not applicable

Attributes TenantId Tenant identifier to which agent belongs

Invited

Device Event OpenMediaInvited

Description Agent is invited to handle the specified interaction

TrackingID Driver ID of the offered interaction

Attributes Interaction properties

Selected

Device Event OpenMediaSelected

Description Sent when the driver changes the internally-selected work item, usually 
sent as a result of a successfully completed OpenMediaSelect command

Attributes Interaction properties of the selected item
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Deselected

Device Event OpenMediaDeselected

Description Sent when the driver deselects a work item when another interaction is 
selected, usually sent as a result of successfully completed  
OpenMediaSelect and OpenMediaDeselect commands

Attributes Interaction properties of the selected item

Released

Device Event OpenMediaReleased

Description Interaction was released from the agent, usually as a result of a transfer, 
place in queue operation, and so on

Attributes Interaction properties

Accepted

Device Event OpenMediaAccepted

Description Interaction was successfully accepted

Attributes Interaction properties of the accepted work item

Submitted

Device Event OpenMediaSubmitted

Description Interaction was created

Attributes Interaction properties of the submitted work item

Pulled
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Device Event OpenMediaPulled

Description Interaction was pulled to the agent

Attributes Interaction properties of the pulled work item

Workbin Content

Device Event OpenMediaWorkbinContent

Description Deliver content of the specified workbin

Attributes WorkbinId Workbin identifier

Content Content of workbin

Workbin Content Changed

Device Event OpenMediaWorkbinChanged

Description Content of workbin was changed

Attributes WorkbinId Workbin identifier

InteractionId ID of the interaction

InteractionType Type of the interaction

InteractionSubtype Subtype of the interaction

MediaType Media type of the interaction

Parent Id ID of the parent interaction (if any)

Operation Type of operation if content changes

UserData User data

Chat New Part

Device Event ChatNewParty
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Description New party was added to the chat session

Attributes ChatUsrId Chat user ID

ChatUsrType Chat user type (AGENT or CLIENT)

ChatMsgType Chat message type (such as TEXT)

ChatUsrNick Nickname of the user who joined the chat 
session

ChatSerialNumber Sequential number of the chat event

ChatTimeshift Time shift of the chat session

ChatVisibility Chat visibility (reserved)

ChatStartedAt Chat start time

Chat Re Enter

Device Event ChatReEnter

Description Party re-enters the chat session

Attributes ChatUsrId Chat user ID

ChatUsrType Chat user type (AGENT or CLIENT)

ChatMsgType Chat message type (such as TEXT)

ChatUsrNick Nickname of the user who re-entered the chat 
session

ChatSerialNumber Sequential number of the chat event

ChatTimeshift Time shift of the chat session

ChatVisibility Chat visibility (reserved)

ChatStartedAt Chat start time

Chat Party Left
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Device Event ChatPartyLeft

Description Chat user left the chat session

Attributes ChatUsrId Chat user ID

ChatUsrType Chat user type (AGENT or CLIENT)

ChatMsgType Chat message type (such as TEXT)

ChatUsrNick Nickname of the user who left the chat session

ChatSerialNumber Sequential number of the chat event

ChatTimeshift Time shift of the chat session

ChatVisibility Chat visibility (reserved)

ChatStartedAt Chat start time
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Chat Message

Device Event ChatMessage

Description Someone enters a new chat message

Attributes ChatUsrId Chat user ID of message author

ChatUsrType Chat user type (AGENT or CLIENT) of message 
author

ChatMsgType Chat message type (such as TEXT)

ChatMsgText Content of the chat message

ChatUsrNick Nickname of the message author

ChatSerialNumber Sequential number of the chat event

ChatTimeshift Time shift of the chat session

ChatVisibility Chat visibility (reserved)

ChatStartedAt Chat start time

Command Status

Device Event OpenMediaCommandStatus

Description Command status was changed

Commands String describing the difference between the current and previous 
command status.
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Chapter

8 Configuration and 
Installation of the Media 
Routing Component
This chapter describes how to configure and install the Gplus Adapter for 
Siebel CRM Media Routing Component. The chapter includes the following 
sections:
 Overview, page 371
 New in This Release, page 372
 Installing the Media Routing Component, page 372
 Configuring Multimedia Agents and Communications, page 380
 Configuring Siebel eMail Response, page 381
 Updating and Deploying the Siebel Repository File, page 384
 Non-Realtime/Background E-Mail Routing for Siebel 7.7/7.8/8.0/8.1, 

page 385
 Pulling/Stopping Siebel eMail Interactions, page 386
 Driver and Configuration Parameters, page 388
 Device Commands and Events, page 388
 Configuring the Media Routing Component for Routing Siebel Work 

Items, page 389

Overview
Installation and configuration of the Media Routing Component includes:

• Compiling and deploying the Siebel Repository

• Configuring and activating business workflows

• Configuring Siebel eMail Response
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• Configuring Siebel.

See the Gplus Adapter 7.5 for Siebel CRM User’s Guide for additional 
information about using this component. 

New in This Release
This section provides information about new features or functionality in this 
release of the Gplus Media Routing Component:

• Supports Siebel 8.0, 8.1.

• No longer uses the Gplus Multimedia driver library to send route requests 
to the Genesys environment, but rather uses the Gplus Communication 
Server.

• Provides the ability to transfer a work item to another agent or queue.

• Provides the ability to pull an interaction while it is in queue waiting to be 
delivered to agents

• Provides the ability to cancel a route request and thus stop its processing in 
the Genesys environment

Installing the Media Routing Component
The Media Routing Component can be installed on either Windows or UNIX 
platforms.

Note: The Media Routing Component for Siebel uses some functionality of 
the Multimedia Component, so the Media Routing Component should 
be installed after the Multimedia Component. The Media Routing 
Component will not function without the Multimedia Component.

The Media Routing Component uses the same communications driver names 
and profile as the Multimedia Component. However, if you plan to use the 
Media Routing Component for routing Siebel work items in addition to Siebel 
eMail, you will need to make some changes in communication configuration. 
See the section called “Configuring the Media Routing Component for 
Routing Siebel Work Items” on page 389.

Installation Prerequisites

The following are prerequisites for installation of the Media Routing 
Component:

• Back up the Siebel database and .srf file.
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• Install the Gplus Communication Server (see Chapter 2, “Configuration 
and Installation of the Gplus Communication Server for Siebel CRM,” on 
page 31).

• Install the Gplus Multimedia Component (see Chapter 7, “Configuration 
and Installation of the Multimedia Component,” on page 331).

Installation

Note: Do not use special symbols in any destination directory name when 
installing in a UNIX environment.

• Start the Media Routing Component setup program:
 setup.exe (for Windows, or)
 install.sh (for UNIX)

Setup will ask you to enter a full path for the destination directory for 
installation. The installation program will place the Siebel archive, scripts, 
and general production information in this folder.

Target Directory Structure and File Locations

The following generic directory names are used in the description of the 
directories structure:

• <Destination Directory> is the destination directory for installation used 
by the installation script to copy the Adapter component files.

• Files in subdirectories <Destination Directory>/objects/7.5 are related to 
Siebel version 7.5.3.

• Files in subdirectories <Destination Directory>/objects/7.7 are related to 
Siebel versions 7.7/7.8.

• Files in subdirectories <Destination Directory>/objects/8.0 are related to 
Siebel version 8.0.

• Files in subdirectories <Destination Directory>/objects/8.1 are related to 
Siebel version 8.1.

Creating a Connection Subsystem

Configure a connection subsystem for the Gplus Communication Server that 
will be used by the Media Routing Component. 

To do this (refer to Figure 30 on page 375):

1. Log in to Siebel Client as Siebel Administrator.

2. Navigate through the Site Map to Siebel Server configuration:
 In a Siebel 7.5.3 environment, select Site Map > Server 

Administration > Enterprise Configuration.
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 In a Siebel 7.7/7.8/8.0/8.1 environment, select Site Map > 
Administration - Server Configuration.

3. Click Profile Configuration.

4. Click the New Record button.

5. Set the following parameters for the new record:
 Set the Profile field and Alias field to GplusCommServerPrimary
 Set the Subsytem Type field to HTTPSubSys
 Set the Description field to GplusCommServerPrimary

6. Save the created record.

7. Click the Profile Parameter applet and enter the following parameters for 
the record you just created:
 Set the HTTP Request Method parameter to POST
 Set the HTTP Request URL Template to 

http://<host>:<port>/MEDIA_REQUEST#RouteRequest

where <host> and <port> are the host and the port of the Gplus 
Communication Server being used.

Note: The Gplus Communication Server port required here must be 
configured in the Connection Protocol option with the value tcp. If 
you have not done this yet, follow the corresponding instructions in 
“Server Info Tab” on page 36 for your Gplus Communication Server 
Application object.

8. Create a connection subsystem for the backup Gplus Communication 
Server, if it is needed. Do the same as for the primary Gplus 
Communication Server, but set the Profile field and Alias field to the 
value GplusCommServerBackup.

Note: After creating/updating a connection subsystem, you might have to 
restart your Siebel server to make the changes effective. Please refer to 
your Siebel server documentation.
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Figure 30: Creating a Connection Subsystem

GplusMediaRouting-ProcessMessage Business Processes: 
Import, Activation, and Deployment

Note: This step is required only if you are using the Media Routing 
Component for routing of Siebel eMail.

Note: If when importing a workflow process, you encounter the following 
error: “This operation is not allowed when there are no records 
displayed. Please execute a query that returns at least one 

record or add a new record.” Please refer to Siebel Alert 594.
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For Siebel Version 7.5.3

To import, configure, and activate the GplusMediaRouting-ProcessMessage 
Business Process definition:

1. Select Business Process Administration > Workflow Processes > All 

Processes.

2. Select Import Workflow from the Processes list menu. Browse to and select 
the GplusMediaRouting-ProcessMessage.xml file.

3. Click Import.

The corresponding GplusMediaRouting-ProcessMessage record appears in 
the Workflow Processes list in an In Progress state.

4. Click on the process.

5. Select the Process Properties tab.

6. Define string values for the following properties according to your 
environment:
 ConnectionName
 SubmitQueue

If you will use non-realtime (background) mode for e-mail processing, 
please set the RoutingMediaType property to BackgroundEmail. For the value 
and meaning of these properties, please refer to the Gplus Adapter 7.5 for 
Siebel CRM Developer’s Guide.

7. Click Activate.

For Siebel Versions 7.7/7.8/8.0/8.1

Starting with Siebel version 7.7.1, Siebel moved all the Business Process 
development from the Siebel Client environment to the Siebel Tools 
environment. Therefore, all changes to the repository file concerning Siebel 
Business Processes should be made using Siebel Tools, exported into XML 
files, and later imported using Siebel Client.

Siebel Tools usage:

1. Lock EMR Workflow project.

2. Using the Object Explorer, choose the Workflow Process tab.

3. Import the GplusMediaRouting-ProcessMessage.xml file, as shown in Figure 
31.
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Figure 31: Siebel Tools Usage

4. Define string values for the following properties according to your 
environment (see Figure 32 on page 378):
 ConnectionName
 SubmitQueue

Here, the ConnectionName value is the application name of a Genesys 
Interaction Server as specified in the Connections tab for the Gplus 
Communication Server. The SubmitQueue value is the name of the queue to 
which the interaction should be submitted.

If you will use non-realtime (background) mode for e-mail processing, 
please set the RoutingMediaType property to BackgroundEmail. These 
properties are used as parameters for the GplusMediaRoute Business 
Service. For more information about these properties, please see the 
“Media Routing Component Customization” section of the Gplus Adapter 
7.5 for Siebel CRM Developer’s Guide.
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Figure 32: Defining Workflow Properties

5. If you would like to add some AttachedUserData values to a route request, 
you should add custom input arguments for the GplusMediaRouting 
workflow step. For this, select the GplusMediaRouting box in design view 
(as seen in Figure 32), then right-click on GplusMediaRouting, select Show 
Input Arguments from the menu (see Figure 33 on page 379), then add a 
new record in the Input Arguments view. All input arguments except the 
predefined arguments will be attached to a route request as 
AttachedUserData.
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Figure 33: Editing Input Arguments for GplusMediaRouting Workflow Step

6. Deploy the workflow process.

7. Export the workflow process into a file.

Siebel Client usage:

1. Import the .xml file exported previously from the Siebel Tools into the 
Active Workflow Processes list/set as shown in Figure 34 on page 380.
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Figure 34: Business Process - Workflow Process Import

2. Make sure that the workflow is active. If not, activate the workflow.

Configuring Multimedia Agents and 
Communications 

In the communications configuration, set a proper value for the 
MediaRoutingDefaultQueue configuration parameter. This parameter defines a 
name of a queue in which will be placed Siebel eMail interactions marked as 
done. No another special parameter is required except what is used in the 
Multimedia component.

In the Genesys environment:

1. Create SiebelEmail and BackgroundEmail media types. If you will use the 
Media Routing Component for routing Siebel work items, create a custom 
media type for each type of work item. Genesys recommends using 
different media types for different Siebel work item types.

2. Add the newly-created media types to agent capacity rules (see Figure 35 
on page 381).
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3. Configure the Genesys routing strategy for routing the newly-created 
media type interactions. (Please see OBJECTS\GplusMediaRoutingSample.zcf 
as a sample strategy in the installation directory.)

No additional agent configuration is required except what was done for the 
Multimedia Component configuration. Please make sure that the agent has a 
proper capacity rule (SiebelEmail media type is enabled if an agent is working 
with Siebel eMail, BackgroundEmail media type is enabled if an agent is 
working with background Siebel eMail). Any custom media types are enabled 
if the Media Routing Component is used for routing of Siebel work items.

Figure 35: Capacity Rule Wizard

Configuring Siebel eMail Response
Configuring Siebel eMail Response includes Configuring Siebel Internet 
SMTP/POP3 Server Driver Profile and Creating a Response Group.

Note: This step is required only if you are using the Media Routing 
Component for routing of Siebel eMail.
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The following Workflow Processes must be activated for the Siebel eMail 
Response application:

• eMail Response-Analyze Message

• eMail Response-Append Thread Id

• eMail Response-Client Send E-mail

• eMail Response-Create Activity

• eMail Response-Get Entitlement Id

• eMail Response-Identify Language

• eMail Response-Parse Junk E-mail

• eMail Response-Response Workflow

• eMail Response-Search Spec

• eMail Response-Send Acknowledgement

• eMail Response-Send Auto Response

• eMail Response-SR Help

• eMail Response-Update Activity Status

For details and more information, please see the Siebel eMail Response 
Administration Guide.

Configuring Siebel Internet SMTP/POP3 Server Driver Profile

To configure the Siebel Internet SMTP/POP3 Server Driver profile:

1. In the Siebel Site Map, navigate to Communications Driver and Profiles.
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 

Communications > Communications Driver and Profiles.
 For earlier versions of Siebel, select Site Map > Communications 

Administration > Communications Driver and Profiles.

2. Select the record for the Internet SMTP/POP3 Server communication 
driver.

3. Select the Profile tab.

4. Click New on the Profiles form and set the name of the profile to the value 
of the e-mail address.

5. Click New to create necessary parameter value overrides:
 From Address: the value must be the same as the e-mail address (with 

which the profile works) or the profile name (which is the same)
 Incoming E-mail Directory: the directory where incoming e-mails are 

saved
 POP3 Account Name: the name of the POP account
 POP3 Account Password: the POP3 Account password string
 POP3 Server: the name of the POP Server
 POP3 Server Port: the POP3 Server Port value (usually 110)
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 Siebel Server: the name of the Siebel Server on which eMail Response 
works

 SMTP Server: the name of the SMTP Server
 SMTP Server Port: the SMTP Server Port value (usually 25)
 SMTP Account Name: the name of the SMTP account
 SMTP Account Password: the SMTP account password string
 Try POP3 Logon: the value is TRUE (for Siebel 7.5.3 only)

Set the Responsibilities of the created Server Driver Profile to Universal 
Agent.

Creating a Response Group

To create a response group: 

1. In the Siebel Site Map, navigate to All Response Groups.
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 

Communications > All Response Groups.
 For earlier versions of Siebel, select Site Map > Communications 

Administration > All Response Groups.

The Response Groups list appears.

2. Click New on the Response Groups form.

3. Set the name of the response group to the exact value of the SMTP/POP3 
driver profile name, with which the response group works.

4. Set the Administrator E-mail Address to an e-mail address in which you 
want to direct undeliverable e-mail that is sent to profiles in each response 
group.

5. Set the Server option to the value of Siebel Server, which is used for the 
eMail Response processing.

6. Set Startup option to Active (Automatic for Siebel 7.5.3)

7. Select the Profiles tab.

8. Click New and select the previously created profile for the SMTP/POP3 
driver from the list of profiles.

9. Select the Input Arguments tab and click Generate Defaults.

10. Rename the ProcessName argument to “GplusMediaRouting-
ProcessMessage.” (Refer to Figure 36 on page 384.)
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Figure 36: Input Arguments Editing

Updating and Deploying the Siebel 
Repository File

1. Start Siebel Tools.

2. Lock the Genesys Multimedia project and lock the GplusMediaRouting 
Project, if it already exists.

3. Import the GplusMediaRouting.sif archive file from 
<Installation Directory>/OBJECTS/<Siebel Version>. For this:

a. In Siebel Tools, select Tools > Import from Archive.

b. In the Select Archive to Import window, browse to 
<Installation Directory>/OBJECTS/7.5 for Siebel Server version 
7.5.3, to <Installation Directory>/OBJECTS/7.7 for Siebel Server 
versions 7.7/7.8, to <Installation Directory>/OBJECTS/8.0 for Siebel 
Server version 8.0, or to <Installation Directory>/OBJECTS/8.1 for 
Siebel Server version 8.1.

c. Select the GplusMediaRouting.sif archive file.

d. Click Merge the object definition in the repository.

4. Compile the projects.
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5. Set up business service query access for the GplusMediaRoute Business 
Service in the Siebel Server configuration, only for Siebel 7.7/7.8/8.0/8.1. 
The business service name has to be specified as the value for the Business 
Service Query Access List Server Component parameter.

a. Log in to the Siebel Server as Siebel administrator.

b. Navigate to Administration > Server Configuration > Enterprises.

c. On the Component Group tab, select the required component; for 
example: Siebel Financial Services.

d. Switch to the Parameters tab.

e. Navigate to the Business Service Query Access List record.

f. Add GplusMediaRoute to the end of the record value, separated by a 
comma.

g. Restart the Siebel Server to make the changes effective.

6. Deploy the SRF (Repository) file. For this:

a. Stop the Siebel Server.

b. Back up the original Siebel Repository File.

c. Copy the compiled repository file into the proper location (so that you 
can use it instead of the original Siebel Repository File).

d. Start the Siebel Server.

Note: The Adapter does not contain limitations for some of the Adapter's 
compiled components that will work only with the T eScript Engine 
(and not the ST eScript Engine). The default Siebel option is set to 
Enable ST Script Engine = TRUE, but for the Genesys component it 
should be set to Enable ST Script Engine = FALSE.

Non-Realtime/Background E-Mail Routing 
for Siebel 7.7/7.8/8.0/8.1

Background processing allows you to apply more server processing power to 
e-mail. This is especially important when your site receives high volumes of e-
mail. Non-realtime (background) mode e-mail processing allows the servers to 
process a high volume of inbound e-mails in the following way:

• Inbound mail messages are retrieved by the Siebel eMail handler.

• The Siebel SMTP/POP3 driver creates inbound e-mail into files.

• The Comm Inbound Receiver (CIR) will move these files into Siebel File 
Systems.

• The Comm Inbound Processor (CIP) then processes these files. Since CIP 
uses workflow to process the e-mail, you can set up multiple CIPs to 
process the volume of e-mail.
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The native Siebel eMail Response application uses Siebel Universal Queue  
(UQ) to route e-mails and to generate the @HandleNonRealtimeWorkItem 
Siebel special event. In the Genesys-adapted Siebel eMail Response 
application, Genesys Universal Router (UR) functionality is used for e-mail 
routing, therefore @HandleNonRealtimeWorkItem is not generated.

The Media Routing Component uses workbins for background interactions. 
Genesys recommends using the same agent workbin for Siebel background e-
mail as for Multimedia inbound e-mail. The mode of interaction processing is 
defined by a Genesys Router strategy, (for example, background interaction 
should be placed into agent workbin, but real-time interactions should be 
placed into inbound queue). By default, The Media Routing Component uses 
different media types to instruct the Genesys Universal Router on how to 
process the e-mail call on the agent side. Refer to the provided strategy sample 
in the installation directory OBJECTS\GplusMediaRoutingSample.zcf file. 

The SiebelEmail media type is used for real-time processing mode, and  
BackgroundEmail media type is used for nonreal-time processing mode. Media 
type is set as an input argument of the GplusMediaRoute business service in 
the GplusMediaRouting-ProcessMessage business process. You may add an 
attribute’s value in an interaction’s attached data as the indicator of the 
processing mode to be applied to an interaction, and update a strategy to check 
this attribute’s value.

Non-realtime (background) mode may be used for routing any Siebel work 
items. The mode of processing is defined by the strategy used, the same as for 
Siebel eMail.

Pulling/Stopping Siebel eMail Interactions
To use pulling/stopping functionality provided in the Media Routing 
Component, customer customization is required, as the component does not 
provide a user interface for this functionality.

Pulling functionality is implemented by the communication commands 
PullbyInteractionIdMR and PullbyThirdPartyIdMR. To enable pulling 
functionality for an agent, you must allow an agent to invoke the 
PullbyInteractionIdMR or PullbyThirdPartyIdMR communication command. 

To enable stopping functionality for an agent, you must allow an agent to 
invoke the StopbyInteractionIdMR or StopbyThirdPartyIdMR communication 
command.

You may add a button into one of the activity applets to invoke the command, 
or you may add a toolbar button, or just set the Hidden parameter of the 
command to True. The agent should locate an appropriate Siebel record and 
invoke a command.
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The command PullbyInteractionIdMR uses the data parameter InteractionId, 
which is the field name to store the Genesys interaction ID, and invokes a 
OpenMediaPullInteractionById multimedia driver device command.

The command PullbyThirdPartyIdMR uses the data parameter ThirdPartyId, 
which is the field name to store the Siebel record ID, and invokes the business 
service method GplusMediaRoute.PullInteraction.

The command StopbyInteractionIdMR uses the data parameter InteractionId, 
which is the field name to store the Genesys interaction ID, and invokes the 
business service method GplusMediaRoute.StopWorkItem.

The command StopbyThirdPartyIdMR uses the data parameter ThirdPartyId, 
which is the field name to store the Siebel record ID, and invokes the business 
service method GplusMediaRoute.StopWorkItem.

For additional information, please refer to the “Media Routing Component 
Customization” section of the Gplus Adapter 7.5 for Siebel CRM Developer’s 
Guide.
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Driver and Configuration Parameters
For a complete list of Driver Parameters that the Media Routing Component 
uses, please refer to the Driver Parameters described in Chapter 7, 
“Configuration and Installation of the Multimedia Component”.

Table 34 below contains the parameter specific to the Media Routing 
Component. 

Device Commands and Events
The Media Routing Component uses the same driver as the Multimedia 
Component, so device commands and events are the same as for the 
Multimedia Component. For a list of device commands and events, please 
refer to Chapter 7, “Configuration and Installation of the Multimedia 
Component,” on page 331.

Table 34: Media Routing Driver Parameters

Parameter Name Default Value Required Comment

MediaRoutingDoneQueue __STOP__ Yes MCR Queue where third-party 
interactions (such as Siebel 
eMails) will be placed after 
completion (Send, Cancel 
buttons for Siebel eMail). 
__STOP__ means that 
processing of the interaction 
will be stopped completely. If 
post processing for completed 
third-party items is needed, 
this value should be changed 
to the post processing queue 
where the post processing 
strategy is running.

MediaRoutingDefaultQueue (E-mails for agent 
processing)

Yes MCR Queue where third-party 
interactions (such as Siebel 
eMails) will be placed for 
processing
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Configuring the Media Routing Component 
for Routing Siebel Work Items

The Media Routing Component for Siebel can be used for routing any type of 
Siebel work item by means of Genesys Multimedia, both in real-time and in 
background mode. The Media Routing Component provides basic 
functionality for workitem routing, but does not provide a graphical user 
interface (GUI) out-of-the-box. Customization is required to create this 
functionality.

To configure the Media Routing Component for this, do the following:

In the Genesys environment:

1. Create a new custom media type, making sure to use different media types 
for different Siebel work item types. To try provided samples, create 
ServiceRequest and ServiceOrder media types.

2. Add the newly-created media types to agent capacity rules.

3. Configure the Genesys routing strategy for routing the newly-created 
media type interactions. (Please see the file 
OBJECTS\GplusMediaRoutingSample.zcf as a sample strategy in the 
installation directory.)

In the Siebel environment:

1. Add the newly-created media types into the Driver.Channel String.

2. Create Ready and NotReady commands for newly-created media types. A 
sample of this command is provided in the file 
OBJECTS/GenComm_universal.def in the installation directory. At the end of 
this file, look for ReadyForSiebelSRGroup and NotReadyForSiebelSR 
commands.

3. Add the new commands into the proper group commands. To try the 
provided samples, add the ReadyForSiebelSRGroup command into the 
ReadyGroup command group, and the NotReadyForSiebelSR command into 
the NotReadyGroup command group.

4. Create an Event Handler for the OpenMediaAccepted event for each of the 
newly-created media types (please refer to the sample event handler 
OpenMediaAcceptedSR). Set the proper Filter and Event Response.

5. Create an Event Handler for the OpenMediaSelected event for each of the 
custom media types (please refer to the sample event handlers 
OpenMediaSelectedSR and OpenMediaSelectedOrder. Set the proper 
FilterSpec and Event Response. In Event Response you should set a Siebel 
view which should be used for editing a routed work item as a SingleView 
parameter. You should set the QuerySpec parameter to the value 
FieldName='{ThirdPartyId}’, where FieldName is the ID field for a Siebel 
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work item. Please refer to the sample event responses OpenMediaSelectedSR 
and OpenMediaSelectedSO (at the end of the file 
OBJECTS/GenComm_universal.def).

6. Create Event Handlers for the OnOpenMediaPulledSR and OpenMediaAccepted 
events for each of the custom media types. Set the proper Filter, 
MediaType, and Event Response. Please refer to the sample event handlers 
OnOpenMediaPulledSR and OpenMediaAcceptedSR.

7. Create commands to send a route request. Set the proper command 
parameters. The ServiceParam.ThirdPartyId parameter should be set to the 
ID field for a Siebel work item, and should be the same field as in a proper 
event handler. You may also send a route request from a workflow by 
calling a route method of a GplusMediaRoute business service. For more 
information please refer to the “Media Routing Component 
Customization” section of the Gplus Adapter 7.5 for Siebel CRM 
Developer’s Guide.

See the sample SendRouteSR command to route Siebel Service Requests in 
real-time mode, and see the sample SendRouteSO command to route Service 
Orders in background mode (at the end of the file 
OBJECTS/GenComm_universal.def).

8. Configure the MarkWorkItemDone command to support your media types, 
such as adding the newly-created media types into the FilterMediaType 
parameter. This parameter contains a list of media types separated by 
commas. For a ServiceOrder media type you may use a MarkDoneSO 
command. For a ServiceRequest media type you may use a MarkDoneSR 
command, or you may create your own MarkDone command. As an 
alternative method, you may customize a button on a workitem view or 
add a custom button on a communication toolbar to invoke a MarkDone 
command. For more information please refer to the Gplus Adapter 7.5 for 
Siebel CRM Developer’s Guide.

9. Make sure that agents have enough responsibilities to have access to 
proper views. For the provided samples, the agent should have access to 
the following views: Service Request Detail, Personal Service Request 
List, Service Order-Browse Catalog, Order Entry - Line Items, Order 
Entry - My Orders.
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Note: The provided samples show how to route Siebel Service Requests in 
real-time mode and how to route Service Orders in background mode. 
Samples use the ServiceRequest media type for Siebel Service 
Requests and the ServiceOrder media type for Service Orders. To try 
the samples, please remove the comment marks in the file 
OBJECTS/GenComm_universal.def before an import of a configuration, 
and perform the above-mentioned actions.
To try the Service Requests commands, please open the All Service 
Request List view and then invoke a command from this view. To try 
Service Orders commands please open the Order Entry - All Orders 
view and then invoke a command from this view.

If you are going to use the pulling/stopping functionality for Siebel work items 
as for Siebel eMail Routing, you should provide a record field to store the 
Genesys interaction ID, as it is required to support a relation between Siebel 
work item records and Genesys interactions.

If a work item is represented in the Siebel database as an activity record, you 
may use a Call Id field, as done for Siebel eMail. For more information please 
refer to the “Media Routing Component Customization” section of the Gplus 
Adapter 7.5 for Siebel CRM Developer’s Guide.
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Chapter

9 Uninstallation Instructions
This chapter provides uninstallation instructions for the Gplus Adapter 7.5 for 
Siebel CRM.

This chapter includes the following sections:
 Overview, page 393
 Uninstalling the Gplus Communication Server for Siebel CRM, page 394
 Uninstalling the Configuration Synchronization Component, page 395
 Uninstalling the Campaign Synchronization Component, page 401
 Uninstalling the Voice Component, page 408
 Uninstalling the Gplus UCS Gateway for Siebel CRM, page 427
 Uninstalling the Media Routing Component, page 427
 Uninstalling the Multimedia Component, page 429

Overview 
This chapter describes how to uninstall the Gplus Adapter 7.5 for Siebel CRM. 
The Adapter must be uninstalled one component at a time. To uninstall a 
component, refer to the corresponding section in this chapter.

Uninstallation is typically performed for the following reasons:

• You do not want to use one or more of the Adapter’s components.

• You want to upgrade to a new (more current) release of the Gplus Adapter, 
which may require uninstallation of the existing release. 

Note: Some Gplus Adapter 7.5 for Siebel CRM components share common 
files. Therefore, uninstalling one component may delete a file or files 
necessary for a remaining component. This problem can be resolved in 
the following way: After you uninstall a component, you can reinstall 
the Adapter for the remaining component.
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Uninstalling the Gplus Communication 
Server for Siebel CRM

The process of uninstalling the Gplus Communication Server for Siebel CRM 
consists of two steps:

• Remove files installed by the Gplus Communication Server for Siebel 
CRM in the installation directory. 

• Remove files installed in the Siebel Server directory. This step is necessary 
when the Siebel Server runs on a Unix platform, or when the Siebel Server 
and the Gplus Communication Server are installed on different hosts.

Removing Files Installed by the Gplus Communication Server 
for Siebel CRM

Follow the instructions below based on your environment.

For Windows Customers

• Complete the uninstallation program for the Communication Server 
Component by using Add/Remove Programs in the Control Panel on the host 
where you installed the component.

For UNIX Customers

1. Delete the Communication Server Component’s files by removing the 
directory that was used as the destination directory during installation.

2. You will also need to remove libGenCommDrv.so from the Siebel Server 
directory.

Removing Files from the Siebel Server Directory

Follow the instructions below based on your environment.

For Windows Customers

• Remove GenCommDrv.ini and GenCommDrv.dll from the Siebel Server’s BIN 
directory.

For UNIX Customers

• Remove GenCommDrv.ini and libGenCommDrv.so from the Siebel Server’s 
lib directory.
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Uninstalling the Configuration 
Synchronization Component

This section describes how to uninstall the Gplus Adapter 7.5 for Siebel CRM 
Configuration Synchronization Component.

Uninstalling the Configuration Synchronization Component involves these 
major tasks: 

1. Changing Siebel Configuration

2. Changing Genesys Configuration

3. Uninstallation

Changing the Siebel Configuration

This section describes how to change the Siebel configuration in order to 
uninstall the Component.

Prestart Information

Before starting this part of the configuration process you must have the Siebel 
Tools application running.

You should be connected to the local copy of the Siebel Server database and 
have sufficient privileges to modify the Siebel Server Repository.

Changing Run Time Events

To delete the Run Time Events required by the Configuration Synchronization 
Component, you have to run the UninstallRunTimeEvents method of the 
Genesys Config Synchronization Siebel Business Service once using the 
Siebel Business Service Simulator applet.

To run the method:

1. Navigate through the Site Map to Business Service Administration > 
Business Service Simulator.

2. In the Service Methods applet, create a new record.

3. Specify the following parameters for the new record:
 Service Name: Genesys Config Synchronization
 Method Name: UninstallRunTimeEvents

4. Click the Run button.

After running the method, you should navigate in the Siebel client to Runtime 
Events Administration > Events (Administration – Runtime Events > Events 
in Siebel 7.7/7.8/8.0/8.1), and select the system menu item Reload 
Personalization (Reload Runtime Events in Siebel 7.7/7.8/8.0/8.1).
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Deleting EAI Transport Data Handling Subsystems and Connection Subsystems

Delete the following EAI Transport Data Handling and Connection 
Subsystems, which were created in your Siebel environment during 
deployment (listed here by their Alias):

• GplusConfSynchExportAllData

• GplusConfSyncConnectionPrimary

• GplusConfSyncConnectionBackup

Use the Siebel Server Manager (srvrmgr) utility to delete these subsystems. 
Specifically, use the “Delete named subsystem” command. For information 
about using Siebel Server Manager, see the Siebel documentation.

Changing the Siebel Configuration Using Siebel Tools

Use Siebel Tools to compile an updated release of the Siebel Repository File 
for one or more of the Siebel applications you use on your Siebel Server, then 
deploy the updated version on the server. Instructions follow. For detailed 
information about using Siebel Tools, see the Siebel documentation.

Checking Out Existing Projects

Make sure that the following projects are checked out from the Siebel 
Repository:

• Genesys Configuration Synchronization

• Personalization

If some of these projects are not checked out:

1. In Siebel Tools, select Tools > Check Out...
The Check Out dialog box displays.

2. In the Projects list, select the projects to be checked out.

3. Click Check Out.
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Changing the Personalization Action Set Business Component

To delete modifications that were made to the Personalization Action Set 
Business Component during deployment:

1. From the Object Explorer, select the Business Component folder and 
navigate to the Personalization Action Set Business Component.

2. Using the Types tab of the Object Explorer, select the Field folder under 
the Business Component folder. 

The Fields window displays.

3. Select the Action Set ID field.

4. Right-click the selected record.

5. Select Delete Record from the drop-down menu.

6. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

7. Select the Actions field.

8. Right-click the selected record.

9. Select Delete Record from the drop-down menu.

10. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

11. Using the Types tab of the Object Explorer, select the Multi Value Field 
folder under the Business Component folder. 

12. The Multi Value Fields window displays.

13. Make sure the Actions field is deleted.

Deleting Objects from the Genesys Configuration Synchronization 
Project

You must delete multiple objects from the Genesys Configuration 
Synchronization project. These objects are listed in Table 35, “Objects in the 
Genesys Configuration Synchronization Project,” on page 398. 

To delete objects from the Genesys Config project:

1. In Siebel Tools, in the Project field of the Object Explorer, select All 
Projects.

2. From the Object Explorer, select the Business Component folder. 
The Business Components window displays.

3. Select the next object listed in Table 35. Start with the first, the Genesys 
CommSrv CM Agents / ACD Queues Business Component.

4. Right-click the selected record.

5. Select Delete Record from the drop-down menu.
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6. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

7. Repeat Steps 2 through 6 for each of the Siebel Repository elements 
referenced in Table 35.

Compiling the Siebel Repository File

To compile the Siebel Repository File:

1. In Siebel Tools, select Tools > Compile Projects... 

2. Select Locked projects.

3. In the Siebel Repository File edit box, enter the name of the Repository 
File.

4. Click Compile. 

The status bar at the bottom of the Object Compiler window indicates 
when the compilation is finished.

5. When the compilation is finished, close Siebel Tools.

Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after compiling the Siebel Repository File.

Changing the Siebel Server Configuration

Table 35: Objects in the Genesys Configuration Synchronization 
Project

Type Name

Business Component Genesys CommSrv CM Agents / ACD Queues

Business Component Genesys CommSrv CM Agents /Adapter 
Profiles / Adapters

Business Component Genesys CommSrv CM Agents / Telesets

Business Component Genesys Profiles / Organizations

Business Component Genesys Users / Organizations

Business Object Genesys CommSrv CM Administration

Business Object Genesys Users / Organizations

Business Service Genesys Config Synchronization

Integration Object Genesys Agent

Link Genesys Users / Organizations/Employee Skill
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Complete the procedures in this section to delete the Component 
implementation from the Siebel Server.

Updating Configuration Files

Update the eai.cfg file in the Siebel Server installation. To update this file, 
open it and delete the following lines from the [HTTP Services] section:
GplusConfSynchExportAllData = GplusConfSynchExportAllData

Deploying the Siebel Repository File

You need to deploy the compiled Siebel Repository File on your Siebel Server. 
Additionally, you may have to generate and deploy browser scripts for the new 
Repository File.

For further information on deploying an updated Repository File to the Siebel 
Server, refer to the Siebel documentation.

Note: This completes the changes to the Siebel configuration. Now you are 
ready to change the Genesys configuration.

Changing the Genesys Configuration

This section describes how to change the Genesys configuration in order to 
uninstall the Component.

Prestart Information

Before starting the configuration process you should have the following 
Genesys Framework applications running:

• Configuration Database

• Configuration Server 

• Configuration Manager 

As a Configuration Manager user, you should have sufficient privileges to 
make changes to Configuration Layer objects.

Deleting the Application Object

To delete the Application object that was used for the Component:

1. In Configuration Manager, right-click the Application object.

2. Click Delete from the drop-down menu.

3. Click Yes to delete the Application object.

Deleting the Application Template

To delete the Application Template:
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1. In Configuration Manager, right-click the Application Template. 
Depending on the version you are using, the default name for the Template 
is:
Gplus_SiebelCRM_Config_Synch_750_for_CL_70.apd 

or
Gplus_SiebelCRM_Config_Synch_750_for_CL_71_and_higher.apd

2. Click Delete from the drop-down menu.

3. Click Yes to delete the Application Template.

Deleting the Person Object

To delete the Person object:

1. In Configuration Manager, right-click the Person object. The default user 
name for the object is: 
siebel7gplus.

2. Click Delete from the drop-down menu.

3. Click Yes to delete the Person object.

This completes the changes you need to make to the Genesys configuration. 

Uninstallation

Select one of the following sections depending on your environment.

For Windows Customers

Complete the uninstallation program for the Component by using the 
Add/Remove Programs in the Control Panel on the host where you installed the 
Component.

For UNIX Customers

Delete the Component’s files by removing the directory that was used as the 
destination directory during installation.

You have deleted the Gplus Adapter 7.5 for Siebel CRM Configuration 
Synchronization Component from your environment. 

Note: If you re-install this component, note that this component was renamed 
in Release 7.0 of the Gplus Adapter for Siebel CRM; it is called the 
“Configuration Synchronization Component”.
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Uninstalling the Campaign 
Synchronization Component

The process of uninstalling the Campaign Synchronization Component (known 
as the Outbound Server component prior to release 7.0) includes three general 
procedures: 

1. Changing Genesys Configuration

2. Changing Siebel Configuration

3. Uninstallation

Changing the Genesys Configuration

This section describes how to change the Genesys configuration in order to 
uninstall the Component.

Prestart Information

Before starting the configuration process you should have the following 
Genesys Framework applications running:

• Configuration Database

• Configuration Server 

• Configuration Manager 

As a Configuration Manager user, you should have sufficient privileges to 
make changes to Configuration Layer objects.

Deleting the Application Object

To delete the Application object that was used for the Component:

1. In Configuration Manager, right-click the Application object.

2. Select Delete.
The Delete dialog box displays.

3. Click Yes to delete the Application object.

Deleting the Application Template

To delete the Application Template:

1. In Configuration Manager, right-click the Application Template. The 
default name for the Template is either 
Gplus_SiebelCRM_Camp_Synch_750_for_CL_70.apd 

or 
Gplus_SiebelCRM_Camp_Synch_750_for_CL_71_and_higher.apd
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2. Select Delete.
The Delete dialog box displays.

3. Click Yes to delete the Application Template.

Deleting the Person Object

To delete the Person object:

1. In Configuration Manager, right-click the Person object. The default user 
name for the object is 
siebel7gplus.

2. Select Delete.
The Delete dialog box displays.

3. Click Yes to delete the Person object.

This completes the changes you need to make to the Genesys configuration. 
Now you are ready to change the Siebel configuration.

Changing the Siebel Configuration

This section describes how to change the Siebel configuration in order to 
uninstall the Component.

Prestart Information

Before starting this part of the configuration process, you must have the Siebel 
Tools application running.

You should be connected to the local copy of the Siebel Server database and 
have sufficient privileges to modify the Siebel Server Repository.

Changing Run Time Events

To delete Run Time Events required by the Campaign Synchronization 
Component, you have to run the UninstallRunTimeEvents method of the 
Genesys Campaign Synchronization Siebel Business Service once using the 
Siebel Business Service Simulator applet. 

To run the method:

1. Navigate through the Site Map to Business Service Administration > 
Business Service Simulator. 

2. In the Service Methods applet, create a new record. 

3. Specify the following parameters for the new record:
 Service Name: Genesys Campaign Synchronization
 Method Name: UninstallRunTimeEvents

4. Click the Run button.
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After running the method, you should navigate in Siebel client to Runtime 
Events Administration > Events (Administration – Runtime Events > Events 
in Siebel 7.7/7.8/8.0/8.1), and select Reload Personalization (Reload Runtime 
Events in Siebel 7.7/7.8/8.0/8.1) system menu item.

Changing the Siebel Configuration Using Siebel Tools

You will use Siebel Tools to compile an updated release of the Siebel 
Repository File for one or more of the Siebel applications you use on your 
Siebel Server, which you will then deploy on the server. For information about 
using Siebel Tools, see Siebel documentation.

Checking Out Existing Projects

Make sure that the following projects are checked out from the Siebel 
Repository:

• Campaign

• Genesys Campaign Synchronization

• Personalization

If some of these projects are not checked out:

1. In Siebel Tools, select Tools > Check Out...
The Check Out dialog box displays.

2. In the Projects list, select the projects to be checked out.

3. Click Check Out.

Deleting Objects from Projects

To delete objects from projects:

1. In Siebel Tools, in the Project field of the Object Explorer, select All 
Projects.

2. From the Object Explorer, select the Business Component folder. 
The Business Components window displays.

3. Select the Genesys Campaign List Business Component.

4. Right-click the selected record.

5. Select Delete Record from the drop-down menu.

6. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

7. Repeat Steps 2 – 6 for all Siebel Repository elements referenced 
in Table 36.
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Table 36: Objects in the Genesys Campaign Synchronization 
Project

Type Name

Business Component Genesys Campaign List

Business Component Genesys Queue Item

Business Component Genesys Synch Summary

Business Component Genesys Campaign Members

Business Object Genesys Campaign Default List

Business Object Genesys Campaign List

Business Object Genesys Campaign List Contact

Business Object Genesys Queue

Business Object Genesys Synch Summary

Business Object Genesys Campaign Members

Business Service Genesys Campaign Synchronization

Integration Object Genesys — Campaign List Contact

Link Campaign List Contact / Campaign

Link Campaign List Contact / Campaign Lists

Link (for Siebel 7.5.3) Campaign/Campaign List Contact
(Genesys Campaign Default List)

Link Genesys Campaign List / Campaign

Link Genesys Campaign List / Campaign List 
Contact

Link Genesys Campaign List / Campaign Lists

Link Genesys Queue / Genesys Queue Item

Link Genesys Queue / Genesys Queue Item. 
Sequence Number (Sequence)

Table CX_GEN_QUEUE_ITM

Table CX_GEN_SYN_SUM
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Changing the Campaign Business Component (Siebel 7.5.3)

To delete modifications that were made to the Campaign Business Component 
during deployment:

1. In Siebel Tools, in the Project field of the Object Explorer, select Campaign.

2. From the Object Explorer, select the Business Component folder. 
The Business Components window displays.

3. Select the Campaign Business Component.

4. Using the Types tab of the Object Explorer, select the Field folder under 
the Business Component folder. 
The Fields window displays.

5. Select the Created By Name field.

6. Right-click the selected record.

7. Select Delete Record from the drop-down menu.

8. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

9. Select the Join folder under the Business Component folder.
The Joins window displays.

10. Select the S_USER record.

11. Right-click the selected record.

12. Select Delete Record from the drop-down menu.

13. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

Components are referenced in Table 37.

Table 37: Elements to Delete from the Campaign Business 
Component (Siebel 7.5.3)

Type Name

Field Created By Name

Join S_USER
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Changing the Campaign List Contact Business Component

To delete modifications that were made to the Campaign List Contact Business 
Component during deployment:

1. In Siebel Tools, in the Project field of the Object Explorer, select Campaign.

2. From the Object Explorer, select the Business Component folder.
The Business Components window displays.

3. Select the Campaign List Contact Business Component.

4. Using the Types tab of the Object Explorer, select the Field folder under 
the Business Component folder. 
The Fields window displays.

5. Select the Primary Call List Id field.

6. Right-click the selected record.

7. Select Delete Record from the drop-down menu.

8. When prompted, “Are you sure you want to delete the current record?” 
click Yes to delete the record.

9. Repeat Steps 4–8 for all elements of the Campaign List Contact Business 
Component referenced in Table 38.

Compiling the Siebel Repository File

To compile the Siebel Repository File:

1. In Siebel Tools, select Tools > Compile Projects... 

2. Select Locked projects.

3. In the Siebel Repository File edit box, enter the name of the Repository 
File.

4. Click Compile. 
The status bar at the bottom of the Object Compiler window indicates 
when the compilation is finished.

5. When the compilation is finished, close Siebel Tools.

Table 38: Elements to Delete from the Campaign List Contact 
Business Component

Type Name

Field Primary Call List Id

Field Time Zone Id

Field Time Zone Name

Join S_TIMEZONE
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Note: It is possible for siebel_assert_xxx.txt file(s) to be generated by the 
Siebel environment after compiling the Siebel Repository File.

Changing the Siebel Server Configuration

Complete the steps described in this section to delete the Component 
implementation from the Siebel Server.

Deploying the Siebel Repository File

You need to deploy the compiled Siebel Repository File on your Siebel Server. 
Additionally, you may need to generate and deploy browser scripts for the new 
Repository File.

For further information on deploying an updated Repository File to the Siebel 
Server, refer to Siebel documentation.

Deleting EAI Transport Data Handling Subsystems and Connection 
Subsystems

Delete the following EAI Transport Data Handling and Connection 
Subsystems, which were created in your Siebel environment during 
deployment (listed here by their Alias):

• GplusCampSynchDispatch 

• GplusCampSyncConnectionPrimary 
• GplusCampSyncConnectionBackup 

Use the Siebel Server Manager (srvrmgr) utility to delete these subsystems. 
Specifically, use the “Delete named subsystem” command. For information 
about using Siebel Server Manager, see the Siebel documentation. 

Updating Configuration Files

Update the eai.cfg file in the Siebel Server installation. To update this file, 
open it and delete the following lines from the [HTTP Services] section:
GplusCampSynch = GplusCampSynchDispatch.

Deleting Genesys Tables from Siebel Server Database

Deleting Genesys tables from the Siebel repository does not delete them from 
the Siebel database. You have to delete them manually. The Genesys 
Campaign Synchronization project contains two tables: CX_GEN_QUEUE_ITM, and 
CX_GEN_SYN_SUM. You can use any affordable database tool (such as Microsoft 
SQL Enterprise Manager, Oracle Enterprise Manager, and so on) to drop these 
tables.
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Uninstallation

Select one of the following topics depending on your environment.

For Windows Customers

Complete the uninstallation program for the Component by using the 
Add/Remove Programs in the Control Panel on the host where you installed the 
Component.

For UNIX Customers

Delete the Component’s files by removing the directory that was used as the 
destination directory during installation.

You have deleted the Gplus Adapter 7.5 for Siebel CRM Campaign 
Synchronization Component from your environment.

Uninstalling the Voice Component
This section describes how to uninstall the Gplus Voice Adapter for Siebel 
CRM. Since there is a separate .sif file for each Voice feature, information 
about individual features is inserted into the general discussion. 

This section describes one uninstallation scenario: a full uninstallation of the 
Voice Component.

As in any installation or uninstallation procedure, back up all files and 
configuration before starting.

Note: Before proceeding with Step 4 of uninstallation of the Voice 
Component, stop the Gplus Communication Server. 

Uninstallation involves four processes:

1. Removing Gplus Adapter Specific Values and Settings from Siebel

You use the Siebel administration application to complete the related tasks.

2. Removing drivers and configurations from the Siebel application.

3. Removing Gplus Adapter objects from the Siebel application using Siebel 
Tools and compiling a new .srf file. 

Note: Basic Voice Siebel objects from the GenComm.sif file may be shared 
among other Voice components, so these should be removed only 
as the last step of a full uninstallation of the Gplus Voice Adapter.

4. Removing Files Installed by the Gplus Adapter Installation.



Gplus Adapter for Siebel CRM—Deployment Guide 409

Chapter 9: Uninstallation Instructions Uninstalling the Voice Component

Step-by-step instructions for completing each process are provided below.

Environment

The following environment is required in order to complete the uninstallation 
process:

• Siebel CRM Server platform with the Gplus Adapter 7.5 for Siebel CRM  
installed and deployed

• Siebel Tools

• Administrator rights for accessing the Siebel application

• Administrator privileges when logging into the operating system

Removing Gplus Adapter Specific Values and Settings from 
Siebel

For the Voice features, remove Values of the following types from the List of 
Values:

Basic Voice

• AGENT_WORK_MODE

• REASON_CODE

Expert Contact

• GENESYS_CALL_STATUS

• GENESYS_LOCATION

Outbound Campaign

• GENESYS_CALL_RESULT

• GENESYS_TREATMENT_TYPE

• GENESYS_CALLBACK_TYPE

Voice Callback

• GENESYS_ROUTING_POINT

Before you remove these values, read “Configuring the Siebel Call Center 
Application” on page 147. 

Removing Drivers and Configurations from Siebel

This step is optional. To remove drivers and configurations from the Siebel 
application follow this procedure: 

1. Log into Siebel as an Administrator.

2. In the Siebel Site Map, navigate to Communications Drivers and Profiles.
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 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 
Communications> Communications Drivers and Profiles.

 For earlier versions of Siebel, select Site Map > Communications 
Administration > Communications Drivers and Profiles.

3. Navigate to the Gplus driver record and delete it.

4. In the Siebel Site Map, navigate to All Configurations.
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration - 

Communications> All Configurations.
 For earlier versions of Siebel, select Site Map > Communications 

Administration > All Configurations.

5. Navigate to any unused Profiles associated with the Gplus driver and 
delete them.

Removing Siebel Components and Objects from Siebel

These elements of the configurations will be affected during the uninstallation 
process:

Basic Voice

Refer also to the GenComm.sif file for details.

Bitmap Category HTML Command Icons

• Bitmap

Business Service Genesys Voice

• Business Service Server Scripts

Command

• “HTML Comm *”

Toolbar Communication

• Toolbar Items

Expert Contact

Refer also to the GenComm_ECS.sif file for details.

Command

• HTML Comm *KW*

Toolbar Communication

• Toolbar Items
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Universal Callback

Refer also to the GenComm_VCB.sif file for details.

Contact Activity List Applet

• Server script

• Applet Web Template

• Control

Business Component Action

• BusComp Server Scripts

• Field

Business Component Contact

• BusComp Server Scripts

• Field

Pick List

• PickList Genesys Call Result

• PickList Genesys Rout Point

Command

• HTML Comm VoiceCallback*

Toolbar Communication

• Toolbar Items 

Table S_EVT_ACT_X

• Fields 

Outbound Campaign

Refer also to the GenComm_OCS.sif file for details.

Campaign Contact/Prospect Form Applet

• Server script

• Applet Web Template

• Control

Persistent Customer Dashboard Applet

• Control

Business Component Campaign List Contact

• BusComp Server Scripts

• Field

• Single Value Field

Business Service Persistent Customer Dashboard
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• Business Service User Prop

Command

• “HTML Comm *OB*”

Pick List

• PickList Genesys Call Result

Toolbar Communication

• Toolbar Items

Toolbar Dashboard

Making the Changes with Siebel Tools

If the components/objects above are already checked out and reside in the local 
database, you will need to lock each one. See the topic, “Updating the Siebel 
Repository File” on page 136 for instructions on how to check out and lock 
projects, if it is necessary.

1. In Siebel Tools, on the Object Explorer tab, navigate to Project.

2. In the Projects list, lock the projects as selected from Table 39. 

* This project is locked when deploying the Universal Callback feature as 
described in “Procedures for Siebel Repository File Preparation” on page 139. 
This is the project related to an application on which the Adapter is deployed. 

Table 39: Projects for All Supported Siebel Versions - Common for all Components 
and Feature-Specific

Feature Archive File Common Projects
(for all components)

Feature-Specific 
Projects

Basic Voice GenComm.sif

• Command

• Communication

• Communication 
Administration

• Persistent Customer 
Dashboard

None

Expert Contact GenComm_ECS.sif None

Outbound Campaign GenComm_OCS.sif • Campaign

Universal Callback GenComm_VCB • Activity

• Contact

• Contact (SSE)

• Table Activity

• Genesys Voice

• <Project related to an 
application on which 
the Adapter is 
deployed with the 
Universal Callback 
feature >*
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For example: Siebel Universal Agent (for Siebel version 7.5.3) or Siebel 
Financial Services (for Siebel versions 7.7/7.8/8.0/8.1).

The installation package for the Gplus Adapter 7.5 for Siebel CRM Voice 
Component contains Toolbar buttons, command descriptions, and bitmap 
images for Genesys Chat, Genesys E-mail, and Siebel eMail Components. 
Only elements related to uninstalling components should be deleted. Delete all 
elements for a full uninstallation. See the instructions under “Toolbar 
Communication” on page 423, “Command” on page 417 and “Bitmap 
Category HTML Command Icons” on page 413 for distribution of elements 
between components.

Bitmap Category HTML Command Icons

To remove Gplus customizations, do the following:

1. From the Object Explorer, go to Bitmap Category objects.

2. In the Bitmap Categories window, select the Bitmap Category HTML 
Command Icons.

3. Process the following actions for the Bitmap records.

Bitmap

1. From the Object Explorer, expand Bitmap Category > Bitmap object.

2. Delete the following records in the Bitmaps window:

a. Basic Voice Feature
 Comm Do Not Disturb
 Comm Do Not Disturb On
 Comm Ready
 Comm Ready Disabled

b. Expert Contact Feature
 Comm Accept Callback Enabled
 Comm Accept Callback Disabled
 Comm Reject Callback Enabled
 Comm Reject Callback Disabled

c. Outbound Campaign Feature
 Comm OB Add Disabled
 Comm OB Add Enabled
 Comm OB Cancel Disabled
 Comm OB Cancel Enabled
 Comm OB Chained Record Disable
 Comm OB Chained Record Enabled
 Comm OB Do Not Call
 Comm OB Do Not Call Disabled
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 Comm OB Get Preview Record
 Comm OB Get Preview Record Dis
 Comm OB Record Disabled
 Comm OB Record Enabled
 Comm OB Record Processed Dis
 Comm OB Record Processed Ena 
 Comm OB Record Reject Disabled
 Comm OB Record Reject Enabled
 Comm OB Schedule Disabled
 Comm OB Schedule Enabled
 Comm OB Start Preview Disabled
 Comm OB Start Preview Enabled
 Comm OB Stop Preview Disabled
 Comm OB Stop Preview Enabled
 Comm OB Update Disabled
 Comm OB Update Enabled

d. Web Callback Feature
 Comm Accept Callback Disabled
 Comm Accept Callback Enabled
 Comm Callback Done Disabled
 Comm Callback Done Enabled
 Comm Initiate Callback Dis
 Comm Initiate Callback Enabled
 Comm Reject Callback Disabled
 Comm Reject Callback Enabled

e. Voice Callback Feature
 Comm Callback Done Disabled*
 Comm OB Cancel Enabled*
 Comm OB Cancel Disabled*
 Comm OB Add Enabled*
 Comm OB Add Disabled*
 Comm OB Record Processed Ena*
 Comm OB Record Processed Dis*
 Comm OB Record Enabled*
 Comm OB Record Disabled*
 Comm OB Get Preview Record*
 Comm OB Get Preview Record Dis*
 Comm OB Record Reject Enabled*
 Comm OB Record Reject Disabled*
 Comm OB Schedule Enabled*
 Comm OB Schedule Disabled*
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 Comm VCB Start Session Enabled
 Comm VCB Start Session Disable

* - Shared with other configurations
f. Genesys Chat Feature

 Comm GChat Not Ready
 Comm GChat Ready

g. Genesys E-mail Feature
 Comm GEmail Not Ready
 Comm GEmail Ready

Command

To remove Gplus customizations for Command:

1. From the Object Explorer, go to the Command objects.

2. Delete the following records in the Commands window:

a. Basic Voice Feature
 HTML Comm AcceptGVoice
 HTML Comm Alternate Call
 HTML Comm Cancel Monitoring
 HTML Comm Delete From Conf
 HTML Comm Do Not Disturb
 HTML Comm InitiateGVoice
 HTML Comm LoginToGVoice
 HTML Comm LogoutFromGVoice
 HTML Comm Monitor Next Call
 HTML Comm NotReadyGVoice
 HTML Comm Query Address
 HTML Comm ReadyGVoice
 HTML Comm Send DTMF

b. Outbound Campaign Feature
 HTML Comm OB Add
 HTML Comm OB Chain Request
 HTML Comm OB Do Not Call
 HTML Comm OB Preview Over
 HTML Comm OB Preview Start
 HTML Comm OB Record Cancel
 HTML Comm OB Record Processed
 HTML Comm OB Record Reject
 HTML Comm OB Record Request
 HTML Comm OB Record Reschedule
 HTML Comm OB Scheduled Resched
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 HTML Comm OB Update
 HTML Comm OB Request Logout

c. Voice Callback Feature
 HTML Comm VoiceCallBackCancel
 HTML Comm VoiceCallbackAdd
 HTML Comm VoiceCallbackDone
 HTML Comm VoiceCallbackQuery
 HTML Comm VoiceCallbackRecord
 HTML Comm VoiceCallbackReject
 HTML Comm VoiceCallbackResched
 HTML Comm VoiceCallbackStart

d. Genesys Chat Feature
 HTML Comm AcceptGChat
 HTML Comm LoginToGChat
 HTML Comm LogoutFromGChat
 HTML Comm NotReadyGChat
 HTML Comm ReadyGChat

e. Genesys E-mail Feature
 HTML Comm AcceptGEmail
 HTML Comm InitiateGEmail
 HTML Comm LoginToGEmail
 HTML Comm LogoutFromGEmail
 HTML Comm NotReadyGEmail
 HTML Comm ReadyGEmail

f. Siebel eMail Feature
 HTML Comm AcceptSEmail
 HTML Comm InitiateSEmail
 HTML Comm LoginToSEmail
 HTML Comm LogoutFromSEmail
 HTML Comm NotReadySEmail
 HTML Comm ReadySEmail

g. Universal Interaction Handling commands
 HTML Comm AddInteraction
 HTML Comm Cancel Interaction
 HTML Comm Interaction Done
 HTML Comm Reschedule Interact

Business Service Genesys Voice

To remove Gplus customizations for this Business Service:

1. From the Object Explorer, go to Business Service objects.
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2. Select Business Service Genesys Voice from the list of Business Services.

3. Delete the record.

Expert Contact Feature

Command

1. From the Object Explorer, go to the Command objects.

2. Delete the following records in the Commands window:
 HTML Comm AcceptKwInteraction
 HTML Comm KwCallStatusResponse
 HTML Comm KwOnCall
 HTML Comm RejectKwInteraction

Toolbar Communication

Toolbar Items

1. From the Object Explorer, go to and expand Toolbar objects.

2. Select the Toolbar Communication in the Toolbars window.

3. Process the following actions for Toolbar Items.
 Toolbar Items

1. From the Object Explorer, go to the category Toolbar Item.

2. Delete the following records:
 Kw On Call

Outbound Campaign Feature

Campaign Contact/Prospect Form Applet

To remove Gplus customizations for this applet:

1. From the Object Explorer, go to the Applet objects.

2. Select the Campaign Contact/Prospect Form Applet on the list of applets.

3. Expand the Applet object on the Object Explorer.

4. Next, follow the steps below to process these categories:
 Server Script 
 Applet Web Template
 Control

Server Script

1. On the List of Applets window, right-click on the record and select Edit 
Server Scripts from the drop down menu.
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2. Navigate to the WebApplet_PreCanInvokeMethod.

3. If this method contains only Gplus-related modifications, then replace the 
complete source code between the braces with the statement:
return (ContinueOperations) ;

If this method contains user customizations, remove only the Gplus-related 
part of the code. 

For more details, refer to the topic, “Applet “Campaign Contact/Prospect 
Form Applet” Server Script Source Code” on page 426.

Applet Web Template

1. From the Object Explorer, go to the Applet Web Template category.

2. From the Applet Web Templates window, select the record Edit.

Control

1. From the Object Explorer, go to and expand the Control category.

2. Navigate to the Controls window.

3. Delete the following record:
 RescheduleTime

Business Component Campaign List Contact

To remove Gplus customizations for this Business Component:

1. From the Object Explorer, go to and expand the Business Component 
objects.

2. Select the Business Component Campaign List Contact in the Business 
Components window.

3. Process the following actions for:
 BusComp Server Scripts
 Field
 Single Value Field

BusComp Server Scripts

1. Select the Business Component Campaign List Contact in the Business 
Components window.

2. Right-click on the record and select Edit Server Scripts from the drop 
down menu.

3. On the Script editor window explorer, expand the (general) category.

4. Select the (declarations) section.

5. Delete following statements:
 var cStatusValue = null;
 var bInitiatedByCommCommand = false;
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6. Under the BusComp category navigate to the BusComp_PreInvokeMethod.

7. If this method contains only Gplus-related modifications, then replace the 
complete source code between the braces with the statement:
return (ContinueOperations) ;

If this method contains user customizations, remove only the Gplus-related 
part of the code.

For more details, refer to the topic, “Business Component “Campaign List 
Contact” Server Script Source Code” on page 426.

8. Repeat Steps 6 and 7 for the following event handlers:
 BusComp_PreSetFieldValue 
 BusComp_SetFieldValue 
 BusComp_WriteRecord 

9. Close BusComp[Campaign list Contact] - Script window using the Tools 
menu command Window > Close.

10. From the Object Explorer, navigate to the BusComp Server Scripts 
category. 

11. From the Business Component Server Scripts window, delete the following 
records:
 CallCommunicationsCommand 
 DisplayGenesysError 
 GetGenesysStatusCode 
 SetDoNotCallFlag 
 PostChangesToGenesys 
 WriteRecordNoGenesysUpdate

12. Save files using the File > Save All menu command.

Field
 From the Object Explorer, go to and expand the Field category.
 Select the Status record.
 On the Properties dialog box, set the field’s PickList value PickList 

Genesys Call Result to blank.

Pick List

To remove Gplus customizations for Pick List:

1. From the Object Explorer, go to the Pick List objects.

2. Process the following actions for PickList Genesys Call Result.

PickList Genesys Call Result

1. Select the PickList Genesys Call Result on the PickLists window.

2. Delete the record.
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Universal Callback

Application Siebel Universal Agent (for Siebel version 7.5.3), or Siebel Financial 
Services (for Siebel versions 7.7/7.8/8.0/8.1)

To remove Gplus customizations for this Application: 

1. From the Object Explorer, go to the Applications objects. 

2. On the Applications list window, select the application on which the Gplus 
Adapter was deployed (for example, Siebel Universal Agent for Siebel 
version 7.5.3, or Siebel Financial Services for Siebel versions 
7.7/7.8/8.0/8.1), then right-click the record and select Edit Server Scripts 
from the drop down menu.

3. Under the Application category, navigate to the Application_PreNavigate 
method.

4. If this method contains only Gplus-related modifications, then replace the 
complete source code between the braces with the statement:
return (ContinueOperations) ;

If this method contains user customizations, remove only the Gplus-related 
part of the code. 

For more details, refer to the topic, “Universal Callback Server Script 
Source Code” on page 427.

Contact Activity List Applet

To remove Gplus customizations for this applet:

1. From the Object Explorer, go to the Applet objects.

2. Select the Contact Activity List Applet on the list of applets.

3. Expand the Applet object on the Object Explorer.

4. Next, follow the steps below to process these categories:
 Applet Web Template
 List

Applet Web Template

1. From the Object Explorer, go to the Applet Web Template category.

2. From the Applet Web Templates window, select the record Base.

3. From the Object Explorer, expand the Applet Web Template Item.

4. From the Applet Web Template Items window, delete the following 
records:
 Genesys Rout Point

5. From the Applet Web Templates screen, select record Edit List.

6. Repeat Steps 3 and 4.
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List

1. From the Object Explorer, go to and expand the List category. 

2. Select then List Column item

3. Navigate to the List Columns window. 

4. Delete the following record: 
 Genesys RoutPoint

Business Component Action

To remove Gplus customizations for this Business Component:

1. From the Object Explorer, go to and expand the Business Component 
objects.

2. Select the Business Component Action in the Business Components 
window.

3. Process the following actions for:
 Field

4. From the Object Explorer, go to and expand the Field category. 

5. From the Fields window delete the following records:
 Genesys Call Id
 Genesys Route Point

Pick List

To remove Gplus customizations for Pick List:

1. From the Object Explorer, go to the Pick List objects.

2. Process the following actions for PickList Genesys Rout Point.

PickList Genesys Rout Point

1. Select the PickList Genesys Rout Point on the PickLists window.

2. Delete the record.

Command

1. From the Object Explorer, go to the Command objects.

2. Delete the following records in the Commands window:
 HTML Comm VoiceCallbackAdd
 HTML Comm VoiceCallbackDone
 HTML Comm VoiceCallbackQuery
 HTML Comm VoiceCallbackRecord
 HTML Comm VoiceCallbackReject
 HTML Comm VoiceCallbackResched
 HTML Comm VoiceCallbackStart
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Restoring S_EVT_ACT_X table structure

To update a table on a local Siebel database (or on the Siebel server database):

Note: This operation is required only when new tables or new fields were 
created, as is the case for GenComm_VCB.sif.

1. Connect Tools to the server database.

2. In Siebel Tools, in the Object Explorer, navigate and expand the Table 
object.

3. Navigate to the List of Tables pane.

4. Locate the table S_EVT_ACT_X.

5. On the Object Explorer window, select the Columns category.

6. Locate and remove the following records:
 X_ATTRIB_51
 X_ATTRIB_52

7. Click Apply.

A pop-up Warning window appears.

8. Click OK to accept the warning.

9. In the new Apply Schema window, from the Tables drop down list, select 
Current Row.

10. Enter correct values for the Database user, Database user password, and 
ODBC data source.

You must enter the user name and password for a Database user who has 
an administrator's privileges in the Siebel environment.

Refer to Figure 15, “Creating New Tables in a Siebel Database,”  on 
page 113.

See the Siebel documentation for more information about creating custom 
tables.

11. Click Apply.

The message “Changes successfully applied” appears, indicating that 
tables were created.

12. Click the Activate button to propagate database changes and make them 
available to all users.

Note: It may be necessary to create some fields in the local database. Refer to 
the Siebel Tools documentation.



Gplus Adapter for Siebel CRM—Deployment Guide 423

Chapter 9: Uninstallation Instructions Uninstalling the Voice Component

Deploying the Changed Tables to the Siebel Server

To deploy the changed table to the Siebel Server Repository, you have to check 
in projects as follows:

1. In Siebel Tools, select Tools > Check In....

The Check In dialog box displays.

2. In the Projects list, select the following projects:
 Table Activity.

3. Click Check In.

To apply changes to Siebel databases, follow the steps described in the section 
“Updating New Tables in a Genesys Project on a Server Database” on 
page 146.

Toolbar Communication

To delete Toolbar Items

1. From the Object Explorer, go to and expand Toolbar objects.

2. Select the Toolbar Communication in the Toolbars window.

3. Process the following actions for Toolbar Items.

Toolbar Items

1. From the Object Explorer, go to the category Toolbar Item.

2. Delete the following record:
 Start Voice Callback

Toolbar Communication 

Note: Some Communication Toolbar buttons are deleted during component 
uninstallation procedures. The scenario described below is provided to 
present an overview of toolbar uninstallation procedures and to remove 
universal interaction control buttons, which are used with all Voice 
components.

To remove Gplus customizations:

1. From the Object Explorer, go to and expand Toolbar objects.

2. Select the Toolbar Communication in the Toolbars window.

3. Process the following actions for Toolbar Items.

Toolbar Items

1. From the Object Explorer, go to the category Toolbar Item.

2. Delete the following records:

a. Basic Voice Feature
 Alternate Call
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 Cancel Monitoring
 Delete From Conference
 Do Not Disturb 
 LogIn GVoice
 LogOut GVoice
 Monitor Next Call
 Query Address
 Ready GVoice

b. Expert Contact Feature
 KW on Call

c. Outbound Campaign Feature
 Chained Record Request
 Do Not Call
 Preview Dialing Mode Over
 Preview Dialing Mode Start
 Preview Record Request

d. WebCallback Feature
 None

e. Genesys Chat Feature
 Accept GChat
 LogIn GChat
 LogOut GChat
 Not Ready GChat
 Ready GChat

f. Genesys E-mail Feature
 Accept GEmail
 Initiate GEmail
 LogIn GEmail
 LogOut GEmail
 Not Ready GEmail
 Ready GEmail

g. Siebel eMail Feature
 Accept Email
 Initiate Email
 LogIn SEmail
 LogOut SEmail
 Not Ready Email
 Ready SEmail

h. Universal Interaction control buttons
 Add Interaction
 Reject Interaction
 Cancel Interaction
 Reschedule Interaction
 Interaction Done
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Compiling the Siebel Repository File

Recompile Siebel Repository File. See the Siebel documentation for 
instructions.

Removing Files Installed by the Gplus Adapter Installation

This process involves removing files that were installed in the system from the 
Gplus Adapter installation package.

Before starting with uninstallation of files, read the topic, “Installation” on 
page 123. The information from this topic will help you successfully complete 
the uninstallation process. 

For Windows Customers

1. Log into the system as an Administrator.

2. Stop the Gplus Communication Server.

3. Double-click setup.exe from the installation package (windows\setup.exe).

4. When prompted, Genesys Installation Wizard lets you remove the 
current installation of the Gplus Adapter for Siebel CRM Voice from 
your computer, choose Remove and click Next.

5. To complete uninstallation, remove icons from the web server images 
directory.

For UNIX Customers

1. Log into the system as an Administrator.

2. Stop the Gplus Communication Server.

3. Go to the Gplus Communication Server directory.

4. Manually remove the following Adapter files:
<Gplus Communication Server directory>/libGenComm.so

<Gplus Communication Server directory>/libGenModel.so

<Gplus Communication Server directory>/libGenComm.ini.

5. Remove all files and subdirectories in <Destination Directory> (the 
destination directory for installation that is used by the installation script to 
copy the Gplus Adapter for Siebel CRM Voice files.

6. To complete uninstallation, remove icons from the web server images 
directory.

Note: Don’t forget to restore from backup the original Siebel icons for 
Ready/Not Ready Communication toolbar buttons. See the Installation 
section of Chapter 5, “Configuration and Installation of the Voice 
Component,” on page 119 for details.
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List of Files Included in the Gplus Adapter Installation 
Package

You can obtain source code for the following:

• Business Component “Campaign List Contact” Server Script

• Applet “Campaign Contact/Prospect Form Applet” Server Script

• Universal Callback Server Script

Business Component “Campaign List Contact” Server 
Script Source Code

To obtain the source code:

1. Prepare a clean local Siebel database. Refer to Siebel Tools documentation 
for detailed procedures.

2. Start Siebel Tools and set up to work with your local database.

3. Import the GenCommocs.sif archive. For more information, see the topic, 
“Importing Voice Component Archive (.sif) Files and Resolving Conflicts” 
on page 141.

4. From the Object Explorer, go to the Business Component objects.

5. From the Business component window, select the Campaign List Contact 
record.

6. Right-click the record and select Edit Server Script from the drop-down 
menu.

7. From the Siebel Tools main menu, select File > Export.

8. Save the source code of the script.

Applet “Campaign Contact/Prospect Form Applet” 
Server Script Source Code

After you have completed the steps in “Business Component Campaign List 
Contact” on page 418, follow this procedure to obtain the source code:

1. From the Object Explorer, go to the Applet objects.

2. From the Applets window, select the Campaign Contact/Prospect Form 
Applet record.

3. Right-click the record and select Edit Server Script from the drop-down 
menu.

4. From the Siebel Tools main menu, select File > Export.

5. Save the script’s source code.
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Universal Callback Server Script Source Code

Source code for the Server Script Application_PreNavigate method is provided 
with the Gplus Adapter installation in the file 
<InsDir>/<OBJECTS>/Application_PreNavigate_VCB.es. Refer to “Updating the 
Application's Application_PreNavigate Event Server Script” on page 436 in 
the Appendix.

Uninstalling the Gplus UCS Gateway for 
Siebel CRM

The process of uninstalling the Gplus UCS Gateway for Siebel CRM consists 
of removing the files installed by the Gplus UCS Gateway in the installation 
directory.

Removing Files Installed by the Gplus UCS Gateway for 
Siebel CRM

Follow the instructions below based on your environment.

For Windows Customers

• Complete the uninstallation program for the UCS Gateway Component by 
using Add/Remove Programs in the Control Panel on the host where you 
installed the component.

For UNIX Customers

• Delete the UCS Gateway Component’s files by removing the directory that 
was used as the destination directory during installation.

Uninstalling the Media Routing Component
This section describes how to uninstall the Gplus Media Routing Component 
for Siebel. The uninstallation process consists of three steps:

1. Backing up your files and configuration before starting the uninstallation 
process (Genesys recommendation)

2. Removing files installed in the installation directory

3. Removing Siebel objects brought by the Gplus Adapter for Siebel CRM 
Media Routing Component.
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Environment

The following environment is required to complete the uninstallation process:

• Siebel Server platform with the Gplus Media Routing Component for 
Siebel installed and deployed

• Siebel Tools

• Administrator rights to access the Siebel application

• Administrator privileges to log in to the operating system

Uninstallation Process

This section contains step-by-step instructions about how to uninstall the 
Media Routing Component from Siebel Server and remove unused 
components from the Siebel application.

Removing Files Installed by the Gplus Adapter for 
Siebel CRM Media Routing Component

Follow the instructions below based on your environment.

For Windows Customers

• Complete the uninstallation program for the Media Routing Component by 
using Add/Remove Programs in the Control Panel on the host where you 
installed the component.

For UNIX Customers

• Delete the Media Routing Component’s files by removing the directory 
that was used as the destination directory during installation.

Removing Siebel Objects

Use Siebel tools to perform the following steps: 

1. Remove the GplusMediaRoute Business Service.

a. Lock the GplusMediaRoute Project.

b. From the Object Explorer, browse to the GplusMediaRoute Project and 
select the Business Service tab.

c. In the Business Services window, right-click the GplusMediaRoute 
Business Service and select Delete from the drop-down menu.

2. Remove the MediaRouting Communication Detail View.

a. From the Object Explorer, select the View tab.

b. Click the New Query button on the toolbar.
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c. Set the Name to MediaRouting Communication Detail View, and click 
the Execute Query button.

d. From the Views window, right-click the MediaRouting Communication 
Detail View record and select Delete from the drop-down menu.

3. Remove the MediaRouting Comm Inbound Item Form Applet and 
MediaRouting Comm Outbound Item Applet.

a. From the Object Explorer, select the Applet tab.

b. Click the New Query button on the toolbar.

c. Set the Project to GplusMediaRouting, and click the Execute Query 
button.

d. From the Applets window, right-click the MediaRouting Comm Inbound 
Item Form Applet record and select Delete from the drop-down menu.

e. From the Applets window, right-click the MediaRouting Comm Outbound 
Item Applet record and select Delete from the drop-down menu.

4. Recompile the project.

Siebel Administration Application

1. Start Siebel Server.

2. Deactivate and delete the GplusMediaRouting-ProcessMessage Workflow 
Process.

a. Select Site Map > Business Process Administration > Workflow 
Processes.

b. Make a query for the GplusMediaRouting-ProcessMessage workflow.

c. Deactivate and delete all the GplusMediaRouting-ProcessMessage 
workflows.

Uninstalling the Multimedia Component
The process of uninstalling the Gplus Adapter for Siebel CRM Multimedia 
Component consists of the following steps:

• Remove files installed in the installation directory. 

• Remove Siebel objects brought by the Gplus Adapter for Siebel CRM 
Multimedia Component.

• Update the Siebel configuration.

Removing Files Installed by the Gplus Adapter for Siebel 
CRM Multimedia Component

Follow the instructions below based on your environment.
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For Windows Customers

• Complete the uninstallation program for the Multimedia Component by 
using Add/Remove Programs in the Control Panel on the host where you 
installed the component.

For UNIX Customers

• Delete the Multimedia Component’s files by removing the directory that 
was used as the destination directory during installation.
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Removing Siebel Objects

1. Start Siebel Tools.

2. Select the Genesys Multimedia project in the top drop-down combo box of 
the Object Explorer.

3. Go to the following folders and remove all objects belonging to the 
Genesys Multimedia project:
 Applet
 Business Component
 Business Object
 Business Service
 Integration Object
 Link
 Screen
 Symbolic Strings (Siebel 7.5.3 or later)
 View
 Web Template

4. Remove the page tab created during deployment.

5. Compile a new SRF file.

Updating Siebel Configuration

This step is optional. To remove drivers and configurations from the Siebel 
application, follow this procedure:

1. Log in to Siebel as an Administrator.

2. In the Siebel Site Map, navigate to Communications Drivers and Profiles:
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration -

Communications > Communications Drivers and Profiles. 
 For earlier versions of Siebel, select Site Map > Communications 

Administration > Communications Drivers and Profiles. 

3. Navigate to the Gplus_OpenMedia record and delete it.

4. In the Siebel Site Map, navigate to All Configurations:
 For Siebel 7.7/7.8/8.0/8.1, select Site Map > Administration -

Communications > All Configurations. 
 For earlier versions of Siebel, select Site Map > Communications 

Administration > All Configurations. 

5. Navigate to any unused Profiles associated with the Gplus_OpenMedia 
record and delete them.
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Removing List of Values

To remove List of Values:

1. Log in as Siebel administrator.

2. In the Siebel Site map, navigate to the List of Values administration 
applet and delete the following records identified by Type and Display 
value:
a. CHANNEL_TYPE, OpenMedia

b. REPOSITORY_HTML_CTRL_TYPE, GChatControl

c. COMM_MEDIA_TYPE, OpenMedia

d. TODO_TYPE, Email - Outbound (MCR)\

e. TODO_TYPE, Email - Inbound (MCR)
f. LOV_TYPE, MCR_WORKBIN_TYPE

g. MCR_WORKBIN_TYPE,*

h. EVENT_STATUS,Completed

i. EVENT_STATUS, NotQueued

Removing Responsibilities and View Definitions

To remove responsibilities and view definitions:

1. Log in as Siebel administrator.

2. In the Siebel Site map, navigate to the Responsibilities administration 
view and delete the following record identified by Name:
 Genesys Multimedia Agent

3. In the Siebel Site map, navigate to the View administration view and 
delete the following records identified by Name:

a. MCR Chat plus Knowledge Manager

b. MCR Reply Email plus InAttachments

c. MCR Reply Email plus Knowledge Manager

d. MCR Reply Email plus OutAttachments

e. MCR Reply Email with Suggestion

f. MCR Reply Email plus InAttachments T

g. MCR Reply Email plus Knowledge Manager T

h. MCR Reply Email plus OutAttachments T

i. MCR Reply Email with Suggestion T

j. MCR Workbin View

k. MCR dummy 1

l. MCR dummy 2

m. MediaRouting Communication Detail View
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Removing the Outbound Web Service Definition

To remove the Outbound Web Service definition:

1. Log in as Siebel administrator.

2. In the Siebel site map, navigate to the Outbound Web Service 
administration view and delete the following record identified by Name:
 Genesys Gplus WebService
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Appendix

Scripts
This appendix includes the following sections:
 Generating and Deploying Browser Scripts, page 435
 Updating the Application's Application_PreNavigate Event Server Script, 

page 436

Generating and Deploying Browser Scripts
You must generate and deploy browser scripts each time a new Siebel 
Repository File (.srf) is deployed to the Mobile Web Client or Siebel Server.

The browser scripts are JavaScript files (*.js). They are automatically 
generated when you compile objects to a repository file (for compiled projects 
only). You can specify where the files are to be compiled (see the option in 
Siebel Tools), but if you are deploying to a server environment, the files have 
to be manually migrated to a specific directory on the Web Server. This process 
has been replaced by a utility that extracts the compiled Browser Script files 
from the .srf. The utility is called genbscript.exe and may be found in either 
siebsrvr/bin or client/bin.

You must locate browser scripts on the Siebel Server machine in 
<SWEApp>/public/language_code .

After you have created the browser scripts, you must re-start Siebel Server.

For further information about browser script generation and deployment, see 
“Siebel Tools Reference” and “Alert 365: Browser Script Generation in Siebel 
v7” on the Siebel support website.
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Updating the Application's 
Application_PreNavigate Event Server 
Script

During Voice component or Multimedia component configuration you must 
add or modify (if it already exists) the Server script handler for the 
Application_PreNavigate event for the Siebel application being used. 

The content of the event handler for each component is provided in a special 
.es file.

For the Voice component, this file is:
<InsDir>/OBJECTS/Application_PreNavigate_VCB.es

For the Multimedia component, this file is:
<InsDir>/OBJECTS/Application_PreNavigate.es

Each of these files has the following structure:
function Application_PreNavigate (DestViewName, DestBusObjName)

{

    <function body>

    return (ContinueOperation);

}

where <function body> is e-script code designed for the appropriate 
component.

If the original Application_PreNavigate event script consists only of a 
return(ContinueOperation) call, construct the resulting one as:
function Application_PreNavigate (DestViewName, DestBusObjName)

{

<VOICE function body>

<MULTIMEDIA function body>

return (ContinueOperation);

}

Therefore, just copy <function body> code from the appropriate files for each 
component into the Application_PreNavigate event script body and finalize 
them by a return(ContinueOperation) call.

If the original Application_PreNavigate event script is more complex, make a 
manual merge.
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